# Table of Contents

1. C Language ...................................................................................................................... 1
   1.1. Data Types .................................................................................................................. 1
       1.1.1. Changing the Alignment: __align() ................................................................. 3
   1.2. Accessing Memory ..................................................................................................... 3
       1.2.1. Memory Type Qualifiers .................................................................................. 3
       1.2.2. Pointers ......................................................................................................... 4
       1.2.3. Placing an Object at an Absolute Address: __at() ......................................... 5
       1.2.4. Accessing Hardware from C ................................................................. 6
   1.3. Shift JIS Kanji Support .............................................................................................. 7
   1.4. Using Assembly in the C Source: __asm() ................................................................. 8
   1.5. Attributes ................................................................................................................. 14
   1.6. Pragmas to Control the Compiler ............................................................................... 18
   1.7. Predefined Preprocessor Macros ............................................................................... 23
   1.8. Switch Statement ....................................................................................................... 24
   1.9. Functions .................................................................................................................. 25
       1.9.1. Calling Convention ....................................................................................... 25
       1.9.2. Register Usage .............................................................................................. 26
       1.9.3. Inlining Functions: inline .............................................................................. 27
       1.9.4. Interrupt Functions ....................................................................................... 28
       1.9.5. Intrinsic Functions ....................................................................................... 31
   1.10. PCP Code Generation .............................................................................................. 38
       1.10.1. Non-interruptible Code Generation ............................................................. 38
       1.10.2. Interruptible Code Generation ...................................................................... 39
   1.11. Compiler Generated Sections ................................................................................... 41
       1.11.1. Rename Sections ......................................................................................... 42

2. Assembly Language .......................................................................................................... 45
   2.1. Assembly Syntax ........................................................................................................ 45
   2.2. Assembler Significant Characters ............................................................................ 46
   2.3. Operands of an Assembly Instruction ......................................................................... 47
   2.4. Symbol Names ......................................................................................................... 47
       2.4.1. Predefined Preprocessor Symbols ................................................................ 48
   2.5. Registers .................................................................................................................. 48
       2.5.1. Special Function Registers ......................................................................... 49
   2.6. Assembly Expressions ............................................................................................... 49
       2.6.1. Numeric Constants ...................................................................................... 50
       2.6.2. Strings ..................................................................................................... 50
       2.6.3. Expression Operators ................................................................................. 51
   2.7. Working with Sections ............................................................................................... 52
   2.8. Built-in Assembly Functions ...................................................................................... 53
   2.9. Assembler Directives and Controls ........................................................................... 65
       2.9.1. Assembler Directives ............................................................................... 66
       2.9.2. Assembler Controls ................................................................................... 113
   2.10. Macro Operations .................................................................................................... 125
       2.10.1. Defining a Macro .................................................................................... 125
       2.10.2. Calling a Macro ...................................................................................... 125
       2.10.3. Using Operators for Macro Arguments .................................................... 126
   2.11. Generic Instructions ............................................................................................... 130

3. Using the C Compiler ....................................................................................................... 133
TASKING VX-toolset for PCP User Guide

10. Libraries .................................................................................................................. 519
  10.1. Library Functions ................................................................................................. 520
    10.1.1. assert.h .......................................................................................................... 520
    10.1.2. complex.h .................................................................................................... 520
    10.1.3. cstart.h ......................................................................................................... 521
    10.1.4. ctype.h and wctype.h .................................................................................. 521
    10.1.5. dbg.h ........................................................................................................... 522
    10.1.6. errno.h ......................................................................................................... 523
    10.1.7. except.h ....................................................................................................... 524
    10.1.8. fcntl.h .......................................................................................................... 524
    10.1.9. env.h ............................................................................................................. 524
    10.1.10. float.h ....................................................................................................... 525
    10.1.11. inttypes.h and stdint.h ............................................................................. 526
    10.1.12. io.h ............................................................................................................. 526
    10.1.13. iso646.h ..................................................................................................... 527
    10.1.14. limits.h ...................................................................................................... 527
    10.1.15. locale.h ..................................................................................................... 527
    10.1.16. malloc.h .................................................................................................... 527
    10.1.17. math.h and tgmath.h ............................................................................... 528
    10.1.18. setjmp.h ..................................................................................................... 532
    10.1.19. signal.h ..................................................................................................... 532
    10.1.20. stdalign.h .................................................................................................. 533
    10.1.21. stdarg.h .................................................................................................... 533
    10.1.22. stdbool.h ................................................................................................. 534
    10.1.23. stddef.h .................................................................................................. 534
    10.1.24. stdint.h .................................................................................................... 534
    10.1.25. stdio.h and wchar.h ............................................................................... 534
    10.1.26. stdlib.h and wchar.h ............................................................................. 542
    10.1.27. stdnoreturn.h .......................................................................................... 545
    10.1.28. string.h and wchar.h ............................................................................. 546
    10.1.29. time.h and wchar.h ................................................................................. 547
    10.1.30. uchar.h ...................................................................................................... 550
    10.1.31. unistd.h .................................................................................................... 550
    10.1.32. wchar.h .................................................................................................... 551
    10.1.33. wctype.h .................................................................................................. 552
  10.2. C Library Reentrancy .......................................................................................... 553
11. List File Formats ...................................................................................................... 565
  11.1. Assembler List File Format ................................................................................ 565
  11.2. Linker Map File Format ..................................................................................... 566
12. Linker Script Language (LSL) ................................................................................ 571
  12.1. Structure of a Linker Script File ........................................................................ 571
  12.2. Syntax of the Linker Script Language ................................................................ 573
    12.2.1. Preprocessing ............................................................................................... 573
    12.2.2. Lexical Syntax ............................................................................................. 574
    12.2.3. Identifiers and Tags ..................................................................................... 575
    12.2.4. Expressions ............................................................................................... 575
    12.2.5. Built-in Functions ....................................................................................... 576
    12.2.6. LSL Definitions in the Linker Script File .................................................... 578
    12.2.7. Memory and Bus Definitions ...................................................................... 579
    12.2.8. Architecture Definition ............................................................................... 581
Chapter 1. C Language

This chapter describes the target specific features of the C language, including language extensions that are not standard in ISO-C. For example, pragmas are a way to control the compiler from within the C source.

The TASKING C compiler fully supports the ISO C99 standard and supports all mandatory language features of the C11 standard, and adds extra possibilities to program the special functions of the target. C11 is the default of the C compiler.

C11 language features

All mandatory ISO C11 language features are supported (ISO/IEC 9899:2011 section 6.10.8.1 Mandatory macros). Furthermore the C compiler supports the following conditional features (ISO/IEC 9899:2011 section 6.10.8.3 Conditional feature macros):

• variable length arrays and variably modified types

Other conditional language features such as threads, as mentioned in section 6.10.8.3 Conditional feature macros and section 6.10.8.2 Environment macros of the ISO/IEC 9899:2011 standard, are not supported. __STDC_NO_ATOMICS__ and __STDC_NO_THREADS__ are defined as 1.

Additional language features

In addition to the standard C language, the compiler supports the following:

• keywords to specify memory types for data and functions
• attribute to specify alignment and absolute addresses
• intrinsic (built-in) functions that result in target specific assembly instructions
• pragmas to control the compiler from within the C source
• predefined macros
• the possibility to use assembly instructions in the C source
• keywords for inlining functions and programming interrupt routines
• libraries

All non-standard keywords have two leading underscores (__).

In this chapter the target specific characteristics of the C language are described, including the above mentioned extensions.

1.1. Data Types

The C compiler supports the following data types.
### Aggregate and Union Types

Aggregate types are aligned on 32 bits by default. All members of the aggregate types are aligned as required by their individual types as listed in the table above. The struct/union data types may contain bit-fields. The allowed bit-field fundamental data types are \_Bool, (un)signed char and (un)signed int. The maximum bit-field size is equal to that of the type’s size. For the bit-field types the same rules regarding to alignment and signed-ness apply as specified for the fundamental data types. In addition, the following rules apply:

- The first bit-field is stored at the least significant bits. Subsequent bit-fields fill the higher significant bits.
C Language

- A bit-field of a particular type cannot cross a boundary as is specified by its maximum width. For example, a bit-field of type `int` cannot cross a 32-bit boundary.

- Bit-fields share a storage unit with other bit-field members if and only if there is sufficient space in the storage unit.

- An unnamed bit-field creates a gap that has the size of the specified width. As a special case, an unnamed bit-field having width 0 (zero) prevents any further bit-field from residing in the storage unit corresponding to the type of the zero-width bit-field.

1.1.1. Changing the Alignment: `__align()`

By default the PCP compiler aligns objects to the minimum alignment required by the architecture. With the attribute `__align()` you can change the object alignment that is located in the FPI space. Objects qualified with `__far` are located in the FPI space. The alignment must be a power of two. `__align()` has no effect on object located in the PRAM space of the PCP.

Example:

```c
int __align( 8 ) __far src[4];
```

The compiler generates the following assembly:

```
.sdecl '.bss.linear', data, linear, clear
.sect '.bss.linear'
.global _PCP_src
.align 8
_PCPSrc: .type object
.size _PCP_src,16
.space 16
```

Instead of the attribute `__align()` you can also use `#pragma align`.

1.2. Accessing Memory

You can use static memory type qualifiers to allocate static objects in a particular part of the addressing space of the processor.

In addition, you can place variables at absolute addresses with the keyword `__at()`.

1.2.1. Memory Type Qualifiers

In the C language you can specify that a variable must lie in a specific part of memory. You can do this with a memory type qualifier. If you do not specify a memory type qualifier, data objects get a default memory type.

You can specify the following memory type qualifiers:
If you do not specify __far, the compiler chooses where to place the declared object.

Data objects are located by default in the PRAM space of the PCP (__near is the default). The Memory Access Unit (MAU) of PRAM is 32-bit. All objects located in the PRAM always have a size of 32 bits.

Data objects that are qualified __far are located in the FPI space. The FPI space is the TriCore® linear address space. The Memory Access Unit (MAU) of the FPI is 8-bit. By default the object size of __far qualified objects is 32-bit, because the default data type size is 32-bits on the PCP for PRAM and FPI.

__far data objects with type char or short can have type modifier __mau8 to allow 8-bit and 16-bit data allocation on the FPI. FPI instructions are generated to access objects that are qualified __far.

Examples

```c
char c;   // 32-bit object in PRAM
short s;  // 32-bit object in PRAM
int   i;   // 32-bit object in PRAM
char text[] = "No smoking"; // 11 words in PRAM

__far char c;   // 32-bit object in FPI
__far short s;  // 32-bit object in FPI
__far int   i;  // 32-bit object in FPI
__far char text[] = "No smoking"; // 11 words in FPI

__far __mau8 char c;  // 8-bit object in FPI
__far __mau8 short s; // 16-bit object in FPI
__far __mau8 int   i; // 32-bit object in FPI
__far __mau8 char text[] = "No smoking"; // 11 bytes in FPI
```

### 1.2.2. Pointers

The PCP compiler supports code and data pointers as shown in the following table.

<table>
<thead>
<tr>
<th>Pointer</th>
<th>Location</th>
<th>Maximum object size</th>
<th>Pointer size</th>
<th>Section type</th>
</tr>
</thead>
<tbody>
<tr>
<td>__near data pointer</td>
<td>PRAM space</td>
<td>64 kB</td>
<td>14-bit</td>
<td>data</td>
</tr>
<tr>
<td>__far data pointer</td>
<td>FPI space</td>
<td>4 GB</td>
<td>32-bit</td>
<td>linear</td>
</tr>
<tr>
<td>code pointer</td>
<td>CMEM space</td>
<td>128 kB</td>
<td>16-bit</td>
<td>code</td>
</tr>
</tbody>
</table>
The default section name is equal to the generated section type that is prefixed with .pcptext. for code in CMEM and .pcpdata. for data in PRAM. The default code section name is .pcptext.code and the default PRAM data section name is .pcpdata.data. The default FPI data section name uses a prefix conform the TriCore C compiler. E.g. __far int i; is located in a section with name .bss.linear. You can change section names with #pragma section or with the command line option --rename-sections.

**Pointers with memory type qualifiers**

Pointers for the PCP can have two types: a 'logical' type and a memory type. For example,

```c
char __far * p;
```

means p has memory type PRAM (p itself is allocated in PRAM, PRAM is the default), but has logical type 'character in target memory space FPI (__far). The memory type qualifier used left to the '*', specifies the target memory of the pointer, the memory type qualifier used right to the '*', specifies the storage memory of the pointer.

Examples:

```c
int * p; // pointer 'p' located in PRAM pointing to int in PRAM
int __far * q; // pointer 'q' located in PRAM pointing to int in FPI
int * __far r; // pointer 'r' located in FPI pointing to int in PRAM
int __far * __far s; // pointer 's' located in FPI pointing to int in FPI
```

A PRAM pointer cannot be converted to an FPI (__far) pointer or visa versa.

**1.2.3. Placing an Object at an Absolute Address: __at()**

Just like you can declare a variable in a specific part of memory (using memory type qualifiers), you can also place an object or function at an absolute address in memory.

With the attribute __at() you can specify an absolute address. The address is a 32-bit linear address.

Examples

```c
unsigned char Display[80*24] __at( 0x2000 );
```

The array Display is placed at address 0x2000. In the generated assembly, an absolute section is created. On this position space is reserved for the variable Display.

```c
int i __at(0x1000) = 1;
```

The variable i is placed at address 0x1000 and is initialized.

```c
void f(void) __at( 0xf0ff + 1 ) { }
```

The function f is placed at address 0xf100.

**Restrictions**

Take note of the following restrictions if you place a variable at an absolute address:
• The argument of the __at() attribute must be a constant address expression. Otherwise the compiler generates an error.

• You can place only global variables at absolute addresses. Parameters of functions, or automatic variables within functions cannot be placed at absolute addresses. If they are, the compiler generates an error.

• A variable that is declared extern, is not allocated by the compiler in the current module. Hence you should not use the keyword __at() on an external variable. If you do, the compiler ignores the keyword __at() without generating an error. Use __at() at the definition of the variable.

• You cannot place structure members at an absolute address. If you do, the compiler ignores the keyword __at() and generates a warning.

• Absolute variables cannot overlap each other. If you declare two absolute variables at the same address, the assembler and/or linker issues an error. The compiler does not check this.

1.2.4. Accessing Hardware from C

Using Special Function Registers

It is easy to access Special Function Registers (SFRs) that relate to peripherals from C. The SFRs are defined in a special function register file (*.sfr) as symbol names for use with the compiler. An SFR file contains the names of the SFRs and the bits in the SFRs.

Example use in C (SFRs from regtc1796b.sfr):

```c
void set_sfr(void)
{
    SBCU_SRC.I |= 0xb32a;  /* access SBCU Service Request Control register as a whole */

    SBCU_SRC.B.SRE = 0x1;  /* access SRE bit-field of SBCU Service Request Control register */
}
```

You can find a list of defined SFRs and defined bits by inspecting the SFR file for a specific processor. The files are located in the sfr subdirectory of the standard include directory. The files are named regcpu.sfr, where cpu is the CPU specified with the control program option --cpu. The compiler includes this register file if you specify option --include-file=sfr/regtc179b.sfr.

Defining Special Function Registers: __sfrbit32

SFRs are defined in SFR files and are written in C. With the data type qualifier __sfrbit32 you can declare bit-fields in special function registers.

According to the TriCore Embedded Applications Binary Interface, 'normal' bit-fields are accessed as char, short or int. Bit-fields are aligned according to the table in Section 1.1, Data Types.

6
If you declare bit-fields in special function registers, this behavior is not always desired: some special function registers require 32-bit access. To force 32-bit access, you can use the data type qualifier __sfrbit32.

When the SFR contains fields, the layout of the SFR is defined by a typedef-ed union. The next example is part of an SFR file and illustrates the declaration of a special function register using the data type qualifier __sfrbit32:

typedef volatile union
{
    struct
    {
        unsigned __sfrbit32 SRPN : 8;  /* Service Priority Number */
        unsigned __sfrbit32      : 2;
        unsigned __sfrbit32 TOS  : 2;  /* Type-of-Service Control */
        unsigned __sfrbit32 SRE  : 1;  /* Service Request Enable Control */
        unsigned __sfrbit32 SRR  : 1;  /* Service Request Flag */
        unsigned __sfrbit32 CLRR : 1;  /* Request Flag Clear Bit */
        unsigned __sfrbit32 SETR : 1;  /* Request Flag Set Bit */
        unsigned __sfrbit32      : 16;
    } B;
    int I;
    unsigned int U;
} LBCU_SRC_type;

Read-only fields can be marked by using the const keyword.

The SFR is defined by a cast to a ‘typedef-ed union’ pointer. The SFR address is given in parenthesis. Read-only SFRs are marked by using the const keyword in the macro definition.

#define LBCU_SRC (*(LBCU_SRC_type*)(0xF87FFEFCu))
    /* LBCU Service Control Register */

Restrictions

• You can use the __sfrbit32 data type qualifier only for int types. The compiler issues an error if you use for example __sfrbit32 char x : 8;

• When you use the __sfrbit32 data type qualifier for other types than a bit-field, the compiler ignores this without a warning. For example, __sfrbit32 int global; is equal to int global;

• Structures or unions that contain a member qualified with __sfrbit32, are zero padded to complete a full word if necessary. The structure or union will be word aligned.

1.3. Shift JIS Kanji Support

In order to allow for Japanese character support on non-Japanese systems (like PCs), you can use the Shift JIS Kanji Code standard. This standard combines two successive ASCII characters to represent one Kanji character. A valid Kanji combination is only possible within the following ranges:
TASKING VX-toolset for PCP User Guide

- First (high) byte is in the range 0x81-0x9f or 0xe0-0xef.
- Second (low) byte is in the range 0x40-0x7e or 0x80-0xfc

Compiler option -Ak enables support for Shift JIS encoded Kanji multi-byte characters in strings and (wide) character constants. Without this option, encodings with 0x5c as the second byte conflict with the use of the backslash ('\') as an escape character. Shift JIS in comments is supported regardless of this option.

Note that Shift JIS also includes Katakana and Hiragana.

Example:

```c
// Example usage of Shift JIS Kanji
// Do not switch off option -Ak
// At the position of the italic text you can
// put your Shift JIS Kanji code
int i; // put Shift JIS Kanji here
char c1;
char c2;
unsigned int ui;
const char mes[]="put Shift JIS Kanji here";
const unsigned int ar[5]=
    {'K', 'a', 'n', 'j', 'i'};
    // 5 Japanese array
void main(void)
{
    i=(int)c1;
    i++; /* put Shift JIS Kanji here\n    continuous comment */
    c2=mes[9];
    ui=ar[0];
}
```

1.4. Using Assembly in the C Source: __asm()

With the keyword __asm you can use assembly instructions in the C source and pass C variables as operands to the assembly code. Be aware that C modules that contain assembly are not portable and harder to compile in other environments.

The compiler does not interpret assembly blocks but passes the assembly code to the assembly source file; they are regarded as a black box. So, it is your responsibility to make sure that the assembly block is syntactically correct. Possible errors can only be detected by the assembler.

You need to tell the compiler exactly what happens in the inline assembly code because it uses that for code generation and optimization. The compiler needs to know exactly which registers are written and which registers are only read. For example, if the inline assembly writes to a register from which the compiler assumes that it is only read, the generated code after the inline assembly is based on the fact that the register still contains the same value as before the inline assembly. If that is not the case the results may be unexpected. Also, an inline assembly statement using multiple input parameters may be
assigned the same register if the compiler finds that the input parameters contain the same value. As long as this register is only read this is not a problem.

**General syntax of the __asm keyword**

```
__asm("instruction_template"
   [ : output_param_list
   [ : input_param_list
   [ : register_reserve_list]])
```

- **instruction_template**
  - Assembly instructions that may contain parameters from the input list or output list in the form: `%parm_nr`
- **%parm_nr**
  - Parameter number in the range 0..9.
- **output_param_list**
  - `[ "=constraint_char"(C_expression),...]
- **input_param_list**
  - `[ "constraint_char"(C_expression),...]
- **&**
  - Says that an output operand is written to before the inputs are read, so this output must not be the same register as any input.
- **constraint_char**
  - Constraint character: the type of register to be used for the `C_expression`. See the table below.
- **C_expression**
  - Any C expression. For output parameters it must be an lvalue, that is, something that is legal to have on the left side of an assignment.
- **register_reserve_list**
  - `["register_name"],...]
- **register_name**
  - Name of the register you want to reserve. For example because this register gets clobbered by the assembly code. The compiler will not use this register for inputs or outputs. Note that reserving too many registers can make register allocation impossible.

**Specifying registers for C variables**

With a **constraint character** you specify the register type for a parameter.

You can reserve the registers that are used in the assembly instructions, either in the parameter lists or in the reserved register list (`register_reserve_list`). The compiler takes account of these lists, so no unnecessary register saves and restores are placed around the inline assembly instructions.

<table>
<thead>
<tr>
<th>Constraint character</th>
<th>Type</th>
<th>Operand</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>r</td>
<td>register</td>
<td>r0 .. r7</td>
<td></td>
</tr>
<tr>
<td>number</td>
<td>type of operand it is associated with</td>
<td>same as <code>%number</code></td>
<td>Input constraint only. The <code>number</code> must refer to an output parameter. Indicates that <code>%number</code> and <code>number</code> are the same register.</td>
</tr>
</tbody>
</table>
If an input parameter is modified by the inline assembly then this input parameter must also be added to the list of output parameters (see Example 6). If this is not the case, the resulting code may behave differently than expected since the compiler assumes that an input parameter is not being changed by the inline assembly.

**Loops and conditional jumps**

The compiler does not detect loops with multiple `__asm()` statements or (conditional) jumps across `__asm()` statements and will generate incorrect code for the registers involved.

If you want to create a loop with `__asm()`, the whole loop must be contained in a single `__asm()` statement. The same counts for (conditional) jumps. As a rule of thumb, all references to a label in an `__asm()` statement must be in that same statement. You can use numeric labels for these purposes.

**Example 1: no input or output**

A simple example without input or output parameters. You can use any instruction or label. When it is required that a sequence of `__asm()` statements generates a contiguous sequence of instructions, then they can be best combined to a single `__asm()` statement. Compiler optimizations can insert instruction(s) in between `__asm()` statements. Use newline characters `\n` to continue on a new line in a `__asm()` statement. For multi-line output, use tab characters `\t` to indent instructions.

```
__asm( "nop\n" 
       "nop" );
```

**Example 2: using output parameters**

Assign the result of inline assembly to a variable. With the constraint `r` a register is chosen for the parameter; the compiler decides which register it uses. The `%0` in the instruction template is replaced with the name of this register. The compiler generates code to assign the result to the output variable.

```c
int out;
void addone( void )
{
    __asm( "add.i %0,#1"
           : "=r" (out) );
}
```

Generated assembly code:

```
add.i r5,#1
ldl.il r7,@DPTR(_PCP_out)
st.pi r5,[_PCP_out]
```

**Example 3: using input parameters**

Assign a variable to a register. A register is chosen for the parameter because of the constraint `r`; the compiler decides which register is best to use. The `%0` in the instruction template is replaced with the
name of this register. The compiler generates code to move the input variable to the input register. Because there are no output parameters, the output parameter list is empty. Only the colon has to be present.

```c
int in;
void initreg( void )
{
    __asm( "MOV R0,%0,cc_Z"
            :
            : "r" (in) )
;
}
```

Generated assembly code:

```
ldl.il r7,@DPTR(_PCP_in)
ld.pi r5,[_PCP_in]
MOV R0,r5,cc_Z
```

**Example 4: using input and output parameters**

Multiply two C variables and assign the result to a third C variable. Registers are necessary for the input and output parameters (constraint r,%0 for out, %1 for in1, %2 for in2 in the instruction template). The compiler generates code to move the input expressions into the input registers and to assign the result to the output variable.

```c
int in1, in2, out;
void multiply( void )
{
    __asm( "minit \%1,\%2\n" "\tmstep.u \%0,\%2\n" "\tmstep.u \%0,\%2\n" "\tmstep.u \%0,\%2\n" "\tmstep.u \%0,\%2"
            : "=r" (out)
            : "r" (in1), "r" (in2) )
;
}
```

Generated assembly code:

```
_PCPC_multiply: .type func
ldl.il r7,@DPTR(_PCP_in1)
ld.pi r5,[_PCP_in1]
ld.pi r1,[_PCP_in2]
minit r5,r1
mstep.u r5,r1
mstep.u r5,r1
mstep.u r5,r1
mstep.u r5,r1
ldl.il r7,@DPTR(_PCP_out)
st.pi r5,[_PCP_out]
```
Example 5: reserving registers

Sometimes an instruction knocks out certain specific registers. The most common example of this is a function call, where the called function is allowed to do whatever it likes with some registers. If this is the case, you can list specific registers that get clobbered by an operation after the inputs.

Same as Example 4, but now register r1 is a reserved register. You can do this by adding a reserved register list (e.g., "r1"). As you can see in the generated assembly code, register r1 is not used (register r3 is used instead).

```
int in1, in2, out;

void multiply( void )
{
    __asm( "minit	%1,%2\n"
            "\tmstep.u	%0,%2\n"
            "\tmstep.u	%0,%2\n"
            "\tmstep.u	%0,%2\n"
            "\tmstep.u	%0,%2"
            : "=r" (out)
            : "r" (in1), "r" (in2)
            : "r1" );
}
```

Generated assembly code:

```
_PCPC_multiply: .type   func
    ldl.il  r7,@DPTR(_PCP_in1)
    ld.pi   r5,[_PCP_in1]
    ld.pi   r3,[_PCP_in2]
    minit   r5,r3
    mstep.u r5,r3
    mstep.u r5,r3
    mstep.u r5,r3
    mstep.u r5,r3
    ldl.il  r7,@DPTR(_PCP_out)
    st.pi   r5,[_PCP_out]
```

Example 6: use the same register for input and output

As input constraint you can use a number to refer to an output parameter. This tells the compiler that the same register can be used for the input and output parameter. When the input and output parameter are the same C expression, these will effectively be treated as if the input parameter is also used as output. In that case it is allowed to write to this register. For example:

```
inline int foo(int par1, int par2, int * par3)
{
    int retvalue;

    __asm(}
```


In this example the "1" constraint for the input parameter `par1` refers to the output parameter `par1`, and similar for the "2" constraint and `par2`. In the inline assembly `%1 (par1)` and `%2 (par2)` are written. This is allowed because the compiler is aware of this.

This results in the following generated assembly code:

```
ld.i   r5,0x28
ldl.i  r5,0x3e8
mov   r1,r5,cc_uc
ldl.il r3,@LO(_PCP_parm)

shl   r5,#2
add   r1,r5,cc_uc
mov   r3,r1,cc_uc
mov   r4,r1,cc_uc

ldl.il r7,@DPTR(_PCP_result)
st.pi  r4,[_PCP_result]
```

However, when the inline assembly would have been as given below, the compiler would have assumed that `%1 (par1)` and `%2 (par2)` were read-only. Because of the `inline` keyword the compiler knows that `par1` and `par2` both contain 1000. Therefore the compiler can optimize and assign the same register to `%1` and `%2`. This would have given an unexpected result.

```
__asm(
    "shl   %1,#2\n"
    "add   %2,%1,cc_uc\n"
    "mov   %3,%1,cc_uc\n"
    "mov   %0,%2,cc_uc"
    : "=r" (retvalue)
    : "r" (par1), "r" (par2), "r" (par3)
);
```

Generated assembly code:


1.5. Attributes

You can use the keyword `__attribute__` to specify special attributes on declarations of variables, functions, types, and fields.

Syntax:

```
__attribute__((name,...))
```

or:

```
__name__
```

The second syntax allows you to use attributes in header files without being concerned about a possible macro of the same name. For example, you may use `__noreturn__` instead of `__attribute__((noreturn))`.

`alias("symbol")`

You can use `__attribute__((alias("symbol")))` to specify that the function declaration appears in the object file as an alias for another symbol. For example:

```c
void __f() { /* function body */; }
void f() __attribute__((weak, alias("__f")));
```

declares `f` to be a weak alias for `__f`.

`const`

You can use `__attribute__((const))` to specify that a function has no side effects and will not access global data. This can help the compiler to optimize code. See also attribute `pure`.

The following kinds of functions should not be declared `__const__`:

- A function with pointer arguments which examines the data pointed to.
- A function that calls a non-const function.
export

You can use `__attribute__((export))` to specify that a variable/function has external linkage and should not be removed. During MIL linking, the compiler treats external definitions at file scope as if they were declared `static`. As a result, unused variables/functions will be eliminated, and the alias checking algorithm assumes that objects with static storage cannot be referenced from functions outside the current module. During MIL linking not all uses of a variable/function can be known to the compiler. For example when a variable is referenced in an assembly file or a (third-party) library. With the `export` attribute the compiler will not perform optimizations that affect the unknown code.

```c
int i __attribute__((export)); /* 'i' has external linkage */
```

flatten

You can use `__attribute__((flatten))` to force inlining of all function calls in a function, including nested function calls.

Unless inlining is impossible or disabled by `__attribute__((noinline))` for one of the calls, the generated code for the function will not contain any function calls.

format(type, arg_string_index, arg_check_start)

You can use `__attribute__((format(type, arg_string_index, arg_check_start)))` to specify that functions take `printf`, `scanf`, `strftime` or `strfmon` style arguments and that calls to these functions must be type-checked against the corresponding format string specification.

`type` determines how the format string is interpreted, and should be `printf`, `scanf`, `strftime` or `strfmon`.

`arg_string_index` is a constant integral expression that specifies which argument in the declaration of the user function is the format string argument.

`arg_check_start` is a constant integral expression that specifies the first argument to check against the format string. If there are no arguments to check against the format string (that is, diagnostics should only be performed on the format string syntax and semantics), `arg_check_start` should have a value of 0. For `strftime`-style formats, `arg_check_start` must be 0.

Example:

```c
int foo(int i, const char * my_format, ...) __attribute__((format(printf, 2, 3)));
```

The format string is the second argument of the function `foo` and the arguments to check start with the third argument.

leaf

You can use `__attribute__((leaf))` to specify that a function is a leaf function. A leaf function is an external function that does not call a function in the current compilation unit, directly or indirectly. The attribute is intended for library functions to improve dataflow analysis. The attribute has no effect on functions defined within the current compilation unit.
malloc

You can use __attribute__((malloc)) to improve optimization and error checking by telling the compiler that:

• The return value of a call to such a function points to a memory location or can be a null pointer.

• On return of such a call (before the return value is assigned to another variable in the caller), the memory location mentioned above can be referenced only through the function return value; e.g., if the pointer value is saved into another global variable in the call, the function is not qualified for the malloc attribute.

• The lifetime of the memory location returned by such a function is defined as the period of program execution between a) the point at which the call returns and b) the point at which the memory pointer is passed to the corresponding deallocation function. Within the lifetime of the memory object, no other calls to malloc routines should return the address of the same object or any address pointing into that object.

noinline

You can use __attribute__((noinline)) to prevent a function from being considered for inlining. Same as keyword __noinline or #pragma noinline.

always_inline

With __attribute__((always_inline)) you force the compiler to inline the specified function, regardless of the optimization strategy of the compiler itself. Same as keyword inline or #pragma inline.

noretur

Some standard C function, such as abort and exit cannot return. The C compiler knows this automatically. You can use __attribute__((noreturn)) to tell the compiler that a function never returns. For example:

void fatal() __attribute__((noreturn));

void fatal( /* ... */ )
{
    /* Print error message */
    exit(1);
}

The function fatal cannot return. The compiler can optimize without regard to what would happen if fatal ever did return. This can produce slightly better code and it helps to avoid warnings of uninitialized variables.
**protect**

You can use `__attribute__((protect))` to exclude a variable/function from the duplicate/unreferenced section removal optimization in the linker. When you use this attribute, the compiler will add the "protect" section attribute to the symbol's section. Example:

```c
int i __attribute__((protect));
```

Note that the protect attribute will not prevent the compiler from removing an unused variable/function (see the used symbol attribute).

This attribute is the same as `#pragma protect/endprotect`.

**pure**

You can use `__attribute__((pure))` to specify that a function has no side effects, although it may read global data. Such pure functions can be subject to common subexpression elimination and loop optimization. See also attribute `const`.

**section("section_name")**

You can use `__attribute__((section("name")))` to specify that a function must appear in the object file in a particular section. For example:

```c
extern void foobar(void) __attribute__((section("bar")));
```

puts the function `foobar` in the section named `bar`.

See also `#pragma section`.

**used**

You can use `__attribute__((used))` to prevent an unused symbol from being removed, by both the compiler and the linker. Example:

```c
static const char copyright[] __attribute__((used)) = "Copyright 2019 TASKING BV";
```

When there is no C code referring to the `copyright` variable, the compiler will normally remove it. The `__attribute__((used))` symbol attribute prevents this. Because the linker should also not remove this symbol, `__attribute__((used))` implies `__attribute__((protect))`.

**unused**

You can use `__attribute__((unused))` to specify that a variable or function is possibly unused. The compiler will not issue warning messages about unused variables or functions.

**weak**

You can use `__attribute__((weak))` to specify that the symbol resulting from the function declaration or variable must appear in the object file as a weak symbol, rather than a global one. This is primarily...
1.6. Pragmas to Control the Compiler

Pragmas are keywords in the C source that control the behavior of the compiler. Pragmas overrule compiler options. Put pragmas in your C source where you want them to take effect. Unless stated otherwise, a pragma is in effect from the point where it is included to the end of the compilation unit or until another pragma changes its status.

The syntax is:

```c
#pragma [label:]pragma-spec pragma-arguments [on | off | default | restore]
```
or:

```c
Pragma ("[label:]pragma-spec pragma-arguments [on | off | default | restore]"
```

Some pragmas can accept the following special arguments:

- **on**: switch the flag on (same as without argument)
- **off**: switch the flag off
- **default**: set the pragma to the initial value
- **restore**: restore the previous value of the pragma

Examples:

```
// by default all warnings are shown

#pragma warning 535       // disable W535
#pragma warning 530       // also disable W530
const char var_1 = 0x5678; // W530 is not shown
var_2;                  // W535 is not shown
#pragma warning restore    // restore one level, only W535 is disabled
const char var_3 = 0x56789; // W530 is shown
#pragma warning default    // back to default, all warnings are shown
var_4;                  // W535 is shown
```

**Label pragmas**

Some pragmas support a label prefix of the form "`label:`" between `#pragma` and the pragma name. Such a label prefix limits the effect of the pragma to the statement following a label with the specified name. The `restore` argument on a pragma with a label prefix has a special meaning: it removes the most recent definition of the pragma for that label.

You can see a label pragma as a kind of macro mechanism that inserts a pragma in front of the statement after the label, and that adds a corresponding `#pragma ... restore` after the statement.
Compared to regular pragmas, label pragmas offer the following advantages:

- The pragma text does not clutter the code, it can be defined anywhere before a function, or even in a header file. So, the pragma setting and the source code are uncoupled. When you use different header files, you can experiment with a different set of pragmas without altering the source code.

- The pragma has an implicit end: the end of the statement (can be a loop) or block. So, no need for pragma restore / endoptimize etc.

Example:

```c
#pragma lab1:optimize P

volatile int v;

void f( void )
{
    int i, a;

    a = 42;

lab1: for( i=1; i<10; i++ )
    {
        /* the entire for loop is part of the pragma optimize */
        a += i;
    }
    v = a;
}
```

### Supported pragmas

The compiler recognizes the following pragmas, other pragmas are ignored. On the command line you can use `cpcp --help=pragmas` to get a list of all supported pragmas. Pragmas marked with (*) support a label prefix.

**STDC FP_CONTRACT [on | off | default | restore] (*)**

This pragma is defined in ISO C99/C11. With this pragma you can control the `+contract` flag of C compiler option `--fp-model`.

**alias symbol=defined_symbol**

Define `symbol` as an alias for `defined_symbol`. It corresponds to a `.ALIAS` directive at assembly level. The `symbol` should not be defined elsewhere, and `defined_symbol` should be defined with static storage duration (not extern or automatic).
**align {value | default | restore} (*)&nbsp;**

Change the alignment of objects located in the FPI space. By default the PCP compiler aligns objects to the minimum alignment required by the architecture. With this pragma you can increase this alignment for objects of four bytes or larger. The value must be a power of two.

See Section 1.1.1, *Changing the Alignment: __align().*

**boolean [on | off | default | restore] (*)&nbsp;**

This pragma is used to mark the macros "false" and "true" from the library header file stdbool.h as "essentially BOOLEAN", which is a concept from the MISRA C:2012 standard.

**clear / noclear [on | off | default | restore] (*)&nbsp;**

By default, uninitialized global or static variables are cleared to zero on startup. With pragma noclear, this step is skipped. Pragma clear resumes normal behavior. This pragma applies to constant data as well as non-constant data.

See C compiler option --no-clear.

**compactmaxmatch {value | default | restore} (*)&nbsp;**

With this pragma you can control the maximum size of a match.

See C compiler option --compact-max-size.

**extension isuffix [on | off | default | restore] (*)&nbsp;**

Enables a language extension to specify imaginary floating-point constants. With this extension, you can use an "i" suffix on a floating-point constant, to make the type _Imaginary.

```c
float 0.5i
```

**extern symbol**

Normally, when you use the C keyword extern, the compiler generates an .EXTERN directive in the generated assembly source. However, if the compiler does not find any references to the extern symbol in the C module, it optimizes the assembly source by leaving the .EXTERN directive out.

With this pragma you can force an external reference (.EXTERN assembler directive), even when the symbol is not used in the module.

**fp_negzero [on | off | default | restore] (*)&nbsp;**

With this pragma you can control the +negzero flag of C compiler option --fp-model.
fp_nonan [on | off | default | restore] (*)
With this pragma you can control the \texttt{+nonan} flag of C compiler option \texttt{--fp-model}.

fp_rewrite [on | off | default | restore] (*)
With this pragma you can control the \texttt{+rewrite} flag of C compiler option \texttt{--fp-model}.

inline / noinline / smartinline [default | restore] (*)
See Section 1.9.3, Inlining Functions: \texttt{inline}.

inline_max_incr \{value | default | restore\} (*)
inline_max_size \{value | default | restore\} (*)
With these pragmas you can control the automatic function inlining optimization process of the compiler. It has effect only when you have enabled the inlining optimization (C compiler option \texttt{--optimize=+inline}).
See C compiler options \texttt{--inline-max-incr} / \texttt{--inline-max-size}.

linear_switch / jump_switch / binary_switch / smart_switch
With these pragmas you can overrule the compiler chosen switch method:

linear_switch force jump chain code. A jump chain is comparable with an if/else-if/else-if/else construction.
jump_switch force jump table code. A jump table is a table filled with jump instructions for each possible switch value. The switch argument is used as an index to jump within this table.
binary_switch force binary lookup table code. A binary search table is a table filled with a value to compare the switch argument with and a target address to jump to.
smart_switch let the compiler decide the switch method used
See also Section 1.8, Switch Statement.

macro / nomacro [on | off | default | restore] (*)
Turns macro expansion on or off. By default, macro expansion is enabled.

message "message" ...
Print the message string(s) on standard output.

nomisrac \[nr,...\] [default | restore] (*)
Without arguments, this pragma disables MISRA C checking. Alternatively, you can specify a comma-separated list of MISRA C rules to disable.
See C compiler option --misrac and Section 3.7.2, C Code Checking: MISRA C.

**novector value [default | restore] (*)**

With this pragma you tell the compiler not to generate code for channel vectors and channel context.

See C compiler option --no-vector.

**optimize [flags] / endoptimize [default | restore] (*)**

You can overrule the C compiler option --optimize for the code between the pragmas optimize and endoptimize. The pragma works the same as C compiler option --optimize.

See Section 3.6, Compiler Optimizations.

**protect / endprotect [on | off | default | restore] (*)**

With these pragmas you can protect sections against linker optimizations. This excludes a section from unreferenced section removal and duplicate section removal by the linker. endprotect restores the default section protection.

**section [type=name] / endsection [default | restore] (*)**

Changes section names. See Section 1.11, Compiler Generated Sections and C compiler option --rename-sections for more information.

**source / nosource [on | off | default | restore] (*)**

With these pragmas you can choose which C source lines must be listed as comments in assembly output.

See C compiler option --source.

**stdinc [on | off | default | restore] (*)**

This pragma changes the behavior of the #include directive. When set, the C compiler options --include-directory and --no-stdinc are ignored.

**tradeoff {level | default | restore} (*)**

Specify tradeoff between speed (0) and size (4). See C compiler option --tradeoff

**warning [number,...] [default | restore] (*)**

With this pragma you can disable warning messages. If you do not specify a warning number, all warnings will be suppressed.
weak symbol

Mark a symbol as "weak" (.WEAK assembler directive). The symbol must have external linkage, which means a global or external object or function. A static symbol cannot be declared weak.

A weak external reference is resolved by the linker when a global (or weak) definition is found in one of the object files. However, a weak reference will not cause the extraction of a module from a library to resolve the reference. When a weak external reference cannot be resolved, the null pointer is substituted.

A weak definition can be overruled by a normal global definition. The linker will not complain about the duplicate definition, and ignore the weak definition.

1.7. Predefined Preprocessor Macros

You can use the following predefined macros in your C source. The macros are useful to create conditional C code.

<table>
<thead>
<tr>
<th>Macro</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>BIG_ENDIAN</em></td>
<td>Expands to 0. The processor accesses data in little-endian.</td>
</tr>
<tr>
<td><em>BUILD</em></td>
<td>Identifies the build number of the compiler in the format yymmddqq (year, month, day and quarter in UTC).</td>
</tr>
<tr>
<td><em>CORE</em></td>
<td>Expands to pcp2.</td>
</tr>
<tr>
<td><em>CORE_PCP2</em></td>
<td>Expands to 1.</td>
</tr>
<tr>
<td><em>CPU</em></td>
<td>Expands to the name of the CPU supplied with the control program option --cpu=cpu. When no --cpu is supplied, or when you do not use the control program, this symbol is not defined. For example, if --cpu=tc1796b is specified, the symbol <em>CPU</em> expands to tc1796b.</td>
</tr>
<tr>
<td><em>CPU_cpu</em></td>
<td>A symbol is defined depending on the control program option --cpu=cpu. The cpu is converted to uppercase. For example, if --cpu=tc1796b is specified to the control program, the symbol <em>CPU_TC1796B</em> is defined. When no --cpu is supplied, or when you do not use the control program, this symbol is not defined.</td>
</tr>
<tr>
<td><em>DATE</em></td>
<td>Expands to the compilation date: “mmm dd yyyy”.</td>
</tr>
<tr>
<td><em>FILE</em></td>
<td>Expands to the current source file name.</td>
</tr>
<tr>
<td><em>LINE</em></td>
<td>Expands to the line number of the line where this macro is called.</td>
</tr>
<tr>
<td><em>REVISION</em></td>
<td>Expands to the revision number of the compiler. Digits are represented as they are; characters (for prototypes, alphas, betas) are represented by -1. Examples: v1.0r1 -&gt; 1, v1.0rb -&gt; -1</td>
</tr>
</tbody>
</table>
If control program option --cpu=cpu is specified, this macro expands to the filename of the used SFR file, including the pathname and the < >. The cpu is the argument of the macro. For example, if --cpu=tc1796b is specified, the macro __SFRFILE__(__CPU__) expands to __SFRFILE__(tc1796b), which expands to <sfr/regtc1796b.sfr>.

__SINGLE_FP__
Expands to 1 (‘double’ is always treated as ‘float’).

__STDC__
Identifies the level of ANSI standard. The macro expands to 1 if you set option --language (Control language extensions), otherwise expands to 0.

__STDC_HOSTED__
Always expands to 0, indicating the implementation is not a hosted implementation.

__STDC_NO_ATOMICS__
(C11 only) Expands to 1 to indicate that this implementation does not support atomic types and the stdatomic.h header file.

__STDC_NO_THREADS__
(C11 only) Expands to 1 to indicate that this implementation does not support the threads.h header file.

__STDC_VERSION__
Identifies the ISO-C version number. Expands to 201112L for ISO C11, 199901L for ISO C99 or 199409L for ISO C90.

__TASKING__
Identifies the compiler as a TASKING compiler. Expands to 1 if a TASKING compiler is used.

__TIME__
Expands to the compilation time: “hh:mm:ss”

__VERSION__
Identifies the version number of the compiler. For example, if you use version 6.1r1 of the compiler, __VERSION__ expands to 6001 (dot and revision number are omitted, minor version number in 3 digits).

Example

```c
#ifdef __CPU_TC1796B__
/* this part is only valid for the TC1796B */
...
#endif
```

1.8. Switch Statement

The TASKING C compiler supports three ways of code generation for a switch statement: a jump chain (linear switch), a jump table or a binary search table.

A jump chain is comparable with an if/else-if/else-if/else construction. A jump table is a table filled with jump instructions for each possible switch value. The switch argument is used as an index to jump within this table. A binary search table is a table filled with a value to compare the switch argument with and a target address to jump to.

By default, the compiler will automatically choose the most efficient switch implementation based on code and data size and execution speed. With the C compiler option --tradeoff you can tell the compiler to put more emphasis on speed than on ROM size.
Especially for large switch statements, the jump table approach executes faster than the lookup table approach. Also the jump table has a predictable behavior in execution speed: independent of the switch argument, every case is reached in the same execution time. However, when the case labels are distributed far apart, the jump table becomes sparse, wasting code memory. The compiler will not use the jump table method when the waste becomes excessive.

With a small number of cases, the jump chain method can be faster in execution and shorter in size.

**How to overrule the default switch method**

You can overrule the compiler chosen switch method by using a pragma:

```c
#pragma linear_switch force jump chain code
#pragma jump_switch force jump table code
#pragma binary_switch force binary search table code
#pragma smart_switch let the compiler decide the switch method used (this is the default)
```

The switch pragmas must be placed before the `switch` statement. Nested `switch` statements use the same switch method, unless the nested `switch`is implemented in a separate function which is preceded by a different switch pragma.

Example:

```c
/* place pragma before function body */

#pragma jump_switch

void test(unsigned char val)
{
    /* function containing the switch */
    switch (val)
    {
        /* use jump table */
    }
}
```

**1.9. Functions**

**1.9.1. Calling Convention**

**Parameter passing**

A lot of execution time of an application is spent transferring parameters between functions. The fastest parameter transport is via registers. Therefore, function parameters are first passed via registers. If no more registers are available for a parameter, the compiler pushes parameters on the stack.

Registers available for parameter passing are R1, R3, R4, R6, R0. The parameters are processed from left to right. The first unused register is used. Registers are searched for in the order listed above. When a parameter is larger than 32 bit, or when all registers are used, parameter passing continues on the
The stack grows from higher towards lower addresses, each parameter on the stack is stored in little endian. The alignment on the stack depends on the data type as listed in Section 1.1, Data Types.

Structures up to four bytes are passed via a register. Larger structures are passed via the stack.

The PCP compiler uses a static stack, which restricts the number of arguments passed for an indirect function call. Parameters of an indirect function call can only be passed in registers and not via the static stack.

Example with three arguments:

```
func1( int a, long b, char c )
```

a (first parameter) is passed in register R1.

b (second parameter) is passed in register R3.

c (third parameter) is passed in register R4.

Variable argument lists

For functions with a variable argument list, the last fixed parameter and all subsequent parameters must be pushed on the stack. For parameters before the last fixed parameter the normal parameter passing rules apply.

Variable arguments are not supported for indirect function calls, due to the static stack implementation.

Function return values

The C compiler uses register R1 to store C function return values.

When the function return type is a structure, it is copied to a "return area" that is allocated by the caller. The address of this area is passed as an implicit first argument in R6.

Stack usage

The stack is used for parameter passing, allocation of automatics, temporary storage and storing the function return address. The compiler uses a static stack. Overlay sections are generated by the compiler to contain the stack objects. The overlay sections are overlayed by the linker using a call graph.

1.9.2. Register Usage

The PCP C compiler uses registers according to the convention given in the following table.

<table>
<thead>
<tr>
<th>Register</th>
<th>Class</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>R0</td>
<td>caller saves</td>
<td>Parameter passing and automatic variables</td>
</tr>
<tr>
<td>R1</td>
<td>caller saves</td>
<td>Parameter passing, automatic variables and return values</td>
</tr>
<tr>
<td>R2</td>
<td>callee saves</td>
<td>Automatic variables, stack frame pointer and function return address</td>
</tr>
<tr>
<td>R3</td>
<td>caller saves</td>
<td>Parameter passing and automatic variables</td>
</tr>
</tbody>
</table>
### Register Classification

<table>
<thead>
<tr>
<th>Register</th>
<th>Class</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>R4</td>
<td>caller saves</td>
<td>Parameter passing and automatic variables</td>
</tr>
<tr>
<td>R5</td>
<td>caller saves</td>
<td>Automatic variables and function return address of code compaction functions</td>
</tr>
<tr>
<td>R6</td>
<td>caller saves</td>
<td>Parameter passing, automatic variables and return buffer</td>
</tr>
<tr>
<td>R7</td>
<td>special purpose</td>
<td>PC, CC, DPTR</td>
</tr>
</tbody>
</table>

The registers are classified: **caller saves**, **callee saves** and **special purpose**.

- **caller saves**: These registers are allowed to be changed by a function without saving the contents. Therefore, the calling function must save these registers when necessary prior to a function call.
- **callee saves**: These registers must be saved by the called function, i.e., the caller expects them not to be changed after the function call.
- **special purpose**: The purpose of R7 is defined by the PCP core.

### 1.9.3. Inlining Functions: inline

With the **C compiler option --optimize=+inline**, the C compiler automatically inlines small functions in order to reduce execution time (smart inlining). The compiler inserts the function body at the place the function is called. The C compiler decides which functions will be inlined. You can overrule this behavior with the two keywords **inline** (ISO-C) and **__noinline**.

With the **inline** keyword you force the compiler to inline the specified function, regardless of the optimization strategy of the compiler itself:

```c
inline unsigned int abs(int val) {
    unsigned int abs_val = val;
    if (val < 0) abs_val = -val;
    return abs_val;
}
```

If a function with the keyword **inline** is not called at all, the compiler does not generate code for it.

You must define inline functions in the same source module as in which you call the function, because the compiler only inlines a function in the module that contains the function definition. When you need to call the inline function from several source modules, you must include the definition of the inline function in each module (for example using a header file).

With the **__noinline** keyword, you prevent a function from being inlined:

```c
__noinline unsigned int abs(int val) {
    unsigned int abs_val = val;
    if (val < 0) abs_val = -val;
    return abs_val;
}
```
Using pragmas: inline, noinline, smartinline

Instead of the `inline` qualifier, you can also use `#pragma inline` and `#pragma noinline` to inline a function body:

```c
#pragma inline
unsigned int abs(int val)
{
    unsigned int abs_val = val;
    if (val < 0) abs_val = -val;
    return abs_val;
}
#pragma noinline
void main( void )
{
    int i;
    i = abs(-1);
}
```

If a function has an `inline/__noinline` function qualifier, then this qualifier will overrule the current pragma setting.

With the `#pragma noinline/#pragma smartinline` you can temporarily disable the default behavior that the C compiler automatically inlines small functions when you turn on the C compiler option `--optimize=+inline`.

With the C compiler options `--inline-max-incr` and `--inline-max-size` you have more control over the automatic function inlining process of the compiler.

Combining inline with __asm to create intrinsic functions

With the keyword `__asm` it is possible to use assembly instructions in the body of an inline function. Because the compiler inserts the (assembly) body at the place the function is called, you can create your own intrinsic function. See Section 1.9.5, Intrinsic Functions.

1.9.4. Interrupt Functions

The PCP has an unusual programming model. The best way to think of PCP programming is that there is a series of autonomous programs, or tasks that are called channel programs. These can be very short and simple, or very complex and long, and these can be mixed together. The PCP has a channel program associated with each interrupt number (SRPN). This could be thought of as the interrupt routine for a given interrupt source. When an interrupt of number “n” is received by the PCP core, it restores the context associated with number “n” from PRAM, and begins executing Channel Program “n” from Code Memory until it encounters a terminating condition - usually an EXIT instruction. At that point it saves the current context for number “n” back into the PRAM. If there is a new pending interrupt it starts this process again. If there is no pending new interrupt, the PCP stops until there is a new interrupt to process.

The PCP C compiler only supports the Full Context Model. Full context means that there are eight registers per channel available for the compiler.
For an extensive description of the PCP channel operation, see chapter *Peripheral Control Processor (PCP)* in the *User's Manual* of the TriCore [Infineon].

### 1.9.4.1. Defining an Interrupt Service Routine: __interrupt()

With the function type qualifier __interrupt() you can declare a function as an interrupt function (interrupt service routine or channel program). The function type qualifier __interrupt() takes one channel number (0..255) as argument.

Interrupt functions cannot return anything and must have a void argument type list:

```c
void __interrupt(channel_number)
    isr( void )
{
    ...
}
```

The argument `channel_number` is an 8-bit channel number that defines the channel entry table address and the context address. The channel number must be in range [0..255]. Channel number 0 is not used on the PCP; for interrupts with channel number 0 the channel entry table and the channel context are not generated.

For "Channel Start at Context PC" mode (CS.RCB=0) the compiler generates a section containing the context of the appropriate channel. The PC context (R7.PC) is initialized with the start address of interrupt service routine. The Channel Enable (R7.CEN) context is set to 1. The Enable Interrupt Control context is by default set to zero, because a channel cannot be interrupted by another channel. With the C compiler option --interrupt-enable you can set the Interrupt Control context to allow the channel to be interrupted. Channels that have interrupts enabled must be linked separately, because they cannot share static stack. See Section 1.10, *PCP Code Generation*. The remainder of the R7 context is cleared also (Z,N,C,V,CN1Z,DPTR).

All other context registers (R0..R6) are initialized to zero.

For "Channel Start at Base" mode (CS.RCB=1) the compiler generates a section with the channel entry table entry of the appropriate channel. The channel table entry contains a jump to the interrupt service routine.

At interrupt function return, an EXIT instruction is generated. The arguments of the EXIT instruction generated are: EC=0, ST=0, INT=0, EP=0, cc_UC.

**Example**

```c
void __interrupt( 1 ) isr( void )
{
    ...
}
```

### 1.9.4.2. Setting the Current PCP Priority Number: __cppn()

With the function qualifier __cppn() you can define the interrupt priority of an interruptible function. __cppn() can only be used on functions that are qualified __interrupt, and the functions must be
interruptible (option \texttt{--interrupt-enable}). The CPPN is superfluous for functions that have interrupts disabled (R7.IEN=0).

\begin{verbatim}
void __interrupt( channel_number ) __cppn(CPPN) isr( void )
{
  ...
}
\end{verbatim}

The function qualifier takes one argument \texttt{CPPN}. The CPPN (Current PCP interrupt Priority Number) is an 8-bit channel interrupt priority number in the range [0..255]. The channel interrupt priority number is defined in the register context R6.CPPN. At interrupt EXIT R6.CPPN is restored to this value.

1.9.4.3. Shared Data: \texttt{__share, __share_pcp}

Shared data between PCP channels

Global data can be shared between separately linked channels with the keyword \texttt{__share}. Only global and external variables can be qualified with the keyword \texttt{__share}.

For example, in one channel the following variable is defined:

\begin{verbatim}
int __share channel1_shared_PCP_PRAM = 0;
\end{verbatim}

In another channel you can reference this variable as:

\begin{verbatim}
extern int __share channel1_shared_PCP_PRAM;
\end{verbatim}

\texttt{__share} variables get application scope instead of channel scope. \texttt{__share} global variables get the \texttt{_lc_} linker prefix instead of the default \texttt{_PCP_} symbol prefix.

To link channels separately use linker option \texttt{--link-only}.

Shared data between TriCore and PCP

The \texttt{__share_pcp} qualifier is used for sharing global data with the TriCore CPU.

For example, in the TriCore source \texttt{tc_main.c} of the \texttt{pcp-multi-start} example delivered with the product, the following variable is defined:

\begin{verbatim}
volatile int __far __share_pcp shared_CPU_FPI;
\end{verbatim}

In the PCP source \texttt{channel1.c} of the \texttt{pcp-multi-ch1} example delivered with the product, this variable is referenced as:

\begin{verbatim}
extern int __far __share_pcp shared_CPU_FPI;
\end{verbatim}

To access PCP PRAM data from the TriCore CPU you can use the keyword \texttt{__pram} in the TriCore source. Also see the linker share label \texttt{_lc_s_}.
1.9.5. Intrinsic Functions

Some specific assembly instructions have no equivalence in C. Intrinsic functions give the possibility to use these instructions. Intrinsic functions are predefined functions that are recognized by the compiler. The compiler generates the most efficient assembly code for these functions.

The compiler always inlines the corresponding assembly instructions in the assembly source (rather than calling it as a function). This avoids parameter passing and register saving instructions which are normally necessary during function calls.

Intrinsic functions produce very efficient assembly code. Though it is possible to inline assembly code by hand, intrinsic functions use registers even more efficiently. At the same time your C source remains very readable.

You can use intrinsic functions in C as if they were ordinary C (library) functions. All intrinsics begin with a double underscore character (\_\_).

The following example illustrates the use of an intrinsic function and its resulting assembly code.

\_\_nop();

The resulting assembly code is inlined rather than being called:

nop

Writing your own intrinsic function

Because you can use any assembly instruction with the \_\_asm() keyword, you can use the \_\_asm() keyword to create your own intrinsic functions. The essence of an intrinsic function is that it is inlined.

1. First write a function with assembly in the body using the keyword \_\_asm(). See Section 1.4, Using Assembly in the C Source: \_\_asm()

2. Next make sure that the function is inlined rather than being called. You can do this with the function qualifier inline. This qualifier is discussed in more detail in Section 1.9.3, Inlining Functions: inline.

```
int in1, in2, out;
inline void __my_mul( void )
{
    __asm( "minit	%1,%2\n"
            "tmstep.u	%0,%2\n"
            "tmstep.u	%0,%2\n"
            "tmstep.u	%0,%2\n"
            "tmstep.u	%0,%2"
            : "=r" (out)
            : "r" (in1), "r" (in2) );
}
```

```
void main(void)
{
    // call to function __my_mul

```
Generated assembly code:

```
__PCP_main: .type func
; __my_mul code is inlined here
ldl.il  r7,@DPTR(_PCP_in1)
ld.pi   r5,[_PCP_in1]
ld.pi   r1,[_PCP_in2]
minit   r5,r1
mstep.u r5,r1
mstep.u r5,r1
mstep.u r5,r1
mstep.u r5,r1

ldl.il  r7,@DPTR(_PCP_out)
st.pi   r5,[_PCP_out]
```

As you can see, the generated assembly code for the function __my_mul is inlined rather than called.

**Supported intrinsic functions**

You can use the following intrinsic functions in your C source:

__alloc

```c
__alloc_t volatile __alloc( __size_t size );
```

Allocate memory. Same as C library function malloc(). Returns a pointer to space in external memory of size bytes length. Returns NULL if there is not enough space left. This function is used internally for variable length arrays, it is not to be used by end users.

__bcopy

```c
void volatile __bcopy( void __far * dst, void __far * src,
    const signed int DSTINCDEC, const signed int SRCINCDEC,
    const unsigned int CNC, const unsigned int CNT0,
    unsigned int CNT1 );
```

This intrinsic generates a BCOPY instruction. The BCOPY instruction moves a block of data (always 32-bit data) from source (src=R[4]) location on the FPI bus to destination (dst= R[5]) on the FPI bus. Constant arguments DSTINCDEC and SRCINCDEC determine if source and destination pointer are incremented or decremented, 1 for increment, -1 for decrement and 0 for no change. Constant arguments CNC and CNT0 are conform the argument values of the BCOPY instruction. CNT1 is loaded in R6.CNT1 if the value of CNC is 1 or 2. If CNC is 1 this intrinsic generates a outer loop.

The BCOPY instruction use FPI Burst mode (CNT0=2, 4 or 8 words), which requires alignment of source and destination data blocks. Use the attribute __align({8|16|32}) to specify the data block alignment. E.g. unsigned int __align( 8 ) __far array[2];
Example:

```c
int __align(8) __far src[4], dst[4];
void bcopy( void )
{
    // bcopy  dst, src, +, +, CNC=2, CNT0=2, CNT1=2
    __bcopy( dst, src, 1, 1, 2, 2, 2 );
}
```
generates:

```
ldl.iu  r5,@HI(_PCP_dst)
ldl.il  r5,@LO(_PCP_dst)
ldl.iu  r4,@HI(_PCP_src)
ldl.il  r4,@LO(_PCP_src)
l.d    r6,0x2
bcopy   dst+,src+,cnc=0x2,cnt0=0x2
```

__cen

```c
void __cen( const unsigned int value );
```

Set or clear the CEN flag. You can use this intrinsic safely only when the R7 flags are preserved by the compiler (`-preserve-r7-flags`).

__copy

```c
void volatile __copy( void __far * dst, void __far * src,
    const signed int DSTINCDEC, const signed int SRCINCDEC,
    const unsigned int CNC, const unsigned int CNT0,
    unsigned int CNT1, const unsigned int SIZE );
```

This intrinsic generates a COPY instruction. The COPY instruction moves content of source (\texttt{src=R[4]}) location on the FPI bus to destination (\texttt{dst=R[5]}) on the FPI bus. Constant arguments \texttt{DSTINCDEC} and \texttt{SRCINCDEC} determine if source and destination pointer are incremented or decremented, 1 for increment, -1 for decrement and 0 for no change. Constant arguments \texttt{CNC}, \texttt{CNT0} and \texttt{SIZE} are conform the argument values of the COPY instruction. \texttt{CNT1} is loaded in R6.\texttt{CNT1} if the value of \texttt{CNC} is 1 or 2. If \texttt{CNC} is 1 this intrinsic generates a outer loop.

Example:

```c
int __far src[4], dst[4];
void copy( void )
{
    // copy  dst, src, +, +, CNC=1, CNT0=2, CNT1=8 SIZE=8
    __copy( dst, src, 1, 1, 1, 2, 8, 8 );
}
```
generates:

```
ldl.iu  r5,@HI(_PCP_dst)
ldl.il  r5,@LO(_PCP_dst)
```
__debug

void __debug( const unsigned int eda, const unsigned int dac, 
const unsigned int rta, const unsigned int sdb );

This intrinsic generates a DEBUG instruction for the PCP2. The generated DEBUG instruction 
unconditionally cause a debug event. Optionally stop the channel execution (sdb=1), generate an external 
debug event (eda=1), disable further channel invocation (rta=0) or disable the PCP for operation (dac=1).

Example:

void __interrupt( 4 ) channel_4( void )
{
  /* DEBUG instruction that stops unconditionally the PCP, 
   * prevents the serving of any other interrupt and generates 
   * an "Illegal Operation Error". 
   */
  __debug(1,1,0,1);
}

generates:

depug eda=0x1, sdb=0x1, dac=0x1, rta=0x0, cc_uc

__dotdotdot__

char * __dotdotdot__( void );

Variable argument '...' operator. Used in C library function va_start(). Returns the stack offset to the 
variable argument list.

__exit

void __exit( const unsigned long srpn );

To allow rearbitration of interrupts, a 'voluntary exiting' scheme is supported via the intrinsic __exit(). 
This intrinsic generates an EXIT instruction with the following settings: EC=0, ST=0, INT=1, EP=1, cc_UC.

The R6.TOS is set for a PCP service request and the srpn value is loaded in R6.SRPN. It is your 
responsibility not to use this intrinsic in combination with the 'Channel Start at Base' mode.

The srpn value must be in range 0..255. If R6.SRPN is set to zero, it causes an illegal operation error 
on the PCP. When srpn is set to zero, no code is generated for loading R6.SRPN and the interrupt flag 
in the EXIT instruction is disabled (EXIT EC=0, ST=0, INT=0, EP=1, cc_UC).
The `__exit()` intrinsic function is kept simple as apposed to the EXIT instruction. The concept of the program flow in C (and any high level language), is that you have a routine that starts at the top and runs to the end (return), and then the initiative is past to the 'caller' side again. The flow can be interrupted by an interrupt. With the EXIT instructions however, other interrupts can be started (in fact anything is possible), enabling all kind of 'unwanted' flow.

```c
__exit_cpu

void __exit_cpu( const unsigned long srpn );
```

To service TriCore CPU interrupts, a 'voluntary exiting' scheme is supported via the intrinsic `__exit_cpu()`. This intrinsic generates an EXIT instruction with the following settings: EC=0, ST=0, INT=1, EP=1, cc_UC. The R6.TOS is set for a TriCore CPU service request and the `srpn` value is loaded in R6.SRPN.

```c
__Exit

void __Exit( int status );
```

Exit unconditionally. Same as C library function `__Exit()`. This intrinsic generates an EXIT instruction with the following settings: EC=0, ST=1, INT=0, EP=0, cc_UC. The CEN flag is cleared. Returns with status as the return value.

```c
__free

void volatile __free( __alloc_t buffer );
```

Deallocate the memory pointed to by `buffer`. `buffer` must point to memory earlier allocated by a call to `__alloc()`. Same as library function `free()`.

```c
__get_return_address

__codeptr volatile __get_return_address( void );
```

Returns the return address of a function.

```c
__ien

void __ien( const unsigned int value );
```

Set or clear the IEN flag. You can use this intrinsic safely only when the R7 flags are preserved by the compiler (`--preserve-r7-flags`).

```c
__ld32_fpi

unsigned long volatile __ld32_fpi( unsigned long addr );
```

Load a 32-bit value from a 32-bit FPI address using the `ld.f` instruction with `size=32`. Returns a 32-bit value for FPI memory address.
Example:

```c
#include <regtc1791.sfr>
unsigned int ld32( void )
{
    return __ld32_fpi( (unsigned long)(&(P10_OUT.U)) );
}
```
generates:

```assembly
ldl.iu  r5,@HI(0xf0003210)
ldl.il  r5,@LO(0xf0003210)
ld.f    r1,[r5], size=32
__nop

void __nop( void );
A NOP instruction is generated.

__pri

unsigned int __pri( unsigned int value );
Use PRI R[b], R[a], cc_UC instruction to prioritize value.

__rl

unsigned int __rl( unsigned int value,
    unsigned int count );
Rotate value left count times. This intrinsic uses RL R[a],Imm5 instruction(s). Returns the rotated value.

__rr

unsigned int __rr( unsigned int value,
    unsigned int count );
Rotate value right count times. This intrinsic uses RR R[a],Imm5 instruction(s). Returns the rotated value.

__st32_fpi

void volatile __st32_fpi( unsigned long addr,
    unsigned long value );
Store a 32-bit value on a 32-bit FPI address using the st.f instruction with size=32.
Example:
#include <regtc1791.sfr>
void st32( unsigned int value )
{
    __st32_fpi( (unsigned long)(&(P10_OUT.U)), value );
}
generates:

    ldl.iu  r5,@HI(0xf0003210)
    ldl.il  r5,@LO(0xf0003210)
    st.f    r1,[r5], size=32

__xchf8

unsigned int volatile __xchf8( unsigned int value,
    unsigned int __far * address );

Exchange the 8-bit contents of register value and FPI variable. address must be a constant FPI address expression. This intrinsic generates a XCH.F R[b], [R[a]] instruction.

Returns: 8-bit contents of FPI address

__xchf16

unsigned int volatile __xchf16( unsigned int value,
    unsigned int __far * address );

Exchange the 16-bit contents of register value and FPI variable. address must be a constant FPI address expression. This intrinsic generates a XCH.F R[b], [R[a]] instruction.

Returns: 16-bit contents of FPI address

__xchf32

unsigned int volatile __xchf32( unsigned int value,
    unsigned int __far * address );

Exchange the 32-bit contents of register value and FPI variable. address must be a constant FPI address expression. This intrinsic generates a XCH.F R[b], [R[a]] instruction.

Returns: 32-bit contents of FPI address

__xchpi

unsigned int volatile __xchpi( unsigned int value,
    unsigned int __near * address );

Exchange the 32-bit contents of register value and PRAM variable. address must be a constant PRAM address expression. This intrinsic generates a XCH.PI R[a], [#offset6] instruction.

Returns: 32-bit contents of PRAM address
1.10. PCP Code Generation

The effectiveness of the code generated by the PCP C compiler strongly depends on its stack implementation which is a static one. This means automatic stack variables, function stack parameters and temporary data are stored in overlayable static data areas.

A dynamic stack cannot be supported because the PCP instruction set does not have push and pop instructions. Simulating push and pop instructions is not an option because that requires registers by itself. This might force the compiler to abort in cases where a register must be pushed but all registers are in use.

A static stack poses the restriction that functions cannot be reentrant or recursive. Additionally, function pointer prototypes are limited to register parameters as the remaining parameters require a dynamic stack. Because the PCP does not have a hardware stack, function return addresses are stored on the static stack as well.

For effectiveness of the code generated by the PCP C compiler it is advised to use MIL linking and MIL archives, which is the default for building PCP applications with the Eclipse development environment.

The PCP core is designed to support high(est) priority non-interruptible functions most effectively. It is defined by Infineon to use a programming model for PCP applications that mainly consists of non-interruptible functions called non-interruptible PCP channels. The TriCore itself is intended to be used as the scheduler and arbitrator for these high priority non-interruptible PCP channels. Interruptible PCP channels, that can interrupt each other, are intended to be an exceptional case, they are supported but not by default.

1.10.1. Non-interruptible Code Generation

By default the compiler supports code generation for high(est) priority non-interruptible functions. Functions using a static stack are implicitly not interruptible, because they are not reentrant. The interrupt flag is disabled and must be kept disabled (IEN=0).

Lower priority interruptible functions can only be supported when they do not share static stack space, which means that they cannot have common functions. See Section 1.10.2, Interruptible Code Generation.

Preserving R7.IEN and R7.CEN when updating DPTR for PRAM access is superfluous if functions are not interruptible. For example, when accessing global variable "x" in PRAM the next code is generated.

\[
\text{ldl.il } r7, @\text{DPTR}(_\text{PCP}_x) ; \text{load R7.DPTR, R7.[7..0] flags are cleared}
\]
\[
\text{st.pi } r5, [_\text{PCP}_x]
\]

Not preserving the IEN and CEN reduces the amount of generated code substantially, an average of 45% of the code size is saved. The CEN flag is not explicitly set for each PRAM access, although it would not cost any extra code for direct PRAM access in the above example, but for each indirect PRAM access an extra set bit instruction is required to keep the CEN enabled.

A non-interruptible function can voluntarily exit, by using an \texttt{__exit()} intrinsic function. The \texttt{__exit()} SRPN argument specifies the interrupt channel that needs to be serviced. This can be itself or another interrupt. If another interrupt is serviced this interrupt cannot use the same functions that use the static

\[1\] This average is statistically determined on a large number of test programs.
stack, because functions using a static stack are not reentrant. Ignoring this requirement will result in undefined run-time behavior. The same interrupt can be serviced without any restrictions.

The IEN flag in the channel context, generated by the compiler for __interrupt() qualified functions, is set to zero, because functions are not interruptible by default. The interrupt priority of the channel R6.CPPN is set to zero, because channels that do not allow interrupts do not need a interrupt priority value. Channels that have IEN disabled in the channel context are serviced if their channel number is higher than the priority of the currently running channel.

The CEN flag in the context channel is set. For each PRAM access CEN is cleared. CEN is re-set at interrupt function return or at voluntary exit when using the __exit() intrinsic.

Depending on the channels start mode the channel continues execution at the next PC or restarts. The channels start at context PC mode is the default of the PCP (CS.RCB=0), the channel continues on the next PC after a voluntary exit (EP=1). Voluntary exit and channel start at base is not supported, it may lead to undefined run-time behavior. See the __exit() intrinsic function.

### 1.10.2. Interruptible Code Generation

Interruptible functions can only be supported when they do not share static stack space, which means that they cannot have common functions that use the static stack. The static stack is not only used for user defined functions, but also for compiler run-time functions and C library functions.

Each interrupt channel must be linked separately when they have commonly used functions. The linker option --link-only is used to link a single channel without locating it. Several linked channels can be located with the linker to a single PCP application. Functions that are used in different interrupt channels are duplicated, their names need to be unique to avoid duplicate name conflicts. With the compiler option --symbol-prefix="name" you can prefix all global variables with name. You need to rebuild the libraries with the prefix that corresponds to the channel. Each channel needs its own prefixed library functions. It is not required to create C libraries for each channel when C libraries are linked in the compiler with the option --mil.

To share global variables between PCP channels the qualifier __share needs to be used on the definition. E.g. extern int __share variable. __share variables get application scope instead of channel scope, using the _lc linker label prefix.

To share global functions between PCP channels the PCP can post channel requests to itself using the __exit(SRPN) intrinsic function. For servicing TriCore CPU interrupts the __exit_cpu(SRPN) intrinsic need to be used. The SRPN is the channel number to service, which can be an interruptible or non-interruptible channel.

The IEN flag in the channel context, generated by the compiler for __interrupt() qualified functions, is set to one, when interruptible code generation is enabled with the PCP C compiler option --interrupt-enable.

The PCP interrupt priority CPPN can be set using __cppn(CPPN) interrupt function qualifier. The __cppn() function qualifier can only be used for __interrupt() qualified functions and have interrupting enabled. The R6.CPPN value is restored at function exit, because R6 is used by the PCP C compiler as general purpose register to store local objects.
Functions that are interruptible need to keep the IEN flag enabled or need to preserve its state. With the PCP C compiler option `--interrupt-enable` the IEN flag is kept enabled.

With PCP C compiler option `--preserve-r7-flags` code is generated for PRAM access that does not write any of the R7.0..7 flags. Preserving the R7 flags increases the generated code substantially, but the state of the IEN and CEN flags can be changed anywhere in the C code. For example the interrupts can be temporary turned off in the code to call a non-interruptible function and turn it on afterwards. Also the channel can be turned off to prevent servicing the channel anymore. The code generated for accessing global PRAM variable "x" is:

```c
ld.i r1,0x3f
ldl.il r1,0xff
and r7,r1,cc_uc
ldl.il r1,@DPTR(_PCP_x)
or r7,r1,cc_uc ; load R7.DPTR
st.pi r5,[_PCP_x]
```

With the intrinsics `__ien()` and `__cen()` the IEN and CEN flags can be set or cleared in the code. These intrinsics can only be safely used when the r7 flags are preserved by the compiler.

When `--preserve-r7-flags` is not used and `--interrupt-enable` is used code is generated by the PCP C compiler that keeps the IEN and CEN flags enabled when accessing PCP PRAM. For example, when accessing global variable "x" in PRAM next code is generated.

```c
ldl.ilf r7,@DPTR_FLAGS(_PCP_x,0x60) ; load R7.DPTR, IEN=1 and CEN=1
st.pi r5,[_PCP_x]
```

For direct PRAM access the generated code is comparable for interruptible and un-interruptible code generation (`--interrupt-enable`). Indirect PRAM access is smaller and faster for un-interruptible code generation, because for interruptible code generation the IEN and CEN flags are set for every indirect PRAM access. For example, the next indirect PRAM access is generated for `--interrupt-enable`.

```c
ldl.il r3,0x3fc0
and r3,r1,cc_uc
shl r3,0x2
set r3,0x5 ; set IEN
set r3,0x6 ; set CEN
mov r7,r3,cc_uc ; load R7.DPTR
st.p r5,[r1],cc_uc
```

The generated code with `--interrupt-enable` averages 1.5% larger in code size and 1.3% slower in performance than the default code generation. With `--preserve-r7-flags` the generated code increases an average of 45%\(^2\).

\(^2\)This average is statistically determined on a large number of test programs.
1.11. Compiler Generated Sections

The compiler generates several `.SDECL/.SECT` assembler directives containing code and data. The compiler uses the following naming convention:

```
section_type_prefix.section_type
```

The default section name is equal to the generated section type that is prefixed with `.pcptext` for code in CMEM and `.pcpdata` for data in PRAM. The default code section name is `.pcptext.code` and the default PRAM data section name is `.pcpdata.data`. The default FPI data section name uses a prefix conforms the TriCore C compiler. E.g. `__far int i;` is located in a section with name `.bss.linear`. You can change section names with `#pragma section` or with the command line option `--rename-sections`.

The following table lists the section types and name prefixes.

<table>
<thead>
<tr>
<th>Section type</th>
<th>Name prefix</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>code</td>
<td>.pcptext</td>
<td>program code</td>
</tr>
<tr>
<td>data</td>
<td>.pcpdata</td>
<td>initialized __near data</td>
</tr>
<tr>
<td>linear</td>
<td><code>conform TriCore</code></td>
<td>initialized __far data</td>
</tr>
</tbody>
</table>

The names used in the `.SDECL/.SECT` directives are independent of the section attributes such as clear, init, max, group and overlay, whereas the assembler also uses the attributes to generate the actual section names.

For example, if part of a C source file `hello.c` contains:

```
char * world;
```

The compiler generates the following directives in the assembly source:

```
.sdecl '.pcpdata.data', data, group('page0_hello')
.sect  '.pcpdata.data'
```

Because of the `group` attribute, the assembler generates the following section name:

```
.pcpdata.data@page0_hello
```

Section names are case sensitive. By default, the sections are not concatenated by the linker. This means that multiple sections with the same name may exist. At link time, sections with different attributes can be selected by their attributes. The linker may remove unreferenced sections from the application.

**Overlay sections**

For static stack overlay sections the compiler uses a different section naming convention. The name used in the generated `.SDECL/.SECT` assembler directives equals the function name in which the overlay section is allocated.

For example, for function `main`, the compiler generates the following assembler directives:
The assembler generates static stack overlay sections using the following naming convention:

```
section_type_prefix.overlay_name@function_name
```

In our example, for function `main` the assembler generates the following static stack overlay section:

```
.pcpdata._PCP_stack_data@_PCP_main
```

### 1.11.1. Rename Sections

You can rename sections with a pragma or with a command line option. The syntax is the same:

```
--rename-sections=[type]=format_string[, [type]=format_string]...
```

```
#pragma section [type]=format_string[, [type]=format_string]...
```

With the memory `type` you select which sections are renamed. The matching sections will get the specified format string for the section name. The format string can contain characters and may contain the following format specifiers:

- `{attrib}`: section attributes, separated by underscores
- `{module}`: module name
- `{name}`: object name, name of variable or function
- `{type}`: section type

The naming convention for the renamed section is:

```
section_type_prefixpragma_value
```

Some examples (file `test.c`):

```
#pragma section data={module}_{type}_{attrib}
int x;
/* Section name: .pcpdata.test_data_data_clear */

#pragma section data=cpcp_{module}_{name}
int status;
/* Section name: .pcpdata.cpcp_test_status */

#pragma section data=RENAMED_{name}
int barcode;
/* Section name: .pcpdata.RENAMED_barcode */
```

```
#pragma endsection
```

With the `#pragma endsection` the default section name is restored. Nesting of pragma `section/endsection` pairs will save the status of the previous level.
Examples (file example.c)

char a;    // allocated in '.pcpdata.data'
#pragma section data=MyData1
char b;    // allocated in '.pcpdata.MyData1'
#pragma section data=MyData2
char c;    // allocated in '.pcpdata.MyData2'
#pragma endsection
char d;    // allocated in '.pcpdata.MyData1'
#pragma endsection
char e;    // allocated in '.pcpdata.data'
Chapter 2. Assembly Language

This chapter describes the most important aspects of the TASKING assembly language for the PCP. For a complete overview of the PCP2 architecture, refer to the PCP2 Target Specification [V 1.0, 2000-06, Infineon].

2.1. Assembly Syntax

An assembly program consists of statements. A statement may optionally be followed by a comment. Any source statement can be extended to more lines by including the line continuation character (\) as the last character on the line. The length of a source statement (first line and continuation lines) is only limited by the amount of available memory.

Mnemonics, directives and other keywords are case insensitive. Labels, symbols, directive arguments, and literal strings are case sensitive.

The syntax of an assembly statement is:

[label[:]] [instruction | directive | macro_call] [;comment]

(label) A label is a special symbol which is assigned the value and type of the current program location counter. A label can consist of letters, digits and underscore characters (_). The first character cannot be a digit. The label can also be a number. A label which is prefixed by whitespace (spaces or tabs) has to be followed by a colon (;). The size of an identifier is only limited by the amount of available memory.

(number) is a number ranging from 1 to 255. This type of label is called a numeric label or local label. To refer to a numeric label, you must put an n (next) or p (previous) immediately after the label. This is required because the same label number may be used repeatedly.

Examples:

LAB1: ; This label is followed by a colon and can be prefixed by whitespace
LAB1 ; This label has to start at the beginning; of a line
1: jg 1p ; This is an endless loop; using numeric labels

(instruction) An instruction consists of a mnemonic and zero, one or more operands. It must not start in the first column.

Operands are described in Section 2.3, Operands of an Assembly Instruction. The instructions are described in the target's core Architecture Manual.
With directives you can control the assembler from within the assembly source. Except for preprocessing directives, these must not start in the first column. Directives are described in Section 2.9, Assembler Directives and Controls.

A call to a previously defined macro. It must not start in the first column. See Section 2.10, Macro Operations.

Comment, preceded by a ; (semicolon).

You can use empty lines or lines with only comments.

Apart from the assembly statements as described above, you can put a so-called 'control line' in your assembly source file. These lines start with a $ in the first column and alter the default behavior of the assembler.

For more information on controls see Section 2.9, Assembler Directives and Controls.

2.2. Assembler Significant Characters

You can use all ASCII characters in the assembly source both in strings and in comments. Also the extended characters from the ISO 8859-1 (Latin-1) set are allowed.

Some characters have a special meaning to the assembler. Special characters associated with expression evaluation are described in Section 2.6.3, Expression Operators. Other special assembler characters are:

<table>
<thead>
<tr>
<th>Character</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>;</td>
<td>Start of a comment</td>
</tr>
<tr>
<td>\</td>
<td>Line continuation character or macro operator: argument concatenation</td>
</tr>
<tr>
<td>?</td>
<td>Macro operator: return decimal value of a symbol</td>
</tr>
<tr>
<td>%</td>
<td>Macro operator: return hex value of a symbol</td>
</tr>
<tr>
<td>^</td>
<td>Macro operator: override local label</td>
</tr>
<tr>
<td>&quot;</td>
<td>Macro string delimiter or quoted string .DEFINE expansion character</td>
</tr>
<tr>
<td>'</td>
<td>String constants delimiter</td>
</tr>
<tr>
<td>@</td>
<td>Start of a built-in assembly function</td>
</tr>
<tr>
<td>*</td>
<td>Location counter substitution</td>
</tr>
<tr>
<td>#</td>
<td>Constant number</td>
</tr>
<tr>
<td>++</td>
<td>String concatenation operator</td>
</tr>
<tr>
<td>[]</td>
<td>Substring delimiter</td>
</tr>
</tbody>
</table>
2.3. Operands of an Assembly Instruction

In an instruction, the mnemonic is followed by zero, one or more operands. An operand has one of the following types:

<table>
<thead>
<tr>
<th>Operand</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>symbol</td>
<td>A symbolic name as described in Section 2.4, Symbol Names. Symbols can also occur in expressions.</td>
</tr>
<tr>
<td>register</td>
<td>Any valid register as listed in Section 2.5, Registers.</td>
</tr>
<tr>
<td>expression</td>
<td>Any valid expression as described in Section 2.6, Assembly Expressions.</td>
</tr>
<tr>
<td>address</td>
<td>A combination of expression, register and symbol.</td>
</tr>
</tbody>
</table>

Addressing modes

The PCP assembly language has several addressing modes. These addressing modes are used for FPI addressing, PRAM data indirect addressing or flow control destination addressing. For details see the PCP2 Target Specification [V 1.0, 2000-06, Infineon].

2.4. Symbol Names

User-defined symbols

A user-defined symbol can consist of letters, digits and underscore characters (_). The first character cannot be a digit. The size of an identifier is only limited by the amount of available memory. The case of these characters is significant. You can define a symbol by means of a label declaration or an equate or set directive.

Predefined preprocessor symbols

These symbols start and end with two underscore characters, __symbol__, and you can use them in your assembly source to create conditional assembly. See Section 2.4.1, Predefined Preprocessor Symbols.

Labels

Symbols used for memory locations are referred to as labels. It is allowed to use reserved symbols as labels as long as the label is followed by a colon.

Reserved symbols

Symbol names and other identifiers starting with a period (.) are reserved for the system (for example for directives or section names). Identifiers starting with an at sign (@) are reserved for built-in assembler functions. Instructions are also reserved. The case of these built-in symbols is insignificant.

Examples

Valid symbol names:
loop_1
ENTRY
a_B_c
_aBC

Invalid symbol names:

1_loop ; starts with a number
r1 ; reserved register name
.DEFINEn ; reserved directive name

### 2.4.1. Predefined Preprocessor Symbols

The TASKING assembler knows the predefined symbols as defined in the table below. The symbols are useful to create conditional assembly.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ASPCP</strong></td>
<td>Identifies the assembler. You can use this symbol to flag parts of the source which must be recognized by the <code>aspcp</code> assembler only. It expands to 1.</td>
</tr>
<tr>
<td><strong>BUILD</strong></td>
<td>Identifies the build number of the assembler in the format yymmddqq (year, month, day and quarter in UTC).</td>
</tr>
<tr>
<td><strong>REVISION</strong></td>
<td>Expands to the revision number of the assembler. Digits are represented as they are; characters (for prototypes, alphas, betas) are represented by -1. Examples: v1.0r1 -&gt; 1, v1.0rb -&gt; -1</td>
</tr>
<tr>
<td><strong>TASKING</strong></td>
<td>Identifies the assembler as a TASKING assembler. Expands to 1 if a TASKING assembler is used.</td>
</tr>
<tr>
<td><strong>VERSION</strong></td>
<td>Identifies the version number of the assembler. For example, if you use version 2.1r1 of the assembler, <strong>VERSION</strong> expands to 2001 (dot and revision number are omitted, minor version number in 3 digits).</td>
</tr>
</tbody>
</table>

**Example**

```assembly
.if @defined('__ASPCP__')
    ; this part is only for the aspcp assembler
...
.endif
```

### 2.5. Registers

The following register names, either uppercase or lowercase, should not be used for user-defined symbol names in an assembly language source file:

R0 .. R7 (general purpose registers)
2.5.1. Special Function Registers

It is easy to access Special Function Registers (SFRs) that relate to peripherals from assembly. The SFRs are defined in a special function register definition file (*.def) as symbol names for use by the assembler. The assembler can include the SFR definition file with the command line option `--include-file (-H)`. SFRs are defined with `.EQU` directives.

For example (from `regtc1796b.def`):

```
PC .equ 0xFE08
```

Without an SFR file the assembler only knows the general purpose registers R0-R7.

2.6. Assembly Expressions

An expression is a combination of symbols, constants, operators, and parentheses which represent a value that is used as an operand of an assembler instruction (or directive).

Expressions can contain user-defined labels (and their associated integer or floating-point values), and any combination of integers, floating-point numbers, or ASCII literal strings.

Expressions follow the conventional rules of algebra and boolean arithmetic.

Expressions that can be evaluated at assembly time are called absolute expressions. Expressions where the result is unknown until all sections have been combined and located, are called relocatable or relative expressions.

When any operand of an expression is relocatable, the entire expression is relocatable. Relocatable expressions are emitted in the object file and evaluated by the linker. Relocatable expressions can only contain integral functions; floating-point functions and numbers are not supported by the ELF/DWARF object format.

The assembler evaluates expressions with 64-bit precision in two's complement.

The syntax of an expression can be any of the following:

- numeric constant
- string
- symbol
- expression binary_operator expression
- unary_operator expression
- (expression)
- function call

All types of expressions are explained in separate sections.
2.6.1. Numeric Constants

Numeric constants can be used in expressions. If there is no prefix, by default the assembler assumes the number is a decimal number. Prefixes can be used in either lowercase or uppercase.

<table>
<thead>
<tr>
<th>Base</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Binary</td>
<td>A 0b or 0B prefix followed by binary digits (0,1).</td>
<td>0B1101 0b11001010</td>
</tr>
<tr>
<td>Hexadecimal</td>
<td>A 0x or 0X prefix followed by hexadecimal digits (0-9, A-F, a-f).</td>
<td>0X12FF 0x45 0xfa10</td>
</tr>
<tr>
<td>Decimal integer</td>
<td>Decimal digits (0-9).</td>
<td>12 1245</td>
</tr>
<tr>
<td>Decimal floating-point</td>
<td>Decimal digits (0-9), includes a decimal point, or an 'E' or 'e' followed by the exponent.</td>
<td>6E10 .6 3.14 2.7e10</td>
</tr>
</tbody>
</table>

2.6.2. Strings

ASCII characters, enclosed in single (') or double ("") quotes constitute an ASCII string. Strings between double quotes allow symbol substitution by a .DEFINE directive, whereas strings between single quotes are always literal strings. Both types of strings can contain escape characters.

Strings constants in expressions are evaluated to a number (each character is replaced by its ASCII value). Strings in expressions can have a size of up to 4 characters or less depending on the operand of an instruction or directive; any subsequent characters in the string are ignored. In this case the assembler issues a warning. An exception to this rule is when a string is used in a .BYTE assembler directive; in that case all characters result in a constant value of the specified size. Null strings have a value of 0.

Square brackets ([ ]) delimit a substring operation in the form:

\[string, offset, length\]

offset is the start position within string. length is the length of the desired substring. Both values may not exceed the size of string.

Examples

'ABCD' ; (0x41424344)
"'79"   ; to enclose a quote double it
"A""BC" ; or to enclose a quote escape it
'AB'+1  ; (0x4143) string used in expression
'    '  ; null string
.word 'abcdef' ; (0x64636261) 'ef' are ignored
Warning: string value truncated

'abc'++'de' ; you can concatenate
two strings with the '++' operator.
This results in 'abcde'

['TASKING', 0, 4] ; results in the substring 'TASK'

### 2.6.3. Expression Operators

The next table shows the assembler operators. They are ordered according to their precedence. Operators of the same precedence are evaluated left to right. Parenthetical expressions have the highest priority (innermost first).

Valid operands include numeric constants, literal ASCII strings and symbols.

Most assembler operators can be used with both integer and floating-point values. If one operand has an integer value and the other operand has a floating-point value, the integer is converted to a floating-point value before the operator is applied. The result is a floating-point value.

<table>
<thead>
<tr>
<th>Type</th>
<th>Operator</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>( )</td>
<td>parenthesis</td>
<td>Expressions enclosed by parenthesis are evaluated first.</td>
</tr>
<tr>
<td>Unary</td>
<td>+</td>
<td>plus</td>
<td>Returns the value of its operand.</td>
</tr>
<tr>
<td></td>
<td>-</td>
<td>minus</td>
<td>Returns the negative of its operand.</td>
</tr>
<tr>
<td></td>
<td>~</td>
<td>one's complement</td>
<td>Integer only. Returns the one’s complement of its operand. It cannot be used with a floating-point operand.</td>
</tr>
<tr>
<td></td>
<td>!</td>
<td>logical negate</td>
<td>Returns 1 if the operands’ value is 0; otherwise 0. For example, if buf is 0 then !buf is 1. If buf has a value of 1000 then !buf is 0.</td>
</tr>
<tr>
<td>Arithmetic</td>
<td>*</td>
<td>multiplication</td>
<td>Yields the product of its operands.</td>
</tr>
<tr>
<td></td>
<td>/</td>
<td>division</td>
<td>Yields the quotient of the division of the first operand by the second. For integer operands, the divide operation produces a truncated integer result.</td>
</tr>
<tr>
<td></td>
<td>%</td>
<td>modulo</td>
<td>Integer only. This operator yields the remainder from the division of the first operand by the second.</td>
</tr>
<tr>
<td></td>
<td>+</td>
<td>addition</td>
<td>Yields the sum of its operands.</td>
</tr>
<tr>
<td></td>
<td>-</td>
<td>subtraction</td>
<td>Yields the difference of its operands.</td>
</tr>
<tr>
<td>Shift</td>
<td>&lt;&lt;</td>
<td>shift left</td>
<td>Integer only. Causes the left operand to be shifted to the left (and zero-filled) by the number of bits specified by the right operand.</td>
</tr>
<tr>
<td></td>
<td>&gt;&gt;</td>
<td>shift right</td>
<td>Integer only. Causes the left operand to be shifted to the right by the number of bits specified by the right operand. The sign bit will be extended.</td>
</tr>
<tr>
<td>Type</td>
<td>Operator</td>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>----------</td>
<td>----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Relational</td>
<td>&lt;</td>
<td>less than</td>
<td>Returns an integer 1 if the indicated condition is TRUE or an integer 0 if the indicated condition is FALSE.</td>
</tr>
<tr>
<td></td>
<td>&lt;=</td>
<td>less than or equal</td>
<td>For example, if D has a value of 3 and E has a value of 5, then the result of the expression D &lt; E is 1, and the result of the expression D &gt; E is 0.</td>
</tr>
<tr>
<td></td>
<td>&gt;</td>
<td>greater than</td>
<td>Use tests for equality involving floating-point values with caution, since rounding errors could cause unexpected results.</td>
</tr>
<tr>
<td></td>
<td>&gt;=</td>
<td>greater than or equal</td>
<td></td>
</tr>
<tr>
<td></td>
<td>==</td>
<td>equal</td>
<td></td>
</tr>
<tr>
<td></td>
<td>!=</td>
<td>not equal</td>
<td></td>
</tr>
<tr>
<td>Bit and Bitwise</td>
<td>&amp;</td>
<td>AND</td>
<td>Integer only. Yields the bitwise AND function of its operand.</td>
</tr>
<tr>
<td>Bitwise</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Logical</td>
<td>&amp;&amp;</td>
<td>logical AND</td>
<td>Returns an integer 1 if both operands are non-zero; otherwise, it returns an integer 0.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The relational operators and logical operators are intended primarily for use with the conditional assembly .if directive, but can be used in any expression.

### 2.7. Working with Sections

Sections are absolute or relocatable blocks of contiguous memory that can contain code or data. Some sections contain code or data that your program declared and uses directly, while other sections are created by the compiler or linker and contain debug information or code or data to initialize your application. These sections can be named in such a way that different modules can implement different parts of these sections. These sections are located in memory by the linker (using the linker script language, LSL) so that concerns about memory placement are postponed until after the assembly process.

All instructions and directives which generate data or code must be within an active section. The assembler emits a warning if code or data starts without a section definition and activation. The compiler automatically generates sections. If you program in assembly you have to define sections yourself.

For more information about locating sections see Section 5.7.8, The Section Layout Definition: Locating Sections.

### Section definition

Sections are defined with the .SDECL directive and have a name. A section may have attributes to instruct the linker to place it on a predefined starting address, or that it may be overlaid with another section.
Section activation

Sections are defined once and are activated with the .SECT directive.

.SECT 'name'

The linker will check between different modules and emits an error message if the section attributes do not match. The linker will also concatenate all matching section definitions into one section. So, all "code" sections generated by the compiler will be linked into one big "code" chunk which will be located in one piece. A .SECT directive referring to an earlier defined section is called a continuation. Only the name can be specified.

Examples

.SDECL '.pcptext.code', CODE
.SECT '.pcptext.code'

Defines and activates a relocatable section in CODE memory. Other parts of this section, with the same name, may be defined in the same module or any other module. Other modules should use the same .SDECL statement. When necessary, it is possible to give the section an absolute starting address.

.SDECL '.pcpdata.data', data at 0x100
.SECT '.pcpdata.data'

Defines and activates an absolute section named .pcpdata.data starting at address 0x100.

2.8. Built-in Assembly Functions

The TASKING assembler has several built-in functions to support data conversion, string comparison, and math computations. You can use functions as terms in any expression.

Syntax of an assembly function

@function_name([argument[,argument]...])

Functions start with the '@' character and have zero or more arguments, and are always followed by opening and closing parentheses. White space (a blank or tab) is not allowed between the function name and the opening parenthesis and between the (comma-separated) arguments.

The names of assembly functions are case insensitive.

Overview of mathematical functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>@ABS(expr)</td>
<td>Absolute value</td>
</tr>
</tbody>
</table>
### Overview of conversion functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>@CVF(expr)</code></td>
<td>Convert integer to floating-point</td>
</tr>
<tr>
<td><code>@CVI(expr)</code></td>
<td>Convert floating-point to integer</td>
</tr>
<tr>
<td><code>@FLD(base, value, width[, start])</code></td>
<td>Shift and mask operation</td>
</tr>
<tr>
<td><code>@FRACT(expr)</code></td>
<td>Convert floating-point to 32-bit fractional</td>
</tr>
<tr>
<td><code>@SFRACT(expr)</code></td>
<td>Convert floating-point to 16-bit fractional</td>
</tr>
<tr>
<td><code>@LNG(expr1, expr2)</code></td>
<td>Concatenate to double word</td>
</tr>
<tr>
<td><code>@LUN(expr)</code></td>
<td>Convert long fractional to floating-point</td>
</tr>
<tr>
<td><code>@RVB(expr[, exprN])</code></td>
<td>Reverse order of bits in field</td>
</tr>
<tr>
<td><code>@UNF(expr)</code></td>
<td>Convert fractional to floating-point</td>
</tr>
</tbody>
</table>
### Overview of string functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>@CAT(str1, str2)</td>
<td>Concatenate str1 and str2</td>
</tr>
<tr>
<td>@LEN(string)</td>
<td>Length of string</td>
</tr>
<tr>
<td>@POS(str1, str2[, start])</td>
<td>Position of str2 in str1</td>
</tr>
<tr>
<td>@SCP(str1, str2)</td>
<td>Compare str1 with str2</td>
</tr>
<tr>
<td>@SUB(str, expr1, expr2)</td>
<td>Return substring</td>
</tr>
</tbody>
</table>

### Overview of macro functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>@ARG('symbol'</td>
<td>expr)</td>
</tr>
<tr>
<td>@CNT()</td>
<td>Return number of macro arguments</td>
</tr>
<tr>
<td>@MAC(symbol)</td>
<td>Test if macro is defined</td>
</tr>
<tr>
<td>@MXP()</td>
<td>Test if macro expansion is active</td>
</tr>
</tbody>
</table>

### Overview of address calculation functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>@DPTR(expr)</td>
<td>Returns bits 6-13 of the pcpdata address</td>
</tr>
<tr>
<td>@DPTRBIT(expr)</td>
<td>Returns single negated bit in the range 6-13 of the pcpdata address</td>
</tr>
<tr>
<td>@HI(expr)</td>
<td>Returns upper 16 bits of expression value</td>
</tr>
<tr>
<td>@INIT_R7(start, dptr, flags)</td>
<td>Returns the 32-bit value to initialize R7</td>
</tr>
<tr>
<td>@LO(expr)</td>
<td>Returns lower 16 bits of expression value</td>
</tr>
<tr>
<td>@LSB(expr)</td>
<td>Least significant byte of the expression</td>
</tr>
<tr>
<td>@MSB(expr)</td>
<td>Most significant byte of the expression</td>
</tr>
</tbody>
</table>

### Overview of assembler mode functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>@ASPCP()</td>
<td>Returns the name of the PCP assembler executable</td>
</tr>
<tr>
<td>@DEF('symbol'</td>
<td>symbol)</td>
</tr>
<tr>
<td>@EXP(expr)</td>
<td>Expression check</td>
</tr>
<tr>
<td>@INT(expr)</td>
<td>Integer check</td>
</tr>
<tr>
<td>@LST()</td>
<td>LIST control flag value</td>
</tr>
</tbody>
</table>
Detailed Description of Built-in Assembly Functions

@ABS(expression)

Returns the absolute value of the expression as an integer value.

Example:

AVAL .SET @ABS(-2.1) ; AVAL = 2

@ACS(expression)

Returns the arc cosine of expression as a floating-point value in the range zero to pi. The result of expression must be between -1 and 1.

Example:

ACOS .SET @ACS(-1.0) ;ACOS = 3.1415926535897931

@ARG('symbol' | expression)

Returns integer 1 if the macro argument represented by symbol or expression is present, 0 otherwise.

You can specify the argument with a symbol name (the name of a macro argument enclosed in single quotes) or with expression (the ordinal number of the argument in the macro formal argument list). If you use this function when macro expansion is not active, the assembler issues a warning.

Example:

.IF @ARG('TWIDDLE') ;is argument twiddle present?
.IF @ARG(1) ;is first argument present?

@ASN(expression)

Returns the arc sine of expression as a floating-point value in the range -pi/2 to pi/2. The result of expression must be between -1 and 1.

Example:

ARCSINE .SET @ASN(-1.0) ;ARCSINE = -1.570796

@ASPCP()

Returns the name of the assembler executable. This is 'aspcp' for the PCP assembler.

Example:

ANAME: .byte @ASPCP() ;ANAME = 'aspcp'
@AT2(expression1,expression2)

Returns the arc tangent of expression1/expression2 as a floating-point value in the range -pi to pi. expression1 and expression2 must be separated by a comma.

Example:
ATAN2 .EQU @AT2(-1.0,1.0) ; ATAN2 = -0.7853982

@ATN(expression)

Returns the arc tangent of expression as a floating-point value in the range -pi/2 to pi/2.

Example:
ATAN .SET @ATN(1.0) ; ATAN = 0.78539816339744828

@CAT(string1,string2)

Concatenates the two strings into one string. The two strings must be enclosed in single or double quotes.

Example:
.DEFINE ID "@CAT('TASK','ING')" ; ID = 'TASKING'

@CEL(expression)

Returns a floating-point value which represents the smallest integer greater than or equal to expression.

Example:
CEIL .SET @CEL(-1.05) ; CEIL = -1.0

@CNT()

Returns the number of macro arguments of the current macro expansion as an integer. If you use this function when macro expansion is not active, the assembler issues a warning.

Example:
ARGCOUNT .SET @CNT() ; reserve argument count

@COH(expression)

Returns the hyperbolic cosine of expression as a floating-point value.

Example:
HYCOS .EQU @COH(VAL) ; compute hyperbolic cosine
@COS(expression)

Returns the cosine of expression as a floating-point value.

Example:

.WORD  -@COS(@CVF(COUNT)*FREQ) ;compute cosine value

@CVF(expression)

Converts the result of expression to a floating-point value.

Example:

FLOAT .SET  @CVF(5)          ;FLOAT = 5.0

@CVI(expression)

Converts the result of expression to an integer value. This function should be used with caution since the conversions can be inexact (e.g., floating-point values are truncated).

Example:

INT .SET  @CVI(-1.05)        ;INT = -1

@DEF('symbol' | symbol)

Returns 1 if symbol has been defined, 0 otherwise. symbol can be any symbol or label not associated with a .MACRO or .SDECL directive. If symbol is quoted, it is looked up as a .DEFINE symbol; if it is not quoted, it is looked up as an ordinary symbol or label.

Example:

.IF @DEFINED('ANGLE')         ;is symbol ANGLE defined?
.IF @DEFINED(ANGLE)           ;does label ANGLE exist?

@DPTR(expression)

Returns bits 6-13 of the pcpdata address provided. This is equivalent to ((expression>>6) & 0xff).

Example:

ldl.il r7,@DPTR(pcp_data_a0)

@DPTRBIT(expression)

Returns a single negated bit in the range 6-13 of the pcpdata address provided. This is equivalent to ((expression>>n-8+6) ^0x1), where n = 8..15. The bit returned is defined by the BMOVN instruction.

Example:
bmovn r7,8,@DPTRBIT(label) ; bmovn R7,8,(label>>6)^0x1

@EXP(expression)

Returns 0 if the evaluation of expression would normally result in an error. Returns 1 if the expression can be evaluated correctly. With the @EXP function, you prevent the assembler from generating an error if the expression contains an error. No test is made by the assembler for warnings. The expression may be relative or absolute.

Example:

.IF  !@EXP(3/0) ;Do the IF on error  
   ;assembler generates no error
.IF  !(3/0) ;assembler generates an error

@FLD(base,value,width[,start])

Shift and mask value into base for width bits beginning at bit start. If start is omitted, zero (least significant bit) is assumed. All arguments must be positive integers and none may be greater than the target word size. Returns the shifted and masked value.

Example:

VAR1 .EQU @FLD(0,1,1) ;turn bit 0 on, VAR1=1
VAR2 .EQU @FLD(0,3,1) ;turn bit 0 on, VAR2=1
VAR3 .EQU @FLD(0,3,2) ;turn bits 0 and 1 on, VAR3=3
VAR4 .EQU @FLD(0,3,2,1) ;turn bits 1 and 2 on, VAR4=6
VAR5 .EQU @FLD(0,1,1,7) ;turn eighth bit on, VAR5=0x80

@FLR(expression)

Returns a floating-point value which represents the largest integer less than or equal to expression.

Example:

FLOOR .SET  @FLR(2.5) ;FLOOR = 2.0

@FRACT(expression)

Returns the 32-bit fractional representation of the floating-point expression. The expression must be in the range [-1,+1].

Example:

.WORD  @FRACT(0.1), @FRACT(1.0)

@HI(expression)

Returns the upper 16 bits of a value. @HI(expression) is equivalent to ((expression>>16) & 0xffffffff).
Example:

```assembly
ldl.iu r5,#@HI(COUNT) ; upper 16 bits of COUNT
ldl.il r5,#@LO(COUNT)
```

### @INIT_R7(start,dptr,flags)

Returns the 32-bit value needed to initialize R7. This is equivalent to (start<<16) + (((dptr&0x3fff)>>6)<<8) + (flags & 0xff).

Example:

```assembly
.WORD @INIT_R7(start_0,pcp_data_0,7)
```

### @INT(expression)

Returns integer 1 if expression has an integer result; otherwise, it returns a 0. The expression may be relative or absolute.

Example:

```assembly
.IF @INT(TERM) ; Test if result is an integer
```

### @L10(expression)

Returns the base 10 logarithm of expression as a floating-point value. expression must be greater than zero.

Example:

```assembly
LOG .EQU @L10(100.0) ; LOG = 2
```

### @LEN(string)

Returns the length of string as an integer.

Example:

```assembly
SLEN .SET @LEN('string') ; SLEN = 6
```

### @LNG(expression1,expression2)

Concatenates the 16-bit expression1 and expression2 into a 32-bit word value such that expression1 is the high half and expression2 is the low half.

Example:

```assembly
LWORD .WORD @LNG(HI,LO) ; build long word
```
@LO(expression)

Returns the lower 16 bits of a value. @LO(expression) is equivalent to (expression & 0xffff).

Example:

ldl.iu r5,#@HI(COUNT)
ldl.il r5,#@LO(COUNT) ;lower 16 bits of COUNT

@LOG(expression)

Returns the natural logarithm of expression as a floating-point value. expression must be greater than zero.

Example:

LOG .EQU @LOG(100.0) ;LOG = 4.605170

@LSB(expression)

Returns the least significant byte of the result of the expression. The result of the expression is calculated as 16 bit.

Example:

VAR1 .SET @LSB(0x34) ;VAR1 = 0x34
VAR2 .SET @LSB(0x1234) ;VAR2 = 0x34
VAR3 .SET @LSB(0x654321) ;VAR3 = 0x21

@LST()

Returns the value of the $LIST ON/OFF control flag as an integer. Whenever a $LIST ON control is encountered in the assembler source, the flag is incremented; when a $LIST OFF control is encountered, the flag is decremented.

Example:

.DUP @ABS(@LST()) ;list unconditionally

@LUN(expression)

Converts the 32-bit expression to a floating-point value. expression should represent a binary fraction.

Example:

DBLFRC1 .EQU @LUN(0x40000000) ;DBLFRC1 = 0.5
DBLFRC2 .EQU @LUN(3928472) ;DBLFRC2 = 0.007354736
DBLFRC3 .EQU @LUN(0xE0000000) ;DBLFRC3 = -0.75
@MAC(symbol)

Returns integer 1 if symbol has been defined as a macro name, 0 otherwise.

Example:

.IF @MAC(DOMUL) ; does macro DOMUL exist?

@MAX(expression1[,expressionN],...)

Returns the maximum value of expression1, ..., expressionN as a floating-point value.

Example:

MAX: .BYTE @MAX(1,-2.137,3.5) ; MAX = 3.5

@MIN(expression1[,expressionN],...)

Returns the minimum value of expression1, ..., expressionN as a floating-point value.

Example:

MIN: .BYTE @MIN(1,-2.137,3.5) ; MIN = -2.137

@MSB(expression)

Returns the most significant byte of the result of the expression. The result of the expression is calculated as 16 bit.

Example:

VAR1 .SET @MSB(0x34) ; VAR1 = 0x00
VAR2 .SET @MSB(0x1234) ; VAR2 = 0x12
VAR3 .SET @MSB(0x654321) ; VAR3 = 0x43

@MXP()

Returns integer 1 if the assembler is expanding a macro, 0 otherwise.

Example:

.IF @MXP() ; macro expansion active?

@POS(string1,string2[,start])

Returns the position of string2 in string1 as an integer. If string2 does not occur in string1, the last string position + 1 is returned.

With start you can specify the starting position of the search. If you do not specify start, the search is started from the beginning of string1. Note that the first position in a string is position 0.
Assembly Language

Example:

ID1  .EQU  @POS('TASKING','ASK')  ; ID1 = 1
ID2  .EQU  @POS('ABCDABCD','B',2) ; ID2 = 5
ID3  .EQU  @POS('TASKING','BUG')  ; ID3 = 7

@POW(expression1,expression2)

Returns expression1 raised to the power expression2 as a floating-point value. expression1 and expression2 must be separated by a comma.

Example:

BUF  .EQU  @CVI(@POW(2.0,3.0))     ;BUF = 8

@RND()

Returns a random value in the range 0.0 to 1.0.

Example:

SEED  .EQU   @RND()          ;save initial SEED value

@RVB(expression1,expression2)

Reverse the order of bits in expression1 delimited by the number of bits in expression2. If expression2 is omitted the field is bounded by the target word size. Both expressions must be 16-bit integer values.

Example:

VAR1 .SET @RVB(0x200)   ;reverse all bits, VAR1=0x40
VAR2 .SET @RVB(0xB02)   ;reverse all bits, VAR2=0x40D0
VAR3 .SET @RVB(0xB02,2) ;reverse bits 0 and 1,
                          ;VAR3=0xB01

@SCP(string1,string2)

Returns integer 1 if the two strings compare, 0 otherwise. The two strings must be separated by a comma.

Example:

.IF @SCP(STR,'MAIN')  ; does STR equal 'MAIN'? 

@SFRACT(expression)

This function returns the 16-bit fractional representation of the floating-point expression. The expression must be in the range [-1,+1].

Example:

.WORD  @SFRACT(0.1),  @SFRACT(1.0)
@SGN(expression)

Returns the sign of expression as an integer: -1 if the argument is negative, 0 if zero, 1 if positive. The expression may be relative or absolute.

Example:

```
VAR1 .SET @SGN(-1.2e-92) ;VAR1 = -1
VAR2 .SET @SGN(0) ;VAR2 = 0
VAR3 .SET @SGN(28.382) ;VAR3 = 1
```

@SIN(expression)

Returns the sine of expression as a floating-point value.

Example:

```
.WORD @SIN(@CVF(COUNT)*FREQ) ;compute sine value
```

@SNH(expression)

Returns the hyperbolic sine of expression as a floating-point value.

Example:

```
HSINE .EQU  @SNH(VAL) ;hyperbolic sine
```

@SQT(expression)

Returns the square root of expression as a floating-point value. expression must be positive.

Example:

```
SQRT1 .EQU  @SQT(3.5) ;SQRT1 = 1.870829
SQRT2 .EQU  @SQT(16) ;SQRT2 = 4
```

@SUB(string,expression1,expression2)

Returns the substring from string as a string. expression1 is the starting position within string, and expression2 is the length of the desired string. The assembler issues an error if either expression1 or expression2 exceeds the length of string. Note that the first position in a string is position 0.

Example:

```
.DEFINIE ID "@SUB('TASKING',3,4)" ;ID = 'KING'
```

@TAN(expression)

Returns the tangent of expression as a floating-point value.

Example:
TANGENT .SET @TAN(1.0) ; TANGENT = 1.5574077

@TNH(expression)

Returns the hyperbolic tangent of expression as a floating-point value.

Example:
HTAN .SET @TNH(1) ; HTAN = 0.76159415595

@UNF(expression)

Converts expression to a floating-point value. expression should represent a 16-bit binary fraction.

Example:
FRC .EQU @UNF(0x4000) ; FRC = 0.5

@XPN(expression)

Returns the exponential function (base e raised to the power of expression) as a floating-point value.

Example:
EXP .EQU @XPN(1.0) ; EXP = 2.718282

2.9. Assembler Directives and Controls

An assembler directive is simply a message to the assembler. Assembler directives are not translated into machine instructions. There are three main groups of assembler directives.

• Assembler directives that tell the assembler how to go about translating instructions into machine code. This is the most typical form of assembly directives. Typically they tell the assembler where to put a program in memory, what space to allocate for variables, and allow you to initialize memory with data. When the assembly source is assembled, a location counter in the assembler keeps track of where the code and data is to go in memory.

The following directives fall under this group:

• Assembly control directives
• Symbol definition and section directives
• Data definition / Storage allocation directives
• High Level Language (HLL) directives
• Directives that are interpreted by the macro preprocessor. These directives tell the macro preprocessor how to manipulate your assembly code before it is actually being assembled. You can use these directives to write macros and to write conditional source code. Parts of the code that do not match the condition, will not be assembled at all.
Some directives act as assembler options and most of them indeed do have an equivalent assembler (command line) option. The advantage of using a directive is that with such a directive you can overrule the assembler option for a particular part of the code. Directives of this kind are called controls. A typical example is to tell the assembler with an option to generate a list file while with the controls $LIST ON and $LIST OFF you overrule this option for a part of the code that you do not want to appear in the list file. Controls always appear on a separate line and start with a '$' sign in the first column.

The following controls are available:

- Assembly listing controls
- Miscellaneous controls

Each assembler directive or control has its own syntax. You can use assembler directives and controls in the assembly code as pseudo instructions.

Some assembler directives can be preceded with a label. If you do not precede an assembler directive with a label, you must use white space instead (spaces or tabs). The assembler recognizes both uppercase and lowercase for directives.

### 2.9.1. Assembler Directives

#### Overview of assembly control directives

<table>
<thead>
<tr>
<th>Directive</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.COMMENT</td>
<td>Start comment lines. You cannot use this directive in .IF/.ELSE/.ENDIF constructs and .MACRO/.DUP definitions.</td>
</tr>
<tr>
<td>.END</td>
<td>Indicates the end of an assembly module</td>
</tr>
<tr>
<td>.FAIL</td>
<td>Programmer generated error message</td>
</tr>
<tr>
<td>.INCLUDE</td>
<td>Include file</td>
</tr>
<tr>
<td>.MESSAGE</td>
<td>Programmer generated message</td>
</tr>
<tr>
<td>.WARNING</td>
<td>Programmer generated warning message</td>
</tr>
</tbody>
</table>

#### Overview of symbol definition and section directives

<table>
<thead>
<tr>
<th>Directive</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.ALIAS</td>
<td>Create an alias for a symbol</td>
</tr>
<tr>
<td>.EQU</td>
<td>Set permanent value to a symbol</td>
</tr>
<tr>
<td>.EXTERN</td>
<td>Import global section symbol</td>
</tr>
<tr>
<td>.GLOBAL</td>
<td>Declare global section symbol</td>
</tr>
<tr>
<td>.LOCAL</td>
<td>Declare local section symbol</td>
</tr>
<tr>
<td>.ORG</td>
<td>Initialize memory space and location counters to create a nameless section</td>
</tr>
<tr>
<td>.SDECL</td>
<td>Declare a section with name, type and attributes</td>
</tr>
<tr>
<td>.SECT</td>
<td>Activate a declared section</td>
</tr>
</tbody>
</table>
### Directive Description

<table>
<thead>
<tr>
<th>Directive</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.SET</td>
<td>Set temporary value to a symbol</td>
</tr>
<tr>
<td>.SIZE</td>
<td>Set size of symbol in the ELF symbol table</td>
</tr>
<tr>
<td>.TYPE</td>
<td>Set symbol type in the ELF symbol table</td>
</tr>
<tr>
<td>.WEAK</td>
<td>Mark a symbol as 'weak'</td>
</tr>
</tbody>
</table>

#### Overview of data definition / storage allocation directives

<table>
<thead>
<tr>
<th>Directive</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.ACCUM</td>
<td>Define 64-bit constant of 18 + 46 bits format</td>
</tr>
<tr>
<td>.ALIGN</td>
<td>Align location counter</td>
</tr>
<tr>
<td>.ASCII, .ASCIIZ</td>
<td>Define ASCII string without / with ending NULL byte</td>
</tr>
<tr>
<td>.BYTE</td>
<td>Define byte</td>
</tr>
<tr>
<td>.DOUBLE</td>
<td>Define a 64-bit floating-point constant</td>
</tr>
<tr>
<td>.FLOAT</td>
<td>Define a 32-bit floating-point constant</td>
</tr>
<tr>
<td>.FRACT</td>
<td>Define a 32-bit constant fraction</td>
</tr>
<tr>
<td>.HALF</td>
<td>Define half-word (16 bits)</td>
</tr>
<tr>
<td>.SFRACT</td>
<td>Define a 16-bit constant fraction</td>
</tr>
<tr>
<td>.SPACE</td>
<td>Define storage</td>
</tr>
<tr>
<td>.WORD</td>
<td>Define word (32 bits)</td>
</tr>
</tbody>
</table>

#### Overview of macro preprocessor directives

<table>
<thead>
<tr>
<th>Directive</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.DEFINE</td>
<td>Define substitution string</td>
</tr>
<tr>
<td>.DUP, .ENDM</td>
<td>Duplicate sequence of source lines</td>
</tr>
<tr>
<td>.DUPA, .ENDM</td>
<td>Duplicate sequence with arguments</td>
</tr>
<tr>
<td>.DUPC, .ENDM</td>
<td>Duplicate sequence with characters</td>
</tr>
<tr>
<td>.DUPF, .ENDM</td>
<td>Duplicate sequence in loop</td>
</tr>
<tr>
<td>.IF, .ELIF, .ELSE</td>
<td>Conditional assembly directive</td>
</tr>
<tr>
<td>.ENDIF</td>
<td>End of conditional assembly directive</td>
</tr>
<tr>
<td>.EXITM</td>
<td>Exit macro</td>
</tr>
<tr>
<td>.MACRO, .ENDM</td>
<td>Define macro</td>
</tr>
<tr>
<td>.PMACRO</td>
<td>Undefined (purge) macro</td>
</tr>
<tr>
<td>.UNDEF</td>
<td>Undefine .DEFINE symbol</td>
</tr>
</tbody>
</table>
## Overview of HLL directives

<table>
<thead>
<tr>
<th>Directive</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.CALLS</td>
<td>Pass call tree information and/or stack usage information</td>
</tr>
<tr>
<td>.COMPILER_INVOCATION</td>
<td>Pass C compiler invocation</td>
</tr>
<tr>
<td>.COMPILER_NAME</td>
<td>Pass C compiler name</td>
</tr>
<tr>
<td>.COMPILER_VERSION</td>
<td>Pass C compiler version header</td>
</tr>
<tr>
<td>.MISRAC</td>
<td>Pass MISRA C information</td>
</tr>
</tbody>
</table>
.ACCUM

Syntax

[label:].ACCUM expression[,expression]...

Description

With the .ACCUM directive the assembler allocates and initializes two words of memory (64 bits) for each argument. Use commas to separate multiple arguments.

An expression can be:

• a fractional fixed point expression (range \([-2^{17}, 2^{17}\])
• NULL (indicated by two adjacent commas: ,)

Multiple arguments are stored in successive address locations in sets of two words. If an argument is NULL its corresponding address location is filled with zeros.

If the evaluated expression is out of the range \([-2^{17}, 2^{17}\]}, the assembler issues a warning and saturates the fractional value.

Example

ACC:  .ACCUM  0.1,0.2,0.3

Related Information

.FRACT, .SFRACT (Define 32-bit/16-bit constant fraction)
.SPACE (Define Storage)
.ALIAS

Syntax

alias-name .ALIAS symbol-name

Description

With the .ALIAS directive you can create an alias of a symbol. The C compiler generates this directive when you use the #pragma alias.

Example

_PCPl_new .ALIAS _PCPl_existing

Related information

Pragma alias
**.ALIGN**

**Syntax**

```
.ALIGN expression
```

**Description**

With the `.ALIGN` directive you instruct the assembler to align the location counter. By default the assembler aligns on one byte.

When the assembler encounters the `.ALIGN` directive, it advances the location counter to an address that is aligned as specified by `expression` and places the next instruction or directive on that address. The alignment is in minimal addressable units (MAUs). The assembler fills the 'gap' with NOP instructions for code sections or with zeros for data sections. If the location counter is already aligned on the specified alignment, it remains unchanged. The location of absolute sections will not be changed.

The `expression` must be a power of two: 2, 4, 8, 16, ... If you specify another value, the assembler changes the alignment to the next higher power of two and issues a warning.

The assembler aligns sections automatically to the largest alignment value occurring in that section.

A label is not allowed before this directive.

**Example**

```
.sdecl .pcptext.code',code
.sect '.pcptext.code'
.ALIGN 16    ; the assembler aligns
instruction  ; this instruction at 16 MAUs and
            ; fills the 'gap' with NOP instructions.

.sdecl .pcptext.code',code
.sect '.pcptext.code'
.ALIGN 12    ; WRONG: not a power of two, the
instruction  ; assembler aligns this instruction at
            ; 16 MAUs and issues a warning.
```
.ASCII, .ASCIIZ

Syntax

[label:] .ASCII  string[,string]...

[label:] .ASCIIZ string[,string]...

Description

With the .ASCII or .ASCIIZ directive the assembler allocates and initializes memory for each string argument.

The .ASCII directive does not add a NULL byte to the end of the string. The .ASCIIZ directive does add a NULL byte to the end of the string. The "z" in .ASCIIZ stands for "zero". Use commas to separate multiple strings.

Example

STRING:  .ASCII  "Hello world"
STRINGZ: .ASCIIZ "Hello world"

Note that with the .BYTE directive you can obtain exactly the same effect:

STRING:  .BYTE  "Hello world"    ; without a NULL byte
STRINGZ: .BYTE  "Hello world",0  ; with a NULL byte

Related Information

.CODE (Define a constant byte)

.SPACE (Define Storage)
.BYTE

Syntax

[label:] .BYTE argument[,argument]...

Description

With the .BYTE directive the assembler allocates and initializes a byte of memory for each argument.

An argument can be:

• a single or multiple character string constant

• an integer expression

• NULL (indicated by two adjacent commas: ,,)

Multiple arguments are stored in successive byte locations. If an argument is NULL its corresponding byte location is filled with zeros.

If you specify label, it gets the value of the location counter at the start of the directive processing.

Integer arguments are stored as is, but must be byte values (within the range 0-255); floating-point numbers are not allowed. If the evaluated expression is out of the range [-256, +255] the assembler issues an error. For negative values within that range, the assembler adds 256 to the specified value (for example, -254 is stored as 2).

String constants

Single-character strings are stored in a byte whose lower seven bits represent the ASCII value of the character, for example:

```
.BYTE 'R'        ; = 0x52
```

Multiple-character strings are stored in consecutive byte addresses, as shown below. The standard C language escape characters like ‘\n’ are permitted.

```
.BYTE 'AB',,'C'  ; = 0x41420043 (second argument is empty)
```

Example

```
TABLE  .BYTE  'two',0,'strings',0
CHARS  .BYTE  'A','B','C','D'
```

Related Information

.ASCII, .ASCIIZ (Define ASCII string without/with ending NULL)

.WORD, .HALF (Define a word / halfword)

.SPACE (Define Storage)
.CALLS

Syntax

.CALLS 'caller','callee'

or

.CALLS 'caller','','stack_usage'

Description

The first syntax creates a call graph reference between caller and callee. The linker needs this information to build a call graph. caller and callee are names of functions.

The second syntax specifies stack information. When callee is an empty name, this means we define the stack usage of the function itself. The value specified is the stack usage in bytes at the time of the call including the return address.

This information is used by the linker to compute the used stack within the application. The information is found in the generated linker map file within the Memory Usage.

This directive is generated by the C compiler. Normally you will not use it in hand-coded assembly.

A label is not allowed before this directive.

Example

.CALLS 'main','nfunc'

Indicates that the function main calls the function nfunc.

.CALLS 'main','','8'

The function main uses 8 bytes on the stack.
.COMMENT

Syntax

```
.COMMENT   delimiter
.
   delimiter
```

Description

With the .COMMENT directive you can define one or more lines as comments. The first non-blank character after the .COMMENT directive is the comment delimiter. The two delimiters are used to define the comment text. The line containing the second comment delimiter will be considered the last line of the comment. The comment text can include any printable characters and the comment text will be produced in the source listing as it appears in the source file.

A label is not allowed before this directive.

Example

```
.COMMENT   + This is a one line comment +
.COMMENT   * This is a multiple line comment. Any number of lines can be placed between the two delimiters.
   *
```
.COMPILER_INVOCATION, .COMPILER_NAME, .COMPILER_VERSION

Syntax

```
.COMPILER_VERSION "version_header"
.COMPILER_INVOCATION "invocation"
.COMPILER_NAME "name"
```

Description

The C compiler generates information about itself and the invocation at the start of the assembly source. This way you can always see how the assembly source file was generated. When you assemble the source file, this information will appear in .note sections in the object file.

A label is not allowed before these directives.

Example

```
.COMPILER_VERSION "TASKING VX-toolset for PCP: C compiler vx.yrz Build yymmddqq"
.COMPILER_INVOCATION "cpcp test.c"
.COMPILER_NAME "cpcp"
```
.DEFINE

Syntax

.DEFINTE symbol string

Description

With the .DEFINE directive you define a substitution string that you can use on all following source lines. The assembler searches all succeeding lines for an occurrence of symbol, and replaces it with string. If the symbol occurs in a double quoted string it is also replaced. Strings between single quotes are not expanded.

This directive is useful for providing better documentation in the source program. A symbol can consist of letters, digits and underscore characters (_), and the first character cannot be a digit.

Macros represent a special case. .DEFINE directive translations will be applied to the macro definition as it is encountered. When the macro is expanded, any active .DEFINE directive translations will again be applied.

The assembler issues a warning if you redefine an existing symbol.

A label is not allowed before this directive.

Example

Suppose you defined the symbol LEN with the substitution string "32":

.DEFINTE LEN "32"

Then you can use the symbol LEN for example as follows:

.SPACE LEN
.MESSAGHE "The length is: LEN"

The assembler preprocessor replaces LEN with "32" and assembles the following lines:

.SPACE 32
.MESSAGHE "The length is: 32"

Related Information

.UNDEF (Undefine a .DEFINE symbol)

.MACRO, .ENDM (Define a macro)
**.DUP, .ENDM**

**Syntax**

```
[label:] .DUP expression
    ....
    .ENDM
```

**Description**

With the `.DUP/.ENDM` directive you can duplicate a sequence of assembly source lines. With `expression` you specify the number of duplications. If the `expression` evaluates to a number less than or equal to 0, the sequence of lines will not be included in the assembler output. The `expression` result must be an absolute integer and cannot contain any forward references (symbols that have not already been defined). The `.DUP` directive may be nested to any level.

If you specify `label`, it gets the value of the location counter at the start of the directive processing.

**Example**

In this example the loop is repeated three times. Effectively, the preprocessor repeats the source lines `(.BYTE 10)` three times, then the assembler assembles the result:

```
    .DUP 3
    .BYTE 10  ; assembly source lines
    .ENDM
```

**Related Information**

- `.DUPA, .ENDM` (Duplicate sequence with arguments)
- `.DUPC, .ENDM` (Duplicate sequence with characters)
- `.DUPF, .ENDM` (Duplicate sequence in loop)
- `.MACRO, .ENDM` (Define a macro)
.DUPA, .ENDM

Syntax

[label:] .DUPA formal_arg,argument[,argument]...

....

.ENDM

Description

With the .DUPA/.ENDM directive you can repeat a block of source statements for each argument. For each repetition, every occurrence of the formal_arg parameter within the block is replaced with each succeeding argument string. If an argument includes an embedded blank or other assembler-significant character, it must be enclosed with single quotes.

If you specify label, it gets the value of the location counter at the start of the directive processing.

Example

Consider the following source input statements,

.DUPA VALUE,12,,32,34
.BYTE VALUE
.ENDM

This is expanded as follows:

.BYTE 12
.BYTE VALUE ; results in a warning
.BYTE 32
.BYTE 34

The second statement results in a warning of the assembler that the local symbol VALUE is not defined in this module and is made external.

Related Information

.DUP, .ENDM (Duplicate sequence of source lines)
.DUPC, .ENDM (Duplicate sequence with characters)
.DUPF, .ENDM (Duplicate sequence in loop)
.MACRO, .ENDM (Define a macro)
.DUPC, .ENDM

Syntax

[label:] .DUPC formal_arg,string
    ....
    .ENDM

Description

With the .DUPC/.ENDM directive you can repeat a block of source statements for each character within string. For each character in the string, the formal_arg parameter within the block is replaced with that character. If the string is empty, then the block is skipped.

If you specify label, it gets the value of the location counter at the start of the directive processing.

Example

Consider the following source input statements,

    .DUPC VALUE,'123'
    .BYTE VALUE
    .ENDM

This is expanded as follows:

    .BYTE 1
    .BYTE 2
    .BYTE 3

Related Information

.DUP, .ENDM (Duplicate sequence of source lines)
.DUPA, .ENDM (Duplicate sequence with arguments)
.DUPF, .ENDM (Duplicate sequence in loop)
.MACRO, .ENDM (Define a macro)
.DUPF, .ENDM

Syntax

[label:] .DUPF formal_arg,[start],end[,increment]

....

.ENDM

Description

With the .DUPF/.ENDM directive you can repeat a block of source statements \((end - start) + 1 / increment\) times. start is the starting value for the loop index; end represents the final value. increment is the increment for the loop index; it defaults to 1 if omitted (as does the start value). The formal_arg parameter holds the loop index value and may be used within the body of instructions.

If you specify label, it gets the value of the location counter at the start of the directive processing.

Example

Consider the following source input statements,

```assembly
.DUPF NUM,0,7
.BYTE NUM
.ENDM
```

This is expanded as follows:

```assembly
.BYTE 0
.BYTE 1
.BYTE 2
.BYTE 3
.BYTE 4
.BYTE 5
.BYTE 6
.BYTE 7
```
Related Information

.DUP, .ENDM (Duplicate sequence of source lines)

.DUPA, .ENDM (Duplicate sequence with arguments)

.DUPC, .ENDM (Duplicate sequence with characters)

.MACRO, .ENDM (Define a macro)
.END

Syntax

.END

Description

With the optional .END directive you tell the assembler that the end of the module is reached. If the assembler finds assembly source lines beyond the .END directive, it ignores those lines and issues a warning.

You cannot use the .END directive in a macro expansion.

The assembler does not allow a label with this directive.

Example

; source lines
.END ; End of assembly module

Related Information

-
.EQU

Syntax

\texttt{symbol .EQU expression}

Description

With the \texttt{.EQU} directive you assign the value of \textit{expression} to \textit{symbol} permanently. The expression can be relocatable or absolute and forward references are allowed. Once defined, you cannot redefine the symbol. With the \texttt{.GLOBAL} directive you can declare the symbol global.

Example

To assign the value 0x400 permanently to the symbol \texttt{MYSYMBOL}:

\texttt{MYSYMBOL .EQU \textasciitilde 0x4000}

You cannot redefine the symbol \texttt{MYSYMBOL} after this.

Related Information

\texttt{.SET} (Set temporary value to a symbol)
.EXITM

Syntax

.EXITM

Description

With the .EXITM directive the assembler will immediately terminate a macro expansion. It is useful when you use it with the conditional assembly directive .IF to terminate macro expansion when, for example, error conditions are detected.

A label is not allowed before this directive.

Example

CALC .MACRO XVAL,YVAL
   .IF XVAL<0
   .FAIL 'Macro parameter value out of range'
   .EXITM ;Exit macro
   .ENDIF
   .
   .
   .
   .ENDM

Related Information

.DUP, .ENDM (Duplicate sequence of source lines)
.DU PA, .ENDM (Duplicate sequence with arguments)
.DU PC, .ENDM (Duplicate sequence with characters)
.DUPF, .ENDM (Duplicate sequence in loop)
.MACRO, .EN DM (Define a macro)
.EXTERN

Syntax

.extern symbol[,symbol]...

Description

With the .EXTERN directive you define an external symbol. It means that the specified symbol is referenced in the current module, but is not defined within the current module. This symbol must either have been defined outside of any module or declared as globally accessible within another module with the .GLOBAL directive.

If you do not use the .EXTERN directive and the symbol is not defined within the current module, the assembler issues a warning and inserts the .EXTERN directive.

A label is not allowed with this directive.

Example

.extern AA,CC,DD ; defined elsewhere
.sdecl '.pcptext.code', code
.sect '.pcptext.code'

... 

ld.i r5,aa ; AA is used here

Related Information

全球化 (Declare global section symbol)

局部化 (Declare local section symbol)
.FAIL

Syntax

```
.FAIL \{str|exp\}[,{str|exp}]...
```

Description

With the .FAIL directive you tell the assembler to print an error message to stderr during the assembling process.

An arbitrary number of strings and expressions, in any order but separated by commas with no intervening white space, can be specified to describe the nature of the generated error. If you use expressions, the assembler outputs the result. The assembler outputs a space between each argument.

The total error count will be incremented as with any other error. The .FAIL directive is for example useful in combination with conditional assembly for exceptional condition checking. The assembly process proceeds normally after the error has been printed.

With this directive the assembler exits with exit code 1 (an error).

A label is not allowed with this directive.

Example

```
.FAIL 'Parameter out of range'
```

This results in the error:

E143: ["filename" line] Parameter out of range

Related Information

.MESSAGE (Programmer generated message)

.WARNING (Programmer generated warning)
.FLOAT, .DOUBLE

Syntax

[label:].FLOAT  expression[,expression]...
[label:].DOUBLE  expression[,expression]...

Description

With the .FLOAT or .DOUBLE directive the assembler allocates and initializes a floating-point number (32 bits) or a double (64 bits) in memory for each argument.

An expression can be:

• a floating-point expression
• NULL (indicated by two adjacent commas: ,)

You can represent a constant as a signed whole number with fraction or with the 'e' format as used in the C language. For example, 12.457 and +0.27E-13 are legal floating-point constants.

If the evaluated argument is too large to be represented in a single word / double-word, the assembler issues an error and truncates the value.

If you specify label, it gets the value of the location counter at the start of the directive processing.

Example

FLT:  .FLOAT  12.457,+0.27E-13
DBL:  .DOUBLE  12.457,+0.27E-13

Related Information

.SPAC (Define Storage)
.FRACT, .SFRACT

Syntax

[label:].FRACT expression[,expression]...

[label:].SFRACT expression[,expression]...

Description

With the .FRACT or .SFRACT directive the assembler allocates and initializes a 32-bit or 16-bit constant fraction in memory for each argument. Use commas to separate multiple arguments.

An expression can be:

• a fractional fixed point expression (range [-1, +1>)
• NULL (indicated by two adjacent commas: ,)

Multiple arguments are stored in successive address locations in sets of two bytes. If an argument is NULL its corresponding address location is filled with zeros.

If the evaluated expression is out of the range [-1, +1>, the assembler issues a warning and saturates the fractional value.

Example

FRCT: .FRACT 0.1,0.2,0.3
SFRCT: .SFRACT 0.1,0.2,0.3

Related Information

.ACUM (Define 64-bit constant fraction in 18+46 bits format)
.SPACE (Define Storage)
.GLOBAL

Syntax

.GLOBAL  symbol[,symbol]...

Description

All symbols or labels defined in the current section or module are local to the module by default. You can change this default behavior with assembler option --symbol-scope=global.

With the .GLOBAL directive you declare one of more symbols as global. It means that the specified symbols are defined within the current section or module, and that those definitions should be accessible by all modules.

To access a symbol, defined with .GLOBAL, from another module, use the .EXTERN directive.

Only program labels and symbols defined with .EQU can be made global.

If the symbols that appear in the operand field are not used in the module, the assembler gives a warning.

The assembler does not allow a label with this directive.

Example

.sdecl  '.pcpdata.data', data
.sect   '.pcpdata.data'
.GLOBAL  LOOPA  ; LOOPA will be globally
            ; accessible by other modules
LOOPA  .EQU 1          ; definition of symbol LOOPA

Related Information

.EXTERN  (Import global section symbol)

.LOCAL  (Declare local section symbol)
.IF, .ELIF, .ELSE, .ENDIF

Syntax

```
    .IF  expression
    
    [.ELSE] ; the .ELSE directive is optional
    
    .ENDIF
```

Description

With the .IF/.ENDIF directives you can create a part of conditional assembly code. The assembler assembles only the code that matches a specified condition.

The expression must evaluate to an absolute integer and cannot contain forward references. If expression evaluates to zero, the IF-condition is considered FALSE, any non-zero result of expression is considered as TRUE.

If the optional .ELSE and/or .ELIF directives are not present, then the source statements following the .IF directive and up to the next .ENDIF directive will be included as part of the source file being assembled only if the expression had a non-zero result.

If the expression has a value of zero, the source file will be assembled as if those statements between the .IF and the .ENDIF directives were never encountered.

If the .ELSE directive is present and expression has a nonzero result, then the statements between the .IF and .ELSE directives will be assembled, and the statement between the .ELSE and .ENDIF directives will be skipped. Alternatively, if expression has a value of zero, then the statements between the .IF and .ELSE directives will be skipped, and the statements between the .ELSE and .ENDIF directives will be assembled.

You can nest .IF directives to any level. The .ELSE and .ELIF directive always refer to the nearest previous .IF directive.

A label is not allowed with this directive.

Example

Suppose you have an assemble source file with specific code for a test version, for a demo version and for the final version. Within the assembly source you define this code conditionally as follows:

```
    .IF   TEST
    ... ; code for the test version
    .ELIF DEMO
    ... ; code for the demo version
    .ELSE
```
... ; code for the final version
.ENDIF

Before assembling the file you can set the values of the symbols TEST and DEMO in the assembly source before the .IF directive is reached. For example, to assemble the demo version:

TEST .SET 0
DEMO .SET 1

You can also define the symbols on the command line with the assembler option --define (-D):

aspcp --define=DEMO --define=TEST=0 test.asm
.INCLUDE

Syntax

.INCLUDE "filename" | <filename>

Description

With the .INCLUDE directive you include another file at the exact location where the .INCLUDE occurs. This happens before the resulting file is assembled. The .INCLUDE directive works similarly to the #include statement in C. The source from the include file is assembled as if it followed the point of the .INCLUDE directive. When the end of the included file is reached, assembly of the original file continues.

The string specifies the filename of the file to be included. The filename must be compatible with the operating system (forward/backward slashes) and can contain a directory specification.

If an absolute pathname is specified, the assembler searches for that file. If a relative path is specified or just a filename, the order in which the assembler searches for include files is:

1. The current directory if you use the "filename" construction.

   The current directory is not searched if you use the <filename> syntax.

2. The path that is specified with the assembler option --include-directory.

3. The path that is specified in the environment variable ASPCPINC when the product was installed.

4. The default include directory in the installation directory.

The assembler does not allow a label with this directive.

Example

.INCLUDE 'storage\mem.asm'    ; include file
.INCLUDE <data.asm>           ; Do not look in
                           ; current directory
.LOCAL

Syntax

```plaintext
.LOCAL  symbol[,symbol]...
```

Description

All symbols or labels defined in the current section or module are local to the module by default. You can change this default behavior with assembler option --symbol-scope=global.

With the .LOCAL directive you declare one of more symbols as local. It means that the specified symbols are explicitly local to the module in which you define them.

If the symbols that appear in the operand field are not used in the module, the assembler gives a warning.

The assembler does not allow a label with this directive.

Example

```plaintext
.SDECL  '.pcpdata.data',DATA
.SECT   '.pcpdata.data'
.LOCAL  LOOPA   ; LOOPA is local to this section

LOOPA  .HALF   0x100   ; assigns the value 0x100 to LOOPA
```

Related Information

.EXTERN  (Import global section symbol)

.GLOBAL  (Declare global section symbol)
**.MACRO, .ENDM**

**Syntax**

```plaintext
macro_name .MACRO [argument[,argument]...]
    ...
    macro_definition_statements
    ...
    .ENDM
```

**Description**

With the `.MACRO` directive you define a macro. Macros provide a shorthand method for handling a repeated pattern of code or group of instructions. You can define the pattern as a macro, and then call the macro at the points in the program where the pattern would repeat.

The definition of a macro consists of three parts:

- **Header**, which assigns a name to the macro and defines the arguments (.MACRO directive).
- **Body**, which contains the code or instructions to be inserted when the macro is called.
- **Terminator**, which indicates the end of the macro definition (.ENDM directive).

The arguments are symbolic names that the macro processor replaces with the literal arguments when the macro is expanded (called). Each formal `argument` must follow the same rules as symbol names: the name can consist of letters, digits and underscore characters (_). The first character cannot be a digit. Argument names cannot start with a percent sign (%).

Macro definitions can be nested but the nested macro will not be defined until the primary macro is expanded.

You can use the following operators in macro definition statements:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\</td>
<td>Macro argument concatenation</td>
<td>Concatenates a macro argument with adjacent alphanumeric characters.</td>
</tr>
<tr>
<td>?</td>
<td>Return decimal value of symbol</td>
<td>Substitutes the <code>?symbol</code> sequence with a character string that represents the decimal value of the symbol.</td>
</tr>
<tr>
<td>%</td>
<td>Return hex value of symbol</td>
<td>Substitutes the <code>%symbol</code> sequence with a character string that represents the hexadecimal value of the symbol.</td>
</tr>
<tr>
<td>&quot;</td>
<td>Macro string delimiter</td>
<td>Allows the use of macro arguments as literal strings.</td>
</tr>
<tr>
<td>^</td>
<td>Macro local label override</td>
<td>Prevents name mangling on labels in macros.</td>
</tr>
</tbody>
</table>

**Example**

The macro definition:

```plaintext
CONST.D .MACRO reg,value ;header
    ldl.iu reg,@HI(value) ;body
```
The macro call:

```
.SDECL   '.pcptext.code',code
.SECT    '.pcptext.code'
CONST.D  r5,0x12345678
```

The macro expands as follows:

```
ldl.iu   r5,@HI(0x12345678)
ldl.il   r5,@LO(0x12345678)
```

Related Information

Section 2.10, Macro Operations

- **.DUP, .ENDM** (Duplicate sequence of source lines)
- **.DUPA, .ENDM** (Duplicate sequence with arguments)
- **.DUPC, .ENDM** (Duplicate sequence with characters)
- **.DUPF, .ENDM** (Duplicate sequence in loop)
- **.PMACRO** (Undefine macro)
- **.DEFINE** (Define a substitution string)
.MESSAGE

Syntax

EMALESSAGE \{str\exp\}[,{str\exp}]...

Description

With the .MESSAGE directive you tell the assembler to print a message to stderr during the assembling process.

An arbitrary number of strings and expressions, in any order but separated by commas with no intervening white space, can be specified to describe the nature of the generated message. If you use expressions, the assembler outputs the result. The assembler outputs a space between each argument.

The error and warning counts will not be affected. The .MESSAGE directive is for example useful in combination with conditional assembly to indicate which part is assembled. The assembling process proceeds normally after the message has been printed.

This directive has no effect on the exit code of the assembler.

A label is not allowed with this directive.

Example

.DEFINELONG "SHORT"
.MESSAGE 'This is a LONG string'
.MESSAGE "This is a LONG string"

Within single quotes, the defined symbol LONG is not expanded. Within double quotes the symbol LONG is expanded so the actual message is printed as:

This is a LONG string
This is a SHORT string

Related Information

.FAIL (Programmer generated error)

.WARNING (Programmer generated warning)
.MISRAC

Syntax

.MISRAC string

Description

The C compiler can generate the .MISRAC directive to pass the compiler's MISRA C settings to the object file. The linker performs checks on these settings and can generate a report. It is not recommended to use this directive in hand-coded assembly.

Example

.MISRAC 'MISRA-C:2004,64,e2,0b,e,e11,27,6,ef83,e1,ef,66,c7b5,af1,eff,e7,e7f,8d,63,87ff7,6ff3,4'

Related Information

Section 3.7.2, C Code Checking: MISRA C

C compiler option --misrac
.ORG

Syntax

```
.ORG [abs-loc][,sect_type][,attribute]...
```

Description

With the .ORG directive you can specify an absolute location (abs_loc) in memory of a section. This is the same as a .SDECL/.SECT without a section name.

This directive uses the following arguments:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>abs-loc</td>
<td>Initial value to assign to the run-time location counter. abs-loc must be an absolute expression. If abs_loc is not specified, then the value is zero.</td>
</tr>
<tr>
<td>sect_type</td>
<td>An optional section type: code or data</td>
</tr>
<tr>
<td>attribute</td>
<td>An optional section attribute: init, noread, noclear, max, rom, group(string), cluster(string), protect</td>
</tr>
</tbody>
</table>

For more information about the section types and attributes see the assembler directive .SDECL.

The section type and attributes are case insensitive. A label is not allowed with this directive.

Example

```
; define a section at location 100 decimal
.org 100

; define a relocatable nameless section
.org

; define a relocatable data section
.org ,data

; define a data section at 0x8000
.org 0x8000,data
```

Related Information

. SDECL (Declare section name and attributes)

. SECT (Activate a declared section)
.PMACRO

Syntax

\texttt{.PMACRO \ symbol[,symbol]...}

Description

With the \texttt{.PMACRO} directive you tell the assembler to undefine the specified macro, so that later uses of the symbol will not be expanded.

The assembler does not allow a label with this directive.

Example

\texttt{.PMACRO MAC1,MAC2}

This statement causes the macros named \texttt{MAC1} and \texttt{MAC2} to be undefined.

Related Information

\texttt{.MACRO, .ENDM (Define a macro)}
.SDECL

Syntax

.SDECL 'name',type[,attribute]... [AT address]

Description

With the .SDECL directive you can define a section with a *name*, *type* and optional *attributes*. Before any code or data can be placed in a section, you must use the .SECT directive to activate the section.

The *name* specifies the name of the section. The *type* operand specifies the section's type and must be one of:

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CODE</td>
<td>Code section.</td>
</tr>
<tr>
<td>DATA</td>
<td>Data section.</td>
</tr>
<tr>
<td>DEBUG</td>
<td>Debug section.</td>
</tr>
</tbody>
</table>

The section type and attributes are case insensitive.

The defined *attributes* are:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
<th>Allowed on type</th>
</tr>
</thead>
<tbody>
<tr>
<td>AT address</td>
<td>Locate the section at the given <em>address</em>.</td>
<td>CODE, DATA</td>
</tr>
<tr>
<td>CLEAR</td>
<td>Sections are zeroed at startup.</td>
<td>DATA</td>
</tr>
<tr>
<td>CLUSTER(‘name’)</td>
<td>Cluster code sections with companion debug sections. Used by the linker during removal of unreferenced sections. The name must be unique for this module (not for the application). To prevent naming conflicts with other symbols, the prefix &quot;.cluster.&quot; is added to the cluster name during object file generation.</td>
<td>CODE, DATA, DEBUG</td>
</tr>
<tr>
<td>CONCAT</td>
<td>Concatenate sections. Used by the linker to merge sections with the same name.</td>
<td>CODE, DATA</td>
</tr>
<tr>
<td>GROUP(‘group’)</td>
<td>Used to group sections. The assembler appends @group to the section name.</td>
<td>DATA</td>
</tr>
<tr>
<td>INIT</td>
<td>Defines that the section contains initialization data, which is copied from ROM to RAM at program startup.</td>
<td>CODE, DATA</td>
</tr>
<tr>
<td>LINEAR</td>
<td>Section in the FPI space (TriCore linear address space).</td>
<td>DATA</td>
</tr>
<tr>
<td>MAX</td>
<td>When data sections with the same name occur in different object modules with the MAX attribute, the linker generates a section of which the size is the maximum of the sizes in the individual object modules.</td>
<td>DATA</td>
</tr>
<tr>
<td>NOCLEAR</td>
<td>Sections are not zeroed at startup. This is a default attribute for data sections. This attribute is only useful with BSS sections, which are cleared at startup by default.</td>
<td>DATA</td>
</tr>
</tbody>
</table>
Section names

The name of a section can have a special meaning for locating sections. The name of code sections should always start with ".pcptext". The name of data sections in PRAM should always start with ".pcpdata". With data sections in FPI space (data, linear), the prefix in the name is important. The prefix determines if the section is initialized, constant or uninitialized and which addressing mode is used. See the following table.

<table>
<thead>
<tr>
<th>Section name for linear data</th>
<th>Type of section</th>
</tr>
</thead>
<tbody>
<tr>
<td>.data.linear</td>
<td>initialized __far data</td>
</tr>
<tr>
<td>.rodata.linear</td>
<td>constant __far data</td>
</tr>
<tr>
<td>.bss.linear</td>
<td>uninitialized __far data</td>
</tr>
</tbody>
</table>

Note that the compiler uses the following name convention by default:

```
prefix.space
```

where space can be code, data or linear: In the C language you can overrule the default section name with #pragma section.

Static stack overlay

For static stack overlay sections the compiler uses a different section naming convention. The name in the .SDECL directive equals the function name. The OVERLAY attribute results in an extended section name. The name resulting from the .SDECL directive is as follows:

```
section_type_prefix.overlay_name@function_name
```

For example:

```
.sdecl '_PCP_main', data, overlay('_PCP_stack_data')
```

results in a section named: .pcpdata._PCP_stack_data@_PCP_main.

Group names

The GROUP attribute results in an extended section name. The name resulting from the .SDECL directive is as follows:
section-name[@group]

For example:

 .sdecl '.pcpdata.data', data, group('groupname')

results in a section named: .pcpdata.data@groupname.

The linker uses this information to locate sections with the same group name in one page.

Example

 .sdecl '.pcptext.code', code ; declare code section
 .sect '.pcptext.code' ; activate section
 .sdecl '.pcpdata.data', data ; declare data section
 .sect '.pcpdata.data' ; activate section
 .sdecl '_PCP_main', data, overlay('_PCP_stack_data') ; declare overlay section
 .sect '_PCP_main' ; activate section
 .sdecl '.pcpdata.abssec', data at 0x100 ; absolute section
 .sect '.pcpdata.abssec' ; activate section

Related Information

 .SECT (Activate a declared section)
 .ORG (Initialize a nameless section)
.SECT

Syntax

.DECL 'name' [,RESET]

Description

With the .SECT directive you activate a previously declared section with the name name. Before you can activate a section, you must define the section with the .SDECL directive. You can activate a section as many times as you need.

With the attribute RESET you can reset counting storage allocation in data sections that have section attribute MAX.

Example

.DECL '.pcpdata.data', data ; declare data section
.DECL '.pcpdata.data' ; activate section

Related Information

.DECL (Declare section name and attributes)

.ORG (Initialize a nameless section)
.SET

Syntax

symbol .SET expression

.SET symbol expression

Description

With the .SET directive you assign the value of expression to symbol temporarily. If a symbol was defined with the .SET directive, you can redefine that symbol in another part of the assembly source, using the .SET directive again. Symbols that you define with the .SET directive are always local: you cannot define the symbol global with the .GLOBAL directive.

The .SET directive is useful in establishing temporary or reusable counters within macros. expression must be absolute and forward references are allowed.

Example

COUNT .SET 0 ; Initialize count. Later on you can ; assign other values to the symbol

Related Information

.EQU (Set permanent value to a symbol)
.SIZE

Syntax

```
.SIZE symbol,expression
```

Description

With the .SIZE directive you set the size of the specified symbol to the value represented by expression.

The .SIZE directive may occur anywhere in the source file unless the specified symbol is a function. In this case, the .SIZE directive must occur after the function has been defined.

Example

```
_PCPS_str: .type object ; object _PCPS_str
  .size _PCPS_str,4 ; size of object
  .word 80
  .word 67
  .word 80
  .word 0
```

Related Information

.TYPE (Set symbol type)
.SPACE

Syntax

[label:] .SPACE expression

Description

The .SPACE directive reserves a block in memory. The reserved block of memory is not initialized to any value.

If you specify the optional label, it gets the value of the location counter at the start of the directive processing.

The expression specifies the number of MAUs (Minimal Addressable Units) to be reserved, and how much the location counter will advance. The expression must evaluate to an integer greater than zero and cannot contain any forward references (symbols that have not yet been defined). For the TriCore the MAU size is 8 (1 byte).

If you specify label, it gets the value of the location counter at the start of the directive processing.

Example

To reserve 12 bytes (not initialized) of memory in a PRAM data section:

```
.sdecl '.pcpdata.data', data
.sect '.pcpdata.data'
uninit .SPACE 12 ; Sample buffer
```

Related Information

.BYTE (Define a constant byte)
.TYPE

Syntax

symbol .TYPE typeid

Description

With the .TYPE directive you set a symbol's type to the specified value in the ELF symbol table. Valid symbol types are:

- FUNC: The symbol is associated with a function or other executable code.
- OBJECT: The symbol is associated with an object such as a variable, an array, or a structure.
- FILE: The symbol name represents the filename of the compilation unit.

Labels in code sections have the default type FUNC. Labels in data sections have the default type OBJECT.

Example

_PCPC_Afunc: .type func

Related Information

.SIZE (Set symbol size)
.UNDEF

Syntax

.UNDEF symbol

Description

With the .UNDEF directive you can undefine a substitution string that was previously defined with the .DEFINE directive. The substitution string associated with symbol is released, and symbol will no longer represent a valid .DEFINE substitution or macro.

The assembler issues a warning if you undefine a non-existing symbol.

The assembler does not allow a label with this directive.

Example

The following example undefines the LEN substitution string that was previously defined with the .DEFINE directive:

.UNDEF LEN

Related Information

.DEFINE (Define a substitution string)
.WARNING

Syntax

```
.WARNINg {str|exp}[, {str|exp}]...
```

Description

With the .WARNING directive you tell the assembler to print a warning message to stderr during the assembling process.

An arbitrary number of strings and expressions, in any order but separated by commas with no intervening white space, can be specified to describe the nature of the generated warning. If you use expressions, the assembler outputs the result. The assembler outputs a space between each argument.

The total warning count will be incremented as with any other warning. The .WARNING directive is for example useful in combination with conditional assembly to indicate which part is assembled. The assembling process proceeds normally after the message has been printed.

This directive has no effect on the exit code of the assembler, unless you use the assembler option --warnings-as-agers. In that case the assembler exits with exit code 1 (an error).

A label is not allowed with this directive.

Example

```
.WARNINg 'Parameter out of range'
```

This results in the warning:

W144: ["filename" line] Parameter out of range

Related Information

.FAIL (Programmer generated error)

.MESSAGE (Programmer generated message)
.WEAK

Syntax

    .WEAK symbol[,symbol]...

Description

With the .WEAK directive you mark one or more symbols as 'weak'. The symbol can be defined in the same module with the .GLOBAL directive or the .EXTERN directive. If the symbol does not already exist, it will be created.

A 'weak' external reference is resolved by the linker when a global (or weak) definition is found in one of the object files. However, a weak reference will not cause the extraction of a module from a library to resolve the reference.

You can overrule a weak definition with a .GLOBAL definition in another module. The linker will not complain about the duplicate definition, and ignore the weak definition.

Only program labels and symbols defined with .EQU can be made weak.

Example

    LOOPA .EQU 1 ; definition of symbol LOOPA
        .GLOBAL LOOPA ; LOOPA will be globally accessible by other modules
        .WEAK LOOPA ; mark symbol LOOPA as weak

Related Information

    .EXTERN (Import global section symbol)
    .GLOBAL (Declare global section symbol)
**.WORD, .HALF**

**Syntax**

```
[label:] .WORD  argument[,argument]...
[label:] .HALF argument[,argument]...
```

**Description**

With the `.WORD` or `.HALF` directive the assembler allocates and initializes one word (32 bits) or a halfword (16 bits) of memory for each argument.

If you specify the optional `label`, it gets the value of the location counter at the start of the directive processing.

An argument can be a single- or multiple-character string constant, an expression or empty.

Multiple arguments are stored in sets of four or two bytes. One or more arguments can be null (indicated by two adjacent commas), in which case the corresponding byte location will be filled with zeros.

The value of the arguments must be in range with the size of the directive; floating-point numbers are not allowed. If the evaluated argument is too large to be represented in a word / halfword, the assembler issues a warning and truncates the value.

**String constants**

Single-character strings are stored in the least significant byte of a word / halfword, where the lower seven bits in that byte represent the ASCII value of the character, for example:

```
.WORD 'R'        ; = 0x00000052
.HALF 'R'        ; = 0x0052
```

Multiple-character strings are stored in consecutive word addresses, as shown below. The standard C language escape characters like `\n` are permitted.

```
.WORD  'ABCD'         ; = 0x00000041
        0x00000042
        0x00000043
        0x00000044
```

**Related Information**

- `.BYTE` (Define a constant byte)
- `.SPACE` (Define Storage)
2.9.2. Assembler Controls

Controls start with a $ as the first character on the line. Unknown controls are ignored after a warning is issued.

Overview of assembler listing controls

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$LIST ON/OFF</td>
<td>Print / do not print source lines to list file</td>
</tr>
<tr>
<td>$PAGE</td>
<td>Generate form feed in list file</td>
</tr>
<tr>
<td>$PAGE settings</td>
<td>Define page layout for assembly list file</td>
</tr>
<tr>
<td>$PRCTL</td>
<td>Send control string to printer</td>
</tr>
<tr>
<td>$STITLE</td>
<td>Set program subtitle in header of assembly list file</td>
</tr>
<tr>
<td>$TITLE</td>
<td>Set program title in header of assembly list file</td>
</tr>
</tbody>
</table>

Overview of miscellaneous assembler controls

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$CASE ON/OFF</td>
<td>Case sensitive user names ON/OFF</td>
</tr>
<tr>
<td>$DEBUG ON/OFF</td>
<td>Generation of symbolic debug ON/OFF</td>
</tr>
<tr>
<td>$DEBUG &quot;flags&quot;</td>
<td>Select debug information</td>
</tr>
<tr>
<td>$HW_ONLY</td>
<td>Prevent substitution of assembly instructions by smaller or faster instructions</td>
</tr>
<tr>
<td>$IDENT LOCAL/GLOBAL</td>
<td>Assembler treats labels by default as local or global</td>
</tr>
<tr>
<td>$OBJECT</td>
<td>Alternative name for the generated object file</td>
</tr>
<tr>
<td>$WARNING OFF [num]</td>
<td>Suppress all or some warnings</td>
</tr>
</tbody>
</table>

Assembly Language
$CASE

Syntax

$CASE ON
$CASE OFF

Default

$CASE ON

Description

With the $CASE ON and $CASE OFF controls you specify whether the assembler operates in case sensitive mode or not. By default the assembler operates in case sensitive mode. This means that all user-defined symbols and labels are treated case sensitive, so LAB and Lab are distinct.

Note that the instruction mnemonics, register names, directives and controls are always treated case insensitive.

Example

; begin of source
$CASE OFF ; assembler in case insensitive mode

Related Information

Assembler option --case-insensitive
$DEBUG

Syntax

$DEBUG ON
$DEBUG OFF
$DEBUG "flags"

Default

$DEBUG "AhLS"

Description

With the $DEBUG ON and $DEBUG OFF controls you turn the generation of debug information on or off. ($DEBUG ON is similar to the assembler option --debug-info=+local (-gl).

If you use the $DEBUG control with flags, you can set the following flags:

- a/A: Assembly source line information
- h/H: Pass high level language debug information (HLL)
- l/L: Assembler local symbols debug information
- s/S: Smart debug information

You cannot specify $DEBUG "ah". Either the assembler generates assembly source line information, or it passes HLL debug information.

Debug information that is generated by the C compiler, is always passed to the object file.

Example

; begin of source
$DEBUG ON ; generate local symbols debug information

Related Information

Assembler option --debug-info
$HW\_ONLY

Syntax

$HW\_ONLY

Description

Normally the assembler replaces instructions by other, smaller or faster instructions.

With the $HW\_ONLY$ control you instruct the assembler to encode all instruction as they are. The assembler does not substitute instructions with other, faster or smaller instructions.

Example

; begin of source
$HW\_ONLY
 ; the assembler does not substitute
 ; instructions with other, smaller or
 ; faster instructions.

Related Information

-
$IDENT

Syntax

$IDENT LOCAL
$IDENT GLOBAL

Default

$IDENT LOCAL

Description

With the controls $IDENT LOCAL and $IDENT GLOBAL you tell the assembler how to treat symbols that you have not specified explicitly as local or global with the assembler directives .LOCAL or .GLOBAL.

By default the assembler treats all symbols as local symbols unless you have defined them to be global explicitly.

Example

;begin of source
$IDENT GLOBAL ; assembly labels are global by default

Related Information

Assembler directive .GLOBAL
Assembler directive .LOCAL
Assembler option --symbol-scope
$LIST ON/OFF

**Syntax**

$LIST ON
$LIST OFF

**Default**

$LIST ON

**Description**

If you generate a list file with the assembler option `--list-file`, you can use the $LIST ON and $LIST OFF controls to specify which source lines the assembler must write to the list file. Without the assembler option `--list-file` these controls have no effect. The controls take effect starting at the next line.

The $LIST ON control actually increments a counter that is checked for a positive value and is symmetrical with respect to the $LIST OFF control. Note the following sequence:

```
; Counter value currently 1
$LIST ON; Counter value = 2
$LIST ON; Counter value = 3
$LIST OFF; Counter value = 2
$LIST OFF; Counter value = 1
```

The listing still would not be disabled until another $LIST OFF control was issued.

**Example**

```
.SDECL '.pcptext.code',code
.SECT '.pcptext.code'
  ... ; source line in list file
$LIST OFF
  ... ; source line not in list file
$LIST ON
  ... ; source line also in list file
```

**Related Information**

Assembler option `--list-file`

Assembler function `@LST()`
$OBJECT

Syntax

$OBJECT "file"
$OBJECT OFF

Default

$OBJECT

Description

With the $OBJECT control you can specify an alternative name for the generated object file. With the $OBJECT OFF control, the assembler does not generate an object file at all.

Example

;Begin of source
$object "x1.o" ; generate object file x1.o

Related Information

Assembler option --output
$PAGE

Syntax

$PAGE [pagewidth[,pagelength[,blankleft[,blanktop,[blankbtm]]]]]

Default

$PAGE 132,72,0,0,0

Description

If you generate a list file with the assembler option --list-file, you can use the $PAGE control to format the generated list file.

The arguments may be any positive absolute integer expression, and must be separated by commas.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>pagewidth</td>
<td>Number of columns per line. The default is 132, the minimum is 40.</td>
</tr>
<tr>
<td>pagelength</td>
<td>Total number of lines per page. The default is 72, the minimum is 10.</td>
</tr>
<tr>
<td></td>
<td>As a special case, a page length of 0 turns off page breaks.</td>
</tr>
<tr>
<td>blankleft</td>
<td>Number of blank columns at the left of the page. The default is 0, the</td>
</tr>
<tr>
<td></td>
<td>minimum is 0, and the maximum must maintain the relationship: blankleft &lt;</td>
</tr>
<tr>
<td></td>
<td>pagewidth.</td>
</tr>
<tr>
<td>blanktop</td>
<td>Number of blank lines at the top of the page. The default is 0, the</td>
</tr>
<tr>
<td></td>
<td>minimum is 0 and the maximum must be a value so that (blanktop +</td>
</tr>
<tr>
<td></td>
<td>blankbtm) ≤ (pagelength - 10).</td>
</tr>
<tr>
<td>blankbtm</td>
<td>Number of blank lines at the bottom of the page. The default is 0, the</td>
</tr>
<tr>
<td></td>
<td>minimum is 0 and the maximum must be a value so that (blanktop +</td>
</tr>
<tr>
<td></td>
<td>blankbtm) ≤ (pagelength - 10).</td>
</tr>
</tbody>
</table>

If you use the $PAGE control without arguments, it causes a ‘formfeed’: the next source line is printed on the next page in the list file. The $PAGE control itself is not printed.

Example

$PAGE ; formfeed, the next source line is printed
       ; on the next page in the list file.

$PAGE 96 ; set page width to 96. Note that you can
          ; omit the last four arguments.

$PAGE ,,3,3 ; use 3 line top/bottom margins.

Related Information

Assembler option --list-file
$PRCTL

Syntax

$PRCTL exp string[,exp string]...

Description

If you generate a list file with the assembler option --list-file, you can use the $PRCTL control to send control strings to the printer.

The $PRCTL control simply concatenates its arguments and sends them to the listing file (the control line itself is not printed unless there is an error).

You can specify the following arguments:

expr A byte expression which may be used to encode non-printing control characters, such as ESC.
string An assembler string, which may be of arbitrary length, up to the maximum assembler-defined limits.

The $PRCTL control can appear anywhere in the source file; the assembler sends out the control string at the corresponding place in the listing file.

If a $PRCTL control is the last line in the last input file to be processed, the assembler insures that all error summaries, symbol tables, and cross-references have been printed before sending out the control string. In this manner, you can use a $PRCTL control to restore a printer to a previous mode after printing is done.

Similarly, if the $PRCTL control appears as the first line in the first input file, the assembler sends out the control string before page headings or titles.

Example

$PRCTL $1B,'E' ; Reset HP LaserJet printer

Related Information

Assembler option --list-file
$STITLE

Syntax

$STITLE "string"

Default

$STITLE ""

Description

If you generate a list file with the assembler option --list-file, you can use the $STITLE control to specify the program subtitle which is printed at the top of all succeeding pages in the assembler list file below the title.

The specified subtitle is valid until the assembler encounters a new $STITLE control. By default, the subtitle is empty.

The $STITLE control itself will not be printed in the source listing.

If the page width is too small for the title to fit in the header, it will be truncated.

Example

$TITLE 'This is the title'
$STITLE 'This is the subtitle'

Related Information

Assembler option --list-file

Assembler control $TITLE
$TITLE

Syntax

$TITLE "string"

Default

$TITLE ""

Description

If you generate a list file with the assembler option --list-file, you can use the $TITLE control to specify the program title which is printed at the top of each page in the assembler list file.

The specified title is valid until the assembler encounters a new $TITLE control. By default, the title is empty.

The $TITLE control itself will not be printed in the source listing.

If the page width is too small for the title to fit in the header, it will be truncated.

Example

$TITLE 'This is the title'

Related Information

Assembler option --list-file
Assembler control $STITLE
$WARNING OFF

Syntax

$WARNING OFF [number]

Default

All warnings are reported.

Description

This control allows you to disable all or individual warnings. The number argument must be a valid warning message number.

Example

$WARNING OFF ; all warning messages are suppressed
$WARNING OFF 135 ; suppress warning message 135

Related Information

Assembler option --no-warnings
2.10. Macro Operations

Macros provide a shorthand method for inserting a repeated pattern of code or group of instructions. You can define the pattern as a macro, and then call the macro at the points in the program where the pattern would repeat.

Some patterns contain variable entries which change for each repetition of the pattern. Others are subject to conditional assembly.

When a macro is called, the assembler executes the macro and replaces the call by the resulting in-line source statements. ‘In-line’ means that all replacements act as if they are on the same line as the macro call. The generated statements may contain substitutable arguments. The statements produced by a macro can be any processor instruction, almost any assembler directive, or any previously-defined macro. Source statements resulting from a macro call are subject to the same conditions and restrictions as any other statements.

Macros can be nested. The assembler processes nested macros when the outer macro is expanded.

2.10.1. Defining a Macro

The first step in using a macro is to define it.

The definition of a macro consists of three parts:

- **Header**, which assigns a name to the macro and defines the arguments (.MACRO directive).
- **Body**, which contains the code or instructions to be inserted when the macro is called.
- **Terminator**, which indicates the end of the macro definition (.ENDM directive).

A macro definition takes the following form:

```
macro_name .MACRO [argument[,argument]...]
    ...
    macro_definition_statements
    ...
    .ENDM
```

For more information on the definition see the description of the .MACRO directive.

The .DUP, .DUPA, .DUPC, and .DUPF directives are specialized macro forms to repeat a block of source statements. You can think of them as a simultaneous definition and call of an unnamed macro. The source statements between the .DUP, .DUPA, .DUPC, and .DUPF directives and the .ENDM directive follow the same rules as macro definitions.

2.10.2. Calling a Macro

To invoke a macro, construct a source statement with the following format:

```
[label] macro_name [argument[,argument]...] [; comment]
```

where,
**label**
An optional label that corresponds to the value of the location counter at the start of the macro expansion.

**macro_name**
The name of the macro. This may not start in the first column.

**argument**
One or more optional, substitutable arguments. Multiple arguments must be separated by commas.

**comment**
An optional comment.

The following applies to macro arguments:

- Each argument must correspond one-to-one with the formal arguments of the macro definition. If the macro call does not contain the same number of arguments as the macro definition, the assembler issues a warning.

- If an argument has an embedded comma or space, you must surround the argument by single quotes (').

- You can declare a macro call argument as null in three ways:
  - enter delimiting commas in succession with no intervening spaces

```
macroname ARG1,,ARG3 ; the second argument is a null argument
```

  - terminate the argument list with a comma, the arguments that normally would follow, are now considered null

```
macroname ARG1, ; the second and all following arguments are null
```

  - declare the argument as a null string

- No character is substituted in the generated statements that reference a null argument.

### 2.10.3. Using Operators for Macro Arguments

The assembler recognizes certain text operators within macro definitions which allow text substitution of arguments during macro expansion. You can use these operators for text concatenation, numeric conversion, and string handling.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\</td>
<td>Macro argument concatenation</td>
<td>Concatenates a macro argument with adjacent alphanumeric characters.</td>
</tr>
<tr>
<td>?</td>
<td>Return decimal value of symbol</td>
<td>Substitutes the ?symbol sequence with a character string that represents the decimal value of the symbol.</td>
</tr>
<tr>
<td>%</td>
<td>Return hex value of symbol</td>
<td>Substitutes the %symbol sequence with a character string that represents the hexadecimal value of the symbol.</td>
</tr>
<tr>
<td>&quot;</td>
<td>Macro string delimiter</td>
<td>Allows the use of macro arguments as literal strings.</td>
</tr>
<tr>
<td>^</td>
<td>Macro local label override</td>
<td>Prevents name mangling on labels in macros.</td>
</tr>
</tbody>
</table>
Example: Argument Concatenation Operator - \\n
Consider the following macro definition:

```
SWAP_MEM .MACRO REG1,REG2 ; swap memory contents
   LD.P R4,[R\REG1],CC_UC ; use R4 as temp
   LD.P R5,[R\REG2],CC_UC ; use R5 as temp
   ST.P R5,[R\REG1],CC_UC
   ST.P R4,[R\REG2],CC_UC
.ENDM
```

The macro is called as follows:

```
SWAP_MEM 0,1
```

The macro expands as follows:

```
LD.P R4,[R0],CC_UC
LD.P R5,[R1],CC_UC
ST.P R5,[R0],CC_UC
ST.P R4,[R1],CC_UC
```

The macro preprocessor substitutes the character '0' for the argument `REG1`, and the character '1' for the argument `REG2`. The concatenation operator (\) indicates to the macro preprocessor that the substitution characters for the arguments are to be concatenated with the character 'A'.

Without the '\' operator the macro would expand as:

```
LD.P R4,[RREG1],CC_UC
LD.P R5,[RREG2],CC_UC
ST.P R5,[RREG1],CC_UC
ST.P R4,[RREG2],CC_UC
```

which results in an assembler error (invalid operand).

Example: Decimal Value Operator - ?

Instead of substituting the formal arguments with the actual macro call arguments, you can also use the value of the macro call arguments.

Consider the following source code that calls the macro `SWAP_SYM` after the argument `AREG` has been set to 0 and `BREG` has been set to 1.

```
AREG .SET 0
BREG .SET 1
   SWAP_SYM AREG,BREG
```

If you want to replace the arguments with the value of `AREG` and `BREG` rather than with the literal strings 'AREG' and 'BREG', you can use the ? operator and modify the macro as follows:

```
SWAP_SYM .MACRO REG1,REG2 ; swap memory contents
   LD.P R4,[R\?REG1],CC_UC ; use R4 as temp
```

The macro first expands as follows:

```assembly
LD.P R4,[R\?AREG],CC_UC
LD.P R5,[R\?BREG],CC_UC
ST.P R5,[R\?AREG],CC_UC
ST.P R4,[R\?BREG],CC_UC
```

Then ?AREG is replaced by '0' and ?BREG is replaced by '1':

```assembly
LD.P R4,[R\1],CC_UC
LD.P R5,[R\2],CC_UC
ST.P R5,[R\1],CC_UC
ST.P R4,[R\2],CC_UC
```

Because of the concatenation operator '\' the strings are concatenated:

```assembly
LD.P R4,[R1],CC_UC
LD.P R5,[R2],CC_UC
ST.P R5,[R1],CC_UC
ST.P R4,[R2],CC_UC
```

**Example: Hex Value Operator - %**

The percent sign (%) is similar to the standard decimal value operator (?) except that it returns the hexadecimal value of a symbol.

Consider the following macro definition:

```assembly
GEN_LAB .MACRO LAB,VAL,STMT
LAB\%VAL STMT
.ENDM
```

The macro is called after NUM has been set to 10:

```assembly
NUM .SET 10
GEN_LAB HEX,NUM,NOP
```

The macro expands as follows:

```assembly
HEXA NOP
```

The %VAL argument is replaced by the character 'A' which represents the hexadecimal value 10 of the argument VAL.
Example: Argument String Operator - "

To generate a literal string, enclosed by single quotes ('), you must use the argument string operator (") in the macro definition.

Consider the following macro definition:

```assembly
STR_MAC .MACRO STRING
   .BYTE "STRING"
   .ENDM
```

The macro is called as follows:

```assembly
STR_MAC ABCD
```

The macro expands as follows:

```assembly
.BYTE 'ABCD'
```

Within double quotes .DEFINE directive definitions can be expanded. Take care when using constructions with single quotes and double quotes to avoid inappropriate expansions. Since .DEFINE expansion occurs before macro substitution, any .DEFINE symbols are replaced first within a macro argument string:

```assembly
.DEFINE LONG 'short'
STR_MAC .MACRO STRING
   .MESSAGE 'This is a LONG STRING'
   .MESSAGE "This is a LONG STRING"
   .ENDM
```

If the macro is called as follows:

```assembly
STR_MAC sentence
```

it expands as:

```assembly
.MESSAEG 'This is a LONG STRING'
.MESSAEG 'This is a short sentence'
```

Macro Local Label Override Operator - ^

If you use labels in macros, the assembler normally generates another unique name for the labels (such as LAB__M_L000001).

The macro ^-operator prevents name mangling on macro local labels.

Consider the following macro definition:

```assembly
INIT .MACRO ARG, CNT
   LD.I R5,0x1
   ^LAB:
      .WORD ARG
      ADD.I R5,0x1
      COMP.I R5,#CNT
```

Assembly Language
The macro is called as follows:

```
INIT 2,4
```

The macro expands as:

```
LD.I R5,0x1
LAB:
.WORD 2
ADD.I R5,0x1
COMP.I R5,#4
JC LAB,CC_NZ
```

If you would have omitted the `^` operator, the macro preprocessor would choose another name for `LAB` because the label already exists. The macro would expand like:

```
LD.I R5,0x1
LAB__M_L000001:
.WORD 2
ADD.I R5,0x1
COMP.I R5,#4
JC LAB__M_L000001,CC_NZ
```

### 2.11. Generic Instructions

The assembler supports so-called 'generic instructions'. Generic instructions are pseudo instructions (no instructions from the instruction set). Depending on the situation in which a generic instruction is used, the assembler replaces the generic instruction with appropriate real assembly instruction(s).

**Generic jump JG**

The PCP C compiler only generates generic direct jumps. Generic jump instructions are optimized by the PCP assembler to the real jump instructions depending on the operands. The PCP assembler supports the following generic jump:

```
jg _label [,cc_X] ; Jump Generic to label if condition cc_X is true
```

This generic jump is translated to:

- **JL** - If there is no condition or the condition code is `cc_UC` and the target address fits within the relative range of +/- 512 instructions.
- **JC** - If the target address fits within the relative range of +/- 32 instructions.
- **JC.A** - If the target address does not fit within the relative range.

If a condition code is omitted, the `cc_UC` condition code is used.
The indirect jumps JC.I and JC.IA are directly generated by the PCP compiler. Indirect jumps cannot be optimized by PCP assembler.

**Generic bit handling instruction**

`bmovn R[a], #imm5, #imm1`

This instruction moves the negated bit to a single bit in R[a]. If `imm1` is 0 a set single bit in R[a] is done base on `imm5`. If `imm1` is 1 a clr single bit in R[a] is done based on `imm5` (imm5 == [8..15]).

For example:

`bmovn R7,8, @DPTRBIT(label) ; bmovn R7,8, ((label>>6)^0x1)`

**Generic load 10-bit immediate long instruction**

`LDL.IIL R[a], #imm8, #imm2`

This instruction loads the long 10-bit immediate data following into the lower 16-bit of R[a]. The `imm8` is loaded into most significant 8-bits of the lower 16-bit of R[a] (R[a].8 - R[a].15). The `imm2` is loaded at bit offset 5 and 6 of R[a]. The bits in the lower 8-bit of R[a] are cleared. The most significant 16-bits of R[a] are unaffected. This generic instruction is translated by the assembler to a LDL.IIL PCP instruction.

Example:

`ldl.iil r7, @DPTR(label), 0x3`

This loads the page number of `label` in R7.DPTR and sets R7.IEN (R7.5) and R7.CEN (R7.6) to 1, bit 7 and bit 0-4 are cleared. The most significant 16-bits of R7 are unaffected.
Chapter 3. Using the C Compiler

This chapter describes the compilation process and explains how to call the C compiler.

The TASKING VX-toolset for PCP under Eclipse uses the TASKING makefile generator and make utility to build your entire embedded project, from C source till the final ELF/DWARF object file which serves as input for the debugger.

Although in Eclipse you cannot run the C compiler separately from the other tools, this section discusses the options that you can specify for the C compiler.

On the command line it is possible to call the C compiler separately from the other tools. However, it is recommended to use the control program for command line invocations of the toolset (see Section 6.1, Control Program). With the control program it is possible to call the entire toolset with only one command line.

The C compiler takes the following files for input and output:

\[ C \text{ source file} \]
\[ .c \]
\[ \text{compiler intermediate file} \]
\[ .mil \]
\[ \text{assembly file} \]
\[ .src \]

This chapter first describes the compilation process which consists of a frontend and a backend part. Next it is described how to call the C compiler and how to use its options. An extensive list of all options and their descriptions is included in Section 8.2, C Compiler Options. Finally, a few important basic tasks are described, such as including the C startup code and performing various optimizations.

3.1. Compilation Process

During the compilation of a C program, the C compiler runs through a number of phases that are divided into two parts: frontend and backend.

The backend part is not called for each C statement, but starts after a complete C module or set of modules has been processed by the frontend (in memory). This allows better optimization.

The C compiler requires only one pass over the input file which results in relative fast compilation.

Frontend phases

1. The preprocessor phase:

The preprocessor includes files and substitutes macros by C source. It uses only string manipulations on the C source. The syntax for the preprocessor is independent of the C syntax but is also described in the ISO/IEC 9899:1999(E) standard.
2. The scanner phase:

The scanner converts the preprocessor output to a stream of tokens.

3. The parser phase:

The tokens are fed to a parser for the C grammar. The parser performs a syntactic and semantic analysis of the program, and generates an intermediate representation of the program. This code is called MIL (Medium level Intermediate Language).

4. The frontend optimization phase:

Target processor independent optimizations are performed by transforming the intermediate code.

**Backend phases**

1. Instruction selector phase:

This phase reads the MIL input and translates it into Low level Intermediate Language (LIL). The LIL objects correspond to a processor instruction, with an opcode, operands and information used within the C compiler.

2. Peephole optimizer/instruction scheduler/software pipelining phase:

This phase replaces instruction sequences by equivalent but faster and/or shorter sequences, rearranges instructions and deletes unnecessary instructions.

3. Register allocator phase:

This phase chooses a physical register to use for each virtual register. When there are not enough physical registers, virtual registers are spilled to the stack. Intermediate results of any optimization can live, for some time, on the stack or in physical registers.

4. The backend optimization phase:

Performs target processor independent and dependent optimizations which operate on the Low level Intermediate Language.

5. The code generation/formatter phase:

This phase reads through the LIL operations to generate assembly language output.

### 3.2. Calling the C Compiler

The TASKING VX-toolset for PCP under Eclipse uses the TASKING makefile generator and make utility to build your entire project. After you have built your project, the output files are available in a subdirectory of your project directory, depending on the active configuration you have set in the C/C++ Build » Settings page of the Project » Properties for dialog.
Building a project under Eclipse

You have several ways of building your project:

• Build Selected File(s) ( ). This compiles and assembles the selected file(s) without calling the linker.
  1. In the C/C++ Projects view, select the files you want to compile.
  2. Right-click in the C/C++ Projects view and select Build Selected File(s).

• Build Individual Project ( ).
  To build individual projects incrementally, select Project » Build project.

• Rebuild Project ( ). This builds every file in the project whether or not a file has been modified since the last build. A rebuild is a clean followed by a build.
  1. Select Project » Clean...
  2. Enable the option Start a build immediately and click OK.

• Build Automatically. This performs a build of all projects whenever any project file is saved, such as your makefile.
  This way of building is not recommended for C/C++ development, but to enable this feature select Project » Build Automatically and ensure there is a check mark beside the Build Automatically menu item. In order for this option to work, you must also enable option Build on resource save (Auto build) on the Behavior tab of the C/C++ Build page of the Project » Properties for dialog.

See also Chapter 9, Influencing the Build Time.

Select a target processor (core)

Processor options affect the invocation of all tools in the toolset. In Eclipse you need to set them for each configuration. Based on the target processor, the compiler includes a special function register file. This is a regular include file which enables you to use virtual registers that are located in memory.

You can specify the target processor when you create a new project with the New C Project wizard (File » New » TASKING PCP C Project), but you can always change the processor in the project properties dialog.

1. From the Project menu, select Properties for

   The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Processor.

   In the right pane the Processor page appears.

3. From the Configuration list, select a configuration or select [ All configurations ].

4. From the Processor selection list, select a processor.
To access the C compiler options

1. From the Project menu, select Properties for
   
   *The Properties dialog appears.*

2. In the left pane, expand C/C++ Build and select Settings.
   
   *In the right pane the Settings appear.*

3. From the Configuration list, select a configuration or select [ All configurations ].

4. On the Tool Settings tab, select C Compiler.

5. Select the sub-entries and set the options in the various pages.

   Note that the C compiler options are used to create an object file from a C file. The options you enter in the Assembler page are not only used for hand-coded assembly files, but also for intermediate assembly files.

   Note that when you click Restore Defaults to restore the default tool options, as a side effect the processor is also reset to its default value on the Processor page (C/C++ Build » Processor).

You can find a detailed description of all C compiler options in Section 8.2, C Compiler Options.

Invocation syntax on the command line:

cpcp  [ [option]... [file]... ]...

3.3. The C Startup Code

You need the startup code to build an executable application. Just as the PCP is part of the TriCore processor, a PCP application is part of a TriCore application. However, the PCP application runs as an interrupt service routine which is activated by the TriCore application.

The TriCore C startup initializes and clears all global data as required, initializes the PCP compiler stack pointer, PRAM data page pointer and PCP status and control registers for each PCP interrupt function.

The PCP C startup code acts as a 'wrapper' which places the PCP `main()` application into an interrupt service routine on interrupt channel 1.

When this interrupt is activated, it executes in parallel with the TriCore application and returns the exit code of the PCP `main()` function after finishing execution.

The PCP C startup code is part of the library and needs no further configuration.

For details on how to add or change the TriCore C startup code to your TriCore project, see the equivalent section in the TASKING VX-toolset for TriCore User Guide.
3.4. How the Compiler Searches Include Files

When you use include files (with the `#include` statement), you can specify their location in several ways. The compiler searches the specified locations in the following order:

1. If the `#include` statement contains an absolute pathname, the compiler looks for this file. If no path or a relative path is specified, the compiler looks in the same directory as the source file. This is only possible for include files that are enclosed in "".

   This first step is not done for include files enclosed in <>.

2. When the compiler did not find the include file, it looks in the directories that are specified in the **C Compiler » Include Paths** page in the **C/C++ Build » Settings » Tool Settings** tab of the Project Properties dialog (equivalent to option `--include-directory (-I)`).

3. When the compiler did not find the include file (because it is not in the specified include directory or because no directory is specified), it looks in the path(s) specified in the environment variable `CPCPINC`.

4. When the compiler still did not find the include file, it finally tries the default include directory relative to the installation directory (unless you specified option `--no-stdinc`).

**Example**

Suppose that the C source file `test.c` contains the following lines:

```c
#include <stdio.h>
#include "myinc.h"
```

You can call the compiler as follows:

```bash
cpcp -Imyinclude test.c
```

First the compiler looks for the file `stdio.h` in the directory `myinclude` relative to the current directory. If it was not found, the compiler searches in the environment variable `CPCPINC` and then in the default `include` directory.

The compiler now looks for the file `myinc.h`, in the directory where `test.c` is located. If the file is not there the compiler searches in the directory `myinclude`. If it was still not found, the compiler searches in the environment variable `CPCPINC` and then in the default `include` directory.

3.5. Compiling for Debugging

Compiling your files is the first step to get your application ready to run on a target. However, during development of your application you first may want to debug your application.

To create an object file that can be used for debugging, you must instruct the compiler to include symbolic debug information in the source file.
To include symbolic debug information

1. From the Project menu, select Properties for
   The Properties dialog appears.
2. In the left pane, expand C/C++ Build and select Settings.
   In the right pane the Settings appear.
3. On the Tool Settings tab, select C Compiler » Debugging.
4. Select Default in the Generate symbolic debug information box.

Debug and optimizations

Due to different compiler optimizations, it might be possible that certain debug information is optimized away. Therefore, if you encounter strange behavior during debugging it might be necessary to reduce the optimization level, so that the source code is still suitable for debugging. For more information on optimization see Section 3.6, Compiler Optimizations.

Invocation syntax on the command line

The invocation syntax on the command line is:

cpcp -g file.c

3.6. Compiler Optimizations

The compiler has a number of optimizations which you can enable or disable.

1. From the Project menu, select Properties for
   The Properties dialog appears.
2. In the left pane, expand C/C++ Build and select Settings.
   In the right pane the Settings appear.
3. From the Configuration list, select a configuration or select [ All configurations ].
4. On the Tool Settings tab, select C Compiler » Optimization.
5. Select an optimization level in the Optimization level box.
   or:
   In the Optimization level box select Custom optimization and enable the optimizations you want on the Custom optimization page.
Optimization levels

The TASKING C compiler offers four optimization levels and a custom level, at each level a specific set of optimizations is enabled.

- **Level 0 - No optimization**: No optimizations are performed. The compiler tries to achieve a 1-to-1 resemblance between source code and produced code. Expressions are evaluated in the order written in the source code, associative and commutative properties are not used.

- **Level 1 - Optimize**: Enables optimizations that do not affect the debug-ability of the source code. Use this level when you encounter problems during debugging your source code with optimization level 2.

- **Level 2 - Optimize more (default)**: Enables more optimizations to reduce the memory footprint and/or execution time. This is the default optimization level.

- **Level 3 - Optimize most**: This is the highest optimization level. Use this level when your program/hardware has become too slow to meet your real-time requirements.

- **Custom optimization**: you can enable/disable specific optimizations on the Custom optimization page.

Optimization pragmas

If you specify a certain optimization, all code in the module is subject to that optimization. Within the C source file you can overrule the C compiler options for optimizations with `#pragma optimize flag` and `#pragma endoptimize`. Nesting is allowed:

```c
#pragma optimize e    /* Enable expression
...  simplification */
... C source ...
...
#pragma optimize c    /* Enable common expression
...  elimination. Expression
... C source ...
...  simplification still enabled */
...
#pragma endoptimize   /* Disable common expression
...  elimination */
#pragma endoptimize   /* Disable expression
...  simplification */
```

The compiler optimizes the code between the pragma pair as specified.

You can enable or disable the optimizations described in the following subsection. The command line option for each optimization is given in brackets.

**3.6.1. Generic Optimizations (frontend)**

**Common subexpression elimination (CSE) (option -Oc/-OC)**

The compiler detects repeated use of the same (sub-)expression. Such a "common" expression is replaced by a variable that is initialized with the value of the expression to avoid recomputation. This method is called common subexpression elimination (CSE).
A CSE can live in a register, on stack or can be recomputed when required.

**Expression simplification (option -Oe/-OE)**

Multiplication by 0 or 1 and additions or subtractions of 0 are removed. Such useless expressions may be introduced by macros or by the compiler itself (for example, array subcripting).

**Constant propagation (option -Op/-OP)**

A variable with a known value is replaced by that value.

**Automatic function inlining (option -Oi/-OI)**

Small functions that are not too often called, are inlined. This reduces execution time at the cost of code size.

**Control flow simplification (option -Of/-OF)**

A number of techniques to simplify the flow of the program by removing unnecessary code and reducing the number of jumps. For example:

- **Switch optimization**: A number of optimizations of a switch statement are performed, such as removing redundant case labels or even removing an entire switch.

- **Jump chaining**: A (conditional) jump to a label which is immediately followed by an unconditional jump may be replaced by a jump to the destination label of the second jump. This optimization speeds up execution.

- **Conditional jump reversal**: A conditional jump over an unconditional jump is transformed into one conditional jump with the jump condition reversed. This reduces both the code size and the execution time.

- **Dead code elimination**: Code that is never reached, is removed. The compiler generates a warning messages because this may indicate a coding error.

**Subscript strength reduction (option -Os/-OS)**

An array or pointer subscripted with a loop iterator variable (or a simple linear function of the iterator variable), is replaced by the dereference of a pointer that is updated whenever the iterator is updated.

**Loop transformations (option -Ol/-OL)**

Transform a loop with the entry point at the bottom, to a loop with the entry point at the top. This enables constant propagation in the initial loop test and code motion of loop invariant code by the CSE optimization.

**Forward store (option -Oo/-OO)**

A temporary variable is used to cache multiple assignments (stores) to the same non-automatic variable.
MIL linking (Control program option --mil-link)

The frontend phase performs its optimizations on the MIL code. When all C modules and/or MIL modules of an application are given to the C compiler in a single invocation, the C compiler will link MIL code of the modules to a complete application automatically. Next, the frontend will run its optimizations again with application scope. After this, the MIL code is passed on to the backend, which will generate a single .src file for the whole application. Linking with the run-time library, floating-point library and C library is still necessary. Linking with the C library is required because this library contains some hand-coded assembly functions, that are not linked in at MIL level.

In the ISO C99 standard a "translation unit" is a preprocessed source file together with all the headers and source files included via the preprocessing directive #include. After MIL linking the compiler will treat the linked sources files as a single translation unit, allowing global optimizations to be performed, that otherwise would be limited to a single module.

MIL splitting (option --mil-split)

When you specify that the C compiler has to use MIL splitting, the C compiler will first link the application at MIL level as described above. However, after rerunning the optimizations the MIL code is not passed on to the backend. Instead the frontend writes a .ms file for each input file or library. A .ms file has the same format as a .mil file. Only .ms files that really change are updated. The advantage of this approach is that it is possible to use the make utility to translate only those parts of the application to a .src file that really have changed. MIL splitting is therefore a more efficient build process than MIL linking. The penalty for this is that the code compaction optimization in the backend does not have application scope. As with MIL linking, it is still required to link with the normal libraries to build an ELF file.
To read more about how MIL linking influences the build process of your application, see Section 9.2, MIL Linking.

Note that with both options some extra strict type checking is done that can cause building to fail in a way that is unforeseen and difficult to understand. For example, when you use one of these options in combination with option --uchar and you link the MIL library, you might get the following error:

cpcp E289: ['..\..\..\strlen.c' 14/1] "strlen" redeclared with a different type

cpcp I802: ['installation-dir\cpcp\include\string.h' 44/17]
  previous declaration of "strlen"

1 errors, 0 warnings

This is caused by the fact that the MIL library is built without --uchar. You can workaroud this problem by rebuilding the MIL libraries.

3.6.2. Core Specific Optimizations (backend)

Coalescer (option -Oa/-OA)

The coalescer seeks for possibilities to reduce the number of moves (MOV instruction) by smart use of registers. This optimizes both speed and code size.

Interprocedural register optimization (option -Ob/-OB)

Register allocation is improved by taking note of register usage in functions called by a given function.

Peephole optimizations (option -Oy/-OY)

The generated assembly code is improved by replacing instruction sequences by equivalent but faster and/or shorter sequences, or by deleting unnecessary instructions.
Code compaction (reverse inlining) (option -Or/-OR)

Compaction is the opposite of inlining functions: chunks of code that occur more than once, are transformed into a function. This reduces code size at the cost of execution speed. The size of the chunks of code to be inlined depends on the setting of the C compiler option --tradeoff (-t). See the subsection Code Compaction in Section 3.6.3, Optimize for Code Size or Execution Speed.

Note that if you use section renaming, by default, the compiler only performs code compaction on sections that have the same section type prefix, and name given by the section renaming pragma or option. When you use C compiler option --relax-compact-name-check, the compiler does not perform this section name check, but performs code compaction whenever possible.

Generic assembly optimizations (option -Og/-OG)

A set of target independent optimizations that increase speed and decrease code size.

Automatic memory partitioning (option --no-partition)

The PCP has 256 pages of memory. Global variables are accessed by means of a page pointer (DPTR). With this optimization the compiler tries to allocate the global variables together in a page to reduce the loading of the page pointer. So, this optimization reduces code size. This optimization is enabled by default.

3.6.3. Optimize for Code Size or Execution Speed

You can tell the compiler to focus on execution speed or code size during optimizations. You can do this by specifying a size/speed trade-off level from 0 (speed) to 4 (size). This trade-off does not turn optimization phases on or off. Instead, its level is a weight factor that is used in the different optimization phases to influence the heuristics. The higher the level, the more the compiler focusses on code size optimization. To choose a trade-off value read the description below about which optimizations are affected and the impact of the different trade-off values.

Note that the trade-off settings are directions and there is no guarantee that these are followed. The compiler may decide to generate different code if it assessed that this would improve the result.

To specify the size/speed trade-off optimization level:

1. From the Project menu, select Properties for

   The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Settings.

   In the right pane the Settings appear.

3. On the Tool Settings tab, select C Compiler » Optimization.

4. Select a trade-off level in the Trade-off between speed and size box.

See also C compiler option --tradeoff (-t)
Instruction Selection

Trade-off levels 0, 1 and 2: the compiler selects the instructions with the smallest number of cycles.

Trade-off levels 3 and 4: the compiler selects the instructions with the smallest number of bytes.

Switch Jump Chain versus Jump Table

Instruction selection for the switch statements follows different trade-off rules. A switch statement can result in a jump chain or a jump table. The compiler makes the decision between those by measuring and weighing bytes and cycles. This weigh is controlled with the trade-off values:

<table>
<thead>
<tr>
<th>Trade-off value</th>
<th>Time</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>100%</td>
<td>0%</td>
</tr>
<tr>
<td>1</td>
<td>75%</td>
<td>25%</td>
</tr>
<tr>
<td>2</td>
<td>50%</td>
<td>50%</td>
</tr>
<tr>
<td>3</td>
<td>25%</td>
<td>75%</td>
</tr>
<tr>
<td>4</td>
<td>0%</td>
<td>100%</td>
</tr>
</tbody>
</table>

Subscript Strength Reduction

Subscript strength reduction is turned off by default, because it is not possible for the PCP to automatically determine if it improves the generated code.

The total number of additional pointers of a particular type in a particular loop is limited to 4 for the PCP.

The performance increases when more subscript pointers can be allocated for an ideal situation. Ideal is when no registers are needed for other objects than subscripts. This is rarely the case, therefore the maximum number of registers is set to 4 GPRs.

Loop Optimization

For a top-loop, the loop is entered at the top of the loop. A bottom-loop is entered at the bottom. Every loop has a test and a jump at the bottom of the loop, otherwise it is not possible to create a loop. Some top-loops also have a conditional jump before the loop. This is only necessary when the number of loop iterations is unknown. The number of iterations might be zero, in this case the conditional jump jumps over the loop.

Bottom loops always have an unconditional jump to the loop test at the bottom of the loop.

<table>
<thead>
<tr>
<th>Trade-off value</th>
<th>Try to rewrite top-loops to bottom-loops</th>
<th>Optimize loops for size/speed</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>no</td>
<td>speed</td>
</tr>
<tr>
<td>1</td>
<td>yes</td>
<td>speed</td>
</tr>
<tr>
<td>2</td>
<td>yes</td>
<td>speed</td>
</tr>
<tr>
<td>3</td>
<td>yes</td>
<td>size</td>
</tr>
<tr>
<td>4</td>
<td>yes</td>
<td>size</td>
</tr>
</tbody>
</table>
Example:

```c
int a;

void i( int l, int m )
{
    int i;
    for ( i = m; i < l; i++ )
    {
        a++;
    }
    return;
}
```

Coded as a bottom loop (compiled with `--tradeoff=4`) is:

```assembly
jg      _2          ;; unconditional jump to loop test at bottom
_3:
    ld.i    r5,0x1
    ld.i.l  r7,@DPTR(_PCP_a)
    add.pi  r5,[_PCP_a]
    st.pi   r5,[_PCP_a]
    add.i   r3,0x1
_2:                      ;; loop entry point
    comp    r3,r1,cc_uc
    jg      _3,cc_slt
```

Coded as a top loop (compiled with `--tradeoff=0`) is:

```assembly
ldl.il  r7,@DPTR(_PCP_a)
ld.pi   r5,[_PCP_a]
    comp    r3,r1,cc_uc ;; test for at least one loop iteration
    jg      _2,cc_sge   ;; can be omitted when number of iterations is known
_3:                      ;; loop entry point
    add.i   r5,0x1
    add.i   r3,0x1
    comp    r3,r1,cc_uc
    jg      _3,cc_slt
_2:
```

**Automatic Function Inlining**

You can enable automatic function inlining with the option `--optimize=+inline (-Oi)` or by using `#pragma optimize +inline`. This option is also part of the `-O3` predefined option set.

When automatic inlining is enabled, you can use the options `--inline-max-incr` and `--inline-max-size` (or their corresponding pragmas `inline_max_incr` / `inline_max_size`) to control automatic inlining. By default their values are set to -1. This means that the compiler will select a value depending upon the selected trade-off level. The defaults are:
For example with trade-off value 1, the compiler inlines all functions that are smaller or equal to 25 internal compiler units. After that the compiler tries to inline even more functions as long as the function will not grow more than 50%.

When these options/pragmas are set to a value \( \geq 0 \), the specified value is used instead of the values from the table above.

Static functions that are called only once, are always inlined, independent of the values chosen for inline-max-incr and inline-max-size.

### Code Compaction

Trade-off levels 0 and 1: code compaction is disabled.

Trade-off level 2: only code compaction of matches outside loops.

Trade-off level 3: code compaction of matches outside loops, and matches inside loops of patterns that have an estimate execution frequency lower or equal to 10.

Trade-off level 4: code compaction of matches outside loops, and matches inside loops of patterns that have an estimate execution frequency lower or equal to 100.

For loops where the iteration count is unknown an iteration count of 10 is assumed.

For the execution frequency the compiler also accounts nested loops.

See [C compiler option `--compact-max-size`](#)

### 3.6.4. Static Stack Alignment Optimizations

The compiler aligns static stack sections so that they are not located over a PRAM page boundary. The linker locates the begin of the static stack at a PRAM page boundary to ensure that all aligned static stack sections are not located over a page boundary. This alignment restriction saves code by not having to reload the DPTR pointer when it already contains the correct page. The compiler can optimize DPTR updates for static stack accesses to static stack objects that are located in the same page.

The disadvantage is that data space is spilled for the alignment restriction. With the [C compiler option `--align-stack`](#) you can prevent or reduce the alignment gaps on the static stack. Of course less or no page pointer updates can then be optimized by the compiler which increasing the code size. This is a typical data size versus code size optimization.

By default all static stack sections are aligned on a power of 2 depending on its size. The static stack maximum alignment value must be a power of two in the range \([1..64]\).
A value of 1 equals to no alignment optimizations. The default value is 64, which aligns all static stack sections. Also static stack sections that are larger than 64 get an alignment of 64.

3.7. Static Code Analysis

Static code analysis (SCA) is a relatively new feature in compilers. Various approaches and algorithms exist to perform SCA, each having specific pros and cons.

SCA Implementation Design Philosophy

SCA is implemented in the TASKING compiler based on the following design criteria:

• An SCA phase does not take up an excessive amount of execution time. Therefore, the SCA can be performed during a normal edit-compile-debug cycle.

• SCA is implemented in the compiler front-end. Therefore, no new makefiles or work procedures have to be developed to perform SCA.

• The number of emitted false positives is kept to a minimum. A false positive is a message that indicates that a correct code fragment contains a violation of a rule/recommendation. A number of warnings is issued in two variants, one variant when it is guaranteed that the rule is violated when the code is executed, and the other variant when the rules is potentially violated, as indicated by a preceding warning message.

For example see the following code fragment:

```c
extern int some_condition(int);
void f(void)
{
  char buf[10];
  int i;

  for (i = 0; i <= 10; i++)
  {
    if (some_condition(i))
    {
      buf[i] = 0; /* subscript may be out of bounds */
    }
  }
}
```

As you can see in this example, if \( i = 10 \) the array \( buf[] \) might be accessed beyond its upper boundary, depending on the result of \( \text{some\_condition}(i) \). If the compiler cannot determine the result of this function at run-time, the compiler issues the warning "subscript is possibly out of bounds" preceding the CERT warning "ARR35: do not allow loops to iterate beyond the end of an array". If the compiler can determine the result, or if the if statement is omitted, the compiler can guarantee that the "subscript is out of bounds".
• The SCA implementation has real practical value in embedded system development. There are no real objective criteria to measure this claim. Therefore, the TASKING compilers support well known standards for safety critical software development such as the MISRA guidelines for creating software for safety critical automotive systems and secure "CERT C Secure Coding Standard" released by CERT. CERT is founded by the US government and studies internet and networked systems security vulnerabilities, and develops information to improve security.

Effect of optimization level on SCA results

The SCA implementation in the TASKING compilers has the following limitations:

• Some violations of rules will only be detected when a particular optimization is enabled, because they rely on the analysis done for that optimization, or on the transformations performed by that optimization. In particular, the constant propagation and the CSE/PRE optimizations are required for some checks. It is preferred that you enable these optimizations. These optimizations are enabled with the default setting of the optimization level (-O2).

• Some checks require cross-module inspections and violations will only be detected when multiple source files are compiled and linked together by the compiler in a single invocation.

3.7.1. C Code Checking: CERT C

The CERT C Secure Coding Standard provides rules and recommendations for secure coding in the C programming language. The goal of these rules and recommendations is to eliminate insecure coding practices and undefined behaviors that can lead to exploitable vulnerabilities. The application of the secure coding standard will lead to higher-quality systems that are robust and more resistant to attack.

For details about the standard, see the CERT C Secure Coding Standard web site. For general information about CERT secure coding, see www.cert.org/secure-coding.

Versions of the CERT C standard

Version 1.0 of the CERT C Secure Coding Standard is available as a book by Robert C. Seacord [Addison-Wesley]. Whereas the web site is a wiki and reflects the latest information, the book serves as a fixed point of reference for the development of compliant applications and source code analysis tools.

The rules and recommendations supported by the TASKING compiler reflect the version of the CERT web site as of June 1 2009.

The following rules/recommendations implemented by the TASKING compiler, are not part of the book: PRE11-C, FLP35-C, FLP36-C, MSC32-C

For a complete overview of the supported CERT C recommendations/rules by the TASKING compiler, see Chapter 15, CERT C Secure Coding Standard.

Priority and Levels of CERT C

Each CERT C rule and recommendation has an assigned priority. Three values are assigned for each rule on a scale of 1 to 3 for

• severity - how serious are the consequences of the rule being ignored
1. low (denial-of-service attack, abnormal termination)
2. medium (data integrity violation, unintentional information disclosure)
3. high (run arbitrary code)

- likelihood - how likely is it that a flaw introduced by ignoring the rule could lead to an exploitable vulnerability
  1. unlikely
  2. probable
  3. likely

- remediation cost - how expensive is it to comply with the rule
  1. high (manual detection and correction)
  2. medium (automatic detection and manual correction)
  3. low (automatic detection and correction)

The three values are then multiplied together for each rule. This product provides a measure that can be used in prioritizing the application of the rules. These products range from 1 to 27. Rules and recommendations with a priority in the range of 1-4 are level 3 rules (low severity, unlikely, expensive to repair flaws), 6-9 are level 2 (medium severity, probable, medium cost to repair flaws), and 12-27 are level 1 (high severity, likely, inexpensive to repair flaws).

The TASKING compiler checks most of the level 1 and some of the level 2 CERT C recommendations/rules. For a complete overview of the supported CERT C recommendations/rules by the TASKING compiler, see Chapter 15, CERT C Secure Coding Standard.

**To apply CERT C code checking to your application**

1. From the **Project** menu, select **Properties for**

   *The Properties dialog appears.*

2. In the left pane, expand **C/C++ Build** and select **Settings**.

   *In the right pane the Settings appear.*

3. On the Tool Settings tab, select **C Compiler » CERT C Secure Coding**.

4. Make a selection from the **CERT C secure code checking** list.

5. If you selected **Custom**, expand the **Custom CERT C** entry and enable one or more individual recommendations/rules.

On the command line you can use the option **--cert**.

\[cpcp --cert={all | name [-name],...}\]
With `--diag=cert` you can see a list of the available checks, or you can use a three-letter mnemonic to list only the checks in a particular category. For example, `--diag=pre` lists all supported checks in the preprocessor category.

### 3.7.2. C Code Checking: MISRA C

The C programming language is a standard for high level language programming in embedded systems, yet it is considered somewhat unsuitable for programming safety-related applications. Through enhanced code checking and strict enforcement of best practice programming rules, TASKING MISRA C code checking helps you to produce more robust code.

MISRA C specifies a subset of the C programming language which is intended to be suitable for embedded automotive systems. It consists of a set of rules, defined in *MISRA-C:2004, Guidelines for the Use of the C Language in Critical Systems* (Motor Industry Research Association (MIRA), 2004).

The compiler also supports MISRA C:1998, the first version of MISRA C and MISRA C: 2012, the latest version of MISRA C. You can select the version with the following C compiler option:

```
--misrac-version=1998
--misrac-version=2004
--misrac-version=2012
```

In your C source files you can check against the MISRA C version used. For example:

```
#if __MISRAC_VERSION__ == 1998
  ...
#elif __MISRAC_VERSION__ == 2004
  ...
#elif __MISRAC_VERSION__ == 2012
  ...
#endif
```

For a complete overview of all MISRA C rules, see Chapter 16, *MISRA C Rules*.

#### Implementation issues

The MISRA C implementation in the compiler supports nearly all rules. Only a few rules are not supported because they address documentation, run-time behavior, or other issues that cannot be checked by static source code inspection, or because they require an application-wide overview.

During compilation of the code, violations of the enabled MISRA C rules are indicated with error messages and the build process is halted.

MISRA C rules are divided in mandatory rules, required rules and advisory rules. If rules are violated, errors are generated causing the compiler to stop. With the following options warnings, instead of errors, are generated:

```
--misrac-mandatory-warnings
--misrac-required-warnings
--misrac-advisory-warnings
```
Note that not all MISRA C violations will be reported when other errors are detected in the input source. For instance, when there is a syntax error, all semantic checks will be skipped, including some of the MISRA C checks. Also note that some checks cannot be performed when the optimizations are switched off.

Quality Assurance report

To ensure compliance to the MISRA C rules throughout the entire project, the TASKING linker can generate a MISRA C Quality Assurance report. This report lists the various modules in the project with the respective MISRA C settings at the time of compilation. You can use this in your company’s quality assurance system to provide proof that company rules for best practice programming have been applied in the particular project.

To apply MISRA C code checking to your application

1. From the Project menu, select Properties for

   The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Settings.

   In the right pane the Settings appear.

3. On the Tool Settings tab, select C Compiler » MISRA C.


5. In the MISRA C checking box select a MISRA C configuration. Select a predefined configuration for conformance with the required rules in the MISRA C guidelines.

6. (Optional) In the Custom 1998, Custom 2004 or Custom 2012 entry, specify the individual rules.

On the command line you can use the option --misrac.

\texttt{ccep --misrac\{all \mid number \{-number\},...\}}

3.8. C Compiler Error Messages

The C compiler reports the following types of error messages in the Problems view of Eclipse.

F (Fatal errors)

After a fatal error the compiler immediately aborts compilation.

E (Errors)

Errors are reported, but the compiler continues compilation. No output files are produced unless you have set the C compiler option --keep-output-files (the resulting output file may be incomplete).
**W (Warnings)**

Warning messages do not result into an erroneous assembly output file. They are meant to draw your attention to assumptions of the compiler for a situation which may not be correct. You can control warnings in the C/C++ Build » Settings » Tool Settings » C Compiler » Diagnostics page of the Project » Properties for menu (C compiler option --no-warnings).

**I (Information)**

Information messages are always preceded by an error message. Information messages give extra information about the error.

**S (System errors)**

System errors occur when internal consistency checks fail and should never occur. When you still receive the system error message

S9##: internal consistency check failed – please report

please report the error number and as many details as possible about the context in which the error occurred.

**Display detailed information on diagnostics**

1. From the Window menu, select Show View » Other » TASKING » Problems.

   *The Problems view is added to the current perspective.*

2. In the Problems view right-click on a message.

   *A popup menu appears.*

3. Select Detailed Diagnostics Info.

   *A dialog box appears with additional information.*

On the command line you can use the C compiler option --diag to see an explanation of a diagnostic message:

```
cpcp --diag=[format:]{all | number,...}
```
Chapter 4. Using the Assembler

This chapter describes the assembly process and explains how to call the assembler.

The assembler converts hand-written or compiler-generated assembly language programs into machine language, resulting in object files in the ELF/DWARF object format.

The assembler takes the following files for input and output:

assembly file (hand coded) \texttt{.asm} \rightarrow \texttt{list file \texttt{.lst}} \rightarrow \texttt{error messages \texttt{.ers}}

assembly file \texttt{.src} \rightarrow \texttt{assembler} \rightarrow \texttt{relocatable object file \texttt{.o}}

The following information is described:

• The assembly process.

• How to call the assembler and how to use its options. An extensive list of all options and their descriptions is included in Section 8.3, \textit{Assembler Options}.

• The various assembler optimizations.

• How to generate a list file.

• Types of assembler messages.

4.1. Assembly Process

The assembler generates relocatable output files with the extension \texttt{.o}. These files serve as input for the linker.

Phases of the assembly process

• Parsing of the source file: preprocessing of assembler directives and checking of the syntax of instructions

• Instruction grouping and reordering

• Optimization (instruction size)

• Generation of the relocatable object file and optionally a list file

The assembler integrates file inclusion and macro facilities. See Section 2.10, \textit{Macro Operations} for more information.
4.2. Calling the Assembler

The TASKING VX-toolset for PCP under Eclipse uses the TASKING makefile generator and make utility to build your entire project. After you have built your project, the output files are available in a subdirectory of your project directory, depending on the active configuration you have set in the C/C++ Build » Settings page of the Project » Properties for dialog.

Building a project under Eclipse

You have several ways of building your project:

• Build Selected File(s) ( ). This compiles and assembles the selected file(s) without calling the linker.
  1. In the C/C++ Projects view, select the files you want to compile.
  2. Right-click in the C/C++ Projects view and select Build Selected File(s).

• Build Individual Project ( ).
  To build individual projects incrementally, select Project » Build project.

• Rebuild Project ( ). This builds every file in the project whether or not a file has been modified since the last build. A rebuild is a clean followed by a build.
  1. Select Project » Clean...
  2. Enable the option Start a build immediately and click OK.

• Build Automatically. This performs a build of all projects whenever any project file is saved, such as your makefile.

  This way of building is not recommended for C/C++ development, but to enable this feature select Project » Build Automatically and ensure there is a check mark beside the Build Automatically menu item. In order for this option to work, you must also enable option Build on resource save (Auto build) on the Behavior tab of the C/C++ Build page of the Project » Properties for dialog.

Select a target processor (core)

Processor options affect the invocation of all tools in the toolset. In Eclipse you need to set them for each configuration.

1. From the Project menu, select Properties for

   The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Processor.

   In the right pane the Processor page appears.

3. From the Configuration list, select a configuration or select [ All configurations ].
4. From the Processor selection list, select a processor.

To access the assembler options

1. From the Project menu, select Properties for
   
   The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Settings.
   
   In the right pane the Settings appear.

3. From the Configuration list, select a configuration or select [ All configurations ].

4. On the Tool Settings tab, select Assembler.

5. Select the sub-entries and set the options in the various pages.

Note that the options you enter in the Assembler page are not only used for hand-coded assembly files, but also for the assembly files generated by the compiler.

Note that when you click Restore Defaults to restore the default tool options, as a side effect the processor is also reset to its default value on the Processor page (C/C++ Build » Processor).

You can find a detailed description of all assembler options in Section 8.3, Assembler Options.

Invocation syntax on the command line:

\texttt{aspcp [ [option]... [file]... ]...}

The input file must be an assembly source file (\texttt{.asm} or \texttt{.src}).

4.3. How the Assembler Searches Include Files

When you use include files (with the .\texttt{INCLUDE} directive), you can specify their location in several ways. The assembler searches the specified locations in the following order:

1. If the .\texttt{INCLUDE} directive contains an absolute path name, the assembler looks for this file. If no path or a relative path is specified, the assembler looks in the same directory as the source file.

2. When the assembler did not find the include file, it looks in the directories that are specified in the Assembler » Include Paths page in the C/C++ Build » Settings » Tool Settings tab of the Project Properties dialog (equivalent to option \texttt{--include-directory (-I)}).

3. When the assembler did not find the include file (because it is not in the specified include directory or because no directory is specified), it looks in the path(s) specified in the environment variable ASPCPINC.
4. When the assembler still did not find the include file, it finally tries the default include directory relative to the installation directory.

Example

Suppose that the assembly source file `test.asm` contains the following lines:

```assembly
.INCLUDE 'myinc.inc'
```

You can call the assembler as follows:

```bash
aspcp -Imyinclude test.asm
```

First the assembler looks for the file `myinc.asm`, in the directory where `test.asm` is located. If the file is not there the assembler searches in the directory `myinclude`. If it was still not found, the assembler searches in the environment variable `ASPCPINC` and then in the default include directory.

4.4. Assembler Optimizations

The assembler can perform various optimizations that you can enable or disable.

1. From the **Project** menu, select **Properties for**

   *The Properties dialog appears.*

2. In the left pane, expand **C/C++ Build** and select **Settings**.

   *In the right pane the Settings appear.*

3. From the **Configuration** list, select a configuration or select `[ All configurations ]`.

4. On the Tool Settings tab, select **Assembler » Optimization**.

5. Enable one or more optimizations.

You can enable or disable the optimizations described below. The command line option for each optimization is given in brackets.

**Optimize instruction size (option -Os/-OS)**

When this option is enabled, the assembler tries to find the shortest possible operand encoding for instructions. By default this option is enabled.

4.5. Generating a List File

The list file is an additional output file that contains information about the generated code. You can customize the amount and form of information.

If the assembler generates errors or warnings, these are reported in the list file just below the source line that caused the error or warning.
To generate a list file

1. From the Project menu, select Properties for

   The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Settings.

   In the right pane the Settings appear.

3. On the Tool Settings tab, select Assembler → List File.

4. Enable the option Generate list file.

5. (Optional) Enable the options to include that information in the list file.

Example on the command line

The following command generates the list file test.lst:

aspcp -l test.asm

See Section 11.1, Assembler List File Format, for an explanation of the format of the list file.

4.6. Assembler Error Messages

The assembler reports the following types of error messages in the Problems view of Eclipse.

F (Fatal errors)

After a fatal error the assembler immediately aborts the assembly process.

E (Errors)

Errors are reported, but the assembler continues assembling. No output files are produced unless you have set the assembler option --keep-output-files (the resulting output file may be incomplete).

W (Warnings)

Warning messages do not result into an erroneous assembly output file. They are meant to draw your attention to assumptions of the assembler for a situation which may not be correct. You can control warnings in the C/C++ Build → Settings → Tool Settings → Assembler → Diagnostics page of the Project → Properties for menu (assembler option --no-warnings).

Display detailed information on diagnostics

1. From the Window menu, select Show View » Other » TASKING » Problems.

   The Problems view is added to the current perspective.
2. In the Problems view right-click on a message.

   *A popup menu appears.*

3. Select **Detailed Diagnostics Info**.

   *A dialog box appears with additional information.*

On the command line you can use the assembler option `--diag` to see an explanation of a diagnostic message:

```
aspccp --diag=[format:]\{all | number,...\}
```
Chapter 5. Using the Linker

This chapter describes the linking process, how to call the linker and how to control the linker with a script file.

The TASKING linker is a combined linker/locator. The linker phase combines relocatable object files (.o files, generated by the assembler), and libraries into a single relocatable linker object file (.out). The locator phase assigns absolute addresses to the linker object file and creates an absolute object file which you can load into a target processor. From this point the term linker is used for the combined linker/locator.

The linker can simultaneously link and locate all programs for all cores available on a target board. The target board may be of arbitrary complexity. A simple target board may contain one standard processor with some external memory that executes one task. A complex target board may contain multiple standard processors and DSPs combined with configurable IP-cores loaded in an FPGA. Each core may execute a different program, and external memory may be shared by multiple cores.

The linker takes the following files for input and output:

This chapter first describes the linking process. Then it describes how to call the linker and how to use its options. An extensive list of all options and their descriptions is included in Section 8.4, Linker Options.

To control the link process, you can write a script for the linker. This chapter shortly describes the purpose and basic principles of the Linker Script Language (LSL) on the basis of an example. A complete description of the LSL is included in Linker Script Language.

5.1. Linking Process

The linker combines and transforms relocatable object files (.o) into a single absolute object file. This process consists of two phases: the linking phase and the locating phase.

In the first phase the linker combines the supplied relocatable object files and libraries into a single relocatable object file. In the second phase, the linker assigns absolute addresses to the object file so it can actually be loaded into a target.
### Terms used in the linking process

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Absolute object file</td>
<td>Object code in which addresses have fixed absolute values, ready to load into a target.</td>
</tr>
<tr>
<td>Address</td>
<td>A specification of a location in an address space.</td>
</tr>
<tr>
<td>Address space</td>
<td>The set of possible addresses. A core can support multiple spaces, for example in a Harvard architecture the addresses that identify the location of an instruction refer to <em>code space</em>, whereas addresses that identify the location of a data object refer to a <em>data space</em>.</td>
</tr>
<tr>
<td>Architecture</td>
<td>A description of the characteristics of a core that are of interest for the linker. This encompasses the address space(s) and the internal bus structure. Given this information the linker can convert logical addresses into physical addresses.</td>
</tr>
<tr>
<td>Copy table</td>
<td>A section created by the linker. This section contains data that specifies how the startup code initializes the data and BSS sections. For each section the copy table contains the following fields:</td>
</tr>
<tr>
<td></td>
<td>• action: defines whether a section is copied or zeroed</td>
</tr>
<tr>
<td></td>
<td>• destination: defines the section's address in RAM</td>
</tr>
<tr>
<td></td>
<td>• source: defines the sections address in ROM, zero for BSS sections</td>
</tr>
<tr>
<td></td>
<td>• length: defines the size of the section in MAUs of the destination space</td>
</tr>
<tr>
<td>Core</td>
<td>An instance of an architecture.</td>
</tr>
<tr>
<td>Derivative</td>
<td>The design of a processor. A description of one or more cores including internal memory and any number of buses.</td>
</tr>
<tr>
<td>Library</td>
<td>Collection of relocatable object files. Usually each object file in a library contains one symbol definition (for example, a function).</td>
</tr>
<tr>
<td>Logical address</td>
<td>An address as encoded in an instruction word, an address generated by a core (CPU).</td>
</tr>
<tr>
<td>LSL file</td>
<td>The set of linker script files that are passed to the linker.</td>
</tr>
<tr>
<td>MAU</td>
<td>Minimum Addressable Unit. For a given processor the number of bits between an address and the next address. This is not necessarily a byte or a word.</td>
</tr>
<tr>
<td>Object code</td>
<td>The binary machine language representation of the C source.</td>
</tr>
<tr>
<td>Physical address</td>
<td>An address generated by the memory system.</td>
</tr>
<tr>
<td>Processor</td>
<td>An instance of a derivative. Usually implemented as a (custom) chip, but can also be implemented in an FPGA, in which case the derivative can be designed by the developer.</td>
</tr>
<tr>
<td>Relocatable object file</td>
<td>Object code in which addresses are represented by symbols and thus relocatable.</td>
</tr>
<tr>
<td>Relocation</td>
<td>The process of assigning absolute addresses.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>----------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Relocation information</td>
<td>Information about how the linker must modify the machine code instructions when it relocates addresses.</td>
</tr>
<tr>
<td>Section</td>
<td>A group of instructions and/or data objects that occupy a contiguous range of addresses.</td>
</tr>
<tr>
<td>Section attributes</td>
<td>Attributes that define how the section should be linked or located.</td>
</tr>
<tr>
<td>Target</td>
<td>The hardware board on which an application is executing. A board contains at least one processor. However, a complex target may contain multiple processors and external memory and may be shared between processors.</td>
</tr>
<tr>
<td>Unresolved reference</td>
<td>A reference to a symbol for which the linker did not find a definition yet.</td>
</tr>
</tbody>
</table>

### 5.1.1. Phase 1: Linking

The linker takes one or more relocatable object files and/or libraries as input. A relocatable object file, as generated by the assembler, contains the following information:

- **Header information**: Overall information about the file, such as the code size, name of the source file it was assembled from, and creation date.

- **Object code**: Binary code and data, divided into various named sections. Sections are contiguous chunks of code that have to be placed in specific parts of the memory. The program addresses start at zero for each section in the object file.

- **Symbols**: Some symbols are exported - defined within the file for use in other files. Other symbols are imported - used in the file but not defined (external symbols). Generally these symbols are names of routines or names of data objects.

- **Relocation information**: A list of places with symbolic references that the linker has to replace with actual addresses. When in the code an external symbol (a symbol defined in another file or in a library) is referenced, the assembler does not know the symbol's size and address. Instead, the assembler generates a call to a preliminary relocatable address (usually 0000), while stating the symbol name.

- **Debug information**: Other information about the object code that is used by a debugger. The assembler optionally generates this information and can consist of line numbers, C source code, local symbols and descriptions of data structures.

The linker resolves the external references between the supplied relocatable object files and/or libraries and combines the files into a single relocatable linker object file.

The linker starts its task by scanning all specified relocatable object files and libraries. If the linker encounters an unresolved symbol, it remembers its name and continues scanning. The symbol may be defined elsewhere in the same file, or in one of the other files or libraries that you specified to the linker. If the symbol is defined in a library, the linker extracts the object file with the symbol definition from the library. This way the linker collects all definitions and references of all of the symbols.

Next, the linker combines sections with the same section name and attributes into single sections. The linker also substitutes (external) symbol references by (relocatable) numerical addresses where possible.
At the end of the linking phase, the linker either writes the results to a file (a single relocatable object file) or keeps the results in memory for further processing during the locating phase.

The resulting file of the linking phase is a single relocatable object file (.out). If this file contains unresolved references, you can link this file with other relocatable object files (.o) or libraries (.a) to resolve the remaining unresolved references.

With the linker command line option --link-only, you can tell the linker to only perform this linking phase and skip the locating phase. The linker complains if any unresolved references are left.

5.1.2. Phase 2: Locating

In the locating phase, the linker assigns absolute addresses to the object code, placing each section in a specific part of the target memory. The linker also replaces references to symbols by the actual address of those symbols. The resulting file is an absolute object file which you can actually load into a target memory. Optionally, when the resulting file should be loaded into a ROM device the linker creates a so-called copy table section which is used by the startup code to initialize the data and BSS sections.

Code modification

When the linker assigns absolute addresses to the object code, it needs to modify this code according to certain rules or relocation expressions to reflect the new addresses. These relocation expressions are stored in the relocatable object file. Consider the following snippet of x86 code that moves the contents of variable a to variable b via the eax register:

A1 3412 0000 mov a,%eax   (a defined at 0x1234, byte reversed)
A3 0000 0000 mov %eax,b   (b is imported so the instruction refers to 0x0000 since its location is unknown)

Now assume that the linker links this code so that the section in which a is located is relocated by 0x10000 bytes, and b turns out to be at 0x9A12. The linker modifies the code to be:

A1 3412 0100 mov a,%eax   (0x10000 added to the address)
A3 129A 0000 mov %eax,b   (0x9A12 patched in for b)

These adjustments affect instructions, but keep in mind that any pointers in the data part of a relocatable object file have to be modified as well.

Output formats

The linker can produce its output in different file formats. The default ELF/DWARF format (.elf) contains an image of the executable code and data, and can contain additional debug information. The Intel-Hex format (.hex) and Motorola S-record format (.sre) only contain an image of the executable code and data. You can specify a format with the options --output (-o) and --chip-output (-c).

Controlling the linker

Via a so-called linker script file you can gain complete control over the linker. The script language is called the Linker Script Language (LSL). Using LSL you can define:

- The memory installed in the embedded target system:
To assign locations to code and data sections, the linker must know what memory devices are actually installed in the embedded target system. For each physical memory device the linker must know its start-address, its size, and whether the memory is read-write accessible (RAM) or read-only accessible (ROM).

- How and where code and data should be placed in the physical memory:

Embedded systems can have complex memory systems. If for example on-chip and off-chip memory devices are available, the code and data located in internal memory is typically accessed faster and with dissipating less power. To improve the performance of an application, specific code and data sections should be located in on-chip memory. By writing your own LSL file, you gain full control over the locating process.

- The underlying hardware architecture of the target processor.

To perform its task the linker must have a model of the underlying hardware architecture of the processor you are using. For example the linker must know how to translate an address used within the object file (a logical address) into an offset in a particular memory device (a physical address). In most linkers this model is hard coded in the executable and can not be modified. For the TASKING linker this hardware model is described in the linker script file. This solution is chosen to support configurable cores that are used in system-on-chip designs.

When you want to write your own linker script file, you can use the standard linker script files with architecture descriptions delivered with the product.

See also Section 5.7, Controlling the Linker with a Script.

5.2. Calling the Linker

In Eclipse you can set options specific for the linker. After you have built your project, the output files are available in a subdirectory of your project directory, depending on the active configuration you have set in the C/C++ Build » Settings page of the Project » Properties for dialog.

Building a project under Eclipse

You have several ways of building your project:

- Build Individual Project ($\mathbf{1}$).

To build individual projects incrementally, select Project » Build project.

- Rebuild Project ($\mathbf{2}$). This builds every file in the project whether or not a file has been modified since the last build. A rebuild is a clean followed by a build.

  1. Select Project » Clean...

  2. Enable the option Start a build immediately and click OK.
• Build Automatically. This performs a build of all projects whenever any project file is saved, such as your makefile.

This way of building is not recommended, but to enable this feature select Project » Build Automatically and ensure there is a check mark beside the Build Automatically menu item. In order for this option to work, you must also enable option Build on resource save (Auto build) on the Behavior tab of the C/C++ Build page of the Project » Properties for dialog.

To access the linker options

1. From the Project menu, select Properties for

   The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Settings.

   In the right pane the Settings appear.

3. From the Configuration list, select a configuration or select [ All configurations ].

4. On the Tool Settings tab, select Linker.

5. Select the sub-entries and set the options in the various pages.

   Note that when you click Restore Defaults to restore the default tool options, as a side effect the processor is also reset to its default value on the Processor page (C/C++ Build » Processor).

   You can find a detailed description of all linker options in Section 8.4, Linker Options.

Invocation syntax on the command line:

lpcp  [ [option]... [file]... ]...

When you are linking multiple files, either relocatable object files (.o) or libraries (.a), it is important to specify the files in the right order. This is explained in Section 5.3, Linking with Libraries.

Example:

lpcp -dtc1796b.lsl test.o

This links and locates the file test.o and generates the file test.elf.

5.3. Linking with Libraries

There are two kinds of libraries: system libraries and user libraries.

System library

System libraries are stored in the directories:
An overview of the system libraries is given in the following table:

<table>
<thead>
<tr>
<th>Libraries</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>libc.a</td>
<td>C library</td>
</tr>
<tr>
<td>libfp[t].a</td>
<td>Floating-point libraries&lt;br&gt;Optional letter:&lt;br&gt;t = trapping (control program option --fp-model=+trap)</td>
</tr>
</tbody>
</table>

To link the default C (system) libraries

1. From the Project menu, select Properties for

   The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Settings.

   In the right pane the Settings appear.


4. Enable the option Link default libraries.

When you want to link system libraries from the command line, you must specify this with the option --library (-l). For example, to specify the system library libc.a, type:

```
lpcc --library=c test.o
```

User library

You can create your own libraries. Section 6.4, Archiver describes how you can use the archiver to create your own library with object modules.

To link user libraries

1. From the Project menu, select Properties for

   The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Settings.

   In the right pane the Settings appear.


4. Add your libraries to the Libraries box.

When you want to link user libraries from the command line, you must specify their filenames on the command line:
lpcp start.o mylib.a

If the library resides in a sub-directory, specify that directory with the library name:

lpcp start.o mylibs\mylib.a

If you do not specify a directory, the linker searches the library in the current directory only.

Library order

The order in which libraries appear on the command line is important. By default the linker processes object files and libraries in the order in which they appear at the command line. Therefore, when you use a weak symbol construction, like `printf`, in an object file or your own library, you must position this object/library before the C library.

With the option `--first-library-first` you can tell the linker to scan the libraries from left to right, and extract symbols from the first library where the linker finds it. This can be useful when you want to use newer versions of a library routine:

lpcp --first-library-first a.a test.o b.a

If the file `test.o` calls a function which is both present in `a.a` and `b.a`, normally the function in `b.a` would be extracted. With this option the linker first tries to extract the symbol from the first library `a.a`.

Note that routines in `b.a` that call other routines that are present in both `a.a` and `b.a` are now also resolved from `a.a`.

5.3.1. How the Linker Searches Libraries

System libraries

You can specify the location of system libraries in several ways. The linker searches the specified locations in the following order:

1. The linker first looks in the Library search path that are specified in the Linker » Libraries page in the C/C++ Build » Settings » Tool Settings tab of the Project Properties dialog (equivalent to the option `--library-directory (-L)`). If you specify the `-L` option without a pathname, the linker stops searching after this step.

2. When the linker did not find the library (because it is not in the specified library directory or because no directory is specified), it looks in the path(s) specified in the environment variables `LIBTC1V1_3` / `LIBTC1V1_3_1` / `LIBTC1V1_6`.

3. When the linker did not find the library, it tries the default `lib` directory relative to the installation directory (or a processor specific sub-directory).

User library

If you use your own library, the linker searches the library in the current directory only.
5.3.2. How the Linker Extracts Objects from Libraries

A library built with the TASKING archiver arpcp always contains an index part at the beginning of the library. The linker scans this index while searching for unresolved externals. However, to keep the index as small as possible, only the defined symbols of the library members are recorded in this area.

When the linker finds a symbol that matches an unresolved external, the corresponding object file is extracted from the library and is processed. After processing the object file, the remaining library index is searched. If after a complete search of the library unresolved externals are introduced, the library index will be scanned again. After all files and libraries are processed, and there are still unresolved externals and you did not specify the linker option --no-rescan, all libraries are rescanned again. This way you do not have to worry about the library order on the command line and the order of the object files in the libraries. However, this rescanning does not work for ‘weak symbols’. If you use a weak symbol construction, like printf, in an object file or your own library, you must position this object/library before the C library.

The option --verbose (-v) shows how libraries have been searched and which objects have been extracted.

Resolving symbols

If you are linking from libraries, only the objects that contain symbols to which you refer, are extracted from the library. This implies that if you invoke the linker like:

lpcp mylib.a

nothing is linked and no output file will be produced, because there are no unresolved symbols when the linker searches through mylib.a.

It is possible to force a symbol as external (unresolved symbol) with the option --extern (-e):

lpcp --extern=main mylib.a

In this case the linker searches for the symbol main in the library and (if found) extracts the object that contains main.

If this module contains new unresolved symbols, the linker looks again in mylib.a. This process repeats until no new unresolved symbols are found.

5.4. Incremental Linking

With the TASKING linker it is possible to link incrementally. Incremental linking means that you link some, but not all .o modules to a relocatable object file .out. In this case the linker does not perform the locating phase. With the second invocation, you specify both new .o files as the .out file you had created with the first invocation.

Incremental linking is only possible on the command line.

lpcp --incremental test1.o -otest.out
lpcp test2.o test.out
This links the file `test1.o` and generates the file `test.out`. This file is used again and linked together with `test2.o` to create the file `test.elf` (the default name if no output filename is given in the default ELF/DWARF format).

With incremental linking it is normal to have unresolved references in the output file until all `.o` files are linked and the final `.out` or `.elf` file has been reached. The option `--incremental (-r)` for incremental linking also suppresses warnings and errors because of unresolved symbols.

### 5.5. Importing Binary Files

With the TASKING linker it is possible to add a binary file to your absolute output file. In an embedded application you usually do not have a file system where you can get your data from.

**Add a data object in Eclipse**

1. Select **Linker » Data Objects**.

   *The Data objects box shows the list of object files that are imported.*

2. To add a data object, click on the **Add** button in the **Data objects** box.

3. Type or select a binary file (including its path).

On the command line you can add raw data to your application with the linker option `--import-object`.

This makes it possible for example to display images on a device or play audio. The linker puts the raw data from the binary file in a section. The section is aligned on a 4-byte boundary. The section name is derived from the filename, in which dots are replaced by an underscore. So, when importing a file called `my.mp3`, a section with the name `my_mp3` is created. In your application you can refer to the created section by using linker labels.

For example:

```c
#include <stdio.h>
__far extern char   _lc_ub_my_mp3; /* linker labels */
__far extern char   _lc_ue_my_mp3;
char*   mp3 = &_lc_ub_my_mp3;

void main(void)
{
    int size = &_lc_ue_my_mp3 - &_lc_ub_my_mp3;
    int i;
    for (i=0;i<size;i++)
        putchar(mp3[i]);
}
```
Because the compiler does not know in which space the linker will locate the imported binary, you have to make sure the symbols refer to the same space in which the linker will place the imported binary. You do this by using the memory qualifier __far, otherwise the linker cannot bind your linker symbols.

Also note that if you want to use the export functionality of Eclipse, the binary file has to be part of your project.

5.6. Linker Optimizations

During the linking and locating phase, the linker looks for opportunities to optimize the object code. Both code size and execution speed can be optimized.

To enable or disable optimizations

1. From the Project menu, select Properties for

   The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Settings.

   In the right pane the Settings appear.

3. On the Tool Settings tab, select Linker » Optimization.

4. Enable one or more optimizations.

You can enable or disable the optimizations described below. The command line option for each optimization is given in brackets.

Delete unreferenced sections (option -Oc/-OC)

This optimization removes unreferenced sections from the resulting object file.

This optimization considers a section referenced if either of the following two conditions is true:

1. The section is protected from unreferenced section removal, which can be one of:

   • the section is assigned an absolute address, either in the object file or in LSL
   
   • the section is selected by exact name in LSL (no wildcard pattern)
   
   • a symbol defined in the section is referenced in LSL
   
   • the section has the 'protected' section flag set, either in the object file or in LSL

2. The section is referenced via a relocation by another section that is considered referenced.

   * If multiple sections of a specific name are created by using section renaming, all of these sections are protected against unreferenced section removal. With a selection using wildcards, matching sections are
selected, but matching sections that are un referenced may be removed. See Selecting sections for a group in Section 12.8.2, Creating and Locating Groups of Sections.

First fit decreasing (option -Ol/-OL)

When the physical memory is fragmented or when address spaces are nested it may be possible that a given application cannot be located although the size of the available physical memory is larger than the sum of the section sizes. Enable the first-fit-decreasing optimization when this occurs and re-link your application.

The linker's default behavior is to place sections in the order that is specified in the LSL file (that is, working from low to high memory addresses or vice versa). This also applies to sections within an unrestricted group. If a memory range is partially filled and a section must be located that is larger than the remainder of this range, then the section and all subsequent sections are placed in a next memory range. As a result of this gaps occur at the end of a memory range.

When the first-fit-decreasing optimization is enabled the linker will first place the largest sections in the smallest memory ranges that can contain the section. Small sections are located last and can likely fit in the remaining gaps.

Compress copy table (option -Ot/-OT)

The startup code initializes the application’s data areas. The information about which memory addresses should be zeroed and which memory ranges should be copied from ROM to RAM is stored in the copy table.

When this optimization is enabled the linker will try to locate sections in such a way that the copy table is as small as possible thereby reducing the application’s ROM image.

Note that this optimization only affects unrestricted sections that require an initialization action in the copy table. The affected sections get a clustered restriction. Unrestricted sections are sections that do not have their absolute location or their relative location to other sections restricted. See also Define the mutual order of sections in an LSL group in Section 12.8.2, Creating and Locating Groups of Sections.

Delete duplicate code (option -Ox/-OX)

Delete duplicate constant data (option -Oy/-OY)

These two optimizations remove code and constant data that is defined more than once, from the resulting object file.

5.7. Controlling the Linker with a Script

With the options on the command line you can control the linker's behavior to a certain degree. From Eclipse it is also possible to determine where your sections will be located, how much memory is available,
which sorts of memory are available, and so on. Eclipse passes these locating directions to the linker via a script file. If you want even more control over the locating process you can supply your own script.

The language for the script is called the \textit{Linker Script Language}, or shortly LSL. You can specify the script file to the linker, which reads it and locates your application exactly as defined in the script. If you do not specify your own script file, the linker always reads a standard script file which is supplied with the toolset.

\textbf{5.7.1. Purpose of the Linker Script Language}

The Linker Script Language (LSL) serves three purposes:

1. It provides the linker with a definition of the target's core architecture. This definition is supplied with the toolset.

2. It provides the linker with a specification of the memory attached to the target processor.

3. It provides the linker with information on how your application should be located in memory. This gives you, for example, the possibility to create overlaying sections.

The linker accepts multiple LSL files. You can use the specifications of the core architectures that Altium has supplied in the \texttt{include.lsl} directory. Do not change these files.

If you use a different memory layout than described in the LSL file supplied for the target core, you must specify this in a separate LSL file and pass both the LSL file that describes the core architecture and your LSL file that contains the memory specification to the linker. Next you may want to specify how sections should be located and overlaid. You can do this in the same file or in another LSL file.

LSL has its own syntax. In addition, you can use the standard C preprocessor keywords, such as \texttt{#include} and \texttt{#define}, because the linker sends the script file first to the C preprocessor before it starts interpreting the script.

The complete LSL syntax is described in Chapter 12, \textit{Linker Script Language (LSL)}.

\textbf{5.7.2. Eclipse and LSL}

In Eclipse you can specify the size of the stack and heap; the physical memory attached to the processor; identify that particular address ranges are reserved; and specify which sections are located where in memory. Eclipse translates your input into an LSL file that is stored in the project directory under the name \texttt{project_name.lsl} and passes this file to the linker. If you want to learn more about LSL you can inspect the generated file \texttt{project_name.lsl}.

Because a PCP project is part of a TriCore project you only need to specify an LSL file to the TriCore project.

\textbf{To add a generated Linker Script File to your project}

1. From the \texttt{File} menu, select \texttt{File} \textasciitilde \texttt{New} \textasciitilde \texttt{TASKING TriCore C/C++ Project}.
   
   The \texttt{New C/C++ Project wizard} appears.

2. Fill in the project settings in each dialog and click \texttt{Next >} until the following dialog appears.
3. Enable the option **Add linker script file to the project** and click **Finish**.

   *Eclipse creates your project and the file "project_name.lsl" in the project directory.*

If you do not add the linker script file here, you can always add it later with **File » New » Linker Script File (LSL).**

**To change the Linker Script File in Eclipse**

There are two ways of changing the LSL file in Eclipse.

• You can change the LSL file directly in an editor.

  1. Double-click on the file **project_name.lsl**.

   *The project LSL file opens in the editor area.*
2. You can edit the LSL file directly in the project_name.lsl editor.

A * appears in front of the name of the LSL file to indicate that the file has changes.

3. Click or select File » Save to save the changes.

- You can also make changes to the property pages Memory and Stack/Heap.

1. From the Project menu, select Properties for

   The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Memory or Stack/Heap.

   In the right pane the corresponding property page appears.

3. Make changes to memory and/or stack/heap and click OK.

   The project LSL file is updated automatically according to the changes you make in the pages.

You can quickly navigate through the LSL file by using the Outline view (Window » Show View » Outline).

5.7.3. Structure of a Linker Script File

A script file consists of several definitions. The definitions can appear in any order.

The architecture definition (required)

In essence an architecture definition describes how the linker should convert logical addresses into physical addresses for a given type of core. If the core supports multiple address spaces, then for each space the linker must know how to perform this conversion. In this context a physical address is an offset
on a given internal or external bus. Additionally the architecture definition contains information about items such as the (hardware) stack and the interrupt vector table.

This specification is normally written by Altium. Altium supplies LSL files in the include.lsl directory. The file tc_arch.lsl defines the base architecture for all cores and includes an interrupt vector table (inttab.lsl) and an trap vector table (traptab.lsl). The files tc1v1_3.lsl, tc1v1_3_1.lsl and tc1v1_6.lsl extend the base architecture for each TriCore core.

The architecture definition of the LSL file should not be changed by you unless you also modify the core's hardware architecture. If the LSL file describes a multi-core system an architecture definition must be available for each different type of core.

The linker uses the architecture name in the LSL file to identify the target. For example, the default library search path can be different for each core architecture.

The derivative definition

The derivative definition describes the configuration of the internal (on-chip) bus and memory system. Basically it tells the linker how to convert offsets on the buses specified in the architecture definition into offsets in internal memory. Microcontrollers and DSPs often have internal memory and I/O sub-systems apart from one or more cores. The design of such a chip is called a derivative.

When you want to use multiple cores of the same type, you must instantiate the cores in a derivative definition, since the linker automatically instantiates only a single core for an unused architecture.

Altium supplies LSL files for each derivative (derivative.lsl), along with "SFR files", which provide easy access to registers in I/O sub-systems from C and assembly programs. When you build an ASIC or use a derivative that is not (yet) supported by the TASKING tools, you may have to write a derivative definition.

The processor definition

The processor definition describes an instance of a derivative. A processor definition is only needed in a multi-processor embedded system. It allows you to define multiple processors of the same type.

If for a derivative 'A' no processor is defined in the LSL file, the linker automatically creates a processor named 'A' of derivative 'A'. This is why for single-processor applications it is enough to specify the derivative in the LSL file.

The memory and bus definitions (optional)

Memory and bus definitions are used within the context of a derivative definition to specify internal memory and on-chip buses. In the context of a board specification the memory and bus definitions are used to define external (off-chip) memory and buses. Given the above definitions the linker can convert a logical address into an offset into an on-chip or off-chip memory device.

The board specification

The processor definition and memory and bus definitions together form a board specification. LSL provides language constructs to easily describe single-core and heterogeneous or homogeneous multi-core systems. The board specification describes all characteristics of your target board's system buses, memory
devices, I/O sub-systems, and cores that are of interest to the linker. Based on the information provided in the board specification the linker can for each core:

- convert a logical address to an offset within a memory device
- locate sections in physical memory
- maintain an overall view of the used and free physical memory within the whole system while locating

The section layout definition (optional)

The optional section layout definition enables you to exactly control where input sections are located. Features are provided such as: the ability to place sections at a given address, to place sections in a given order, and to overlay code and/or data sections.

Example: Skeleton of a Linker Script File

A linker script file that defines a derivative "X" based on the TC1V1.3 architecture, its external memory and how sections are located in memory, may have the following skeleton:

```plaintext
architecture TC1V1.3 {
  // Specification of the TC1V1.3 core architecture.
  // Written by Altium.
}

derivative X  // derivative name is arbitrary
{
  // Specification of the derivative.
  // Written by Altium.
  core tc      // always specify the core
  {
    architecture = TC1V1.3;
  }

  bus fpi_bus  // internal bus
  {
    // maps to bus "fpi_bus" in "tc" core
  }

  // internal memory
}

processor spe  // processor name is arbitrary
{
  derivative = X;

  // You can omit this part, except if you use a
  // multi-core system.
}
```
memory ext_name
{
    // external memory definition
}

section_layout spe:tc:linear    // section layout
{
    // section placement statements
    // sections are located in address space 'linear'
    // of core 'tc' of processor 'spe'
}

Overview of LSL files delivered by Altium

Altium supplies the following LSL files in the directory include.lsl.

<table>
<thead>
<tr>
<th>LSL file</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>tc_arch.lsl</td>
<td>Defines the base architecture (TC) for all generic TriCore cores. It includes the files inttab.lsl and traptab.lsl.</td>
</tr>
<tr>
<td>tc_mc_arch.lsl</td>
<td>Defines the base architecture (TC) for all multi-core TriCore cores.</td>
</tr>
<tr>
<td>inttab.lsl</td>
<td>Defines the interrupt vector table. It is included in the file tc_arch.lsl.</td>
</tr>
<tr>
<td>traptab.lsl</td>
<td>Defines the trap vector table. It is included in the file tc_arch.lsl.</td>
</tr>
<tr>
<td>tc1v1_3.lsl</td>
<td>Extends the base architecture for cores TC1V1.3, TC1V1.3.1, TC1V1.6 or TC1V1.6.X. It includes the file tc_arch.lsl or tc_mc_arch.lsl and mcs_arch.lsl.</td>
</tr>
<tr>
<td>tc1v1_3_1.lsl</td>
<td></td>
</tr>
<tr>
<td>tc1v1_6.lsl</td>
<td></td>
</tr>
<tr>
<td>tc1v1_6_x.lsl</td>
<td></td>
</tr>
<tr>
<td>derivative.lsl</td>
<td>Defines the derivative and defines a single processor. Contains a memory definition and section layout. It includes one of the files tcversion.lsl. The selection of the derivative is based on your CPU selection (control program option --cpu).</td>
</tr>
<tr>
<td>userdef13.lsl</td>
<td>Defines a user defined derivative for cores TC1V1.3, TC1V1.3.1, TC1V1.6 or TC1V1.6.X and defines a single processor for TC1V1.3, TC1V1.3.1 and TC1V1.6 and a multi-core processor for TC1V1.6.X.</td>
</tr>
<tr>
<td>userdef131.lsl</td>
<td></td>
</tr>
<tr>
<td>userdef16.lsl</td>
<td></td>
</tr>
<tr>
<td>userdef16x.lsl</td>
<td></td>
</tr>
<tr>
<td>template.lsl</td>
<td>This file is used by Eclipse as a template for the project LSL file. It includes the file derivative.lsl based on your CPU selection. The CPU is specified by the <strong>CPU</strong> macro.</td>
</tr>
<tr>
<td>default.lsl</td>
<td>Contains a default memory definition and section layout based on the tc1796b derivative. This file is used on a command line invocation of the tools, when no CPU is selected (no option --cpu). It includes the file extmem.lsl.</td>
</tr>
<tr>
<td>extmem.lsl</td>
<td>Template file with a specification of the external memory attached to the target processor.</td>
</tr>
</tbody>
</table>
When you select to add a linker script file when you create a project in Eclipse, Eclipse makes a copy of the file `template.lsl` and names it “`project_name.lsl`”. On the command line, the linker uses the file `default.lsl`, unless you specify another file with the linker option `--lsl-file (-d)`.

### 5.7.4. The Architecture Definition

Although you will probably not need to write an architecture definition (unless you are building your own processor core) it helps to understand the Linker Script Language and how the definitions are interrelated.

Within an architecture definition the characteristics of a target processor core that are important for the linking process are defined. These include:

- space definitions: the logical address spaces and their properties
- bus definitions: the I/O buses of the core architecture
- mappings: the address translations between logical address spaces, the connections between logical address spaces and buses and the address translations between buses

#### Address spaces

A logical address space is a memory range for which the core has a separate way to encode an address into instructions. Most microcontrollers and DSPs support multiple address spaces. For example, the PCP has separate spaces for code and data. Normally, the size of an address space is $2^N$, with $N$ the number of bits used to encode the addresses.

The relation of an address space with another address space can be one of the following:

- one space is a subset of the other. These are often used for "small" absolute or relative addressing.
- the addresses in the two address spaces represent different locations so they do not overlap. This means the core must have separate sets of address lines for the address spaces. For example, in Harvard architectures we can identify at least a code and a data memory space.

Address spaces (even nested) can have different minimal addressable units (MAU), alignment restrictions, and page sizes. All address spaces have a number that identifies the logical space (id). The following table lists the different address spaces for the architecture `TC` as defined in `tc_arch.lsl`.

<table>
<thead>
<tr>
<th>Space</th>
<th>Id</th>
<th>MAU</th>
<th>Description</th>
<th>ELF sections</th>
</tr>
</thead>
<tbody>
<tr>
<td>linear</td>
<td>1</td>
<td>1</td>
<td>Linear address space.</td>
<td>.text*, .data*, .sdata*, .ldata*, .rodata*, .bss*, .sbss*, table, istung, ustack</td>
</tr>
<tr>
<td>abs24</td>
<td>2</td>
<td>8</td>
<td>Absolute 24-bit addressable space</td>
<td></td>
</tr>
<tr>
<td>abs18</td>
<td>3</td>
<td>8</td>
<td>Absolute 18-bit addressable space</td>
<td>.zdata, .zbss</td>
</tr>
<tr>
<td>csa</td>
<td>4</td>
<td>8</td>
<td>Context Save Area</td>
<td>csa.*</td>
</tr>
<tr>
<td>pcp_code</td>
<td>8</td>
<td>16</td>
<td>PCP code</td>
<td>.pcptext</td>
</tr>
<tr>
<td>pcp_data</td>
<td>9</td>
<td>32</td>
<td>PCP data</td>
<td>.pcpdata</td>
</tr>
</tbody>
</table>
The TriCore architecture in LSL notation

The best way to write the architecture definition, is to start with a drawing. The following figure shows a part of the TriCore architecture:

![TriCore Architecture Diagram]

The figure shows three address spaces called `linear`, `abs18` and `pcp_code`. The address space `abs18` is a subset of the address space `linear`. All address spaces have attributes like a number that identifies the logical space (id), a MAU and an alignment. In LSL notation the definition of these address spaces looks as follows:

```lsl
space linear
{
    id = 1;
    mau = 8;

    map (src_offset=0x00000000, dest_offset=0x00000000, size=4G, dest=bus:fpi_bus);
}

space abs18
{
    id = 3;
    mau = 8;

    map (src_offset=0x00000000, dest_offset=0x00000000, size=16k, dest=space:linear);
    map (src_offset=0x10000000, dest_offset=0x10000000, size=16k, dest=space:linear);
    map (src_offset=0x20000000, dest_offset=0x20000000, size=16k, dest=space:linear);
    //...
}

space pcp_code
{
    id = 8;
    mau = 16;

    map (src_offset=0x80000000, dest_offset=0x80000000, size=32k, dest=bus:pcp_code_bus);
    map (src_offset=0x80000000, dest_offset=0x80000000, size=32k, dest=space:linear);
    //...
}
```
mau = 16;
map (src_offset=0x00000000, dest_offset=0,
    size=0x04000000, dest=bus:pcp_code_bus);
}

The keyword map corresponds with the arrows in the drawing. You can map:

- address space => address space
- address space => bus
- memory => bus (not shown in the drawing)
- bus => bus (not shown in the drawing)

Next the two internal buses, named fpi_bus and pcp_code_bus must be defined in LSL:

bus fpi_bus
{
    mau = 8;
    width = 32;  // there are 32 data lines on the bus
}

bus pcp_code_bus
{
    mau = 8;
    width = 8;
}

This completes the LSL code in the architecture definition. Note that all code above goes into the architecture definition, thus between:

architecture TC1V1.3
{
    // All code above goes here.
}

5.7.5. The Derivative Definition

Although you will probably not need to write a derivative definition (unless you are using multiple cores that both access the same memory device) it helps to understand the Linker Script Language and how the definitions are interrelated.

A derivative is the design of a processor, as implemented on a chip (or FPGA). It comprises one or more cores and on-chip memory. The derivative definition includes:

- core definition: an instance of a core architecture
- bus definition: the I/O buses of the core architecture
- memory definitions: internal (or on-chip) memory
Core

Each derivative must have at least one core and each core must have a specification of its core architecture. This core architecture must be defined somewhere in the LSL file(s).

core tc
{
    architecture = TC1V1.3;
}

In a multi-core environment you can combine multiple cores with the same architecture into a single link task. This is done by importing one or more cores into a root core. The imported cores share a single symbol namespace. The address spaces in each imported core must have a unique ID in the link task. For each imported core is specified that the space IDs of the imported core start at a specific offset. If writable sections for a core must be initialized by using the copy table of a different core, this is specified by a copytable_space. The following example is part of tc27x.lsl delivered with the product.

core tc0 // core 0
{
    architecture = TC1V1.6.X;
    space_id_offset = 100; // add 100 to all space IDs in
                           // the architecture definition
    copytable_space = vtc:linear; // use copytable from core vtc
}
core tc1 // core 1
{
    architecture = TC1V1.6.X;
    space_id_offset = 200; // add 200 to all space IDs in
                           // the architecture definition
    copytable_space = vtc:linear; // use copytable from core vtc
}
core tc2 // core 2
{
    architecture = TC1V1.6.X;
    space_id_offset = 300; // add 300 to all space IDs in
                           // the architecture definition
    copytable_space = vtc:linear; // use copytable from core vtc
}
core vtc
{
    architecture = TC1V1.6.X;
    import tc0; // add all address spaces of tc0 for linking
    import tc1; // add all address spaces of tc1 for linking
    import tc2; // add all address spaces of tc2 for linking
}
Bus

Each derivative can contain a bus definition for connecting external memory. In this example, the bus `fpi_bus` maps to the bus `fpi_bus` defined in the architecture definition of core `tc`:

```plaintext
bus fpi_bus
{
    mau = 8;
    width = 32;
    map (dest=bus:tc:fpi_bus, dest_offset=0, size=4G);
}
```

Memory

External memory is usually described in a separate memory definition, but you can specify on-chip memory for a derivative. For example:

```
memory pcode
{
    mau = 8;
    size = 16k;
    type = ram;
    map (dest=bus:tc:fpi_bus, dest_offset=0xF0020000, size=16k);
    map (dest=bus:tc:pcp_code_bus, size=16k);
}
```

According to the drawing, the TriCore contains internal memory called `pcode` with a size 0x04000 (16 kB). This is physical memory which is mapped to the internal bus `pcp_code_bus` and to the `fpi_bus`, so both the `tc` unit and the PCP can access the memory:

```plaintext
This completes the LSL code in the derivative definition. Note that all code above goes into the derivative definition, thus between:

derivative X    // name of derivative
{
```
5.7.6. The Processor Definition

The processor definition is only needed when you write an LSL file for a multi-processor embedded system. The processor definition explicitly instantiates a derivative, allowing multiple processors of the same type.

```
processor name
{
    derivative = derivative_name;
}
```

If no processor definition is available that instantiates a derivative, a processor is created with the same name as the derivative.

Altium defines a “single processor environment” (spe) in each derivative.lsl file. For example:

```
processor spe
{
    derivative = tc1796b;
}
```

5.7.7. The Memory Definition

Once the core architecture is defined in LSL, you may want to extend the processor with external (or off-chip) memory. You need to specify the location and size of the physical external memory devices in the target system.

The principle is the same as defining the core’s architecture but now you need to fill the memory definition:

```
memory name
{
    // memory definitions
}
```
Suppose your embedded system has 16 kB of external ROM, named `code_rom` and 2 kB of external NVRAM, named `my_nvsram`. Both memories are connected to the bus `fpi_bus`. In LSL this looks like:

```c
memory code_rom
{
    mau = 8;
    size = 16k;
    type = rom;
    map( dest=bus:spe:fpi_bus, dest_offset=0xa0000000, size=16k );
}

memory my_nvsram
{
    mau = 8;
    size = 2k;
    type = nvram;
    map( dest=bus:spe:fpi_bus, dest_offset=0xc0000000, size=2k );
}
```

If you use a different memory layout than described in the LSL file supplied for the target core, you can specify this in Eclipse or you can specify this in a separate LSL file and pass both the LSL file that describes the core architecture and your LSL file that contains the memory specification to the linker.

**To add memory using Eclipse**

1. From the **Project** menu, select **Properties for**

   *The Properties dialog appears.*

2. In the left pane, expand **C/C++ Build** and select **Memory**.

   *In the right pane the Memory page appears.*

3. Open the **Memory** tab and click on the **Add...** button.

   *The Add new memory dialog appears.*

4. Enter the memory name (for example `my_nvsram`), type (for example `nvram`) and size.

5. Click on the **Add...** button.

   *The Add new mapping dialog appears.*

6. You have to specify at least one mapping. Enter the mapping name (optional), address, size and destination and click **OK**.

   *The new mapping is added to the list of mappings.*

7. Click **OK**.

   *The new memory is added to the list of memories (user memory).*

8. Click **OK** to close the Properties dialog.
The updated settings are stored in the project LSL file.

If you make changes to the on-chip memory as defined in the architecture LSL file, the memory is copied to your project LSL file and the line `#define __REDEFINE_ON_CHIP_ITEMS` is added. If you remove all the on-chip memory from your project LSL file, also make sure you remove this define.

### 5.7.8. The Section Layout Definition: Locating Sections

Once you have defined the internal core architecture and optional memory, you can actually define where your application must be located in the physical memory.

During compilation, the compiler divides the application into sections. Sections have a name, an indication (section type) in which address space it should be located and attributes like writable or read-only.

In the section layout definition you can exactly define how input sections are placed in address spaces, relative to each other, and what their absolute run-time and load-time addresses will be.

#### Example: section propagation through the toolset

To illustrate section placement, the following example of a C program (`bat.c`) is used. The program saves the number of times it has been executed in battery back-upped memory, and prints the number.

```c
#define BATTERY_BACKUP_TAG 0xa5f0
#include <stdio.h>

int uninitialized_data;
int initialized_data = 1;
#pragma section data="non_volatile"
#pragma noclear
int battery_backup_tag;
int battery_backup_invok;
#pragma clear
#pragma endsection

void main (void)
{
    if (battery_backup_tag != BATTERY_BACKUP_TAG )
    {
        // battery back-upped memory area contains invalid data
        // initialize the memory
        battery_backup_tag = BATTERY_BACKUP_TAG;
        battery_backup_invok = 0;
    }
    printf( "This application has been invoked %d times\n",
            battery_backup_invok++);
}
```

The compiler assigns names and attributes to sections. With the `#pragma section data=non_volatile` the compiler's default section naming convention is overruled and a section with the name `.pcpdata.non_volatile` is defined. In this section the battery back-upped data is stored.
By default the compiler creates a section with the name ".pcpdata.data" of section type data to store uninitialized data objects. The attribute clear tells the linker that the section content should be filled with zeros at startup.

As a result of the #pragma section data=non_volatile, the data objects between the pragma pair are placed in a section with the name ".pcpdata.non_volatile". Note that uninitialized data sections are cleared at startup. However, battery back-upped sections should not be cleared and therefore we used #pragma noclear.

Section placement

The number of invocations of the example program should be saved in non-volatile (battery back-upped) memory. This is the memory my_nvsram from the example in Section 5.7.7, The Memory Definition.

To control the locating of sections, you need to write one or more section definitions in the LSL file. At least one for each address space where you want to change the default behavior of the linker. In our example, we need to locate sections in the address space pcp_data:

```plaintext
section_layout ::pcp_data
{
    select "ELF sections";
    // Section placement statements
}
```

The space, in this case pcp_data, and the ELF sections must be a valid combination from the table in Section 5.7.4, The Architecture Definition.

To locate sections, you must create a group in which you select sections from your program. For the battery back-up example, we need to define one group, which contains the section .pcpdata.non_volatile. All other sections are located using the defaults specified in the architecture definition. Section .pcpdata.non_volatile should be placed in non-volatile ram. To achieve this, the run address refers to our non-volatile memory called my_nvsram.

```plaintext
group ( run_addr = mem:my_nvsram )
{
    select ".pcpdata.non_volatile";
}
```

This completes the LSL file for the sample architecture and sample program. You can now invoke the linker with this file and the sample program to obtain an application that works for this architecture.

For a complete description of the Linker Script Language, refer to Chapter 12, Linker Script Language (LSL).

5.8. Linker Labels

The linker creates labels that you can use to refer to from within the application software. Some of these labels are real labels at the beginning or the end of a section. Other labels have a second function, these labels are used to address generated data in the locating phase. The data is only generated if the label is used.
Linker labels are labels starting with _lc_. The linker assigns addresses to the following labels when they are referenced:

<table>
<thead>
<tr>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>_lc_ub_name</td>
<td>Begin of section name. Also used to mark the begin of the stack or heap or copy table.</td>
</tr>
<tr>
<td>_lc_b_name</td>
<td></td>
</tr>
<tr>
<td>_lc_ue_name</td>
<td>End of section name. Also used to mark the end of the stack or heap.</td>
</tr>
<tr>
<td>_lc_e_name</td>
<td></td>
</tr>
<tr>
<td>_lc_cb_name</td>
<td>Start address of an overlay section in ROM.</td>
</tr>
<tr>
<td>_lc_ce_name</td>
<td>End address of an overlay section in ROM.</td>
</tr>
<tr>
<td>_lc_gb_name</td>
<td>Begin of group name. This label appears in the output file even if no reference to the label exists in the input file.</td>
</tr>
<tr>
<td>_lc_ge_name</td>
<td>End of group name. This label appears in the output file even if no reference to the label exists in the input file.</td>
</tr>
<tr>
<td>_lc_s_name</td>
<td>Variable name is mapped through memory in shared memory situations.</td>
</tr>
</tbody>
</table>

The linker only allocates space for the stack and/or heap when a reference to either of the section labels exists in one of the input object files.

At C level, all linker labels start with _lc_ (the PCP C compiler adds the label prefix _PCP_ and an extra underscore).

If you want to use linker labels in your C source for sections that have a dot (.) in the name, you have to replace all dots by underscores.

Additionally, the linker script file defines the following symbols:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>_lc_cp</td>
<td>Start of copy table. Same as _lc_ub_table. The copy table gives the source and destination addresses of sections to be copied. This table will be generated by the linker only if this label is used.</td>
</tr>
<tr>
<td>_lc_bh</td>
<td>Begin of heap. Same as _lc_ub_heap.</td>
</tr>
<tr>
<td>_lc_eh</td>
<td>End of heap. Same as _lc_ue_heap.</td>
</tr>
<tr>
<td>_PCP__lc_ub_heap_far</td>
<td>Begin of PCP heap in TriCore address space linear. Same as _lc_ub_pcp_heap_far.</td>
</tr>
<tr>
<td>_PCP__lc_ue_heap_far</td>
<td>End of PCP heap in TriCore address space linear. Same as _lc_ue_pcp_heap_far.</td>
</tr>
<tr>
<td>_PCP__lc_ub_heap</td>
<td>Begin of PCP heap in address space pcp_data. Same as _lc_ub_pcp_heap.</td>
</tr>
<tr>
<td>_PCP__lc_ue_heap</td>
<td>End of PCP heap in address space pcp_data. Same as _lc_ue_pcp_heap.</td>
</tr>
</tbody>
</table>
Example: refer to a label with section name with dots from C

Suppose the C source file *foo.c* contains the following:

```c
#pragma section myname
int myfunc(int a)
{
    /* some source lines */
    return 1;
}
#pragma endsection
```

This results in a section with the name `.pcptext.myname`.

In the following source file *main.c* all dots of the section name are replaced by underscores:

```c
#include <stdio.h>
extern char _lc_ub__pcptext_myname[];

void main(void)
{
    printf("The function myfunc is located at %x\n",
            &_lc_ub__pcptext_myname);
}
```

To prevent the linker error `E106: unresolved external: _PCP__lc_ub__pcptext_myname`, you must define this symbol in the LSL file as follows:

```c
section_layout ::pcp_code
{
    "_PCP__lc_ub__pcptext_myname" := "_lc_ub__pcptext_myname";
}
```

If there is no LSL file in your project, select **File » New » Linker Script File (LSL)**, add the lines that define the symbol. Add the LSL file to the linker options (**Tool Options » Linker » Script File » Linker script file (.lsl)**).

When the PCP linked project (*.out*) is linked with a TriCore project, then the TriCore LSL file also needs this addition.

Example: refer to a PCP variable from TriCore C source

When memory is shared between two or more cores, for instance TriCore and PCP, the addresses of variables (or functions) on that memory may be different for the cores. For the TriCore the variable will be defined and you can access it in the usual way. For the PCP, when you would use the variable directly in your TriCore source, this would use an incorrect address (PCP address). The linker can map the address of the variable from one space to another, if you prefix the variable name with `_lc_s_`.

When a symbol `foo` is defined in a PCP assembly source file, by default it gets the symbol name `foo`. To use this symbol from a TriCore C source file, write:
extern long _lc_s_foo;
void main(int argc, char **argv)
{
    _lc_s_foo = 7;
}

Example: refer to the heap

The heap is only needed when you use one or more of the dynamic memory management library functions: malloc(), calloc(), free() and realloc(). The heap is a reserved area in memory. Only if you use one of the memory allocation functions listed above, the linker automatically allocates a heap. In the LSL file tc_arch.lsl a heap section is defined with the name "pcp_heap" (with the keyword heap). Symbol _PCP__lc_ub_heap is mapped to _lc_ub_pcp_heap. You can refer to the begin and end of the heap from your C source as follows:

```
#include <stdio.h>
extern char _lc_ub_heap[]; /* the compiler prefixes the label with _PCP_ */
extern char _lc_ue_heap[];
void main()
{
    printf( "Size of heap is %d\n",
            _lc_ue_heap - _lc_ub_heap );
}
```

In the C library the linker labels _lc_ub_heap and _lc_ue_heap are used in the function _sbrk() which is called by malloc() when memory is needed from the heap.

The special pcp_heap section is only allocated when its linker labels are used in the program.

From assembly you can refer to the end of the heap with:
```
.extern _PCP__lc_ue_heap ; end of pcp_heap
```

5.9. Generating a Map File

The map file is an additional output file that contains information about the location of sections and symbols. You can customize the type of information that should be included in the map file.

To generate a map file

1. From the **Project** menu, select **Properties for**
   
   *The Properties dialog appears.*

2. In the left pane, expand **C/C++ Build** and select **Settings**.
   
   *In the right pane the Settings appear.*

3. On the Tool Settings tab, select **Linker » Map File**.
4. Enable the option **Generate XML map file format (.mapxml) for map file viewer.**

5. (Optional) Enable the option **Generate map file (.map).**

6. (Optional) Enable the options to include that information in the map file.

**Example on the command line**

The following command generates the map file `test.map`:

```bash
lpcp --map-file test.o
```

With this command the map file `test.map` is created.


### 5.10. Linker Error Messages

The linker reports the following types of error messages in the Problems view of Eclipse.

**F (Fatal errors)**

After a fatal error the linker immediately aborts the link/locate process.

**E (Errors)**

Errors are reported, but the linker continues linking and locating. No output files are produced unless you have set the linker option `--keep-output-files`.

**W (Warnings)**

Warning messages do not result into an erroneous output file. They are meant to draw your attention to assumptions of the linker for a situation which may not be correct. You can control warnings in the C/C++ Build » Settings » Tool Settings » Linker » Diagnostics page of the Project » Properties for menu (linker option `--no-warnings`).

**I (Information)**

Verbose information messages do not indicate an error but tell something about a process or the state of the linker. To see verbose information, use the linker option `--verbose`.

**S (System errors)**

System errors occur when internal consistency checks fail and should never occur. When you still receive the system error message

*S6##: message*
please report the error number and as many details as possible about the context in which the error occurred.

**Display detailed information on diagnostics**

1. From the **Window** menu, select **Show View » Other » TASKING » Problems**.
   
   *The Problems view is added to the current perspective.*

2. In the Problems view right-click on a message.
   
   *A popup menu appears.*

3. Select **Detailed Diagnostics Info**.
   
   *A dialog box appears with additional information.*

On the command line you can use the **linker option --diag** to see an explanation of a diagnostic message:

```
lpcp --diag=[format:]{all | number,...}
```
Chapter 6. Using the Utilities

The TASKING VX-toolset for PCP comes with a number of utilities:

- **ccpcp**: A control program. The control program invokes all tools in the toolset and lets you quickly generate an absolute object file from C and/or assembly source input files. Eclipse uses the control program to call the compiler, assembler and linker.

- **amk**: A make utility to maintain, update, and reconstruct groups of programs. The make utility looks whether files are out of date, rebuilds them and determines which other files as a consequence also need to be rebuilt. It supports parallelism which utilizes the multiple cores found on modern host hardware.

- **mkpcp**: A make utility for backwards compatibility with older versions of the toolset. Not recommended for new projects.

- **arpcp**: An archiver. With this utility you create and maintain library files with relocatable object modules (.o) generated by the assembler.

- **expirepcp**: A utility to limit the size of the cache by removing all files older than a few days or by removing older files until the total size of the cache is smaller than a specified size.

6.1. Control Program

The control program is a tool that invokes all tools in the toolset for you. It provides a quick and easy way to generate the final absolute object file out of your C sources without the need to invoke the compiler, assembler and linker manually.

Eclipse uses the control program to call the C compiler, assembler and linker, but you can call the control program from the command line. The invocation syntax is:

```
ccpcp [ [option]... [file]... ]...
```

**Recognized input files**

- Files with a `.c` suffix are interpreted as C source programs and are passed to the compiler.

- Files with a `.asm` suffix are interpreted as hand-written assembly source files which have to be passed to the assembler.

- Files with a `.src` suffix are interpreted as compiled assembly source files. They are directly passed to the assembler.

- Files with a `.a` suffix are interpreted as library files and are passed to the linker.

- Files with a `.o` suffix are interpreted as object files and are passed to the linker.

- Files with a `.out` suffix are interpreted as linked object files and are passed to the locating phase of the linker. The linker accepts only one `.out` file in the invocation.

- Files with a `.lsl` suffix are interpreted as linker script files and are passed to the linker.
Options

The control program accepts several command line options. If you specify an unknown option to the control program, the control program looks if it is an option for a specific tool. If so, it passes the option directly to the tool. However, it is recommended to use the control program options --pass-* (-Wc, -Wa, -WI) to pass arguments directly to tools.

For a complete list and description of all control program options, see Section 8.5, Control Program Options.

Example with verbose output

ccpcp --verbose --cpu=tc1796b test.c

The control program calls all tools in the toolset and generates the absolute object file test.elf. With option --verbose (-v) you can see how the control program calls the tools:

+ "path\cpcp" -D__CPU__=tc1796b -D__CPU_TC1796B__ -o cc3248a.src test.c
+ "path\aspcp" -D__CPU__=tc1796b -D__CPU_TC1796B__ -o cc3248b.o cc3248a.src
+ "path\lpcp" -o test.elf -dtc1796b.lsl -dextmem.lsl -D__CPU__=tc1796b
   --map-file cc3248b.o "-Lpath\lib\pcp2" -lc -lfp

The control program produces unique filenames for intermediate steps in the compilation process (such as cc3248a.src and cc3248b.o in the example above) which are removed afterwards, unless you specify command line option --keep-temporary-files (-t).

Example with argument passing to a tool

ccpcp --pass-c=-Oc test.c

The option -Oc is directly passed to the compiler.
6.2. Make Utility amk

amk is a make utility that you can use to maintain, update, and reconstruct groups of programs. amk features parallelism which utilizes the multiple cores found on modern host hardware, hardening for path names with embedded white space and it has an (internal) interface to provide progress information for updating a progress bar. It does not use an external command shell (/bin/sh, cmd.exe) but executes commands directly.

The primary purpose of any make utility is to speed up the edit-build-test cycle. To avoid having to build everything from scratch even when only one source file changes, it is necessary to describe dependencies between source files and output files and the commands needed for updating the output files. This is done in a so called "makefile".

6.2.1. Makefile Rules

A makefile dependency rule is a single line of the form:

[target ...] : [prerequisite ...]

where target and prerequisite are path names to files. Example:

test.o : test.c

This states that target test.o depends on prerequisite test.c. So, whenever the latter is modified the first must be updated. Dependencies accumulate: prerequisites and targets can be mentioned in multiple dependency rules (circular dependencies are not allowed however). The command(s) for updating a target when any of its prerequisites have been modified must be specified with leading white space after any of the dependency rule(s) for the target in question. Example:

test.o :
   ccpcp test.c   # leading white space

Command rules may contain dependencies too. Combining the above for example yields:

test.o :
   ccpcp test.c
cccpcp test.c

White space around the colon is not required. When a path name contains special characters such as ‘:’, ‘#’ (start of comment), ‘=’ (macro assignment) or any white space, then the path name must be enclosed in single or double quotes. Quoted strings can contain anything except the quote character itself and a newline. Two strings without white space in between are interpreted as one, so it is possible to embed single and double quotes themselves by switching the quote character.

When a target does not exist, its modification time is assumed to be very old. So, amk will try to make it. When a prerequisite does not exist possibly after having tried to make it, it is assumed to be very new. So, the update commands for the current target will be executed in that case. amk will only try to make targets which are specified on the command line. The default target is the first target in the makefile which does not start with a dot.
Static pattern rules

Static pattern rules are rules which specify multiple targets and construct the prerequisite names for each target based on the target name.

[target ...] : target-pattern : [prerequisite-patterns ...]

The target specifies the targets the rules applies to. The target-pattern and prerequisite-patterns specify how to compute the prerequisites of each target. Each target is matched against the target-pattern to extract a part of the target name, called the stem. This stem is substituted into each of the prerequisite-patterns to make the prerequisite names (one from each prerequisite-pattern).

Each pattern normally contains the character '%' just once. When the target-pattern matches a target, the '%' can match any part of the target name; this part is called the stem. The rest of the pattern must match exactly. For example, the target foo.o matches the pattern '%.o', with 'foo' as the stem. The targets foo.c and foo.elf do not match that pattern.

The prerequisite names for each target are made by substituting the stem for the '%' in each prerequisite pattern.

Example:

objects = test.o filter.o

all: $(objects)

$(objects): %.o: %.c
    ccpcp -c $< -o $@
    echo the stem is $*

Here '$<$' is the automatic variable that holds the name of the prerequisite, '$@' is the automatic variable that holds the name of the target and '$*' is the stem that matches the pattern. Internally this translates to the following two rules:

test.o: test.c
    ccpcp -c test.c -o test.o
    echo the stem is test

filter.o: filter.c
    ccpcp -c filter.c -o filter.o
    echo the stem is filter

Each target specified must match the target pattern; a warning is issued for each target that does not.

Special targets

There are a number of special targets. Their names begin with a period.

<table>
<thead>
<tr>
<th>Target</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.DONE</td>
<td>When the make utility has finished building the specified targets, it continues with the rules following this target.</td>
</tr>
</tbody>
</table>
The rules following this target are executed before any other targets are built.

The prerequisites of this target are considered to be phony targets. A phony target is a target that is not really the name of a file. The rules following a phony target are executed unconditionally, regardless of whether a file with that name exists or what its last-modification time is.

For example:

```
.PHONY: clean

clean:
  rm *.o
```

With `amk clean`, the command is executed regardless of whether there is a file named `clean`.

### 6.2.2. Makefile Directives

Directives inside makefiles are executed while reading the makefile. When a line starts with the word "`include`" or "`-include`" then the remaining arguments on that line are considered filenames whose contents are to be inserted at the current line. "`-include`" will silently skip files which are not present. You can include several files. Include files may be nested.

Example:

```
include makefile2 makefile3
```

White spaces (tabs or spaces) in front of the directive are allowed.

### 6.2.3. Macro Definitions

A *macro* is a symbol name that is replaced with its definition before the makefile is executed. Although the macro name can consist of lowercase or uppercase characters, uppercase is an accepted convention. When a line does not start with white space and contains the assignment operator '`=`, `:=` or `+=` then the line is interpreted as a macro definition. White space around the assignment operator and white space at the end of the line is discarded. Single character macro evaluation happens by prefixing the name with `'$'`. To evaluate macros with names longer than one character put the name between parentheses `'( ')'` or curly braces `'{ }'`. Macro names may contain anything, even white space or other macro evaluations.

Example:

```
DINNER = $(FOOD) and $(BEVERAGE)
FOOD = pizza
BEVERAGE = sparkling water
FOOD += with cheese
```

With the `+=` operator you can add a string to an existing macro. An extra space is inserted before the added string automatically.
Macros are evaluated recursively. Whenever $(DINNER)$ or ${DINNER}$ is mentioned after the above, it will be replaced by the text "pizza with cheese and sparkling water". The left hand side in a macro definition is evaluated before the definition takes place. Right hand side evaluation depends on the assignment operator:

- Evaluate the macro at the moment it is used.
- Evaluate the replacement text before defining the macro.

Subsequent '+=' assignments will inherit the evaluation behavior from the previous assignment. If there is none, then '+=' is the same as '='. The default value for any macro is taken from the environment. Macro definitions inside the makefile overrule environment variables. Macro definitions on the `amk` command line will be evaluated first and overrule definitions inside the makefile.
## Predefined macros

<table>
<thead>
<tr>
<th>Macro</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$</td>
<td>This macro translates to a dollar sign. Thus you can use &quot;$$&quot; in the makefile to represent a single &quot;$&quot;.</td>
</tr>
<tr>
<td>@</td>
<td>The name of the current target. When a rule has multiple targets, then it is the name of the target that caused the rule commands to be run.</td>
</tr>
<tr>
<td>*</td>
<td>The basename (or stem) of the current target. The stem is either provided via a static pattern rule or is calculated by removing all characters found after and including the last dot in the current target name. If the target name is 'test.c' then the stem is 'test' (if the target was not created via a static pattern rule).</td>
</tr>
<tr>
<td>&lt;</td>
<td>The name of the first prerequisite.</td>
</tr>
<tr>
<td>MAKE</td>
<td>The <code>amk</code> path name (quoted if necessary). Optionally followed by the options <code>-n</code> and <code>-s</code>.</td>
</tr>
<tr>
<td>ORIGIN</td>
<td>The name of the directory where <code>amk</code> is installed (quoted if necessary).</td>
</tr>
<tr>
<td>SUBDIR</td>
<td>The argument of option <code>-G</code>. If you have nested makes with <code>-G</code> options, the paths are combined. This macro is defined in the environment (i.e. default macro value).</td>
</tr>
</tbody>
</table>

The @, * and < macros may be suffixed by 'D' to specify the directory component or by 'F' to specify the filename component. `$(@D)` evaluates to the directory name holding the file. `$(@D)/$(@F)` is equivalent to $@. Note that on MS-Windows most programs accept forward slashes, even for UNC path names. The result of the predefined macros @, * and < and 'D' and 'F' variants is not quoted, so it may be necessary to put quotes around it.

Note that stem calculation can cause unexpected values. For example:

```
$@
/home/.wine/test
/home/test/.project
/./file
```

### Macro string substitution

When the macro name in an evaluation is followed by a colon and equal sign as in

```
$ (MACRO: string1=string2)
```

then `amk` will replace `string1` at the end of every word in `$ (MACRO)` by `string2` during evaluation. When `$ (MACRO)` contains quoted path names, the quote character must be mentioned in both the original string and the replacement string¹. For example:

```
$ (MACRO:.o"=.d")
```

¹ Internally, `amk` tokenizes the evaluated text, but performs substitution on the original input text to preserve compatibility here with existing make implementations and POSIX.
6.2.4. Makefile Functions

A function not only expands but also performs a certain operation. The following functions are available:

$(filter pattern ....,item ...)

The filter function filters a list of items using a pattern. It returns items that do match any of the pattern words, removing any items that do not match. The patterns are written using '%

${filter %.c %.h, test.c test.h test.o readme.txt .project output.c}
results in:

    test.c test.h output.c

$(filter-out pattern ....,item ...)

The filter-out function returns all items that do not match any of the pattern words, removing the items that do match one or more. This is the exact opposite of the filter function.

${filter-out %.c %.h, test.c test.h test.o readme.txt .project output.c}
results in:

    test.o readme.txt .project

$(foreach var-name, item ..., action)

The foreach function runs through a list of items and performs the same action for each item. The var-name is the name of the macro which gets dynamically filled with an item while iterating through the item list. In the action you can refer to this macro. For example:

${foreach T, test filter output, ${T}.c ${T}.h}
results in:

    test.c test.h filter.c filter.h output.c output.h

6.2.5. Conditional Processing

Lines containing ifdef, ifndef, else or endif are used for conditional processing of the makefile. They are used in the following way:

ifdef macro-name
    if-lines
else
    else-lines
endif

The if-lines and else-lines may contain any number of lines or text of any kind, even other ifdef, ifndef, else and endif lines, or no lines at all. The else line may be omitted, along with the else-lines following it. White spaces (tabs or spaces) in front of preprocessing directives are allowed.
First the *macro-name* after the `ifdef` command is checked for definition. If the macro is defined then the *if-lines* are interpreted and the *else-lines* are discarded (if present). Otherwise the *if-lines* are discarded; and if there is an *else* line, the *else-lines* are interpreted; but if there is no else line, then no lines are interpreted.

When you use the `ifndef` line instead of `ifdef`, the macro is tested for not being defined. These conditional lines can be nested to any level.

You can also add tests based on strings. With `ifeq` the result is true if the two strings match, with `ifneq` the result is true if the two strings do not match. They are used in the following way:

```
ifeq(string1, string2)
 if-lines
 else
  else-lines
endif
```

### 6.2.6. Makefile Parsing

`amk` reads and interprets a makefile in the following order:

1. When the last character on a line is a backslash (`\`) (i.e. without trailing white space) then that line and the next line will be concatenated, removing the backslash and newline.

2. The unquoted `#` character indicates start of comment and may be placed anywhere on a line. It will be removed in this phase.

```
# this comment line is continued\
on the next line
```

3. Trailing white space is removed.

4. When a line starts with white space and it is not followed by a directive or preprocessing directive, then it is interpreted as a command for updating a target.

5. Otherwise, when a line contains the unquoted text `=`, `+=` or `:=` operator, then it will be interpreted as a macro definition.

6. Otherwise, all macros on the line are evaluated before considering the next steps.

7. When the resulting line contains an unquoted `:` the line is interpreted as a dependency rule.

8. When the first token on the line is "`include`" or "`-include`" (which by now must start on the first column of the line), `amk` will execute the directive.

9. Otherwise, the line must be empty.

Macros in commands for updating a target are evaluated right before the actual execution takes place (or would take place when you use the `-n` option).
6.2.7. Makefile Command Processing

A line with leading white space (tabs or spaces) without a (preprocessing) directive is considered as a command for updating a target. When you use the option -j or -J, amk will execute the commands for updating different targets in parallel. In that case standard input will not be available and standard output and error output will be merged and displayed on standard output only after the commands have finished for a target.

You can precede a command by one or more of the following characters:

- @ Do not show the command. By default, commands are shown prior to their output.
- - Continue upon error. This means that amk ignores a non-zero exit code of the command.
- + Execute the command, even when you use option -n (dry run).
- | Execute the command on the foreground with standard input, standard output and error output available.

Built-in commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>true</td>
<td>This command does nothing. Arguments are ignored.</td>
</tr>
<tr>
<td>false</td>
<td>This command does nothing, except failing with exit code 1. Arguments are ignored.</td>
</tr>
<tr>
<td>echo arg...</td>
<td>Display a line of text.</td>
</tr>
<tr>
<td>exit code</td>
<td>Exit with defined code. Depending on the program arguments and/or the extra rule options '-' this will cause amk to exit with the provided code. Please note that 'exit 0' has currently no result.</td>
</tr>
<tr>
<td>argfile file arg...</td>
<td>Create an argument file suitable for the --option-file (-f) option of all the other tools. The first argfile argument is the name of the file to be created. Subsequent arguments specify the contents. An existing argument file is not modified unless necessary. So, the argument file itself can be used to create a dependency to options of the command for updating a target.</td>
</tr>
<tr>
<td>rm [option]... file...</td>
<td>Remove the specified file(s). The following options are available:</td>
</tr>
<tr>
<td>-r, --recursive</td>
<td>Remove directories and their contents recursively.</td>
</tr>
<tr>
<td>-f, --force</td>
<td>Force deletion. Ignore non-existent files, never prompt.</td>
</tr>
<tr>
<td>-i, --interactive</td>
<td>Interactive. Prompt before every removal.</td>
</tr>
<tr>
<td>-v, --verbose</td>
<td>Verbose mode. Explain what is being done.</td>
</tr>
<tr>
<td>-m file</td>
<td>Read options from file.</td>
</tr>
<tr>
<td>-?, --help</td>
<td>Show usage.</td>
</tr>
</tbody>
</table>
6.2.8. Calling the amk Make Utility

The invocation syntax of `amk` is:

```
amk [option]... [target]... [macro=def]...
```

For example:

```
amk test.elf
```

<table>
<thead>
<tr>
<th><code>target</code></th>
<th>You can specify any target that is defined in the makefile. A target can also be one of the intermediate files specified in the makefile.</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>macro=def</code></td>
<td>Macro definition. This definition remains fixed for the <code>amk</code> invocation. It overrides any regular definitions for the specified macro within the makefiles and from the environment. It is not inherited by subordinate <code>amk</code>'s</td>
</tr>
<tr>
<td><code>option</code></td>
<td>For a complete list and description of all <code>amk</code> make utility options, see Section 8.7, <code>Parallel Make Utility Options</code>.</td>
</tr>
</tbody>
</table>

**Exit status**

The make utility returns an exit status of 1 when it halts as a result of an error. Otherwise it returns an exit status of 0.
6.3. Make Utility mkpcp

This make utility is for backwards compatibility with older versions of the toolset. It is not recommended for new projects. Use amk instead.

If you are working with large quantities of files, or if you need to build several targets, it is rather time-consuming to call the individual tools to compile, assemble, link and locate all your files.

You save already a lot of typing if you use the control program and define an options file. You can even create a batch file or script that invokes the control program for each target you want to create. But with these methods all files are completely compiled, assembled and linked to obtain the target file, even if you changed just one C source. This may demand a lot of (CPU) time on your host.

The make utility mkpcp is a tool to maintain, update, and reconstruct groups of programs. The make utility looks which files are out-of-date and only recreates these files to obtain the updated target.

Make process

In order to build a target, the make utility needs the following input:

- the target it should build, specified as argument on the command line
- the rules to build the target, stored in a file usually called makefile

In addition, the make utility also reads the file mkpcp.mk which contains predefined rules and macros. See Section 6.3.2, Writing a Makefile.

The makefile contains the relationships among your files (called dependencies) and the commands that are necessary to create each of the files (called rules). Typically, the absolute object file (.elf) is updated when one of its dependencies has changed. The absolute file depends on .o files and libraries that must be linked together. The .o files on their turn depend on .src files that must be assembled and finally, .src files depend on the C source files (.c) that must be compiled. In the makefile this looks like:

```
test.src : test.c
            cpcp test.c

        test.o : test.src
                aspcp test.src

        test.elf : test.o
                     lpcp test.o -o test.elf --map-file -lc -lfp
```

You can use any command that is valid on the command line as a rule in the makefile. So, rules are not restricted to invocation of the toolset.

Example

To build the target test.elf, call mkpcp with one of the following lines:
**Using the Utilities**

```
mkpcp test.elf
mkpcp -fmymake.mak test.elf
```

By default the make utility reads the file makefile so you do not need to specify it on the command line. If you want to use another name for the makefile, use the option `-f`.

If you do not specify a target, `mkpcp` uses the first target defined in the makefile. In this example it would build `test.src` instead of `test.elf`.

Based on the sample invocation, the make utility now tries to build `test.elf` based on the makefile and performs the following steps:

1. From the makefile the make utility reads that `test.elf` depends on `test.o`.
2. If `test.o` does not exist or is out-of-date, the make utility first tries to build this file and reads from the makefile that `test.o` depends on `test.src`.
3. If `test.src` does exist, the make utility now creates `test.o` by executing the rule for it: `aspcp test.src`.
4. There are no other files necessary to create `test.elf` so the make utility now can use `test.o` to create `test.elf` by executing the rule: `lpcp test.o -o test.elf` ...

The make utility has now built `test.elf` but it only used the assembler to update `test.o` and the linker to create `test.elf`.

If you compare this to the control program:

```
ccpcp test.c
```

This invocation has the same effect but now all files are recompiled (assembled, linked and located).

### 6.3.1. Calling the Make Utility

You can only call the make utility from the command line. The invocation syntax is:

```
mkpcp [ [option]... [target]... [macro=def]... ]
```

For example:

```
mkpcp test.elf
```

**target**  You can specify any target that is defined in the makefile. A target can also be one of the intermediate files specified in the makefile.

**macro=def**  Macro definition. This definition remains fixed for the `mkpcp` invocation. It overrides any regular definitions for the specified macro within the makefiles and from the environment. It is inherited by subordinate `mkpcp`'s but act as an environment variable for these. That is, depending on the `-e` setting, it may be overridden by a makefile definition.
option For a complete list and description of all make utility options, see Section 8.6, Make Utility Options.

Exit status
The make utility returns an exit status of 1 when it halts as a result of an error. Otherwise it returns an exit status of 0.

6.3.2. Writing a Makefile
In addition to the standard makefile makefile, the make utility always reads the makefile mkpcp.mk before other inputs. This system makefile contains implicit rules and predefined macros that you can use in the makefile makefile.

With the option -r (Do not read the mkpcp.mk file) you can prevent the make utility from reading mkpcp.mk.

The default name of the makefile is makefile in the current directory. If you want to use another makefile, use the option -f.

The makefile can contain a mixture of:

• targets and dependencies
• rules
• macro definitions or functions
• conditional processing
• comment lines
• include lines
• export lines

To continue a line on the next line, terminate it with a backslash (\):

# this comment line is continued\
on the next line

If a line must end with a backslash, add an empty macro:

# this comment line ends with a backslash \$(EMPTY)
# this is a new line

6.3.2.1. Targets and Dependencies
The basis of the makefile is a set of targets, dependencies and rules. A target entry in the makefile has the following format:
Target lines must always start at the beginning of a line, leading white spaces (tabs or spaces) are not allowed. A target line consists of one or more targets, a semicolon and a set of files which are required to build the target (dependencies). The target itself can be one or more filenames or symbolic names:

```
all: demo.elf final.elf

demo.elf final.elf: test.o demo.o final.o
```

You can now can specify the target you want to build to the make utility. The following three invocations all have the same effect:

```
mkpcp
mkpcp all
mkpcp demo.elf final.elf
```

If you do not specify a target, the first target in the makefile (in this example all) is built. The target all depends on demo.elf and final.elf so the second and third invocation have the same effect and the files demo.elf and final.elf are built.

You can normally use colons to denote drive letters. The following works as intended:

```
c:foo.o : a:foo.c
```

If a target is defined in more than one target line, the dependencies are added to form the target’s complete dependency list:

```
all: demo.elf  # These two lines are equivalent with:
all: final.elf  # all: demo.elf final.elf
```

**Special targets**

There are a number of special targets. Their names begin with a period.

<table>
<thead>
<tr>
<th>Target</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.DEFAULT</td>
<td>If you call the make utility with a target that has no definition in the makefile, this target is built.</td>
</tr>
<tr>
<td>.DONE</td>
<td>When the make utility has finished building the specified targets, it continues with the rules following this target.</td>
</tr>
<tr>
<td>.IGNORE</td>
<td>Non-zero error codes returned from commands are ignored. Encountering this in a makefile is the same as specifying the option <code>-i</code> on the command line.</td>
</tr>
<tr>
<td>.INIT</td>
<td>The rules following this target are executed before any other targets are built.</td>
</tr>
<tr>
<td>.PRECIOUS</td>
<td>Dependency files mentioned for this target are never removed. Normally, if a command in a rule returns an error or when the target construction is interrupted, the make utility removes that target file. You can use the option <code>-p</code> on the command line to make all targets precious.</td>
</tr>
</tbody>
</table>
## TASKING VX-toolset for PCP User Guide

### 6.3.2.2. Makefile Rules

A line with leading white space (tabs or spaces) is considered as a rule and associated with the most recently preceding dependency line. A **rule** is a line with commands that are executed to build the associated target. A target-dependency line can be followed by one or more rules.

```
final.src : final.c  # target and dependency
    move test.c final.c  # rule1
    cpcp final.c         # rule2
```

You can precede a rule with one or more of the following characters:

- `@` does not echo the command line, except if `-n` is used.
- `-` the make utility ignores the exit code of the command. Normally the make utility stops if a non-zero exit code is returned. This is the same as specifying the option `-i` on the command line or specifying the special `.IGNORE` target.
- `+` The make utility uses a shell or Windows command prompt (cmd.exe) to execute the command. If the `+` is not followed by a shell line, but the command is an MS-DOS command or if redirection is used (<, |, >), the shell line is passed to cmd.exe anyway.

You can force `mkpcp` to execute multiple command lines in one shell environment. This is accomplished with the token combination `;\`. For example:

```
cd c:\Tasking\bin ;
mkpcp -V
```

Note that the `;` must always directly be followed by the `\` token. Whitespace is not removed when it is at the end of the previous command line or when it is in front of the next command line. The use of the `;` as an operator for a command (like a semicolon `;` separated list with each item on one line) and the `\` as a layout tool is not supported, unless they are separated with whitespace.

### Inline temporary files

The make utility can generate inline temporary files. If a line contains `<<LABEL` (no whitespaces!) then all subsequent lines are placed in a temporary file until the line `LABEL` is encountered. Next, `<<LABEL` is replaced by the name of the temporary file. For example:

<table>
<thead>
<tr>
<th>Target</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.SILENT</td>
<td>Commands are not echoed before executing them. Encountering this in a makefile is the same as specifying the option <code>-s</code> on the command line.</td>
</tr>
<tr>
<td>.SUFFIXES</td>
<td>This target specifies a list of file extensions. Instead of building a completely specified target, you now can build a target that has a certain file extension. Implicit rules to build files with a number of extensions are included in the system makefile <code>mkpcp.mk</code>. If you specify this target with dependencies, these are added to the existing <code>.SUFFIXES</code> target in <code>mkpcp.mk</code>. If you specify this target without dependencies, the existing list is cleared.</td>
</tr>
</tbody>
</table>
The three lines between `<<EOF` and `EOF` are written to a temporary file (for example `mkce4c0a.tmp`), and the rule is rewritten as: `lpcp -o $@ -f mkce4c0a.tmp`.

**Suffix targets**

Instead of specifying a specific target, you can also define a general target. A general target specifies the rules to generate a file with extension `.ex1` to a file with extension `.ex2`. For example:

```
.SUFFIXES:   .c
  .c.o      :
      ccpcp -c $<
```

Read this as: to build a file with extension `.o` out of a file with extension `.c`, call the control program with `-c $<`. `$<` is a predefined macro that is replaced with the name of the current dependency file. The special target `.SUFFIXES:` is followed by a list of file extensions of the files that are required to build the target.

**Implicit rules**

Implicit rules are stored in the system makefile `mkpcp.mk` and are intimately tied to the `.SUFFIXES` special target. Each dependency that follows the `.SUFFIXES` target, defines an extension to a filename which must be used to build another file. The implicit rules then define how to actually build one file from another. These files share a common basename, but have different extensions.

If the specified target on the command line is not defined in the makefile or has not rules in the makefile, the make utility looks if there is an implicit rule to build the target.

**Example:**

```
LIB =   -lc -lfp # macro

prog.elf:  prog.o sub.o
    lpcp prog.o sub.o $(LIB) -o prog.elf

prog.o:    prog.c inc.h
    cpcp prog.c
    aspcp prog.src

sub.o:     sub.c inc.h
    cpcp sub.c
    aspcp sub.src
```

This makefile says that `prog.elf` depends on two files `prog.o` and `sub.o`, and that they in turn depend on their corresponding source files (`prog.c` and `sub.c`) along with the common file `inc.h`.

The following makefile uses implicit rules (from `mkpcp.mk`) to perform the same job.
6.3.2.3. Macro Definitions

A macro is a symbol name that is replaced with its definition before the makefile is executed. Although the macro name can consist of lowercase or uppercase characters, uppercase is an accepted convention. The general form of a macro definition is:

MACRO = text
MACRO += and more text

Spaces around the equal sign are not significant. With the += operator you can add a string to an existing macro. An extra space is inserted before the added string automatically.

To use a macro, you must access its contents:

$(MACRO)       # you can read this as
${MACRO}       # the contents of macro MACRO

If the macro name is a single character, the parentheses are optional. Note that the expansion is done recursively, so the body of a macro may contain other macros. These macros are expanded when the macro is actually used, not at the point of definition:

FOOD = $(EAT) and $(DRINK)
EAT = meat and/or vegetables
DRINK = water
export FOOD

The macro FOOD is expanded as meat and/or vegetables and water at the moment it is used in the export line, and the environment variable FOOD is set accordingly.

Predefined macros

<table>
<thead>
<tr>
<th>Macro</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAKE</td>
<td>Holds the value mkpcp. Any line which uses MAKE, temporarily overrides the option -n (Show commands without executing), just for the duration of the one line. This way you can test nested calls to MAKE with the option -n.</td>
</tr>
<tr>
<td>MAKEFLAGS</td>
<td>Holds the set of options provided to mkpcp (except for the options -f and -d). If this macro is exported to set the environment variable MAKEFLAGS, the set of options is processed before any command line options. You can pass this macro explicitly to nested mkpcp’s, but it is also available to these invocations as an environment variable.</td>
</tr>
</tbody>
</table>
**Using the Utilities**

<table>
<thead>
<tr>
<th>Macro</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRODDIR</td>
<td>Holds the name of the directory where mkpcp is installed. You can use this macro to refer to files belonging to the product, for example a library source file.</td>
</tr>
<tr>
<td>DOPRINT = $(PRODDIR)/lib/src/_doprint.c</td>
<td></td>
</tr>
<tr>
<td>When mkpcp is installed in the directory c:/Tasking/bin this line expands to:</td>
<td></td>
</tr>
<tr>
<td>DOPRINT = c:/Tasking/lib/src/_doprint.c</td>
<td></td>
</tr>
<tr>
<td>SHELLCMD</td>
<td>Holds the default list of commands which are local to the SHELL. If a rule is an invocation of one of these commands, a SHELL is automatically spawned to handle it.</td>
</tr>
<tr>
<td>$</td>
<td>This macro translates to a dollar sign. Thus you can use &quot;$$&quot; in the makefile to represent a single &quot;$&quot;.</td>
</tr>
</tbody>
</table>

**Dynamically maintained macros**

There are several dynamically maintained macros that are useful as abbreviations within rules. It is best not to define them explicitly.

<table>
<thead>
<tr>
<th>Macro</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$*</td>
<td>The basename of the current target.</td>
</tr>
<tr>
<td>$&lt;</td>
<td>The name of the current dependency file.</td>
</tr>
<tr>
<td>$@</td>
<td>The name of the current target.</td>
</tr>
<tr>
<td>$?</td>
<td>The names of dependents which are younger than the target.</td>
</tr>
<tr>
<td>$!</td>
<td>The names of all dependents.</td>
</tr>
</tbody>
</table>

The $< and $* macros are normally used for implicit rules. They may be unreliable when used within explicit target command lines. All macros may be suffixed with F to specify the Filename components (e.g. ${*F}, ${@F}). Likewise, the macros $*, $< and $@ may be suffixed by D to specify the Directory component.

The result of the $* macro is always without double quotes ("), regardless of the original target having double quotes (") around it or not.

The result of using the suffix F (Filename component) or D (Directory component) is also always without double quotes ("), regardless of the original contents having double quotes (") around it or not.

**6.3.2.4. Makefile Functions**

A function not only expands but also performs a certain operation. Functions syntactically look like macros but have embedded spaces in the macro name, e.g. '($match arg1 arg2 arg3 )'. All functions are built-in and currently these are: match, separate, protect, exist, nexist and addprefix.

$(match suffix filename ...)

The match function yields all arguments which match a certain suffix:
$(match .o prog.o sub.o mylib.a)
yields:
prog.o sub.o

$(separate separator argument ...)

The separate function concatenates its arguments using the first argument as the separator. If the first argument is enclosed in double quotes then \"n\" is interpreted as a newline character, \t is interpreted as a tab, \'ooo\' is interpreted as an octal value (where, ooo is one to three octal digits), and spaces are taken literally. For example:

$(separate "\n" prog.o sub.o)
results in:
prog.o
sub.o

Function arguments may be macros or functions themselves. So,

$(separate "\n" $(match .o $!))
yields all object files the current target depends on, separated by a newline string.

$(protect argument)

The protect function adds one level of quoting. This function has one argument which can contain white space. If the argument contains any white space, single quotes, double quotes, or backslashes, it is enclosed in double quotes. In addition, any double quote or backslash is escaped with a backslash.

Example:
echo $(protect I'll show you the "protect" function)
yields:
echo "I'll show you the \"protect\" function"

$(exist file | directory argument)

The exist function expands to its second argument if the first argument is an existing file or directory.

Example:

$(exist test.c ccpcp test.c)
When the file test.c exists, it yields:
ccpcp test.c
When the file test.c does not exist nothing is expanded.
**$(nexist file|directory argument)**

The `nexist` function is the opposite of the `exist` function. It expands to its second argument if the first argument is not an existing file or directory.

Example:

```bash
$(nexist test.src ccpcp test.c)
```

**$(addprefix prefix, argument ...)**

The `addprefix` function adds a prefix to its arguments. It is used in `mkpcp.mk` for invocation of the control program to pass arguments directly to a tool.

Example:

```bash
ccpcp $(addprefix -Wc, -g1 -O2) test.c
```

yields:

```bash
ccpcp -Wc-g1 -Wc-O2 test.c
```

### 6.3.2.5. Conditional Processing

Lines containing `ifdef`, `ifndef`, `else` or `endif` are used for conditional processing of the makefile. They are used in the following way:

```bash
ifdef macro-name
if-lines
else
else-lines
endif
```

The `if-lines` and `else-lines` may contain any number of lines or text of any kind, even other `ifdef`, `ifndef`, `else` and `endif` lines, or no lines at all. The `else` line may be omitted, along with the `else-lines` following it.

First the `macro-name` after the `ifdef` command is checked for definition. If the macro is defined then the `if-lines` are interpreted and the `else-lines` are discarded (if present). Otherwise the `if-lines` are discarded; and if there is an `else` line, the `else-lines` are interpreted; but if there is no else line, then no lines are interpreted.

When you use the `ifndef` line instead of `ifdef`, the macro is tested for not being defined. These conditional lines can be nested up to 6 levels deep.

You can also add tests based on strings. With `ifeq` the result is true if the two strings match, with `ifneq` the result is true if the two strings do not match. They are used in the following way:

```bash
ifeq(string1,string2)
if-lines
else
```

211
6.3.2.6. Comment, Include and Export Lines

Comment lines

Anything after a "#" is considered as a comment, and is ignored. If the "#" is inside a quoted string, it is not treated as a comment. Completely blank lines are ignored.

test.src  : test.c        # this is comment and is
cpccp test.c  # ignored by the make utility

Include lines

An include line is used to include the text of another makefile (like including a .h file in a C source). Macros in the name of the included file are expanded before the file is included. You can include several files. Include files may be nested.

include makefile2 makefile3

Export lines

An export line is used to export a macro definition to the environment of any command executed by the make utility.

GREETING = Hello
export  GREETING

This example creates the environment variable GREETING with the value Hello. The macro is exported at the moment the export line is read so the macro definition has to precede the export line.
6.4. Archiver

The archiver `arpcp` is a program to build and maintain your own library files. A library file is a file with extension `.a` and contains one or more object files (.o) that may be used by the linker.

The archiver has five main functions:

- Deleting an object module from the library
- Moving an object module to another position in the library file
- Replacing an object module in the library or add a new object module
- Showing a table of contents of the library file
- Extracting an object module from the library

The archiver takes the following files for input and output:

```
\[\text{assembler}\rightarrow\text{relocatable object file}\rightarrow\text{archiver}\]
\[\text{linker}\rightarrow\text{relocatable object file}\rightarrow\text{archiver}\]
```

The linker optionally includes object modules from a library if that module resolves an external symbol definition in one of the modules that are read before.

6.4.1. Calling the Archiver

You can create a library in Eclipse, which calls the archiver or you can call the archiver on the command line.

To create a library in Eclipse

Instead of creating a PCP absolute ELF file, you can choose to create a library. You do this when you create a new project with the New C Project wizard.

1. From the **File** menu, select **New » TASKING PCP C Project**.

   *The New C Project wizard appears.*

2. Enter a project name.

3. In the **Project type** box, select **TASKING PCP Library** and click **Next >**.

4. Follow the rest of the wizard and click **Finish**.
5. Add the files to your project.

6. Build the project as usual. For example, select **Project ➤ Build Project**.

   *Eclipse builds the library. Instead of calling the linker, Eclipse now calls the archiver.*

**Command line invocation**

You can call the archiver from the command line. The invocation syntax is:

`arpcp key_option [sub_option...] library [object_file]`

*key_option*  
With a key option you specify the main task which the archiver should perform. You must *always* specify a key option.

*sub_option*  
Sub-options specify into more detail how the archiver should perform the task that is specified with the key option. It is not obligatory to specify sub-options.

*library*  
The name of the library file on which the archiver performs the specified action. You must always specify a library name, except for the options `-?` and `-V`. When the library is not in the current directory, specify the complete path (either absolute or relative) to the library.

*object_file*  
The name of an object file. You must always specify an object file name when you add, extract, replace or remove an object file from the library.

**Options of the archiver utility**

The following archiver options are available:

<table>
<thead>
<tr>
<th>Description</th>
<th>Option</th>
<th>Sub-option</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Main functions (key options)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Replace or add an object module</td>
<td><code>-r</code></td>
<td><code>-a -b -c -n -u -v</code></td>
</tr>
<tr>
<td>Extract an object module from the library</td>
<td><code>-x</code></td>
<td><code>-o -v</code></td>
</tr>
<tr>
<td>Delete object module from library</td>
<td><code>-d</code></td>
<td><code>-v</code></td>
</tr>
<tr>
<td>Move object module to another position</td>
<td><code>-m</code></td>
<td><code>-a -b -v</code></td>
</tr>
<tr>
<td>Print a table of contents of the library</td>
<td><code>-t</code></td>
<td><code>-s0 -s1</code></td>
</tr>
<tr>
<td>Print object module to standard output</td>
<td><code>-p</code></td>
<td></td>
</tr>
<tr>
<td><strong>Sub-options</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Append or move new modules after existing module name</td>
<td><code>-a name</code></td>
<td></td>
</tr>
<tr>
<td>Append or move new modules before existing module name</td>
<td><code>-b name</code></td>
<td></td>
</tr>
<tr>
<td>Suppress the message that is displayed when a new library is created</td>
<td><code>-c</code></td>
<td></td>
</tr>
<tr>
<td>Create a new library from scratch</td>
<td><code>-n</code></td>
<td></td>
</tr>
<tr>
<td>Preserve last-modified date from the library</td>
<td><code>-o</code></td>
<td></td>
</tr>
<tr>
<td>Print symbols in library modules</td>
<td>`-s{0</td>
<td>1}`</td>
</tr>
<tr>
<td>Description</td>
<td>Option</td>
<td>Sub-option</td>
</tr>
<tr>
<td>-----------------------------------------------------------------</td>
<td>--------</td>
<td>------------</td>
</tr>
<tr>
<td>Replace only newer modules</td>
<td>-u</td>
<td></td>
</tr>
<tr>
<td>Verbose</td>
<td>-v</td>
<td></td>
</tr>
<tr>
<td><strong>Miscellaneous</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Display options</td>
<td>-?</td>
<td></td>
</tr>
<tr>
<td>Display description of one or more diagnostic messages</td>
<td>--diag</td>
<td></td>
</tr>
<tr>
<td>Display version header</td>
<td>-V</td>
<td></td>
</tr>
<tr>
<td>Read options from file</td>
<td>-f file</td>
<td></td>
</tr>
<tr>
<td>Suppress warnings above level (n)</td>
<td>-wn</td>
<td></td>
</tr>
</tbody>
</table>

For a complete list and description of all archiver options, see Section 8.8, *Archiver Options*.

### 6.4.2. Archiver Examples

**Create a new library**

If you add modules to a library that does not yet exist, the library is created. To create a new library with the name `mylib.a` and add the object modules `cstart.o` and `calc.o` to it:

```
arpcp -r mylib.a cstart.o calc.o
```

**Add a new module to an existing library**

If you add a new module to an existing library, the module is added at the end of the module. (If the module already exists in the library, it is replaced.)

```
arpcp -r mylib.a mod3.o
```

**Print a list of object modules in the library**

To inspect the contents of the library:

```
arpcp -t mylib.a
```

The library has the following contents:

```
cstart.o
calc.o
mod3.o
```

**Move an object module to another position**

To move `mod3.o` to the beginning of the library, position it just before `cstart.o`:

```
arpcp -mb cstart.o mylib.a mod3.o
```
Delete an object module from the library

To delete the object module `cstart.o` from the library `mylib.a`:

```
arpcp -d mylib.a cstart.o
```

Extract all modules from the library

Extract all modules from the library `mylib.a`:

```
arpcp -x mylib.a
```
6.5. Expire Cache Utility

With the utility expirepcp you can limit the size of the cache (C compiler option --cache) by removing all files older than a few days or by removing older files until the total size of the cache is smaller than a specified size. See also Section 9.6, Compiler Cache.

The invocation syntax is:

expirepcp [option]... cache-directory

The compiler cache is present in the directory cpcpcache under the specified cache-directory.

For a complete list and description of all options, see Section 8.9, Expire Cache Utility Options. With expirepcp --help you will see the options on stdout.

Examples

To remove all files older than seven days, enter:

expirepcp --days=7 "installation-dir\mproject\.cache"

To reduce the compiler cache size to 4 MB, enter:

expirepcp --megabytes=4 "installation-dir\mproject\.cache"

Older files are removed until the total size of the cache is smaller than 4 MB.

To clear the compiler cache, enter:

expirepcp --megabytes=0 "installation-dir\mproject\.cache"
Chapter 7. Using the Debugger

This chapter describes the debugger and how you can run and debug a C application. This chapter only describes the TASKING specific parts.

7.1. Reading the Eclipse Documentation

Before you start with this chapter, it is recommended to read the Eclipse documentation first. It provides general information about the debugging process. This chapter guides you through a number of examples using the TASKING debugger with simulation as target.

You can find the Eclipse documentation as follows:

1. Start Eclipse.
2. From the Help menu, select Help Contents.
   
   The help screen overlays the Eclipse Workbench.
3. In the left pane, select C/C++ Development User Guide.
4. Open the Getting Started entry and select Debugging projects.
   
   This Eclipse tutorial provides an overview of the debugging process. Be aware that the Eclipse example does not use the TASKING tools and TASKING debugger.

7.2. Debugging a PCP Project

A PCP project is always part of a TriCore project. The TriCore project must have a project reference to the PCP project. In order to debug the PCP project part, you need to disable debug for the TriCore project, because we want to debug the PCP project.

In order to debug a PCP project, follow the steps below.

1. Create a PCP project (for example, myproject), as explained in the Getting Started with the TASKING VX-toolset for TriCore. Enable at least the Debug configuration.
2. (Optional) Build the PCP project. This step is optional because the .out file is built automatically when the project is referenced and built from a TriCore project. See step 5.
   
   This results in a linked output file (.out).
3. Create a TriCore project, as explained in the Getting Started with the TASKING VX-toolset for TriCore.
4. In the TriCore project, make a project reference to the PCP project.
5. In the active TriCore project, select Project » Properties for » C/C++ Build » Settings.
6. In the Tool Settings tab, expand the C/C++ Compiler entry and select Debugging.
7. Set the option **Generate symbolic debug information** to **None**.

8. Build the TriCore project.

   *This builds the referenced PCP project and creates the .out file in the Debug directory of the PCP project. Furthermore this creates a TriCore/PCP ELF file in the Debug directory of the TriCore project.*

9. Create a debug configuration for the TriCore project, as explained in **Section 7.3, Creating a Customized Debug Configuration**.

10. Start the debugger. From the **Debug** menu select **Debug project**. Alternatively you can click the button in the main toolbar.

   *When you use the simulator, the Debug view shows the TriCore core and PCP as separate threads. When you select a thread this changes the context in the Disassembly view.*

![Debug view](image)

**Example**

A PCP Hello World example (pcp-hello-ch1) is delivered with the product for the simulator and is referenced by the TriCore project pcp-hello-start. Use the Import wizard (**File » Import » TASKING C/C++ » TASKING PCP Example Projects**) to import the projects into the workspace.

### 7.3. Creating a Customized Debug Configuration

Before you can debug a project, you need a Debug launch configuration. Such a configuration, identified by a name, contains all information about the debug project: which debugger is used, which project is used, which binary debug file is used, which perspective is used, ... and so forth.

If you want to debug on a target board, you have to create a custom debug configuration for your target board, otherwise you have to create a debug launch configuration for the TASKING simulator.

To debug a project, you need at least one opened and active project in your workbench. In this chapter, it is assumed that the **myproject** is opened and active in your workbench.
Create or customize your debug configuration

To create or change a debug configuration follow the steps below.

1. From the **Debug** menu, select **Debug Configurations**...

   *The Debug Configurations dialog appears.*

2. Select **TASKING C/C++ Debugger** and click the **New launch configuration** button ( ) to add a new configuration.
   Or: In the left pane, select the configuration you want to change, for example, **TASKING C/C++ Debugger » myproject**.

3. In the **Name** field enter the name of the configuration. By default, this is the name of the project, but you can give your configuration any name you want to distinguish it from the project name. For example enter **myproject.simulator** to identify the simulator debug configuration.

4. On the **Target** tab, select the **TriCore 1.3 Instruction Set Simulator** or any of the target boards.

   The dialog shows several tabs.

**Target tab**

On the **Target** tab you can select on which target the application should be debugged. An application can run on an external evaluation board, or on a simulator using your own PC. On this tab you can also select the connection settings. The information in this tab is based on the Debug Target Configuration (DTC) files as explained in Chapter 13, *Debug Target Configuration Files.*

**Initialization tab**

On the **Initialization** tab enable one or more of the following options:
• Initial download of program

If enabled, the target application is downloaded onto the target. If disabled, only the debug information in the file is loaded, which may be useful when the application has already been downloaded (or flashed) earlier. If downloading fails, the debugger will shut down.

• Verify download of program

If enabled, the debugger verifies whether the code and data has been downloaded successfully. This takes some extra time but may be useful if the connection to the target is unreliable.

• Reset target

If enabled, the target is immediately reset after downloading has completed. Registers that have the `init` resource set in the `.dtc` file, are reset to their default value. Execution stops at the reset vector.

• Goto main

If enabled, only the C startup code is processed when the debugger is launched. The application stops executing when it reaches the first C instruction in the function `main()`. Usually you enable this option in combination with the option Reset Target.

• Break on exit

If enabled, the target halts automatically when the `exit()` function is called.

• Reduce target state polling

If you have set a breakpoint, the debugger checks the status of the target every `number` of seconds to find out if the breakpoint is hit. In this field you can change the polling frequency.
Initialization tab: Flash settings

- **Use default flash settings (recommended)**

  By default, the flash settings are derived from the `.dtc` file for the chosen target processor. So, when you change processors the flash settings change automatically. If you do not want that, you can specify your own flash settings. You can click **Restore Defaults** to restore the default flash settings.

- **Monitor file**

  Filename of the monitor, usually an Intel Hex or S-Record file.

- **Sector buffer size**

  Specifies the buffer size for buffering a flash sector.

- **Workspace address**

  The address of the workspace of the flash programming monitor.

Project tab

On the **Project** tab, you can set the properties for the debug configuration such as a name for the project and the application binary file(s) which are used when you choose this configuration.

- In the **Project** field, you can choose the project for which you want to make a debug configuration. Because the project `myproject` is the active project, this project is filled in automatically. Click the **Browse...** button to select a different project. Only the **opened** projects in your workbench are listed.

- In the **Binary files** group box, you can choose one or more binary files to debug. The file `myproject.elf` is automatically selected from the active project.
The order of the binary files matters. Use the **Up** and **Down** buttons to change the order. If there are multiple files, the application start address is taken from the first file that defines one. An ELF file always defines one, whereas Hex files may not.

Note that conflicts between symbols could arise, for example when you download two ELF files that both contain the function `main()`. When you download multiple files, we recommend that the first binary file is an ELF file that contains the startup code and `main()` and that the other files are auxiliary Hex files.

**To add a binary file**

1. Click **Add...** to add a binary file.

   *The Add Binary File dialog appears.*

2. Specify the binary file, use the **Search...** button to select one from the active project, or use the **Browse...** button to search the file system.

3. Optionally, specify an address offset. The value will be added to all target addresses in the binary file.

   Note that the address offset will be applied only to code, data and the start address, not to debug information. Specifying a non-zero offset is not recommended for an ELF/DWARF file. If the offset causes an address to underflow or overflow an error occurs.

**Arguments tab**

If your application's `main()` function takes arguments, you can pass them in this tab. Arguments are conventionally passed in the `argv[]` array. Because this array is allocated in target memory, make sure you have allocated sufficient memory space for it.

- In the C/C++ perspective select **Project » Properties for** to open the Properties dialog. Expand **C/C++ Build » Startup Configuration**. Enable the option **Enable passing argc/argv to main()** and specify a **Buffer size for argv**.
Source tab

On the Source tab, you can add additional source code locations in which the debugger should search for debug data.

• Usually, the default source code location is correct.

Miscellaneous tab

On the Miscellaneous tab you can specify several file locations.
**Debugger location**

The location of the debugger itself. This should not be changed.

**FSS root directory**

The initial directory used by file system simulation (FSS) calls. See the description of the FSS view.

**ORTI file and KSM module**

If you wish to use the debugger's special facilities for kernel-aware debugging, specify the name of a Kernel Debug Interface (KDI) compatible KSM module (shared library) in the appropriate edit box. See also the description of the RTOS view.

**GDI log file and Debug instrument log file**

You can use the options GDI log file and Debug instrument log file (if applicable) to control the generation of internal log files. These are primarily intended for use by or at the request of Altium support personnel.

**Cache target access**

Except when using a simulator, the debugger's performance is generally strongly dependent on the throughput and latency of the connection to the target. Depending on the situation, enabling this option may result in a noticeable improvement, as the debugger will then avoid re-reading registers and memory while the target remains halted. However, be aware that this may cause the debugger to show the wrong data if tasks with a higher priority or external sources can influence the halted target's state.

**Launch in background**

When this option is disabled you will see a progress bar when the debugger starts. If you do not want to see the progress bar and want that the debugger launches in the background you can enable this option.
- **Use linker/locator memory map file (.mdf) for memory map**

You can use this option to find errors in your application that cause access to non-existent memory or cause an attempt to write to read-only memory. When building your project, the linker/locator creates a memory description file (.mdf) file which describes the memory regions of the target you selected in your project properties. The debugger uses this file to initialize the debugging target.

This option is only useful in combination with a simulator as debug target. The debugger may fail to start if you use this option in combination with other debugging targets than a simulator.

### 7.4. Troubleshooting

If the debugger does not launch properly, this is likely due to mistakes in the settings of the execution environment or to an improper connection between the host computer and the execution environment. Always read the notes for your particular execution environment.

Some common problems you may check for, are:

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wrong device name in the launch configuration</td>
<td>Make sure the specified device name is correct.</td>
</tr>
<tr>
<td>Invalid baud rate</td>
<td>Specify baud rate that matches the baud rate the execution environment is configured to expect.</td>
</tr>
<tr>
<td>No power to the execution environment.</td>
<td>Make sure the execution environment or attached probe is powered.</td>
</tr>
<tr>
<td>Cable connected to the wrong port on the execution environment or host.</td>
<td>Some target machines and hosts have several ports. Make sure you connect the cable to the correct port.</td>
</tr>
<tr>
<td>Conflict between communication ports.</td>
<td>A device driver or background application may use the same communications port on the host system as the debugger. Disable any service that uses the same port-number or choose a different port-number if possible.</td>
</tr>
<tr>
<td>Port already in use by another user.</td>
<td>The port may already be in use by another user on some UNIX hosts, or being allocated by a login process. Some target machines and hosts have several ports. Make sure you connect the cable to the correct port.</td>
</tr>
</tbody>
</table>

If the program state shown by the debugger appears to deviate from the true state, check that the linker option 'Include debugger synchronization utility' is enabled.

### 7.5. TASKING Debug Perspective

After you have launched the debugger, you are either asked if the TASKING Debug perspective should be opened or it is opened automatically. The Debug perspective consists of several views.

To open views in the Debug perspective:
1. Make sure the Debug perspective is opened

2. From the Window menu, select Show View »

3. Select a view from the menu or choose Other... for more views.

By default, the Debug perspective is opened with the following views:

![Debug Perspective](image)

### 7.5.1. Debug View

The Debug view shows the target information in a tree hierarchy shown below with a sample of the possible icons:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Session item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Launch" /></td>
<td>Launch instance</td>
<td>Launch configuration name and launch type</td>
</tr>
<tr>
<td><img src="image" alt="Debugger" /></td>
<td>Debugger instance</td>
<td>Debugger name and state</td>
</tr>
<tr>
<td><img src="image" alt="Thread" /></td>
<td>Thread instance</td>
<td>Thread number and state</td>
</tr>
<tr>
<td><img src="image" alt="Stack frame" /></td>
<td>Stack frame instance</td>
<td>Stack frame number, function, file name, and file line number</td>
</tr>
</tbody>
</table>
Stack display

During debugging (running) the actual stack is displayed as it increases or decreases during program execution. By default, all views present information that is related to the current stack item (variables, memory, source code etc.). To obtain the information from other stack items, click on the item you want.

The Debug view displays stack frames as child elements. It displays the reason for the suspension beside the thread, (such as end of stepping range, breakpoint hit, and signal received). When a program exits, the exit code is displayed.

The Debug view contains numerous functions for controlling the individual stepping of your programs and controlling the debug session. You can perform actions such as terminating the session and stopping the program. All functions are available from the right-click menu, though commonly used functions are also available from the toolbar.

Controlling debug sessions

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✗</td>
<td>Remove all</td>
<td>Removes all terminated launches.</td>
</tr>
<tr>
<td>🔄</td>
<td>Reset target system</td>
<td>Resets the target system. Registers that have the init resource set in the .dtc file, are reset to their default value. Execution stops at the reset vector.</td>
</tr>
<tr>
<td>🔄</td>
<td>Restart</td>
<td>Resets the target system and restarts the application. The application stops executing when it reaches the first C instruction in the function main().</td>
</tr>
<tr>
<td>✔️</td>
<td>Resume</td>
<td>Resumes the application after it was suspended (manually, breakpoint, signal).</td>
</tr>
<tr>
<td>🕒</td>
<td>Suspend</td>
<td>Suspends the application (pause). Use the Resume button to continue.</td>
</tr>
<tr>
<td>🔄</td>
<td>Relaunch</td>
<td>Right-click menu. Restarts the selected debug session when it was terminated. If the debug session is still running, a new debug session is launched.</td>
</tr>
<tr>
<td>🔄</td>
<td>Reload current application</td>
<td>Reloads the current application without restarting the debug session. The application does restart of course.</td>
</tr>
<tr>
<td>✗</td>
<td>Terminate</td>
<td>Ends the selected debug session and/or process. Use Relaunch to restart this debug session, or start another debug session.</td>
</tr>
<tr>
<td>✗</td>
<td>Terminate all</td>
<td>Right-click menu. As terminate. Ends all debug sessions.</td>
</tr>
<tr>
<td>✗</td>
<td>Terminate and remove</td>
<td>Right-click menu. Ends the debug session and removes it from the Debug view.</td>
</tr>
<tr>
<td>✗</td>
<td>Terminate and Relaunch</td>
<td>Right-click menu. Ends the debug session and relaunches it. This is the same as choosing Terminate and then Relaunch.</td>
</tr>
<tr>
<td>🕒</td>
<td>Disconnect</td>
<td>Detaches the debugger from the selected process (useful for debugging attached processes).</td>
</tr>
</tbody>
</table>
Stepping through the application

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="icon" /></td>
<td>Step into</td>
<td>Steps to the next source line or instruction.</td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
<td>Step over</td>
<td>Steps over a called function. The function is executed and the application suspends at the next instruction after the call.</td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
<td>Step return</td>
<td>Executes the current function. The application suspends at the next instruction after the return of the function.</td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
<td>Instruction stepping</td>
<td>Toggle. If enabled, the stepping functions are performed on instruction level instead of on C source line level.</td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
<td>Interrupt aware stepping</td>
<td>Toggle. If an interrupt source continues generating interrupts while the target is stopped (either manually or by hitting a breakpoint), a following single step will always enter the Interrupt Service Routine (ISR). This can lead to some problems during single stepping. With interrupt aware stepping enabled, interrupts are temporarily disabled after the target has stopped. When execution resumes the interrupts are restored.</td>
</tr>
</tbody>
</table>

Miscellaneous

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="icon" /></td>
<td>Copy Stack</td>
<td>Right-click menu. Copies the stack as text to the windows clipboard. You can paste the copied selection as text in, for example, a text editor.</td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
<td>Edit project...</td>
<td>Right-click menu. Opens the debug configuration dialog to let you edit the current debug configuration.</td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
<td>Edit Source Lookup...</td>
<td>Right-click menu. Opens the Edit Source Lookup Path window to let you edit the search path for locating source files.</td>
</tr>
</tbody>
</table>

7.5.2. Breakpoints View

You can add, disable and remove breakpoints by clicking in the marker bar (left margin) of the Editor view. This is explained in the Getting Started manual.

**Description**

The Breakpoints view shows a list of breakpoints that are currently set. The button bar in the Breakpoints view gives access to several common functions. The right-most button opens the Breakpoints menu.

**Types of breakpoints**

To access the breakpoints dialog, add a breakpoint as follows:

1. Click the **Add TASKING Breakpoint** button.

   The Breakpoints dialog appears.

Each tab lets you set a breakpoint of a specific type. You can set the following types of breakpoints:
• **File breakpoint**

If a debug session is active, the **File** drop-down box is filled with all source files as present in the debug information in the ELF file. This can include files not present in the Eclipse project (for example from libraries). If a file could be matched to a file in the active Eclipse project it will show as an Eclipse project relative filename.

The target halts when it reaches the specified line of the specified source file. Note that it is possible that a source line corresponds to multiple addresses, for example when a header file has been included into two different source files or when inlining has occurred. If so, the breakpoint will be associated with all those addresses. It is also possible that on some files no line breakpoints can be set because the debugger lacks line information.
The **Function** drop-down box is filled with all functions from the debug information and the symbol table (if not already in the debug information). You can use the **File** drop-down box to filter the list of functions. If you select `<all>` you will see the filenames (between parentheses) behind each entry in the **Function** drop-down box. Functions marked with `function_name [section]` originate from the symbol table. These functions are normally not associated with a filename and will therefore be included if `<unknown>` is selected in the **File** drop-down box. Functions marked `'filename'::function_name` are static functions.

The target halts when it reaches the first line of the specified function. Note that function breakpoints generally will not work on inlined instances of a function.
• **Code Address**

The target halts when it reaches the specified instruction address.

• **Data**

The **Variable** drop-down box is filled with all variables from the debug information and the symbol table (if not already in the debug information), but you can also enter text yourself. If a label is filled in, the size will be 1 MAU. You can use the **File** drop-down box to filter the list of variables. If you select <all> you will see the filenames (between parentheses) behind each entry in the **Variables** drop-down box. Variables marked with **variable_name [section]** originate from the symbol table. These variables are
normally not associated with a filename and will therefore be included if `<unknown>` is selected in the **File** drop-down box. Variables marked ‘filename’::variable_name are static.

The target halts when the given variable is read or written to, as specified.

- **Data Address**

  ![Data Address Window](image1)

  The target halts when the given memory range (specified in terms of an absolute **Address** and a **Length** in MAUs) is read or written to, as specified.

- **Stack**

  ![Stack Window](image2)

  ![Stack Window](image3)
The target halts when it reaches the specified stack level.

- **Instruction**

![Instruction Breakpoint Configuration](image)

The target halts when the given number of instructions (Count) has been executed.

- **Cycle**

![Cycle Breakpoint Configuration](image)

The target halts when the given number of clock cycles (Count) has elapsed.
• **Timer**

The target halts when the given amount of **Time** elapsed. The value entered is interpreted by the debug instrument.

In addition to the type of the breakpoint, you can specify the condition that must be met to halt the program.

In the **Condition** field, type a condition. The condition is an expression which evaluates to 'true' (non-zero) or 'false' (zero). The program only halts on the breakpoint if the condition evaluates to 'true'.

In the **Ignore count** field, you can specify the number of times the breakpoint is ignored before the program halts. For example, if you want the program to halt only in the fifth iteration of a while-loop, type '4': the first four iterations are ignored.

### 7.5.3. File System Simulation (FSS) View

**Description**

The File System Simulation (FSS) view is automatically opened when the target requests FSS input or generates FSS output. The virtual terminal that the FSS view represents, follows the VT100 standard. If you right-click in the view area of the FSS view, a menu is presented which gives access to some self-explanatory functions.

**VT100 characteristics**

The queens example demonstrates some of the VT100 features. (You can find the queens example in the `<TriCore installation path>`\examples directory from where you can import it into your workspace.) Per debugging session, you can have more than one FSS view, each of which is associated with a positive integer. By default, the view "FSS #1" is associated with the standard streams stdin, stdout, stderr and stdaux. Other views can be accessed by opening a file named "terminal window `<number>`", as shown in the example below.
FILE * f3 = fopen("terminal window 3", "rw");
fprintf(f3, "Hello, window 3.\n");
fclose(f3);

You can set the initial working directory of the target application in the Debug configuration dialog (see also Section 7.3, Creating a Customized Debug Configuration):

1. On the Debugger tab, select the Miscellaneous sub-tab.
2. In the FSS root directory field, specify the FSS root directory.

The FSS implementation is designed to work without user intervention. Nevertheless, there are some aspects that you need to be aware of.

First, the interaction between the C library code (in the files dbg*.c and dbg*.h; see Section 10.1.5, dbg.h) and the debugger takes place via a breakpoint, which incidentally is not shown in the Breakpoints view. Depending on the situation this may be a hardware breakpoint, which may be in short supply.

Secondly, proper operation requires certain code in the C library to have debug information. This debug information should normally be present but might get lost when this information is stripped later in the development process.

### 7.5.4. Disassembly View

The Disassembly view shows target memory disassembled into instructions and / or data. If possible, the associated C / C++ source code is shown as well. The Address field shows the address of the current selected line of code.

To view the contents of a specific memory location, type the address in the Address field. If the address is invalid, the field turns red.

### 7.5.5. Expressions View

The Expressions view allows you to evaluate and watch regular C expressions.

To add an expression:

Click OK to add the expression.

1. Right-click in the Expressions View and select Add Watch Expression.

   The Add Watch Expression dialog appears.

2. Enter an expression you want to watch during debugging, for example, the variable name "i"

If you have added one or more expressions to watch, the right-click menu provides options to Remove and Edit or Enable and Disable added expressions.

- You can access target registers directly using #NAME. For example "arr[\#R0 << 3]" or "#TIMER3 = m++". If a register is memory-mapped, you can also take its address, for example, "#ADCIN".
Expressions may contain target function calls like for example "g1 + invert(&g2)". Be aware that this will not work if the compiler has optimized the code in such a way that the original function code does not actually exist anymore. This may be the case, for example, as a result of inlining. Also, be aware that the function and its callees use the same stack(s) as your application, which may cause problems if there is too little stack space. Finally, any breakpoints present affect the invoked code in the normal way.

7.5.6. Memory View

Use the Memory view to inspect and change process memory. The Memory view supports the same addressing as the C language. You can address memory using expressions such as:

- 0x0847d3c
- (&y)+1024
- *ptr

Monitors

To monitor process memory, you need to add a monitor:

1. In the Debug view, select a debug session. Selecting a thread or stack frame automatically selects the associated session.

2. Click the Add Memory Monitor button in the Memory Monitors pane.

   The Monitor Memory dialog appears.

3. Type the address or expression that specifies the memory section you want to monitor and click OK.

   The monitor appears in the monitor list and the Memory Renderings pane displays the contents of memory locations beginning at the specified address.

To remove a monitor:

1. In the Monitors pane, right-click on a monitor.

2. From the popup menu, select Remove Memory Monitor.

Renderings

You can inspect the memory in so-called renderings. A rendering specifies how the output is displayed: hexadecimal, ASCII, signed integer, unsigned integer or traditional. You can add or remove renderings per monitor. Though you cannot change a rendering, you can add or remove them:

1. Click the New Renderings... tab in the Memory Renderings pane.

   The Add Memory Rendering dialog appears.

2. Select the rendering you want (Traditional, Hex, ASCII, Signed Integer, Unsigned Integer or Hex Integer) and click Add Rendering(s).
To remove a rendering:

1. Right-click on a memory address in the rendering.
2. From the popup menu, select Remove Rendering.

**Changing memory contents**

In a rendering you can change the memory contents. Simply type a new value.

---

**Warning**: Changing process memory can cause a program to crash.

The right-click popup menu gives some more options for changing the memory contents or to change the layout of the memory representation.

### 7.5.7. Compare Application View

You can use the Compare Application view to check if the downloaded application matches the application in memory. Differences may occur, for example, if you changed memory addresses in the Memory view.

- To check for differences, click the **Compare** button.

### 7.5.8. Heap View

With the Heap view you can inspect the status of the heap memory. This can be illustrated with the following example:

```c
string = (char *) malloc(100);
strcpy ( string, "abcdefgh" );
free (string);
```

If you step through these lines during debugging, the Heap view shows the situation after each line has been executed. Before any of these lines has been executed, there is no memory allocated and the Heap view is empty.

- After the first line the Heap view shows that memory is occupied, the description tells where the block starts, how large it is (100 MAUs) and what its content is (0x0, 0x0, ...).

- After the second line, "abcdefgh" has been copied to the allocated block of memory. The description field of the Heap view again shows the actual contents of the memory block (0x61, 0x62, ...).

- The third line frees the memory. The Heap view is empty again because after this line no memory is allocated anymore.

### 7.5.9. Logging View

Use the Logging view to control the generation of internal log files. This view is intended mainly for use by or at the request of Altium support personnel.
7.5.10. RTOS View

The debugger has special support for debugging real-time operating systems (RTOSs). This support is implemented in an RTOS-specific shared library called a *kernel support module* (KSM) or *RTOS-aware debugging module* (RADM). Specifically, the TASKING VX-toolset for TriCore ships with a KSM supporting the ISO 17356 standard. You have to create your own Run Time Interface (ORTI) and specify this file on the *Miscellaneous* tab while configuring a customized debug configuration (see also Section 7.3, *Creating a Customized Debug Configuration*):

1. From the **Debug** menu, select **Debug Configurations...**
   
   The **Debug Configurations** dialog appears.

2. In the left pane, select the configuration you want to change, for example, **TASKING C/C++ Debugger » myproject**.
   
   Or: click the **New launch configuration** button (dı) to add a new configuration.

3. Open the **Miscellaneous** tab

4. In the **ORTI file** field, specify the name of your own ORTI file.

5. If you want to use the supplied KSM suitable for RTOS kernels, in the **KSM module** field browse for the file *orti_radm.dll* (Windows) or *orti_radm.so* (UNIX) in the *ctc\bin* directory of the toolset.

   The debugger supports ORTI specifications v2.0 and v2.1.

7.5.11. Registers View

In the Registers view you can examine the value of registers while stepping through your application. The registers are organized in a number of *register groups*, which together contain all known registers. You can select a group to see which registers it contains. This view has a number of features:

- While you step through the application, the registers involved in the step turn yellow. If you scroll in the view or switch groups, some registers may appear on a lighter yellow background, indicating that the debugger does not know whether the registers have changed because the debugger did not read the registers before the step began.
• You can change each register's value.

• For some registers the menu entry **Symbolic Representation** is available in their right-click popup menu. This opens a new view which shows the internal fields of the register. (Alternatively, you can double-click on a register). For example, the SBCU_CON register from the SBCU group may be shown as follows:

![SCU_CCUCON0](image)

In this view you can set the individual values in the register, either by selecting a value from a drop-down box or by simply entering a value depending on the chosen field. To update the register with the new values, click the **Write** button.

• You can search for a specific register: right-click on a register and from the popup menu select **Find Register**.... Enter a group or register name filter, click the register you want to see and click **OK**. The register of your interest will be shown in the view.

### 7.5.12. Trace View

If tracing is enabled, the Trace view shows the code was most recently executed. For example, while you step through the application, the Trace view shows the executed code of each step. To enable tracing:

• Right-click in the Trace view and select **Trace**.
A check mark appears when tracing is enabled.

The view has three tabs, **Source**, **Instruction** and **Raw**, each of which represents the trace in a different way. However, not all target environments will support all three of these. The view is updated automatically each time the target halts.

### 7.6. PCP Simulator Configuration

To simulate the Peripheral Control Processor (PCP), the standard TriCore Instruction Set Simulator (ISS) starts a PCP plugin simulator (pcp). This is set up in a configuration file named `DConfig` that is located in the `etc` directory. This file tells the TriCore ISS to start up the PCP plugin with the specified options.

The available command line options for the PCP plugin simulator are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-cmem_base address</code></td>
<td>Code memory address configuration</td>
<td>0xf0020000</td>
</tr>
<tr>
<td><code>-cmem_size size</code></td>
<td>Code memory size configuration</td>
<td>0x4000</td>
</tr>
<tr>
<td><code>-pram_base address</code></td>
<td>Parameter memory address configuration</td>
<td>0xf0010000</td>
</tr>
<tr>
<td><code>-pram_size size</code></td>
<td>Parameter memory size configuration</td>
<td>0x1000</td>
</tr>
<tr>
<td><code>-preg_base address</code></td>
<td>PCP register memory address configuration</td>
<td>0xf0003f00</td>
</tr>
<tr>
<td><code>-preg_size size</code></td>
<td>PCP register memory size configuration</td>
<td>0xcd</td>
</tr>
<tr>
<td><code>-psrn_base address</code></td>
<td>PCP service register node memory address configuration</td>
<td>0xf0003fd0</td>
</tr>
<tr>
<td><code>-psrn_size size</code></td>
<td>PCP service register node memory size configuration</td>
<td>0x30</td>
</tr>
</tbody>
</table>

If a non default derivative is used, it might be necessary to change the options in this file. The default derivative for the simulator is the TC1796B.
Chapter 8. Tool Options

This chapter provides a detailed description of the options for the compiler, assembler, linker, control program, make utility and the archiver.

Tool options in Eclipse (Menu entry)

For each tool option that you can set from within Eclipse, a Menu entry description is available. In Eclipse you can customize the tools and tool options in the following dialog:

1. From the Project menu, select Properties

   The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Settings.

   In the right pane the Settings appear.

3. Open the Tool Settings tab.

   You can set all tool options here.

   Unless stated otherwise, all Menu entry descriptions expect that you have this Tool Settings tab open.

The following tables give an overview of all tool options on the Tool Settings tab in Eclipse with hyperlinks to the corresponding command line options (if available).

Global Options

<table>
<thead>
<tr>
<th>Eclipse option</th>
<th>Description or option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use global 'product directory' preference</td>
<td>Directory where the TASKING toolset is installed</td>
</tr>
<tr>
<td>Treat warnings as errors</td>
<td>Control program option --warnings-as-errors</td>
</tr>
<tr>
<td>Keep temporary files</td>
<td>Control program option --keep-temporary-files (-t)</td>
</tr>
<tr>
<td>Verbose mode of control program</td>
<td>Control program option --verbose (-v)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Channel Configuration</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Prefix for global symbols</td>
<td>C compiler option --symbol-prefix</td>
</tr>
<tr>
<td>Allow channel to be interruptible</td>
<td>C compiler option --interrupt-enable</td>
</tr>
<tr>
<td>Preserve R7 flags 0..7</td>
<td>C compiler option --preserve-r7-flags</td>
</tr>
</tbody>
</table>
C Compiler

<table>
<thead>
<tr>
<th>Description or option</th>
<th>C compiler option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preprocessing</td>
<td></td>
</tr>
<tr>
<td>Automatic inclusion of <code>.sfr</code> file</td>
<td>--include-file</td>
</tr>
<tr>
<td>Store preprocessor output in <code>&lt;file&gt;.pre</code></td>
<td>--preprocess=+comments</td>
</tr>
<tr>
<td>Keep comments in preprocessor output</td>
<td>--preprocess=-noline</td>
</tr>
<tr>
<td>Keep #line info in preprocessor output</td>
<td></td>
</tr>
<tr>
<td>Defined symbols</td>
<td>--define</td>
</tr>
<tr>
<td>Pre-include files</td>
<td>--include-file</td>
</tr>
<tr>
<td>Include Paths</td>
<td></td>
</tr>
<tr>
<td>Include paths</td>
<td>--include-directory</td>
</tr>
<tr>
<td>Language</td>
<td></td>
</tr>
<tr>
<td>Comply to C standard</td>
<td>--iso</td>
</tr>
<tr>
<td>Allow GNU C extensions</td>
<td>--language=+gcc</td>
</tr>
<tr>
<td>Allow // comments in ISO C90 mode</td>
<td>--language=+comments</td>
</tr>
<tr>
<td>Check assignment of string literal to non-const string pointer</td>
<td>--language=-strings</td>
</tr>
<tr>
<td>Treat 'char' variables as unsigned</td>
<td>--uchar</td>
</tr>
<tr>
<td>Treat 'int' bit-fields as signed</td>
<td>--signed-bitfields</td>
</tr>
<tr>
<td>Allow optimization across volatile access</td>
<td>--language=volatile</td>
</tr>
<tr>
<td>Allow Shift JIS Kanji in strings</td>
<td>--language=+kanji</td>
</tr>
<tr>
<td>Floating-Point</td>
<td></td>
</tr>
<tr>
<td>Floating-point model</td>
<td>--fp-model</td>
</tr>
<tr>
<td>Code Generation</td>
<td></td>
</tr>
<tr>
<td>Maximum size for stack sections to align</td>
<td>--align-stack</td>
</tr>
<tr>
<td>Generate channel entry table</td>
<td>--no-channel-entry-table</td>
</tr>
<tr>
<td>Generate channel vectors</td>
<td>--no-vector</td>
</tr>
<tr>
<td>Allocation</td>
<td></td>
</tr>
<tr>
<td>Clear uninitialized global and static variables</td>
<td>--no-clear</td>
</tr>
<tr>
<td>Optimization</td>
<td></td>
</tr>
<tr>
<td>Optimization level</td>
<td>--optimize</td>
</tr>
<tr>
<td>Trade-off between speed and size</td>
<td>--tradeoff</td>
</tr>
<tr>
<td>Maximum size for code compaction</td>
<td>--compact-max-size</td>
</tr>
<tr>
<td>Always inline function calls</td>
<td>--inline</td>
</tr>
</tbody>
</table>
### Eclipse option | Description or option
---|---
Maximum size increment when inlining (in %) | C compiler option --inline-max-incr
Maximum size for functions to always inline | C compiler option --inline-max-size
Automatic memory partitioning | C compiler option --no-partition
Build for application wide optimizations (MIL linking) | Control program option --mil-link / --mil-split
Custom Optimization | C compiler option --optimize
Compilation Speed | C compiler option --cache

### Debugging
- Generate symbolic debug information | C compiler option --debug-info
- Generate control flow information | C compiler option --control-flow-info

### MISRA C
- MISRA C checking | C compiler option --misrac
- MISRA C version | C compiler option --misrac-version
- Warnings instead of errors for mandatory rules | C compiler option --misrac-mandatory-warnings
- Warnings instead of errors for required rules | C compiler option --misrac-required-warnings
- Warnings instead of errors for advisory rules | C compiler option --misrac-advisory-warnings
- Custom 1998 / Custom 2004 / Custom 2012 | C compiler option --misrac

### CERT C Secure Coding
- CERT C secure code checking | C compiler option --cert
- Warnings instead of errors | C compiler option --warnings-as-errors
- Custom CERT C | C compiler option --cert

### Diagnostics
- Suppress C compiler warnings | C compiler option --no-warnings=num
- Suppress all warnings | C compiler option --no-warnings
- Maximum number of emitted errors | C compiler option --error-limit

### Miscellaneous
- Merge C source code with generated assembly | C compiler option --source
- Additional options | C compiler options, Control program options

### Assembler

<table>
<thead>
<tr>
<th>Eclipse option</th>
<th>Description or option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preprocessing</td>
<td>Assembler option --preprocessor-type</td>
</tr>
</tbody>
</table>

---

245
### Eclipse option | Description or option
---|---
Automatic inclusion of `.def` file | Assembler option --include-file
Defined symbols | Assembler option --define
Pre-include files | Assembler option --include-file

#### Include Paths

Include paths | Assembler option --include-directory

#### Symbols

Generate symbolic debug | Assembler option --debug-info
Case insensitive identifiers | Assembler option --case-insensitive
Emit local EQU symbols | Assembler option --emit-locals=+equ
Emit local non-EQU symbols | Assembler option --emit-locals=+symbols
Set default symbol scope to global | Assembler option --symbol-scope

#### Optimization

Optimize instruction size | Assembler option --optimize=+instr-size

#### List File

Generate list file | Control program option --list-files
List ... | Assembler option --list-format
List section summary | Assembler option --section-info=+list

#### Diagnostics

Suppress warnings | Assembler option --no-warnings=num
Suppress all warnings | Assembler option --no-warnings
Display section summary | Assembler option --section-info=+console
Maximum number of emitted errors | Assembler option --error-limit

#### Miscellaneous

Allow Shift JIS Kanji in strings | Assembler option --kanji
Additional options | Assembler options

### Linker

#### Eclipse option | Description or option
---|---
Libraries

Link default libraries | Control program option --no-default-libraries
Rescan libraries to solve unresolved externals | Linker option --no-rescan
Libraries | The libraries are added as files on the command line.
Library search path | Linker option --library-directory

### Data Objects
### Tool Options

<table>
<thead>
<tr>
<th>Eclipse option</th>
<th>Description or option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data objects</td>
<td>Linker option --import-object</td>
</tr>
</tbody>
</table>

**Script File**

<table>
<thead>
<tr>
<th>Defined symbols</th>
<th>Linker option --define</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linker script file (.lsl)</td>
<td>Linker option --lsl-file</td>
</tr>
</tbody>
</table>

**Optimization**

<table>
<thead>
<tr>
<th>Delete unreferenced sections</th>
<th>Linker option --optimize=c</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use a 'first-fit decreasing' algorithm</td>
<td>Linker option --optimize=l</td>
</tr>
<tr>
<td>Compress copy table</td>
<td>Linker option --optimize=t</td>
</tr>
<tr>
<td>Delete duplicate code</td>
<td>Linker option --optimize=x</td>
</tr>
<tr>
<td>Delete duplicate data</td>
<td>Linker option --optimize=y</td>
</tr>
</tbody>
</table>

**Map File**

<table>
<thead>
<tr>
<th>Generate map file (.map)</th>
<th>Control program option --no-map-file</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate XML map file format (.mapxml) for map file viewer</td>
<td>Linker option --map-file=file.mapxml:XML</td>
</tr>
<tr>
<td>Include ...</td>
<td>Linker option --map-file-format</td>
</tr>
</tbody>
</table>

**Diagnostics**

<table>
<thead>
<tr>
<th>Suppress warnings</th>
<th>Linker option --no-warnings=num</th>
</tr>
</thead>
<tbody>
<tr>
<td>Suppress all warnings</td>
<td>Linker option --no-warnings</td>
</tr>
<tr>
<td>Maximum number of emitted errors</td>
<td>Linker option --error-limit</td>
</tr>
</tbody>
</table>

**Miscellaneous**

<table>
<thead>
<tr>
<th>Strip symbolic debug information</th>
<th>Linker option --strip-debug</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link case insensitive</td>
<td>Linker option --case-insensitive</td>
</tr>
<tr>
<td>Do not use standard copy table for initialization</td>
<td>Linker option --user-provided-initialization-code</td>
</tr>
<tr>
<td>Include debugger synchronization utility</td>
<td>Linker option --extern=_PCP_sync_on_halt</td>
</tr>
<tr>
<td>Additional options</td>
<td>Linker options</td>
</tr>
</tbody>
</table>

---

### 8.1. Configuring the Command Line Environment

If you want to use the tools on the command line (either using a Windows command prompt or using Solaris), you can set *environment variables*.

You can set the following environment variables:

<table>
<thead>
<tr>
<th>Environment variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASPCPINC</td>
<td>With this variable you specify one or more additional directories in which the assembler looks for include files. See Section 4.3, <em>How the Assembler Searches Include Files</em>.</td>
</tr>
<tr>
<td>Environment variable</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>CPCPCACHE</td>
<td>With this variable you specify a cache directory in which the C compiler can store intermediate results. See C compiler option: --cache.</td>
</tr>
<tr>
<td>CPCPINC</td>
<td>With this variable you specify one or more additional directories in which the C compiler looks for include files. See Section 3.4, How the Compiler Searches Include Files.</td>
</tr>
<tr>
<td>CCPCPBIN</td>
<td>When this variable is set, the control program prepends the directory specified by this variable to the names of the tools invoked.</td>
</tr>
<tr>
<td>LIBTC1V1_3 / LIBTC1V1_3_1 / LIBTC1V1_6</td>
<td>With these variables you specify one or more additional directories in which the linker looks for libraries. See Section 5.3.1, How the Linker Searches Libraries.</td>
</tr>
<tr>
<td>PATH</td>
<td>With this variable you specify the directory in which the executables reside. This allows you to call the executables when you are not in the bin directory. Usually your system already uses the PATH variable for other purposes. To keep these settings, you need to add (rather than replace) the path. Use a semicolon (;) to separate path names.</td>
</tr>
<tr>
<td>TMPDIR</td>
<td>With this variable you specify the location where programs can create temporary files. Usually your system already uses this variable. In this case you do not need to change it.</td>
</tr>
</tbody>
</table>

See the documentation of your operating system on how to set environment variables.
8.2. C Compiler Options

This section lists all C compiler options.

Options in Eclipse versus options on the command line

Most command line options have an equivalent option in Eclipse but some options are only available on the command line. Eclipse invokes the compiler via the control program. Therefore, it uses the syntax of the control program to pass options and files to the C compiler. If there is no equivalent option in Eclipse, you can specify a command line option in Eclipse as follows:

1. From the Project menu, select Properties for

   The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Settings.

   In the right pane the Settings appear.

3. On the Tool Settings tab, select C Compiler » Miscellaneous.

4. In the Additional options field, enter one or more command line options.

   Because Eclipse uses the control program, you have to precede the option with -Wc to pass the option via the control program directly to the C compiler.

Be aware that some command line options are not useful in Eclipse or just do not have any effect. For example, the option -n sends output to stdout instead of a file and has no effect in Eclipse.

Short and long option names

Options can have both short and long names. Short option names always begin with a single minus (-) character, long option names always begin with two minus (--) characters. You can abbreviate long option names as long as it forms a unique name. You can mix short and long option names on the command line.

Options can have flags or suboptions. To switch a flag ‘on’, use a lowercase letter or a longflag. To switch a flag off, use an uppercase letter or a longflag. Separate longflags with commas. The following two invocations are equivalent:

cpcp -Oac test.c

cpcp --optimize=+coalesce,+cse test.c

When you do not specify an option, a default value may become active.
**C compiler option: --align-stack**

**Menu entry**

1. Select **C Compiler » Code Generation**.
2. Enter a value in the **Maximum size for stack sections to align** field.

**Command line syntax**

```
--align-stack=value
```

Default: **--align-stack=64**

**Description**

Align static stack sections with size smaller than or equal to `value` so that these sections are not located over a page boundary. This optimization saves code because the DPTR does not have to be reloaded when it already contains the right page number.

The disadvantage is that data space is spilled for the alignment. The alignment must be a power of two in the range [1..64]. 1 equals to no alignment optimizations. The default value 64 turns on alignment optimization for all static sections.

**Example**

To align static stack sections with a size smaller than or equal to 32, enter:

```
cpcp --align-stack=32 test.c
```

The following invocation is not allowed, value is not a power of 2:

```
cpcp --align-stack=20 test.c  // not allowed
```

**Related information**

-
C compiler option: --atomic-divide-multiply

Menu entry
-

Command line syntax
--atomic-divide-multiply

Description
With this option atomic divide and multiply operations are generated. This option only has effect when
the channel is interruptible. This is when option --interrupt-enable is specified. Special care must be
taken when using multiply and divide sequences when a channel program is interruptible. In this case
the compiler makes sure that a sequence cannot be corrupted by the execution of multiply or divide
instructions executed by a higher priority channel. The compiler uses bit R7.IEN to ensure that a sequence
is not interruptible.

Example

cpcp --atomic-divide-multiply --interrupt-enable test.c

The compiler adds CLR and SET instructions around the atomic divide and multiply operations:

```
clr    r7,5
dinit  r5,r1 ; this part is uninterruptible
dstep  r5,r1
dstep  r5,r1
dstep  r5,r1
dstep  r5,r1
set    r7,5
```

Related information

C compiler option --interrupt-enable (Enable interrupts)
C compiler option: --cache

Menu entry
1. Select C Compiler » Optimization » Compilation Speed.
2. Enable the option Cache generated code to improve the compilation speed.
3. In the Directory for cached files field, enter the name for the location of the cache.

Command line syntax

```
--cache [=directory]
```

Default on command line: . (current directory)

Default in Eclipse: .cache directory under project directory

Description

This option enables a cache for output files in the specified directory. When the source code after preprocessing and relevant compiler options and the compiler version are the same as in a previous invocation, the previous result is copied to the output file. The cache only works when there is a single C input file and a single output file (no --mil-split).

You can also enable the cache and specify the cache directory with the environment variable CPCPCACHE. This option takes precedence over the environment variable.

The cache directory may be shared, for instance by placing it on a network drive.

The compiler creates a directory cpcpcache in the directory specified with the option --cache or the environment variable CPCPCACHE. The directory is only created when it does not yet exist. The cache files are stored in this directory.

Example

To improve the compilation speed and put cached files in directory .cache, enter:

```
cpcp --cache=.cache test.c
```

Related information

Section 9.6, Compiler Cache
Section 6.5, Expire Cache Utility
**C compiler option: --cert**

**Menu entry**

1. Select **C Compiler » CERT C Secure Coding**.
2. Make a selection from the **CERT C secure code checking** list.
3. If you selected **Custom**, expand the **Custom CERT C** entry and enable one or more individual recommendations/rules.

**Command line syntax**

```
--cert={all | name[-name],...}
```

Default format: all

**Description**

With this option you can enable one or more checks for CERT C Secure Coding Standard recommendations/rules. When you omit the argument, all checks are enabled. `name` is the name of a CERT recommendation/rule, consisting of three letters and two digits. Specify only the three-letter mnemonic to select a whole category. For the list of names you can use, see Chapter 15, *CERT C Secure Coding Standard*.

On the command line you can use `--diag=cert` to see a list of the available checks, or you can use a three-letter mnemonic to list only the checks in a particular category. For example, `--diag=pre` lists all supported preprocessor checks.

**Example**

To enable the check for CERT rule STR30-C, enter:

```
cpcp --cert=str30 test.c
```

**Related information**

Chapter 15, *CERT C Secure Coding Standard*

C compiler option --diag (Explanation of diagnostic messages)
C compiler option: --check

Menu entry

--check

Description
With this option you can check the source code for syntax errors, without generating code. This saves time in developing your application because the code will not actually be compiled.

The compiler reports any warnings and/or errors.

This option is available on the command line only.

Related information
Assembler option --check (Check syntax)
**C compiler option: --compact-max-size**

**Menu entry**

1. Select **C Compiler » Optimization**.

2. In the **Maximum size for code compaction** field, enter the maximum size of a match.

**Command line syntax**

```
--compact-max-size=value
```

Default: 200

**Description**

This option is related to the compiler optimization **--optimize=+compact** (Code compaction or reverse inlining). Code compaction is the opposite of inlining functions: large sequences of code that occur more than once, are transformed into a function. This reduces code size (possibly at the cost of execution speed).

However, in the process of finding sequences of matching instructions, compile time and compiler memory usage increase quadratically with the number of instructions considered for code compaction. With this option you tell the compiler to limit the number of matching instructions it considers for code compaction.

**Example**

To limit the maximum number of instructions in functions that the compiler generates during code compaction:

```
cpcp --optimize=+compact --compact-max-size=100 test.c
```

**Related information**

**C compiler option ** **--optimize=+compact** (Optimization: code compaction)
C compiler option: --control-flow-info

Menu entry

1. Select C Compiler » Debugging.
2. Select Generate control flow information.

Command line syntax

--control-flow-info

Description

Control flow information

With this option the compiler adds control flow information to the output file. The compiler generates a .debug_control_flow section which describes the basic blocks and their relations. This information can be used for code coverage analysis on optimized code.

Example

ccpc --control-flow-info test.c

Related information

C compiler option --debug-info (Debug information)
C compiler option: --debug-info (-g)

Menu entry

1. Select C Compiler » Debugging.
2. To generate symbolic debug information, select Default, Small set or Full. To disable the generation of debug information, select None.

Command line syntax

--debug-info [suboption]
-g [suboption]

You can set the following suboptions:

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>small</td>
<td>1</td>
<td>c</td>
<td>Emit small set of debug information.</td>
</tr>
<tr>
<td>default</td>
<td>2</td>
<td>d</td>
<td>Emit default symbolic debug information.</td>
</tr>
<tr>
<td>all</td>
<td>3</td>
<td>a</td>
<td>Emit full symbolic debug information.</td>
</tr>
</tbody>
</table>

Default: --debug-info (same as --debug-info=default)

Description

With this option you tell the compiler to add directives to the output file for including symbolic information. This facilitates high level debugging but increases the size of the resulting assembler file (and thus the size of the object file). For the final application, compile your C files without debug information.

The DWARF debug format allows for a flexible approach as to how much symbolic information is included, as long as the structure is valid. Adding all possible DWARF data for a program is not practical. The amount of DWARF information per compilation unit can be huge. And for large projects, with many object modules the link time can grow unacceptably long. That is why the compiler has several debug information levels. In general terms one can say, the higher the level the more DWARF information is produced.

The DWARF data in an object module is not only used for debugging. The toolset can also do "type checking" of the whole application. In that case the linker will use the DWARF information of all object modules to determine if every use of a symbol is done with the same type. In other words, if the application is built with type checking enabled then the compiler will add DWARF information too.

Small set of debug information

With this suboption only DWARF call frame information and type information are generated. This enables you to inspect parameters of nested functions. The type information improves debugging. You can perform a stack trace, but stepping is not possible because debug information on function bodies is not generated. You can use this suboption, for example, to compact libraries.
**Default debug information**

This provides all debug information you need to debug your application. It meets the debugging requirements in most cases without resulting in oversized assembler/object files.

**Full debug information**

With this suboption extra debug information is generated about unused typedefs and DWARF "lookup table sections". Under normal circumstances this extra debug information is not needed to debug the program. Information about unused typedefs concerns all typedefs, even the ones that are not used for any variable in the program. (Possibly, these unused typedefs are listed in the standard include files.) With this suboption, the resulting assembler/object file will increase significantly.

In the following table you see in more detail what DWARF information is included for the debug option levels.

<table>
<thead>
<tr>
<th>Feature</th>
<th>-g1</th>
<th>-g2</th>
<th>-g3</th>
<th>type check</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>basic info</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>info such as symbol name and type</td>
</tr>
<tr>
<td>call frame</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>this is information for a debugger to compute a stack trace when a program has stopped at a breakpoint</td>
</tr>
<tr>
<td>symbol lifetime</td>
<td></td>
<td>+</td>
<td>+</td>
<td></td>
<td>this is information about where symbols live (e.g. on stack at offset so and so, when the program counter is in this range)</td>
</tr>
<tr>
<td>line number info</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td></td>
<td>file name, line number, column number</td>
</tr>
<tr>
<td>&quot;lookup tables&quot;</td>
<td></td>
<td>+</td>
<td></td>
<td></td>
<td>DWARF sections ... this is an optimization for the DWARF data, it is not essential</td>
</tr>
<tr>
<td>unused typedefs</td>
<td></td>
<td></td>
<td>+</td>
<td></td>
<td>in the C code of the program there can be (many) typedefs that are not used for any variable. Sometimes this can cause enormous expansion of the DWARF data and thus it is only included in <strong>-g3</strong>.</td>
</tr>
</tbody>
</table>

**Related information**

-
C compiler option: --define (-D)

Menu entry
1. Select C Compiler » Preprocessing.

The Defined symbols box shows the symbols that are currently defined.
2. To define a new symbol, click on the Add button in the Defined symbols box.
3. Type the symbol definition (for example, demo=1)

Use the Edit and Delete button to change a macro definition or to remove a macro from the list.

Command line syntax

--define=macro_name[=macro_definition]
-Dmacro_name[=macro_definition]

Description
With this option you can define a macro and specify it to the preprocessor. If you only specify a macro name (no macro definition), the macro expands as ‘1’.

You can specify as many macros as you like. Simply use the Add button to add new macro definitions.

On the command line, you can use the option --define (-D) multiple times. If the command line exceeds the limit of the operating system, you can define the macros in an option file which you then must specify to the compiler with the option --option-file (-f) file.

Defining macros with this option (instead of in the C source) is, for example, useful to compile conditional C source as shown in the example below.

Example
Consider the following C program with conditional code to compile a demo program and a real program:

```c
void main( void )
{
#if DEMO
    demo_func();   /* compile for the demo program */
#else
    real_func();   /* compile for the real program */
#endif
}
```

Make sure you do not use a reserved keyword as a macro name, as this can lead to unexpected results.
You can now use a macro definition to set the DEMO flag:

```
cccp --define=DEMO test.c
cccp --define=DEMO=1 test.c
```

Note that both invocations have the same effect.

The next example shows how to define a macro with arguments. Note that the macro name and definition are placed between double quotes because otherwise the spaces would indicate a new option.

```
cccp --define="MAX(A,B)=((A) > (B) ? (A) : (B))" test.c
```

**Related information**

- **C compiler option** `--undefine` *(Remove preprocessor macro)*
- **C compiler option** `--option-file` *(Specify an option file)*
C compiler option: --dep-file

Menu entry

Eclipse uses this option in the background to create a file with extension .d (one for every input file).

Command line syntax

--dep-file [=file]

Description

With this option you tell the compiler to generate dependency lines that can be used in a Makefile. In contrast to the option --preprocess=+make, the dependency information will be generated in addition to the normal output file.

By default, the information is written to a file with extension .d (one for every input file). When you specify a filename, all dependencies will be combined in the specified file.

Example

cpcp --dep-file=test.dep test.c

The compiler compiles the file test.c, which results in the output file test.src, and generates dependency lines in the file test.dep.

Related information

C compiler option --preprocess=+make (Generate dependencies for make)
C compiler option: --diag

Menu entry

1. From the Window menu, select Show View » Other » TASKING » Problems.
   
   The Problems view is added to the current perspective.

2. In the Problems view right-click on a message.

   A popup menu appears.

3. Select Detailed Diagnostics Info.

   A dialog box appears with additional information.

Command line syntax

`--diag=[format:] {all | msg[-msg], ...}`

You can set the following output formats:

- `html`  
  HTML output.
- `rtf`  
  Rich Text Format.
- `text`  
  ASCII text.

Default format: text

Description

With this option you can ask for an extended description of error messages in the format you choose. The output is directed to stdout (normally your screen) and in the format you specify. The compiler does not compile any files. You can specify the following formats: `html`, `rtf` or `text` (default). To create a file with the descriptions, you must redirect the output.

With the suboption `all`, the descriptions of all error messages are given (except for the CERT checks). If you want the description of one or more selected error messages, you can specify the error message numbers, separated by commas, or you can specify a range.

With `--diag=cert` you can see a list of the available CERT checks, or you can use a three-letter mnemonic to list only the checks in a particular category. For example, `--diag=pre` lists all supported preprocessor checks.

Example

To display an explanation of message number 282, enter:

`cpcp --diag=282`

This results in the following message and explanation:
E282: unterminated comment

Make sure that every comment starting with /* has a matching */. Nested comments are not possible.

To write an explanation of all errors and warnings in HTML format to file cerrors.html, use redirection and enter:

cpcp --diag=html:all > cerrors.html

Related information

Section 3.8, C Compiler Error Messages

C compiler option --cert (Enable individual CERT checks)
C compiler option: --error-file

Menu entry

Command line syntax

```
--error-file[=file]
```

Description

With this option the compiler redirects diagnostic messages to a file. If you do not specify a filename, the error file will be named after the output file with extension `.err`.

Example

To write diagnostic messages to `errors.err` instead of `stderr`, enter:

```
cpcp --error-file=errors.err test.c
```

Related information

-
C compiler option: --error-limit

Menu entry
1. Select C Compiler » Diagnostics.
2. Enter a value in the Maximum number of emitted errors field.

Command line syntax

--error-limit=number

Default: 42

Description

With this option you limit the number of error messages in one compiler run to the specified number. When the limit is exceeded, the compiler aborts with fatal error message F105. Warnings and informational messages are not included in the count. When 0 (zero) or a negative number is specified, the compiler emits all errors. Without this option the maximum number of errors is 42.

Related information

Section 3.8, C Compiler Error Messages
C compiler option: --fp-model

Menu entry
1. Select C Compiler » Floating-Point.
2. Make a selection from the Floating-point model list.
3. If you selected Custom, enable one or more individual options.

Command line syntax

--fp-model=flags

You can set the following flags:

+/-contract     c/C     allow expression contraction
+/-fastlib      I/L     allow less precise library functions
+/-nonan        n/N     allow optimizations to ignore NaN/Inf
+/-rewrite      r/R     allow expression rewriting
+/-trap         t/T     support trapping on exceptions
+/-negzero      z/Z     ignore sign of -0.0

0     alias for --fp-model=CLNStZ (strict)
1     alias for --fp-model=cLNSTZ (precise)
2     alias for --fp-model=clnrTz (fast)

Default: --fp-model=clnrTz

Description
With this option you select the floating-point execution model.

With --fp-model=+contract you allow the compiler to contract multiple float operations into a single operation, with different rounding results. A possible example is fused multiply-add.

With --fp-model=+fastlib you allow the compiler to select faster but less accurate library functions for certain floating-point operations.

With --fp-model=+nonan you allow the compiler to ignore NaN or Inf input values. An example is to replace multiply by zero with zero.

With --fp-model=+rewrite you allow the compiler to rewrite expressions by reassociating. This might result in rounding differences and possibly different exceptions. An example is to rewrite \((a^c)+b^c\) as \((a+b)^c\).

With --fp-model=+trap operations trap on floating-point exceptions. Make sure you specify the corresponding trapping floating-point library to the linker.
With `--fp-model=+negzero` you allow the compiler to ignore the sign of -0.0 values. An example is to replace (a-a) by zero.

**Related information**

Pragmas STDC_FP_CONTRACT, fp_negzero, fp_nonan and fp_rewrite in Section 1.6, *Pragmas to Control the Compiler.*
C compiler option: --help (-?)

Menu entry
-

Command line syntax

--help[=item]
-?

You can specify the following arguments:

- **intrinsic**s i Show the list of intrinsic functions
- **options** o Show extended option descriptions
- **pragmas** p Show the list of supported pragmas
- **typedefs** t Show the list of predefined typedefs

Description

Displays an overview of all command line options. With an argument you can specify which extended information is shown.

Example

The following invocations all display a list of the available command line options:

```
cpcp -?
cpcp --help
cpcp
```

The following invocation displays a list of the available pragmas:

```
cpcp --help=pragmas
```

Related information
-

**C compiler option: --include-directory (-I)**

**Menu entry**

1. Select **C Compiler » Include Paths**.

   *The Include paths box shows the directories that are added to the search path for include files.*

2. To define a new directory for the search path, click on the **Add** button in the **Include paths** box.

3. Type or select a path.

   Use the **Edit** and **Delete** button to change a path or to remove a path from the list.

**Command line syntax**

```
--include-directory=path,...
-I path,...
```

**Description**

With this option you can specify the path where your include files are located. A relative path will be relative to the current directory.

The order in which the compiler searches for include files is:

1. The pathname in the C source file and the directory of the C source (only for #include files that are enclosed in "")
2. The path that is specified with this option.
3. The path that is specified in the environment variable **CPCPINC** when the product was installed.
4. The default directory `$(PRODDIR)\include` (unless you specified option **--no-stdinc**).

**Example**

Suppose that the C source file `test.c` contains the following lines:

```c
#include <stdio.h>
#include "myinc.h"
```

You can call the compiler as follows:

```
cpcp --include-directory=myinclude test.c
```

First the compiler looks for the file `stdio.h` in the directory `myinclude` relative to the current directory. If it was not found, the compiler searches in the environment variable and then in the default include directory.
The compiler now looks for the file `myinc.h` in the directory where `test.c` is located. If the file is not there the compiler searches in the directory `myinclude`. If it was still not found, the compiler searches in the environment variable and then in the default include directory.

**Related information**

C compiler option **--include-file** (Include file at the start of a compilation)

C compiler option **--no-stdinc** (Skip standard include files directory)
C compiler option: --include-file (-H)

Menu entry

1. Select C Compiler » Preprocessing.

   The Pre-include files box shows the files that are currently included before the compilation starts.

2. To define a new file, click on the Add button in the Pre-include files box.

3. Type the full path and file name or select a file.

   Use the Edit and Delete button to change a file name or to remove a file from the list.

Command line syntax

--include-file=file,...

-H file,...

Description

With this option you include one or more extra files at the beginning of each C source file, before other includes. This is the same as specifying #include "file" at the beginning of each of your C sources.

Example

cpcp --include-file=stdio.h test1.c test2.c

The file stdio.h is included at the beginning of both test1.c and test2.c.

Related information

C compiler option --include-directory (Add directory to include file search path)
C compiler option: --inline

Menu entry
1. Select C Compiler » Optimization.
2. Enable the option Always inline function calls.

Command line syntax
--inline

Description
With this option you instruct the compiler to inline calls to functions without the __noinline function qualifier whenever possible. This option has the same effect as a #pragma inline at the start of the source file.

This option can be useful to increase the possibilities for code compaction (C compiler option --optimize=+compact).

Example
To always inline function calls:

cpcp --optimize=+compact --inline test.c

Related information
C compiler option --optimize=+compact (Optimization: code compaction)
Section 1.9.3, Inlining Functions: inline
C compiler option: --inline-max-incr / --inline-max-size

Menu entry

1. Select C Compiler » Optimization.

2. In the Maximum size increment when inlining field, enter a value (default -1).

3. In the Maximum size for functions to always inline field, enter a value (default -1).

Command line syntax

```
--inline-max-incr=percentage (default: -1)
--inline-max-size=threshold (default: -1)
```

Description

With these options you can control the automatic function inlining optimization process of the compiler. These options only have effect when you have enabled the inlining optimization (option `--optimize=+inline` or `Optimize most`).

Regardless of the optimization process, the compiler always inlines all functions that have the function qualifier `inline`.

With the option `--inline-max-size` you can specify the maximum size of functions that the compiler inlines as part of the optimization process. The compiler always inlines all functions that are smaller than the specified `threshold`. The threshold is measured in compiler internal units and the compiler uses this measure to decide which functions are small enough to inline. The default threshold is -1, which means that the threshold depends on the option `--tradeoff`.

After the compiler has inlined all functions that have the function qualifier `inline` and all functions that are smaller than the specified threshold, the compiler looks whether it can inline more functions without increasing the code size too much. With the option `--inline-max-incr` you can specify how much the code size is allowed to increase. The default value is -1, which means that the value depends on the option `--tradeoff`.

Example

```
cpcp --optimize=+inline --inline-max-incr=40 --inline-max-size=15 test.c
```

The compiler first inlines all functions with the function qualifier `inline` and all functions that are smaller than the specified threshold of 15. If the code size has still not increased with 40%, the compiler decides which other functions it can inline.

Related information

C compiler option `--optimize=+inline` (Optimization: automatic function inlining)
Section 1.9.3, Inlining Functions: inline
Section 3.6.3, Optimize for Code Size or Execution Speed
C compiler option: --interrupt-enable

Menu entry
1. Select Global Options » Channel Configuration.
2. Enable the option Allow channel to be interruptible.

Command line syntax
--interrupt-enable

Description
With this option the interrupt flag of a channel is enabled. The code generated is interruptible for channels that do not have common functions using static stack. The R7.IEN flag is enabled in the register context table of a channel. The IEN flag and CEN flag are set for each PRAM access or they are preserved when you specify C compiler option --preserve-r7-flags.

Channels that have interrupts enabled must be linked separately. See linker option --link-only or C compiler option --mil.

Related information
Section 1.9.4.1, Defining an Interrupt Service Routine: __interrupt()
Section 1.10.2, Interruptible Code Generation
C compiler option: --iso (-c)

Menu entry
1. Select C Compiler » Language.
2. From the Comply to C standard list, select ISO C99, ISO C11, or ISO C90.

Command line syntax

--iso={90|99|11}
-c{90|99|11}

Default: --iso=11

Description

Example
To select the ISO C99 standard on the command line:

cpcp --iso=99 test.c

Related information
C compiler option --language (Language extensions)
C compiler option: --keep-output-files (-k)

Menu entry

Eclipse *always* removes the `.src` file when errors occur during compilation.

Command line syntax

```bash
--keep-output-files
-k
```

Description

If an error occurs during compilation, the resulting `.src` file may be incomplete or incorrect. With this option you keep the generated output file (.src) when an error occurs.

By default the compiler removes the generated output file (.src) when an error occurs. This is useful when you use the make utility. If the erroneous files are not removed, the make utility may process corrupt files on a subsequent invocation.

Use this option when you still want to inspect the generated assembly source. Even if it is incomplete or incorrect.

Example

```bash
cpcp --keep-output-files test.c
```

When an error occurs during compilation, the generated output file `test.src` will *not* be removed.

Related information

C compiler option **--warnings-as-errors** (Treat warnings as errors)
C compiler option: --language (-A)

Menu entry
1. Select C Compiler » Language.
2. Enable or disable one or more of the following options:
   - Allow GNU C extensions
   - Allow // comments in ISO C90 mode
   - Check assignment of string literal to non-‘const’ string pointer
   - Allow optimization across volatile access

Command line syntax
--language=[flags]
-A[flags]

You can set the following flags:

+/-gcc g/G enable a number of gcc extensions
+/-kanji k/K support for Shift JIS Kanji in strings
+/-comments p/P // comments in ISO C90 mode
+/-volatile v/V don't optimize across volatile access
+/-strings x/X relaxed const check for string literals

Default: -AGKpVx
Default (without flags): -AGKPVX

Description
With this option you control the language extensions the compiler can accept. By default the PCP C compiler allows all language extensions, except for gcc extensions.

The option --language (-A) without flags disables all language extensions.

GNU C extensions
The --language=+gcc (-Ag) option enables the following gcc language extensions:

- The identifier __FUNCTION__ expands to the current function name.
- Alternative syntax for variadic macros.
- Alternative syntax for designated initializers.
• Allow zero sized arrays.
• Allow empty struct/union.
• Allow unnamed struct/union fields.
• Allow empty initializer list.
• Allow initialization of static objects by compound literals.
• The middle operand of a ? : operator may be omitted.
• Allow a compound statement inside braces as expression.
• Allow arithmetic on void pointers and function pointers.
• Allow a range of values after a single case label.
• Additional preprocessor directive #warning.
• Allow comma operator, conditional operator and cast as lvalue.
• An inline function without "static" or "extern" will be global.
• An "extern inline" function will not be compiled on its own.

For a more complete description of these extensions, you can refer to the UNIX gcc info pages (info gcc).

**Shift JIS Kanji support**

With --language=+kanji (-Ak) you tell the compiler to support Shift JIS encoded Kanji multi-byte characters in strings, (wide) character constants and // comments. Without this option, encodings with 0x5c as the second byte conflict with the use of the backslash as an escape character. Shift JIS in /*...*/ comments is supported regardless of this option. Note that Shift JIS also includes Katakana and Hiragana.

**Comments in ISO C90 mode**

With --language=+comments (-Ap) you tell the compiler to allow C++ style comments (//) in ISO C90 mode (option --iso=90). In ISO C99 mode this style of comments is always accepted.

**Check assignment of string literal to non-const string pointer**

With --language=+strings (-Ax) you disable warnings about discarded const qualifiers when a string literal is assigned to a non-const pointer.

```c
char *p;
int main( void )
{
    p = "hello"; // with -AX the compiler issues warning W525
    return 0;
}
```
Optimization across volatile access

With the `--language=volatile` (-Av) option, the compiler will block optimizations when reading or writing a volatile object, by executing all memory and (SFR) register accesses before the access of the volatile object. The volatile access acts as a memory barrier. With this option you can prevent for example that code below the volatile object is optimized away to somewhere above the volatile object.

Example:

```c
extern unsigned int variable;
extern volatile unsigned int access;

void TestFunc( unsigned int flag )
{
    access = 0;
    variable |= flag;
    if( variable == 3 )
    {
        variable = 0;
    }
    variable |= 0x8000;
    access = 1;
}
```

Result with `--language=-volatile` (default):

```
_PCP_TestFunc: .type  func
    ld.i    r5,0x0
    ldl.il  r7,@DPTR(_PCP_access)         ; <== Volatile access
    st.pi   r5,[_PCP_access]              ; <== Volatile access
    ldl.il  r7,@DPTR(_PCP_variable)
    or.pi   r1,[_PCP_variable]
    comp.i  r1,0x3
    mov     r1,r5,cc_z
    set     r1,0xf
    ld.i    r5,0x1
    ldl.il  r7,@DPTR(_PCP_access)
    st.pi   r5,[_PCP_access]              ; <== Volatile access
    ldl.il  r7,@DPTR(_PCP_variable)
    st.pi   r1,[_PCP_variable]            ; <== Moved across volatile access
    jc.ia   r2,cc_uc
```

Result with `--language=+volatile`:

```
_PCP_TestFunc: .type  func
    ld.i    r5,0x0
    ldl.il  r7,@DPTR(_PCP_access)
    st.pi   r5,[_PCP_access]              ; <== Volatile access
    ldl.il  r7,@DPTR(_PCP_variable)
    or.pi   r1,[_PCP_variable]
    comp.i  r1,0x3
```
Note that the volatile behavior of the compiler with option `--language=-volatile` or `--language=+volatile` is ISO C compliant in both cases.

**Related information**

C compiler option `--iso` (ISO C standard)

Section 1.3, *Shift JIS Kanji Support*
C compiler option: --make-target

Menu entry
-

Command line syntax

--make-target=name

Description

With this option you can overrule the default target name in the make dependencies generated by the options --preprocess=+make (-Em) and --dep-file. The default target name is the basename of the input file, with extension .o.

Example

cpcp --preprocess=+make --make-target=mytarget.o test.c

The compiler generates dependency lines with the default target name mytarget.o instead of test.o.

Related information

C compiler option --preprocess=+make (Generate dependencies for make)
C compiler option --dep-file (Generate dependencies in a file)
C compiler option: --mil / --mil-split

Menu entry
1. Select C Compiler » Optimization.
2. Enable the option Build for application wide optimizations (MIL linking).

Command line syntax

--mil
--mil-split[=file,...]

Description

With option --mil the C compiler skips the code generator phase and writes the optimized intermediate representation (MIL) to a file with the suffix .mil. The C compiler accepts .mil files as input files on the command line.

Option --mil-split does the same as option --mil, but in addition, the C compiler splits the MIL representation and writes it to separate files with suffix .ms. One file is written for each input file or MIL library specified on the command line. The .ms files are only updated on a change. The C compiler accepts .ms files as input files on the command line.

With option --mil-split you can perform application-wide optimizations during the frontend phase by specifying all modules at once, and still invoke the backend phase one module at a time to reduce the total compilation time.

Optionally, you can specify another filename for the .ms file the C compiler generates. Without an argument, the basename of the C source file is used to create the .ms filename. Note that if you specify a filename, you have to specify one filename for every input file.

Note that with both options some extra strict type checking is done that can cause building to fail in a way that is unforeseen and difficult to understand. For example, when you use one of these options in combination with option --uchar and you link the MIL library, you might get the following error:

cpcp E289: ["..\.\.\..\strlen.c" 14/1] "strlen" redeclared with a different type

cpcp I802: ["installation-dir\cpcp\include\string.h" 44/17]
    previous declaration of "strlen"
1 errors, 0 warnings

This is caused by the fact that the MIL library is built without --uchar. You can workaround this problem by rebuilding the MIL libraries.

Related information

Section 3.1, Compilation Process

Control program option --mil-link / --mil-split
C compiler option: --misrac

Menu entry

1. Select C Compiler » MISRA C.
2. Make a selection from the MISRA C checking list.
3. If you selected Custom, expand the Custom 1998, Custom 2004 or Custom 2012 entry and enable one or more individual rules.

Command line syntax

--misrac={all | nr[-nr]},...

Description

With this option you specify to the compiler which MISRA C rules must be checked. With the option --misrac=all the compiler checks for all supported MISRA C rules.

Example

cpcp --misrac=9-13 test.c

The compiler generates an error for each MISRA C rule 9, 10, 11, 12 or 13 violation in file test.c.

Related information

Section 3.7.2, C Code Checking: MISRA C
C compiler option --misrac-mandatory-warnings
C compiler option --misrac-advisory-warnings
C compiler option --misrac-required-warnings
Linker option --misrac-report
C compiler option: --misrac-advisory-warnings / --misrac-required-warnings / --misrac-mandatory-warnings

Menu entry

1. Select C Compiler » MISRA C.
2. Make a selection from the MISRA C checking list.
3. Enable one or more of the options:
   - Warnings instead of errors for mandatory rules
   - Warnings instead of errors for required rules
   - Warnings instead of errors for advisory rules.

Command line syntax

--misrac-advisory-warnings
--misrac-required-warnings
--misrac-mandatory-warnings

Description

Normally, if an advisory rule, required rule or mandatory rule is violated, the compiler generates an error. As a consequence, no output file is generated. With this option, the compiler generates a warning instead of an error.

Related information

Section 3.7.2, C Code Checking: MISRA C

C compiler option --misrac

Linker option --misrac-report
C compiler option: --misrac-version

Menu entry

1. Select C Compiler » MISRA C.


Command line syntax

--misrac-version={1998 | 2004 | 2012}

Default: 2004

Description

MISRA C rules exist in three versions: MISRA C:1998, MISRA C:2004 and MISRA C:2012. By default, the C source is checked against the MISRA C:2004 rules. With this option you can select which version to use.

Related information

Section 3.7.2, C Code Checking: MISRA C

C compiler option --misrac
C compiler option: --no-channel-entry-table

Menu entry

1. Select C Compiler » Code Generation.
2. Disable the option Generate channel entry table.

Command line syntax

--no-channel-entry-table

Description

When you use this option no channel start instruction is generated in the Channel Entry Table for an interrupt function. You can use this option when "Channel Start at Context PC" is used (CS.RCB=False) and no EXIT instruction resets the PC to the Channel Entry Table location of that interrupt channel (EP=0).

Related information

Section 1.9.4.1, Defining an Interrupt Service Routine: __interrupt()
C compiler option: --no-clear

Menu entry

1. Select C Compiler » Allocation.
2. Disable the option Clear uninitialized global and static variables.

Command line syntax

--no-clear

Description

Normally uninitialized global/static variables are cleared at program startup. With this option you tell the compiler to generate code to prevent uninitialized global/static variables from being cleared at program startup.

This option applies to constant as well as non-constant variables.

Related information

Pragmas clear/noclear
**C compiler option: --no-partition**

**Menu entry**

1. Select **C Compiler » Optimization**.
2. Disable the option **Automatic memory partitioning**.

**Command line syntax**

```bash
--no-partition
```

**Description**

With this option you tell the compiler to disable automatic memory partitioning.

**Related information**

- **C compiler option --optimize** (Specify optimization level)
- Section 3.6.2, *Core Specific Optimizations (backend)*
C compiler option: --no-stdinc

Menu entry
1. Select C Compiler » Miscellaneous.
2. Add the option --no-stdinc to the Additional options field.

Command line syntax
--no-stdinc

Description
With this option you tell the compiler not to look in the default include directory relative to the installation directory, when searching for include files. This way the compiler only searches in the include file search paths you specified.

Related information
C compiler option --include-directory (Add directory to include file search path)

Section 3.4, How the Compiler Searches Include Files
C compiler option: --no-vector

Menu entry
1. Select C Compiler » Code Generation.
2. Disable the option Generate channel vectors.

Command line syntax

--no-vector

Description
With this option you tell the compiler not to generate code for channel vectors and channel context.

Related information
C compiler option: --no-warnings (-w)

Menu entry
1. Select C Compiler » Diagnostics.

   *The Suppress C compiler warnings box shows the warnings that are currently suppressed.*

2. To suppress a warning, click on the Add button in the Suppress warnings box.

3. Enter the numbers, separated by commas or as a range, of the warnings you want to suppress (for example 537, 538). Or you can use the Add button multiple times.

4. To suppress all warnings, enable the option Suppress all warnings.

   Use the Edit and Delete button to change a warning number or to remove a number from the list.

Command line syntax

```
--no-warnings [=number[-number],...]
-w [number[-number],...]
```

Description

With this option you can suppresses all warning messages or specific warning messages.

On the command line this option works as follows:

- If you do not specify this option, all warnings are reported.
- If you specify this option but without numbers, all warnings are suppressed.
- If you specify this option with a number or a range, only the specified warnings are suppressed. You can specify the option `--no-warnings=number` multiple times.

Example

To suppress warnings 537 and 538, enter:

```
cpcp test.c --no-warnings=537,538
```

Related information

C compiler option --warnings-as-errors (Treat warnings as errors)

Pragma warning
C compiler option: --optimize (-O)

Menu entry

1. Select C Compiler » Optimization.
2. Select an optimization level in the Optimization level box.

Command line syntax

```
--optimize [=flags]
-Oflags
```

You can set the following flags:

```
+/-coalesce   a/A  Coalescer: remove unnecessary moves
+/-ipro       b/B  Interprocedural register optimizations
+/-cse        c/C  Common subexpression elimination
+/-expression e/E  Expression simplification
+/-flow       f/F  Control flow simplification
+/-glo        g/G  Generic assembly code optimizations
+/-inline     i/I  Automatic function inlining
+/-loop       l/L  Loop transformations
+/-forward    o/O  Forward store
+/-propagate  p/P  Constant propagation
+/-compact    r/R  Code compaction (reverse inlining)
+/-subscript  s/S  Subscript strength reduction
+/-peephole   y/Y  Peephole optimizations
```

Use the following options for predefined sets of flags:

```
--optimize=0  -O0  No optimization
              Alias for -OaBCEFGILOPRSy

--optimize=1  -O1  Optimize
              Alias for -OabcefgILOPRSy
```

No optimizations are performed except for the coalescer (to allow better debug information). The compiler tries to achieve an optimal resemblance between source code and produced code. Expressions are evaluated in the same order as written in the source code, associative and commutative properties are not used.

```
--optimize=0  -O0  No optimization
              Alias for -OaBCEFGILOPRSy

--optimize=1  -O1  Optimize
              Alias for -OabcefgILOPRSy
```

Enables optimizations that do not affect the debug ability of the source code. Use this level when you encounter problems during debugging your source code with optimization level 2.
--optimize=2   -O2  Optimize more (default)  
   Alias for -OabcefgilopRSy

Enables more optimizations to reduce code size and/or execution time. This is the default optimization level.

--optimize=3   -O3  Optimize most  
   Alias for -OabcefgilopSy

This is the highest optimization level. Use this level to decrease execution time to meet your real-time requirements.

Default: --optimize=2

**Description**

With this option you can control the level of optimization. If you do not use this option, the default optimization level is *Optimize more* (option --optimize=2 or --optimize).

When you use this option to specify a set of optimizations, you can overrule these settings in your C source file with #pragma optimize flag/ #pragma endoptimize.

In addition to the option --optimize, you can specify the option --tradeoff (-t). With this option you specify whether the used optimizations should optimize for more speed (regardless of code size) or for smaller code size (regardless of speed).

**Example**

The following invocations are equivalent and result all in the default optimization set:

```c
    cpcp test.c
    cpcp --optimize=2 test.c
    cpcp -O2 test.c
    cpcp --optimize test.c
    cpcp -O test.c
    cpcp -OabcefgilopRSy test.c
    cpcp --optimize=+coalesce,+ipro,+cse,+expression,+flow, 
           +glo,-inline,+loop,+forward,+propagate, 
           +compact,+subscript,+peephole test.c
```

**Related information**

- **C compiler option --tradeoff** (Trade off between speed and size)
- **Pragma** optimize/endoptimize
- **Section 3.6, Compiler Optimizations**
C compiler option: --option-file (-f)

Menu entry

1. Select C Compiler » Miscellaneous.

2. Add the option --option-file to the Additional options field.

   Be aware that the options in the option file are added to the C compiler options you have set in the other pages. Only in extraordinary cases you may want to use them in combination.

Command line syntax

--option-file=file,...

-f file,...

Description

This option is primarily intended for command line use. Instead of typing all options on the command line, you can create an option file which contains all options and flags you want to specify. With this option you specify the option file to the compiler.

Use an option file when the command line would exceed the limits of the operating system, or just to store options and save typing.

You can specify the option --option-file multiple times.

Format of an option file

• Multiple arguments on one line in the option file are allowed.

• To include whitespace in an argument, surround the argument with single or double quotes.

• If you want to use single quotes as part of the argument, surround the argument by double quotes and vice versa:

"This has a single quote ' embedded"

'This has a double quote " embedded'

'This has a double quote " and a single quote "' embedded"

• When a text line reaches its length limit, use a \ to continue the line. Whitespace between quotes is preserved.

"This is a continuation \ line"

   -> "This is a continuation line"
• It is possible to nest command line files up to 25 levels.

**Example**

Suppose the file `myoptions` contains the following lines:

```plaintext
--debug-info
--define=DEMO=1
test.c
```

Specify the option file to the compiler:

```plaintext
cpcp --option-file=myoptions
```

This is equivalent to the following command line:

```plaintext
cpcp --debug-info --define=DEMO=1 test.c
```

**Related information**
C compiler option: --output (-o)

Menu entry

Eclipse names the output file always after the C source file.

Command line syntax

--output=file
-o file

Description

With this option you can specify another filename for the output file of the compiler. Without this option the basename of the C source file is used with extension .src.

Example

To create the file output.src instead of test.src, enter:

cpcp --output=output.src test.c

Related information

-
C compiler option: --preprocess (-E)

Menu entry
1. Select C Compiler » Preprocessing.
2. Enable the option Store preprocessor output in <file>.pre.
3. (Optional) Enable the option Keep comments in preprocessor output.
4. (Optional) Enable the option Keep #line info in preprocessor output.

Command line syntax
--preprocess [=flags]
-E[flags]

You can set the following flags:

<table>
<thead>
<tr>
<th>Flag</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>+/-comments</td>
<td>keep comments</td>
</tr>
<tr>
<td>+/-includes</td>
<td>generate a list of included source files</td>
</tr>
<tr>
<td>+/-list</td>
<td>generate a list of macro definitions</td>
</tr>
<tr>
<td>+/-make</td>
<td>generate dependencies for make</td>
</tr>
<tr>
<td>+/-noline</td>
<td>strip #line source position information</td>
</tr>
</tbody>
</table>

Default: –ECILMP

Description
With this option you tell the compiler to preprocess the C source. Under Eclipse the compiler sends the preprocessed output to the file name.pre (where name is the name of the C source file to compile). Eclipse also compiles the C source.

On the command line, the compiler sends the preprocessed file to stdout. To capture the information in a file, specify an output file with the option --output.

With --preprocess=+comments you tell the preprocessor to keep the comments from the C source file in the preprocessed output.

With --preprocess=+includes the compiler will generate a list of all included source files. The preprocessor output is discarded.

With --preprocess=+list the compiler will generate a list of all macro definitions. The preprocessor output is discarded.

With --preprocess=+make the compiler will generate dependency lines that can be used in a Makefile. The preprocessor output is discarded. The default target name is the basename of the input file, with the extension .o. With the option --make-target you can specify a target name which overrules the default target name.
With --preprocess=+noline you tell the preprocessor to strip the #line source position information (lines starting with #line). These lines are normally processed by the assembler and not needed in the preprocessed output. When you leave these lines out, the output is easier to read.

**Example**

cpcp --preprocess=+comments,+includes,-list,-make,-noline test.c --output=test.pre

The compiler preprocesses the file test.c and sends the output to the file test.pre. Comments and a list of all included source files are included but no list of macro definitions and no dependencies are generated and the line source position information is not stripped from the output file.

**Related information**

C compiler option --dep-file (Generate dependencies in a file)

C compiler option --make-target (Specify target name for -Em output)
C compiler option: --preserve-r7-flags

Menu entry
1. Select Global Options » Channel Configuration.
2. Enable the option Preserve R7 flags 0..7.

Command line syntax
--preserve-r7-flags

Description
With this option the R7 flags are preserved for PRAM access. When accessing the PRAM, which requires loading of R7.DPTR, the IEN and CEN flags in register R7 are preserved. By default the R7 flag registers are not preserved, all flags are cleared for each PRAM access.

Related information
C compiler option --interrupt-enable (enable interrupts)
C compiler option: --relax-compact-name-check

Menu entry
1. Select C Compiler » Miscellaneous.
2. Add the option --relax-compact-name-check to the Additional options field.

Command line syntax

--relax-compact-name-check

Description

With code compaction (reverse inlining), chunks of code that can occur more than once in different functions, are transformed into another function. Chunks of code that are part of functions with a different section rename suffix are not taken into account. With this option the compiler does not perform this section name check, but performs code compaction whenever possible.

Related information

Section 3.6.2, Core Specific Optimizations (backend)
C compiler option: --relax-overlay-name-check

Menu entry
1. Select C Compiler » Miscellaneous.
2. Add the option --relax-overlay-name-check to the Additional options field.

Command line syntax
--relax-overlay-name-check

Description
This option relaxes the overlaying of romdata for internal constants, string literals and compound literals. Romdata for internals are overlaid when equal. By default, the compiler only performs overlaying on equal romdata for internals that have the same memory space and section rename suffix. With this option the compiler does not perform this overlay name check, but performs overlaying whenever possible.

Related information
-
C compiler option: --rename-sections (-R)

Menu entry
1. Select C Compiler » Miscellaneous.
2. Add the option --rename-sections to the Additional options field.

Command line syntax

```
--rename-sections=[type=]format_string[,][type=]format_string]...
-R[type=]format_string[,][type=]format_string]...
```

Description

In case a module must be loaded at a fixed address, or a data section needs a special place in memory, you can use this option to generate different section names. You can then use this unique section name in the linker script file for locating.

With the memory type you select which sections are renamed. The matching sections will get the specified format_string for the section name. The types you can use are: data and code. The format string can contain characters and may contain the following format specifiers:

```
{attrib}   section attributes, separated by underscores
{module}   module name
{name}     object name, name of variable or function
{type}     section type
```

Instead of this option you can also uses the pragmas section/endsection in the C source.

Example

To rename sections of memory type data to .pcpdata.cpcp_test_variable_name:

```
cpcp --rename-sections=data=cpcp_{module}_{name} test.c
```

Related information

See assembler directive .SDECL for a list of section types and attributes.

Pragmas section/endsection

Section 1.11, Compiler Generated Sections
C compiler option: --signed-bitfields

Menu entry
1. Select C Compiler » Language.
2. Enable the option Treat 'int' bit-fields as signed.

Command line syntax
--signed-bitfields

Description
For bit-fields it depends on the implementation whether a plain int is treated as signed int or unsigned int. By default an int bit-field is treated as unsigned int. This offers the best performance. With this option you tell the compiler to treat int bit-fields as signed int. In this case, you can still add the keyword unsigned to treat a particular int bit-field as unsigned.

Related information
Section 1.1, Data Types
C compiler option: --silicon-bug

Menu entry

1. Expand C/C++ Build and select Processor.
2. From the Processor Selection list, select a processor.
   The CPU Problem Bypasses and Checks box shows the available workarounds/checks available for the selected processor.
3. (Optional) Select Show all CPU problem bypasses and checks.
4. Click Select All or select one or more individual options.

Command line syntax

--silicon-bug=arg,...

You can give the following argument:

    pcp-tc038  Workaround for CPU_TC.038

Description

With this option you specify for which hardware problems the compiler should generate workarounds. Please refer to Chapter 14, CPU Problem Bypasses and Checks for more information about the individual problems and workarounds.

Example

To enable workarounds for problem PCP_TC.038, enter:

    cpcp --silicon-bug=pcp-tc038 test.c

Related information

Chapter 14, CPU Problem Bypasses and Checks

Assembler option --silicon-bug
**C compiler option: --source (-s)**

**Menu entry**

1. Select C Compiler » Miscellaneous.
2. Enable the option **Merge C source code with generated assembly.**

**Command line syntax**

--source

-s

**Description**

With this option you tell the compiler to merge C source code with generated assembly code in the output file. The C source lines are included as comments.

**Related information**

Pragmas source/nosource
C compiler option: --static

Menu entry

Command line syntax

--static

Description

With this option, the compiler treats external definitions at file scope (except for main) as if they were declared static. As a result, unused functions will be eliminated, and the alias checking algorithm assumes that objects with static storage cannot be referenced from functions outside the current module.

This option only makes sense when you specify all modules of an application on the command line.

To overrule this option for a specific function or variable, you can use the export attribute. For example, when a variable is accessed from assembly:

```c
int i __attribute__((export)); /* 'i' has external linkage */
```

With the export attribute the compiler will not perform optimizations that affect the unknown code.

Example

```bash
cpcp --static module1.c module2.c module3.c ...
```

Related information
C compiler option: --stdout (-n)

Menu entry

Command line syntax

--stdout

-n

Description

With this option you tell the compiler to send the output to stdout (usually your screen). No files are created. This option is for example useful to quickly inspect the output or to redirect the output to other tools.

Related information

-
C compiler option: --symbol-prefix

Menu entry

1. Select Global Options » Channel Configuration.
2. Enter a Prefix for global symbols.

Command line syntax

--symbol-prefix\=name

Default: --symbol-prefix=_PCP

Description

With this option you can define what prefix is used for global symbols. When you link a TriCore application with a PCP application it is required to prefix the PCP global symbols to avoid duplicate name conflicts between the TriCore and PCP application parts. By default global symbols are prefixed with _PCP. When you link multiple PCP channels separately it is required that each channel uses its own global symbol prefix.

Note that the compiler adds an extra underscore to this prefix. For example, the function main will get the symbol name _PCPmain.

Related information

Assembler option --symbol-prefix
C compiler option: --tradeoff (-t)

Menu entry
1. Select C Compiler » Optimization.
2. Select a trade-off level in the Trade-off between speed and size box.

Command line syntax

```
--tradeoff={0|1|2|3|4}
-t{0|1|2|3|4}
```

Default: --tradeoff=4

Description
If the compiler uses certain optimizations (option --optimize), you can use this option to specify whether the used optimizations should optimize for more speed (regardless of code size) or for smaller code size (regardless of speed).

By default the compiler optimizes for code size (--tradeoff=4).

If you have not specified the option --optimize, the compiler uses the default Optimize more optimization. In this case it is still useful to specify a trade-off level.

Example
To set the trade-off level for the used optimizations:

```
cpcp --tradeoff=2 test.c
```

The compiler uses the default Optimize more optimization level and balances speed and size while optimizing.

Related information

C compiler option --optimize (Specify optimization level)

Section 3.6.3, Optimize for Code Size or Execution Speed
C compiler option: --uchar (-u)

Menu entry
1. Select C Compiler » Language.
2. Enable the option Treat 'char' variables as unsigned.

Command line syntax

```
--uchar
-u
```

Description

By default char is the same as specifying signed char. With this option char is the same as unsigned char.

Note that this option can cause conflicts when you use it in combination with MIL linking. With MIL linking some extra strict type checking is done that can cause building to fail in a way that is unforeseen and difficult to understand. For example, when you use option --mil in combination with option --uchar and you link the MIL library, you might get the following error:

```
cpcp E289: ["..\..\..\strlen.c" 14/1] "strlen" redeclared with a different type

I802: ["installation-dir\cpcp\include\string.h" 44/17]
  previous declaration of "strlen"
```

1 errors, 0 warnings

This is caused by the fact that the MIL library is built without --uchar. You can workaround this problem by rebuilding the MIL libraries.

Related information

Section 1.1, Data Types
C compiler option: --undefine (-U)

Menu entry

1. Select C Compiler » Preprocessing

   The Defined symbols box shows the symbols that are currently defined.

2. To remove a defined symbol, select the symbol in the Defined symbols box and click on the Delete button.

Command line syntax

--undefined=macro_name
-U macro_name

Description

With this option you can undefine an earlier defined macro as with #undef. This option is for example useful to undefine predefined macros.

The following predefined ISO C standard macros cannot be undefined:

- __FILE__ current source filename
- __LINE__ current source line number (int type)
- __TIME__ hh:mm:ss
- __DATE__ Mmm dd yyyy
- __STDC__ level of ANSI standard

Example

To undefine the predefined macro __TASKING__:

cpcp --undefine=__TASKING__ test.c

Related information

C compiler option --define (Define preprocessor macro)

Section 1.7, Predefined Preprocessor Macros
C compiler option: --verbose (-v)

Menu entry

Command line syntax

--verbose

-v

Description

With this option you put the C compiler in verbose mode. The C compiler performs its tasks while it prints the steps it performs to stdout.

Related information
C compiler option: --version (-V)

Menu entry
-

Command line syntax

--version

-v

Description

Display version information. The compiler ignores all other options or input files.

Related information
-

C compiler option: --warnings-as-errors

Menu entry
1. Select Global Options.
2. Enable the option Treat warnings as errors.

Command line syntax

--warnings-as-errors [=number[-number],...]

Description

If the compiler encounters an error, it stops compiling. When you use this option without arguments, you tell the compiler to treat all warnings not suppressed by option --no-warnings (or #pragma warning) as errors. This means that the exit status of the compiler will be non-zero after one or more compiler warnings. As a consequence, the compiler now also stops after encountering a warning.

You can limit this option to specific warnings by specifying a comma-separated list of warning numbers or ranges. In this case, this option takes precedence over option --no-warnings (and #pragma warning).

Related information

C compiler option --no-warnings (Suppress some or all warnings)

Pragma warning
8.3. Assembler Options

This section lists all assembler options.

Options in Eclipse versus options on the command line

Most command line options have an equivalent option in Eclipse but some options are only available on the command line. Eclipse invokes the assembler via the control program. Therefore, it uses the syntax of the control program to pass options and files to the assembler. If there is no equivalent option in Eclipse, you can specify a command line option in Eclipse as follows:

1. From the Project menu, select Properties for The Properties dialog appears.
2. In the left pane, expand C/C++ Build and select Settings.
   In the right pane the Settings appear.
3. On the Tool Settings tab, select Assembler » Miscellaneous.
4. In the Additional options field, enter one or more command line options.
   Because Eclipse uses the control program, Eclipse automatically precedes the option with -Wa to pass the option via the control program directly to the assembler.

Note that the options you enter in the Assembler page are not only used for hand-coded assembly files, but also for the assembly files generated by the compiler.

Be aware that some command line options are not useful in Eclipse or just do not have any effect. For example, the option -V displays version header information and has no effect in Eclipse.

Short and long option names

Options can have both short and long names. Short option names always begin with a single minus (-) character, long option names always begin with two minus (--) characters. You can abbreviate long option names as long as it forms a unique name. You can mix short and long option names on the command line.

Options can have flags or suboptions. To switch a flag 'on', use a lowercase letter or a +longflag. To switch a flag off, use an uppercase letter or a -longflag. Separate longflags with commas. The following two invocations are equivalent:

aspcp -gal test.src
aspcp --debug-info=+asm,+local test.src

When you do not specify an option, a default value may become active.
**Assembler option: --case-insensitive (-c)**

**Menu entry**

1. Select Assembler » Symbols.
2. Enable the option Case insensitive identifiers.

**Command line syntax**

`--case-insensitive`

`-c`

Default: case sensitive

**Description**

With this option you tell the assembler not to distinguish between uppercase and lowercase characters. By default the assembler considers uppercase and lowercase characters as different characters.

Assembly source files that are generated by the compiler must always be assembled case sensitive. When you are writing your own assembly code, you may want to specify the case insensitive mode.

**Example**

When assembling case insensitive, the label `LabelName` is the same label as `labelname`.

`aspcp --case-insensitive test.src`

**Related information**

Assembler control `$CASE`
Assembler option: --check

Menu entry
-

Command line syntax
--check

Description
With this option you can check the source code for syntax errors, without generating code. This saves time in developing your application.

The assembler reports any warnings and/or errors.

This option is available on the command line only.

Related information

C compiler option --check (Check syntax)
Assembler option: --concatenate-sections

Menu entry

Command line syntax

--concatenate-sections

Description

By default the linker does not merge sections with the same name into one section. With this option the assembler uses the section attribute concat, instructing the linker to merge sections with the same name.

The advantage of section concatenation is faster locating, because there are less sections to locate.

The disadvantage of section concatenation is less efficient memory use, because of alignment gaps between (sequentially concatenated) sections.

Related information

-
Assembler option: --debug-info (-g)

Menu entry
1. Select Assembler » Symbols.
2. Select an option from the Generate symbolic debug list.

Command line syntax

--debug-info [=flags]
-g [flags]

You can set the following flags:

+/-asm   a/A Assembly source line information
+/-hll   h/H Pass high level language debug information (HLL)
+/-local I/L Assembler local symbols debug information
+/-smart s/S Smart debug information

Default: --debug-info=+hll
Default (without flags): --debug-info=+smart

Description

With this option you tell the assembler which kind of debug information to emit in the object file.

You cannot specify --debug-info=+asm,+hll. Either the assembler generates assembly source line information, or it passes HLL debug information.

When you specify --debug-info=+smart, the assembler selects which flags to use. If high level language information is available in the source file, the assembler passes this information (same as --debug-info=-asm,+hll,-local). If not, the assembler generates assembly source line information (same as --debug-info=+asm,-hll,+local).

With --debug-info=AHLS the assembler does not generate any debug information.

Related information

Assembler control $DEBUG
Assembler option: --define (-D)

Menu entry
1. Select Assembler » Preprocessing.

   The Defined symbols box right-below shows the symbols that are currently defined.

2. To define a new symbol, click on the Add button in the Defined symbols box.

3. Type the symbol definition (for example, demo=1)

   Use the Edit and Delete button to change a macro definition or to remove a macro from the list.

Command line syntax

--define=macro_name[=macro_definition]

-Dmacro_name[=macro_definition]

Description

With this option you can define a macro and specify it to the assembler preprocessor. If you only specify a macro name (no macro definition), the macro expands as '1'.

You can specify as many macros as you like. Simply use the Add button to add new macro definitions.

On the command line, use the option --define (-D) multiple times. If the command line exceeds the limit of the operating system, you can define the macros in an option file which you then must specify to the assembler with the option --option-file (-f) file.

Defining macros with this option (instead of in the assembly source) is, for example, useful in combination with conditional assembly as shown in the example below.

This option has the same effect as defining symbols via the .DEFINE, .SET, and .EQU directives (similar to #define in the C language). With the .MACRO directive you can define more complex macros.

Make sure you do not use a reserved keyword as a macro name, as this can lead to unexpected results.
Example

Consider the following assembly program with conditional code to assemble a demo program and a real program:

```
.IF DEMO == 1
... ; instructions for demo application
.ELSE
... ; instructions for the real application
.ENDIF
```

You can now use a macro definition to set the DEMO flag:

```
aspcp --define=DEMO test.src
aspcp --define=DEMO=1 test.src
```

Note that both invocations have the same effect.

Related information

Assembler option `--option-file` (Specify an option file)
Assembler option: --dep-file

Menu entry

Command line syntax

`--dep-file [=file]`

Description

With this option you tell the assembler to generate dependency lines that can be used in a Makefile. The dependency information will be generated in addition to the normal output file.

By default, the information is written to a file with extension `.d`. When you specify a filename, all dependencies will be combined in the specified file.

Example

```
aspcp --dep-file=test.dep test.src
```

The assembler assembles the file `test.src`, which results in the output file `test.o`, and generates dependency lines in the file `test.dep`.

Related information

Assembler option `--make-target` (Specify target name for `--dep-file` output)
Assembler option: --diag

Menu entry

1. From the Window menu, select Show View » Other » TASKING » Problems. 
   *The Problems view is added to the current perspective.*

2. In the Problems view right-click on a message. 
   *A popup menu appears.*

3. Select Detailed Diagnostics Info. 
   *A dialog box appears with additional information.*

Command line syntax

```
--diag=[format:]{all | nr,...}
```

You can set the following output formats:

- `html`  HTML output.
- `text`  ASCII text.

Default format: `text`

Description

With this option you can ask for an extended description of error messages in the format you choose. The output is directed to stdout (normally your screen) and in the format you specify. You can specify the following formats: `html`, `rtf` or `text` (default). To create a file with the descriptions, you must redirect the output.

With the suboption `all`, the descriptions of all error messages are given. If you want the description of one or more selected error messages, you can specify the error message numbers, separated by commas.

Example

To display an explanation of message number 244, enter:

```
aspcp --diag=244
```

This results in the following message and explanation:

```
W244: additional input files will be ignored
```

The assembler supports only a single input file. All other input files are ignored.
To write an explanation of all errors and warnings in HTML format to file `aserrors.html`, use redirection and enter:

```bash
aspcp --diag=html:all > aserrors.html
```

**Related information**

Section 4.6, *Assembler Error Messages*
Assembler option: --emit-locals

Menu entry
1. Select Assembler » Symbols.
2. Enable or disable one or both of the following options:
   - Emit local EQU symbols
   - Emit local non-EQU symbols

Command line syntax
--emit-locals [=flag, ...]

You can set the following flags:

\begin{align*}
+/-\text{equis} & \quad e/E \quad \text{emit local EQU symbols} \\
+/-\text{symbols} & \quad s/S \quad \text{emit local non-EQU symbols}
\end{align*}

Default: --emit-locals=ES

Default (without flags): --emit-locals=+symbols

Description
With the option --emit-locals=+equis the assembler also emits local EQU symbols to the object file. Normally, only global symbols and non-EQU local symbols are emitted. Having local symbols in the object file can be useful for debugging.

Related information
Assembler directive .EQU
Assembler option: --error-file

Menu entry
-

Command line syntax

--error-file [=file]

Description

With this option the assembler redirects diagnostic messages to a file. If you do not specify a filename, the error file will be named after the output file with extension .ers.

Example

To write diagnostic messages to errors.ers instead of stderr, enter:

aspcp --error-file=errors.ers test.src

Related information

Section 4.6, Assembler Error Messages
Assembler option: --error-limit

Menu entry

1. Select Assembler » Diagnostics.
2. Enter a value in the Maximum number of emitted errors field.

Command line syntax

--error-limit=number

Default: 42

Description

With this option you tell the assembler to only emit the specified maximum number of errors. When 0 (null) is specified, the assembler emits all errors. Without this option the maximum number of errors is 42.

Related information

Section 4.6, Assembler Error Messages
Assembler option: --help (-?)

Menu entry

Command line syntax

--help [=item]

-?

You can specify the following arguments:

  options     Show extended option descriptions

Description

Displays an overview of all command line options. When you specify the argument options you can list detailed option descriptions.

Example

The following invocations all display a list of the available command line options:

  aspcp -?
  aspcp --help
  aspcp

To see a detailed description of the available options, enter:

  aspcp --help=options

Related information

-
Assembler option: --include-directory (-I)

Menu entry
1. Select Assembler » Include Paths.  
   The Include paths box shows the directories that are added to the search path for include files.
2. To define a new directory for the search path, click on the Add button in the Include paths box.
3. Type or select a path.

   Use the Edit and Delete button to change a path or to remove a path from the list.

Command line syntax
--include-directory= path, ...
-I path, ...

Description
With this option you can specify the path where your include files are located. A relative path will be relative to the current directory.

The order in which the assembler searches for include files is:
1. The pathname in the assembly file and the directory of the assembly source.
2. The path that is specified with this option.
3. The path that is specified in the environment variable ASPCPINC when the product was installed.
4. The default directory $(PRODDIR)\include.

Example
Suppose that the assembly source file test.src contains the following lines:

.INCLUDE 'myinc.inc'

You can call the assembler as follows:

aspcp --include-directory=c:\proj\include test.src

First the assembler looks for the file myinc.inc in the directory where test.src is located. If it does not find the file, it looks in the directory c:\proj\include (this option). If the file is still not found, the assembler searches in the environment variable and then in the default include directory.
Related information

Assembler option --include-file (Include file at the start of the input file)
Assembler option: --include-file (-H)

Menu entry
1. Select Assembler » Preprocessing.
   *The Pre-include files box shows the files that are currently included before the assembling starts.*
2. To define a new file, click on the Add button in the Pre-include files box.
3. Type the full path and file name or select a file.

   Use the Edit and Delete button to change a file name or to remove a file from the list.

Command line syntax

```
--include-file=file,...
-H file,...
```

Description
With this option (set at project level) you include one extra file at the beginning of the assembly source file. The specified include file is included before all other includes. This is the same as specifying .INCLUDE 'file' at the beginning of your assembly source.

Example

```
aspcp --include-file=sfr/regtc1796b.def test.src
```

The file regtc1796b.def in the sfr subdirectory of the include directory is included at the beginning of test.src before it is assembled.

Related information

Assembler option --include-directory (Add directory to include file search path)
Assembler option: --kanji

Menu entry
1. Select Assembler » Miscellaneous.
2. Enable the option Allow Shift JIS Kanji in strings.

Command line syntax
--kanji

Description
With this option you tell the assembler to support Shift JIS encoded Kanji multi-byte characters in strings. Without this option, encodings with 0x5c as the second byte conflict with the use of the backslash as an escape character. Shift JIS in comments is supported regardless of this option.

Note that Shift JIS also includes Katakana and Hiragana.

Related information
C compiler option --language=+kanji (Allow Shift JIS Kanji in strings)
Assembler option: --keep-output-files (-k)

Menu entry
Eclipse always removes the object file when errors occur during assembling.

Command line syntax
--keep-output-files
-k

Description
If an error occurs during assembling, the resulting object file (.o) may be incomplete or incorrect. With this option you keep the generated object file when an error occurs.

By default the assembler removes the generated object file when an error occurs. This is useful when you use the make utility. If the erroneous files are not removed, the make utility may process corrupt files on a subsequent invocation.

Use this option when you still want to use the generated object. For example when you know that a particular error does not result in a corrupt object file.

Related information
Assembler option --warnings-as-errors (Treat warnings as errors)
Assembler option: --list-file (-l)

Menu entry
1. Select Assembler » List File.
2. Enable the option Generate list file.
3. Enable or disable the types of information to be included.

Command line syntax

```
--list-file[=file]
-l[=file]
```

Default: no list file is generated

Description

With this option you tell the assembler to generate a list file. A list file shows the generated object code and the relative addresses. Note that the assembler generates a relocatable object file with relative addresses.

With the optional file you can specify an alternative name for the list file. By default, the name of the list file is the basename of the output file with the extension .lst.

Related information

Assembler option --list-format (Format list file)
**Assembler option: --list-format (-L)**

**Menu entry**

1. Select *Assembler » List File*.
2. Enable the option *Generate list file*.
3. Enable or disable the types of information to be included.

**Command line syntax**

```
--list-format=flag,...
-Lflags
```

You can set the following flags:

- `+/-section`  
  d/D  List section directives (.SDECL, .SECT)
- `+/-symbol`  
  e/E  List symbol definition directives
- `+/-macro`  
  m/M  List macro definitions
- `+/-empty-line`  
  n/N  List empty source lines and comment lines (newline)
- `+/-conditional`  
  p/P  List conditional assembly
- `+/-equate`  
  q/Q  List equate and set directives (.EQU, .SET)
- `+/-relocations`  
  r/R  List relocations characters ('r')
- `+/-equate-values`  
  v/V  List equate and set values
- `+/-wrap-lines`  
  w/W  Wrap source lines
- `+/-macro-expansion`  
  x/X  List macro expansions
- `+/-cycle-count`  
  y/Y  List cycle counts
- `+/-define-expansion`  
  z/Z  List define expansions

Use the following options for predefined sets of flags:

```
--list-format=0   -L0  All options disabled
      Alias for --list-format=DEMNPQRVWXYZ
--list-format=1   -L1  All options enabled
      Alias for --list-format=Demnpqrwxyz
```

Default: **--list-format=dEMnPqrVwXyZ**

**Description**

With this option you specify which information you want to include in the list file.

On the command line you must use this option in combination with the option **--list-file** (-l).
Related information

Assembler option `--list-file` (Generate list file)

Assembler option `--section-info=list` (Display section information in list file)
Assembler option: --make-target

Menu entry
-

Command line syntax

--make-target=name

Description

With this option you can overrule the default target name in the make dependencies generated by the option --dep-file. The default target name is the basename of the input file, with extension `.o`.

Example

aspcp --dep-file --make-target=../mytarget.o test.src

The assembler generates dependency lines with the default target name `../mytarget.o` instead of `test.o`.

Related information

Assembler option --dep-file (Generate dependencies in a file)
Assembler option: --no-notes

Menu entry

1. Select Assembler » Miscellaneous.
2. Add the option --no-notes to the Additional options field.

Command line syntax

--no-notes

Description

By default, the assembler generates a note section in the object file. The note section contains compiler version and invocation information, if supplied in the input file, and version and invocation information of the assembler. With this option you can suppress the generation of a note section in the output object file.

Related information

-
Assembler option: --no-warnings (-w)

Menu entry
1. Select Assembler » Diagnostics.

   The Suppress warnings box shows the warnings that are currently suppressed.

2. To suppress a warning, click on the Add button in the Suppress warnings box.

3. Enter the numbers, separated by commas, of the warnings you want to suppress (for example 201, 202). Or you can use the Add button multiple times.

4. To suppress all warnings, enable the option Suppress all warnings.

   Use the Edit and Delete button to change a warning number or to remove a number from the list.

Command line syntax

--no-warnings=[number,...]

-w[number,...]

Description

With this option you can suppresses all warning messages or specific warning messages.

On the command line this option works as follows:

• If you do not specify this option, all warnings are reported.

• If you specify this option but without numbers, all warnings are suppressed.

• If you specify this option with a number, only the specified warning is suppressed. You can specify the option --no-warnings=number multiple times.

Example

To suppress warnings 201 and 202, enter:

aspcp test.src --no-warnings=201,202

Related information

Assembler option --warnings-as-errors (Treat warnings as errors)
Assembler option: --optimize (-O)

Menu entry
1. Select Assembler » Optimization.
2. Select Optimize instruction size

Command line syntax

--optimize=flag,...

-Oflags

You can set the following flags:

```
+/-instr-size       s/S  Optimize instruction size
```

Default: --optimize=s

Description

With this option you can control the level of optimization. For details see Section 4.4, Assembler Optimizations.

Related information

Section 4.4, Assembler Optimizations
Assembler option: --option-file (-f)

Menu entry
1. Select **Assembler » Miscellaneous**.
2. Add the option **--option-file** to the **Additional options** field.

*Be aware that the options in the option file are added to the assembler options you have set in the other pages. Only in extraordinary cases you may want to use them in combination.*

Command line syntax

```bash
--option-file=file,...
-f file,...
```

Description

This option is primarily intended for command line use. Instead of typing all options on the command line, you can create an option file which contains all options and flags you want to specify. With this option you specify the option file to the assembler.

Use an option file when the command line would exceed the limits of the operating system, or just to store options and save typing.

Option files can also be generated on the fly, for example by the make utility. You can specify the option **--option-file** multiple times.

Format of an option file

- Multiple arguments on one line in the option file are allowed.
- To include whitespace in an argument, surround the argument with single or double quotes.
- If you want to use single quotes as part of the argument, surround the argument by double quotes and vise versa:

  "This has a single quote ' embedded"

  'This has a double quote " embedded'

  'This has a double quote " and a single quote ''' embedded"

- When a text line reaches its length limit, use a \ to continue the line. Whitespace between quotes is preserved.

  "This is a continuation \
line"

  -> "This is a continuation line"
• It is possible to nest command line files up to 25 levels.

Example

Suppose the file myoptions contains the following lines:

```bash
--debug-info=+asm,-local
test.src
```

Specify the option file to the assembler:

```bash
aspcp --option-file=myoptions
test.src
```

This is equivalent to the following command line:

```bash
aspcp --debug-info=+asm,-local test.src
```

Related information

-
Assembler option: --output (-o)

Menu entry
Eclipse names the output file always after the input file.

Command line syntax

```
--output=file
-o file
```

Description
With this option you can specify another filename for the output file of the assembler. Without this option, the basename of the assembly source file is used with extension .o.

Example
To create the file relobj.o instead of asm.o, enter:

```
aspcp --output=relobj.o asm.src
```

Related information
-
Assembler option: --page-length

Menu entry
1. Select Assembler » Miscellaneous.
2. Add the option --page-length to the Additional options field.

Command line syntax

--page-length=number

Default: 72

Description

If you generate a list file with the assembler option --list-file, this option sets the number of lines in a page in the list file. The default is 72, the minimum is 10. As a special case, a page length of 0 turns off page breaks.

Related information

Assembler option --list-file (Generate list file)

Assembler control $PAGE
Assembler option: --page-width

Menu entry
1. Select Assembler » Miscellaneous.
2. Add the option --page-width to the Additional options field.

Command line syntax

```
--page-width=number
```

Default: 132

Description

If you generate a list file with the assembler option --list-file, this option sets the number of columns per line on a page in the list file. The default is 132, the minimum is 40.

Related information

Assembler option --list-file (Generate list file)

Assembler control $PAGE
Assembler option: --preprocess (-E)

Menu entry

- 

Command line syntax

--preprocess

-E 

Description

With this option the assembler will only preprocess the assembly source file. The assembler sends the preprocessed file to stdout.

Related information

-
Assembler option: --preprocessor-type (-m)

Menu entry
1. Select Assembler » Preprocessing.
2. Enable or disable the option Use TASKING preprocessor.

Command line syntax
--preprocessor-type=type
-m type

You can set the following preprocessor types:

<table>
<thead>
<tr>
<th>Type</th>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>none</td>
<td>n</td>
<td>No preprocessor</td>
</tr>
<tr>
<td>tasking</td>
<td>t</td>
<td>TASKING preprocessor</td>
</tr>
</tbody>
</table>

Default: --preprocessor-type=tasking

Description
With this option you select the preprocessor that the assembler will use. By default, the assembler uses the TASKING preprocessor.

When the assembly source file does not contain any preprocessor symbols, you can specify to the assembler not to use a preprocessor.

Related information
-
Assembler option: --section-info (-t)

Menu entry
1. Select Assembler » List File.
2. Enable the option Generate list file.
3. Enable the option List section summary.

and/or
1. Select Assembler » Diagnostics.
2. Enable the option Display section summary.

Command line syntax

```
--section-info [=flag,...]
-t [flags]
```

You can set the following flags:

```
+/-console   c/C  Display section summary on console
+/-list      I/L  List section summary in list file
```

Default: `--section-info=CL`

Default (without flags): `--section-info=cl`

Description

With this option you tell the assembler to display section information. For each section its memory space, size, total cycle counts and name is listed on stdout and/or in the list file.

The cycle count consists of two parts: the total accumulated count for the section and the total accumulated count for all repeated instructions. In the case of nested loops it is possible that the total supersedes the section total.

Example

To writes the section information to the list file and also display the section information on stdout, enter:

```
aspcp --list-file --section-info asm.src
```

Related information

Assembler option `--list-file` (Generate list file)
Assembler option: --silicon-bug

Menu entry

1. Expand C/C++ Build and select Processor.
2. From the Processor Selection list, select a processor.
   *The CPU Problem Bypasses and Checks box shows the available workarounds/checks available for the selected processor.*
3. (Optional) Select Show all CPU problem bypasses and checks.
4. Click Select All or select one or more individual options.

Command line syntax

```bash
--silicon-bug=arg,...
```

You can give one or more of the following arguments:

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>pcp-tc034</code></td>
<td>Check for PCP_TC.034</td>
</tr>
<tr>
<td><code>pcp-tc038</code></td>
<td>Check for PCP_TC.038</td>
</tr>
</tbody>
</table>

Description

With this option you specify for which hardware problems the assembler should check or generate workarounds. Please refer to Chapter 14, CPU Problem Bypasses and Checks for more information about the individual problems and workarounds.

Example

To check for problems PCP_TC.034 and PCP_TC.038, enter:

```bash
aspcp --silicon-bug=pcp-tc034,pcp-tc038 test.src
```

Related information

Chapter 14, CPU Problem Bypasses and Checks

C compiler option --silicon-bug
Assembler option: --symbol-prefix

Menu entry
1. Select Assembler » Miscellaneous.
2. Add the option --symbol-prefix to the Additional options field.

Command line syntax
--symbol-prefix=prefix

Description
With this option you can specify a prefix to use for global and external symbols. When you link a TriCore application with a PCP application it is required to prefix the PCP global symbols to avoid duplicate name conflicts between the TriCore and PCP application parts. When you link multiple PCP channels separately it is required that each channel uses its own global symbol prefix.

Note that the C compiler by default adds the prefix _PCP_.

Example
To add the prefix _PCP_ to global/external symbols, enter:

aspcp --symbol-prefix=_PCP_ test.asm

Related information
C compiler option --symbol-prefix
Assembler option: --symbol-scope (-i)

Menu entry

1. Select Assembler » Symbols.

2. Enable or disable the option Set default symbol scope to global.

Command line syntax

```
--symbol-scope=scope

-iscope
```

You can set the following scope:

- **global**      **g**      Default symbol scope is global
- **local**      **l**      Default symbol scope is local

Default: --symbol-scope=local

Description

With this option you tell the assembler how to treat symbols that you have not specified explicitly as global or local. By default the assembler treats all symbols as local symbols unless you have defined them explicitly as global.

Related information

Assembler directive .GLOBAL
Assembler directive .LOCAL
Assembler control $IDENT
Assembler option: --version (-V)

Menu entry

Command line syntax

--version

-v

Description

Display version information. The assembler ignores all other options or input files.

Related information

-
Assembler option: --warnings-as-errors

Menu entry
1. Select Global Options.
2. Enable the option Treat warnings as errors.

Command line syntax

```
--warnings-as-errors[=number,...]
```

Description

If the assembler encounters an error, it stops assembling. When you use this option without arguments, you tell the assembler to treat all warnings as errors. This means that the exit status of the assembler will be non-zero after one or more assembler warnings. As a consequence, the assembler now also stops after encountering a warning.

You can limit this option to specific warnings by specifying a comma-separated list of warning numbers.

Related information

Assembler option --no-warnings (Suppress some or all warnings)
8.4. Linker Options

This section lists all linker options.

Options in Eclipse versus options on the command line

Most command line options have an equivalent option in Eclipse but some options are only available on the command line. Eclipse invokes the linker via the control program. Therefore, it uses the syntax of the control program to pass options and files to the linker. If there is no equivalent option in Eclipse, you can specify a command line option in Eclipse as follows:

1. From the Project menu, select Properties for

   *The Properties dialog appears.*

2. In the left pane, expand C/C++ Build and select Settings.

   *In the right pane the Settings appear.*

3. On the Tool Settings tab, select Linker » Miscellaneous.

4. In the Additional options field, enter one or more command line options.

   _Because Eclipse uses the control program, Eclipse automatically precedes the option with -Wl to pass the option via the control program directly to the linker._

Be aware that some command line options are not useful in Eclipse or just do not have any effect. For example, the option `--keep-output-files` keeps files after an error occurred. When you specify this option in Eclipse, it will have no effect because Eclipse always removes the output file after an error had occurred.

Short and long option names

Options can have both short and long names. Short option names always begin with a single minus (-) character, long option names always begin with two minus (--) characters. You can abbreviate long option names as long as it forms a unique name. You can mix short and long option names on the command line.

Options can have flags or suboptions. To switch a flag 'on', use a lowercase letter or a `+longflag`. To switch a flag off, use an uppercase letter or a `-longflag`. Separate `longflags` with commas. The following two invocations are equivalent:

```
lpcp -mfkl test.o
lpcp --map-file-format=+files,+link,+locate test.o
```

When you do not specify an option, a default value may become active.
Linker option: Include debugger synchronization utility

Menu entry
1. Select **Linker » Miscellaneous**.
2. Enable the option **Include debugger synchronization utility**.

Command line syntax

```
--extern=_PCP_sync_on_halt
```

Description

When the debugger stops the TriCore, this does not automatically flush all the states in the CPU's pipeline and caches. In order to be able to correctly show the program state, the debugger therefore needs to execute special flushing code every time the CPU halts. When you enable the option **Include debugger synchronization utility** this causes extra code (**_PCP_sync_on_halt** and other symbols) to be linked in. If you are not going to use the debugger, you can save a few tens of bytes by disabling this option.

Related information

Linker option **--extern**
**Linker option: --case-insensitive**

**Menu entry**

1. Select **Linker » Miscellaneous**.
2. Enable the option **Link case insensitive**.

**Command line syntax**

`--case-insensitive`

Default: case sensitive

**Description**

With this option you tell the linker not to distinguish between uppercase and lowercase characters in symbols. By default the linker considers uppercase and lowercase characters as different characters.

Assembly source files that are generated by the compiler must *always* be assembled and thus linked case sensitive. When you have written your own assembly code and specified to assemble it case insensitive, you must also link the `.o` file case insensitive.

**Related information**

Assembler option **--case-insensitive**
Linker option: --chip-output (-c)

Menu entry
-

Command line syntax

```
--chip-output=[basename]:format[:addr_size],...
-c[basename]:format[:addr_size],...
```

You can specify the following formats:

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IHEX</td>
<td>Intel Hex</td>
</tr>
<tr>
<td>SREC</td>
<td>Motorola S-records</td>
</tr>
</tbody>
</table>

The `addr_size` specifies the size of the addresses in bytes (record length). For Intel Hex you can use the values 1, 2 or 4 bytes (default). For Motorola-S you can specify: 2 (S1 records), 3 (S2 records) or 4 bytes (S3 records, default).

Description

With this option you specify the Intel Hex or Motorola S-record output format for loading into a PROM-programmer. The linker generates a file for each ROM memory defined in the LSL file, where sections are located:

```
memory memname
{  type=rom;  }
```

The name of the file is the name of the Eclipse project or, on the command line, the name of the memory device that was emitted with extension `.hex` or `.sre`. Optionally, you can specify a `basename` which prepends the generated file name.

The linker always outputs a debugging file in ELF/DWARF format and optionally an absolute object file in Intel Hex-format and/or Motorola S-record format.

Example

To generate Intel Hex output files for each defined memory, enter the following on the command line:

```
lpcp --chip-output=myfile:IHEX test1.o
```

In this case, this generates the file `myfile_memname.hex`.

Related information

Linker option `--output` (Output file)
Linker option: --define (-D)

Menu entry

1. Select Linker » Script File.

   The Defined symbols box shows the symbols that are currently defined.

2. To define a new symbol, click on the Add button in the Defined symbols box.

3. Type the symbol definition (for example, demo=1)

   Use the Edit and Delete button to change a macro definition or to remove a macro from the list.

Command line syntax

```
--define=macro_name[=macro_definition]
-Dmacro_name[=macro_definition]
```

Description

With this option you can define a macro and specify it to the linker LSL file preprocessor. If you only specify a macro name (no macro definition), the macro expands as '1'.

You can specify as many macros as you like; just use the option `--define (-D)` multiple times. If the command line exceeds the limit of the operating system, you can define the macros in an option file which you then must specify to the linker with the option `--option-file (-f) file`.

The definition can be tested by the preprocessor with `#if, #ifdef and #ifndef`, for conditional locating.

Make sure you do not use a reserved keyword as a macro name, as this can lead to unexpected results.

Example

To define the RESET vector, which is used in the linker script file `tc1v1_3.lsl`, enter:

```
lpcp test.o -otest.elf --lsl-file=tc1v1_3.lsl --define=RESET=0xa0000000
```

Related information

Linker option `--option-file` (Specify an option file)
Linker option: --diag

Menu entry

1. From the Window menu, select Show View » Other » TASKING » Problems.
   
   The Problems view is added to the current perspective.

2. In the Problems view right-click on a message.
   
   A popup menu appears.

3. Select Detailed Diagnostics Info.
   
   A dialog box appears with additional information.

Command line syntax

```
--diag= [format:] { all | nr, ... }
```

You can set the following output formats:

- html: HTML output.
- text: ASCII text.

Default format: text

Description

With this option you can ask for an extended description of error messages in the format you choose. The output is directed to stdout (normally your screen) and in the format you specify. You can specify the following formats: html, rtf or text (default). To create a file with the descriptions, you must redirect the output.

With the suboption all, the descriptions of all error messages are given. If you want the description of one or more selected error messages, you can specify the error message numbers, separated by commas.

With this option the linker does not link/locate any files.

Example

To display an explanation of message number 106, enter:

```
lpccp --diag=106
```

This results in the following message and explanation:

```
E106: unresolved external: <message>
```

The linker could not resolve all external symbols.
This is an error when the incremental linking option is disabled. The `<message>` indicates the symbol that is unresolved.

To write an explanation of all errors and warnings in HTML format to file `lkerrors.html`, use redirection and enter:

```
lpcp --diag=html:all > lkerrors.html
```

**Related information**

Section 5.10, *Linker Error Messages*
Linker option: --error-file

Menu entry
-

Command line syntax

`--error-file[=file]`

Description

With this option the linker redirects diagnostic messages to a file. If you do not specify a filename, the error file is `lpcp.elk`.

Example

To write diagnostic messages to `errors.elk` instead of `stderr`, enter:

```
lpcp --error-file=errors.elk test.o
```

Related information

Section 5.10, *Linker Error Messages*
Linker option: --error-limit

Menu entry
1. Select Linker » Diagnostics.
2. Enter a value in the Maximum number of emitted errors field.

Command line syntax

--error-limit=number

Default: 42

Description

With this option you tell the linker to only emit the specified maximum number of errors. When 0 (null) is specified, the linker emits all errors. Without this option the maximum number of errors is 42.

Related information

Section 5.10, Linker Error Messages
Linker option: --extern (-e)

Menu entry
-

Command line syntax

--extern=symbol,...
-e symbol,...

Description

With this option you force the linker to consider the given symbol as an undefined reference. The linker tries to resolve this symbol, either the symbol is defined in an object file or the linker extracts the corresponding symbol definition from a library.

This option is, for example, useful if the startup code is part of a library. Because your own application does not refer to the startup code, you can force the startup code to be extracted by specifying the symbol START as an unresolved external.

Example

Consider the following invocation:

lpcp mylib.a

Nothing is linked and no output file will be produced, because there are no unresolved symbols when the linker searches through mylib.a.

lpcp --extern=_START mylib.a

In this case the linker searches for the symbol _START in the library and (if found) extracts the object that contains _START, the startup code. If this module contains new unresolved symbols, the linker looks again in mylib.a. This process repeats until no new unresolved symbols are found.

Related information

Section 5.3, Linking with Libraries
Linker option: --first-library-first

Menu entry
-

Command line syntax
--first-library-first

Description

When the linker processes a library it searches for symbols that are referenced by the objects and libraries processed so far. If the library contains a definition for an unresolved reference the linker extracts the object that contains the definition from the library.

By default the linker processes object files and libraries in the order in which they appear on the command line. If you specify the option --first-library-first the linker always tries to take the symbol definition from the library that appears first on the command line before scanning subsequent libraries.

This is for example useful when you are working with a newer version of a library that partially overlaps the older version. Because they do not contain exactly the same functions, you have to link them both. However, when a function is present in both libraries, you may want the linker to extract the most recent function.

Example

Consider the following example:

lpcp --first-library-first a.a test.o b.a

If the file test.o calls a function which is both present in a.a and b.a, normally the function in b.a would be extracted. With this option the linker first tries to extract the symbol from the first library a.a.

Note that routines in b.a that call other routines that are present in both a.a and b.a are now also resolved from a.a.

Related information

Linker option --no-rescan (Rescan libraries to solve unresolved externals)
Linker option: --help (-?)

Menu entry
-

Command line syntax

--help[=item]
-

You can specify the following arguments:

    options       Show extended option descriptions

Description

Displays an overview of all command line options. When you specify the argument options you can list detailed option descriptions.

Example

The following invocations all display a list of the available command line options:

    lpcp  -?
    lpcp  --help
    lpcp

To see a detailed description of the available options, enter:

    lpcp  --help=options

Related information
-


Linker option: --hex-format

Menu entry
1. Select Linker » Miscellaneous.
2. Add the option --hex-format to the Additional options field.

Command line syntax

--hex-format=flag,...

You can set the following flag:

+/-start-address  s/S  Emit start address record

Default: --hex-format=s

Description

With this option you can specify to emit or omit the start address record from the hex file.

Related information

Linker option --output (Output file)
**Linker option: --hex-record-size**

**Menu entry**

1. Select **Linker » Miscellaneous.**
2. Add the option **--hex-record-size** to the **Additional options** field.

**Command line syntax**

```bash
--hex-record-size=size
```

Default: 32

**Description**

With this option you can set the size (width) of the Intel Hex data records.

**Related information**

**Linker option --output** (Output file)
**Linker option: --import-object**

**Menu entry**

1. Select **Linker » Data Objects**.
   
   *The Data objects box shows the list of object files that are imported.*

2. To add a data object, click on the **Add** button in the **Data objects** box.

3. Type or select a binary file (including its path).

   Use the **Edit** and **Delete** button to change a filename or to remove a data object from the list.

**Command line syntax**

```
--import-object=file,...
```

**Description**

With this option the linker imports a binary *file* containing raw data and places it in a section. The section name is derived from the filename, in which dots are replaced by an underscore. So, when importing a file called *my.jpg*, a section with the name *my_jpg* is created. In your application you can refer to the created section by using linker labels.

**Related information**

Section 5.5, *Importing Binary Files*
Linker option: --include-directory (-I)

Menu entry
-

Command line syntax
--include-directory=path,...
-I path,...

Description
With this option you can specify the path where your LSL include files are located. A relative path will be relative to the current directory.

The order in which the linker searches for LSL include files is:

1. The pathname in the LSL file and the directory where the LSL file is located (only for #include files that are enclosed in "")

2. The path that is specified with this option.

3. The default directory $(PRODDIR)\include.lsl.

Example
Suppose that your linker script file mylsl.lsl contains the following line:

#include "myinc.inc"

You can call the linker as follows:

lpcp --include-directory=c:\proj\include --lsl-file=mlsl.lsl test.o

First the linker looks for the file myinc.inc in the directory where mylsl.lsl is located. If it does not find the file, it looks in the directory c:\proj\include (this option). Finally it looks in the directory $(PRODDIR)\include.lsl.

Related information
Linker option --lsl-file (Specify linker script file)
Linker option: --incremental (-r)

Menu entry
-

Command line syntax
--incremental
-r

Description
Normally the linker links and locates the specified object files. With this option you tell the linker only to link the specified files. The linker creates a linker output file .out. You then can link this file again with other object files until you have reached the final linker output file that is ready for locating.

In the last pass, you call the linker without this option with the final linker output file .out. The linker will now locate the file.

Example
In this example, the files test1.o, test2.o and test3.o are incrementally linked:
1. lpcp --incremental test1.o test2.o --output=test.out
   
   *test1.o and test2.o are linked*

2. lpcp --incremental test3.o test.out
   
   *test3.o and test.out are linked, task1.out is created*

3. lpcp task1.out
   
   *task1.out is located*

Related information
Section 5.4, Incremental Linking
**Linker option: **--keep-output-files (-k)**

**Menu entry**

Eclipse *always* removes the output files when errors occurred.

**Command line syntax**

--keep-output-files

-k

**Description**

If an error occurs during linking, the resulting output file may be incomplete or incorrect. With this option you keep the generated output files when an error occurs.

By default the linker removes the generated output file when an error occurs. This is useful when you use the make utility. If the erroneous files are not removed, the make utility may process corrupt files on a subsequent invocation.

Use this option when you still want to use the generated file. For example when you know that a particular error does not result in a corrupt object file, or when you want to inspect the output file, or send it to Altium support.

**Related information**

Linker option **--warnings-as-errors** (Treat warnings as errors)
Linker option: --library (-l)

Menu entry

1. Select Linker » Libraries.
   
   The Libraries box shows the list of libraries that are linked with the project.

2. To add a library, click on the Add button in the Libraries box.

3. Type or select a library (including its path).

4. Optionally, disable the option Link default libraries.

Use the Edit and Delete button to change a library name or to remove a library from the list.

Command line syntax

--library=name

-l name

Description

With this option you tell the linker to use system library libname.a, where name is a string. The linker first searches for system libraries in any directories specified with --library-directory, then in the directories specified with the environment variables LIBTC1V1_3 / LIBTC1V1_3_1 / LIBTC1V1_6, unless you used the option --ignore-default-library-path.

Example

To search in the system library libc.a (C library):

lpcp test.o mylib.a --library=c

The linker links the file test.o and first looks in library mylib.a (in the current directory only), then in the system library libc.a to resolve unresolved symbols.

Related information

Linker option --library-directory (Additional search path for system libraries)

Section 5.3, Linking with Libraries
Linker option: --library-directory (-L) / --ignore-default-library-path

Menu entry

1. Select **Linker » Libraries**.

   *The Library search path box shows the directories that are added to the search path for library files.*

2. To define a new directory for the search path, click on the **Add** button in the **Library search path** box.

3. Type or select a path.

   *Use the **Edit** and **Delete** button to change a path or to remove a path from the list.*

Command line syntax

```plaintext
--library-directory=path,...
-L path,...
--ignore-default-library-path
-L
```

Description

With this option you can specify the path(s) where your system libraries, specified with the option **--library** (-l), are located. If you want to specify multiple paths, use the option **--library-directory** for each separate path.

The default path is `$(PRODDIR)\lib\pcp2`.

If you specify only `-L` (without a pathname) or the long option **--ignore-default-library-path**, the linker will not search the default path and also not in the paths specified in the environment variables `LIBTC1V1_3` / `LIBTC1V1_3_1` / `LIBTC1V1_6`. So, the linker ignores steps 2 and 3 as listed below.

The priority order in which the linker searches for system libraries specified with the option **--library** (-l) is:

1. The path that is specified with the option **--library-directory**.

2. The path that is specified in the environment variables `LIBTC1V1_3` / `LIBTC1V1_3_1` / `LIBTC1V1_6`.

3. The default directory `$(PRODDIR)\lib\pcp2`.

Example

Suppose you call the linker as follows:

```plaintext
lpcp test.o --library-directory=c:\mylibs --library=c
```
First the linker looks in the directory `c:\mylibs` for library `libc.a` (this option). If it does not find the requested libraries, it looks in the directory that is set with the environment variables `LIBTC1V1_3` / `LIBTC1V1_3_1` / `LIBTC1V1_6`. Then the linker looks in the default directory `$\{PRODDIR\}\lib\pcp2` for libraries.

**Related information**

Linker option `--library` (Link system library)

Section 5.3.1, *How the Linker Searches Libraries*
**Linker option: --link-only**

**Menu entry**
-

**Command line syntax**

--link-only

**Description**

With this option you suppress the locating phase. The linker stops after linking and informs you about unresolved references.

**Related information**

Control program option --create=relocatable (-cl) (Stop after linking)
Linker option: --lsl-check

Menu entry

Command line syntax

--lsl-check

Description

With this option the linker just checks the syntax of the LSL file(s) and exits. No linking or locating is performed. Use the option --lsl-file to specify the name of the Linker Script File you want to test.

Related information

Linker option --lsl-file (Linker script file)

Linker option --lsl-dump (Dump LSL info)

Section 5.7, Controlling the Linker with a Script
Linker option: --lsl-dump

Menu entry

Command line syntax

--lsl-dump[=file]

Description

With this option you tell the linker to dump the LSL part of the map file in a separate file, independent of the option --map-file (generate map file). If you do not specify a filename, the file lpcp.1df is used.

Related information

Linker option --map-file-format (Map file formatting)
Linker option: --lsl-file (-d)

Menu entry

An LSL file can be generated when you create your TriCore project in Eclipse:

1. From the File menu, select File » New » TASKING TriCore C/C++ Project.
   
   The New C/C++ Project wizard appears.

2. Fill in the project settings in each dialog and click Next > until the TriCore Project Settings appear.

3. Enable the option Add linker script file to the project and click Finish.

   Eclipse creates your project and the file project.lsl in the project directory.

The LSL file can be specified in the Properties dialog:

1. Select Linker » Script File.

2. Specify a LSL file in the Linker script file (.lsl) field.

Command line syntax

--lsl-file=file

-dfile

Description

A linker script file contains vital information about the core for the locating phase of the linker. A linker script file is coded in LSL and contains the following types of information:

- the architecture definition describes the core’s hardware architecture.
- the memory definition describes the physical memory available in the system.
- the section layout definition describes how to locate sections in memory.

With this option you specify a linker script file to the linker. If you do not specify this option, the linker uses a default script file. You can specify the existing file target.lsl or the name of a manually written linker script file. You can use this option multiple times. The linker processes the LSL files in the order in which they appear on the command line.

Related information

Linker option --lsl-check (Check LSL file(s) and exit)

Section 5.7, Controlling the Linker with a Script
Linker option: --map-file (-M)

Menu entry
1. Select Linker » Map File.
2. Enable the option Generate XML map file format (.mapxml) for map file viewer.
3. (Optional) Enable the option Generate map file.
4. Enable or disable the types of information to be included.

Command line syntax

```bash
--map-file=[file][:XML]
-M[file][:XML]
```

Default (Eclipse): XML map file is generated
Default (linker): no map file is generated

Description

With this option you tell the linker to generate a linker map file. If you do not specify a filename and you specified the option `--output`, the linker uses the same basename as the output file with the extension .map. If you did not specify the option `--output`, the linker uses the file `task1.map`. Eclipse names the .map file after the project.

A linker map file is a text file that shows how the linker has mapped the sections and symbols from the various object files (.o) to the linked object file. A locate part shows the absolute position of each section. External symbols are listed per space with their absolute address, both sorted on symbol and sorted on address.

Related information

Linker option `--map-file-format` (Format map file)

Section 11.2, Linker Map File Format
Linker option: --map-file-format (-m)

Menu entry
1. Select **Linker » Map File**.
2. Enable the option **Generate XML map file format (.mapxml) for map file viewer**.
3. (Optional) Enable the option **Generate map file**.
4. Enable or disable the types of information to be included.

Command line syntax

```
--map-file-format=flag,...
-mflags
```

You can set the following flags:

```
+/-callgraph c/C Include call graph information
+/-removed d/D Include information on removed sections
+/-files f/F Include processed files information
+/-invocation i/I Include information on invocation and tools
+/-link k/K Include link result information
+/-locate l/L Include locate result information
+/-memory m/M Include memory usage information
+/-nonalloc n/N Include information of non-alloc sections
+/-overlay o/O Include overlay information
+/-statics q/Q Include module local symbols information
+/-crossref r/R Include cross references information
+/-lsl s/S Include processor and memory information
+/-rules u/U Include locate rules
```

Use the following options for predefined sets of flags:

```
--map-file-format=0 -m0 Link information
 Alias for -mcDfkLMNoQrSU
--map-file-format=1 -m1 Locate information
 Alias for -mCDfIKIMNoQRSU
--map-file-format=2 -m2 Most information
 Alias for -mdfiklmNoQrSu
```

Default: --map-file-format=2
Description

With this option you specify which information you want to include in the map file.

On the command line you must use this option in combination with the option `--map-file (-M)`.

Related information

Linker option `--map-file` (Generate map file)

Section 11.2, Linker Map File Format
Linker option: --misra-c-report

Menu entry

Command line syntax

--misra-c-report [=file]

Description

With this option you tell the linker to create a MISRA C Quality Assurance report. This report lists the various modules in the project with the respective MISRA C settings at the time of compilation. If you do not specify a filename, the file basename.mcr is used.

Related information

C compiler option --misrac (MISRA C checking)
**Linker option: --non-romable**

**Menu entry**
-  

**Command line syntax**

```
--non-romable
```

**Description**

With this option you tell the linker that the application must not be located in ROM. The linker will locate all ROM sections, including a copy table if present, in RAM. When the application is started, the data sections are re-initialized and the BSS sections are cleared as usual.

This option is, for example, useful when you want to test the application in RAM before you put the final application in ROM. This saves you the time of flashing the application in ROM over and over again.

If you want to locate your application in RAM only, without using ROM/flash resources of the chip, for example when you run the debugger in RAM only, also specify the options `--no-rom-copy` and `--user-provided-initialization-code`.

**Related information**

- Linker option `--no-rom-copy` (Do not generate ROM copy)
- Linker option `--user-provided-initialization-code` (Own initialization code, no standard copy table)
**Linker option: --no-rescan**

**Menu entry**

1. Select Linker » Libraries.
2. Disable the option Rescan libraries to solve unresolved externals.

**Command line syntax**

```
--no-rescan
```

**Description**

When the linker processes a library it searches for symbol definitions that are referenced by the objects and libraries processed so far. If the library contains a definition for an unresolved reference the linker extracts the object that contains the definition from the library. The linker processes object files and libraries in the order in which they appear on the command line.

When all objects and libraries are processed the linker checks if there are unresolved symbols left. If so, the default behavior of the linker is to rescan all libraries in the order given at the command line. The linker stops rescanning the libraries when all symbols are resolved, or when the linker could not resolve any symbol(s) during the rescan of all libraries. Notice that resolving one symbol may introduce new unresolved symbols.

With this option, you tell the linker to scan the object files and libraries only once. When the linker has not resolved all symbols after the first scan, it reports which symbols are still unresolved. This option is useful if you are building your own libraries. The libraries are most efficiently organized if the linker needs only one pass to resolve all symbols.

**Related information**

Linker option `--first-library-first` (Scan libraries in given order)
Linker option: --no-rom-copy (-N)

Menu entry
-

Command line syntax
--no-rom-copy
-N

Description
With this option the linker will not generate a ROM copy for data sections. A copy table is generated and contains entries to clear BSS sections. However, no entries to copy data sections from ROM to RAM are placed in the copy table.

The data sections are initialized when the application is downloaded. The data sections are not re-initialized when the application is restarted.

Related information
Linker option --non-romable (Application is not romable)
Linker option --user-provided-initialization-code (Own initialization code, no standard copy table)
Linker option: --no-warnings (-w)

Menu entry

1. Select Linker » Diagnostics.

   The Suppress warnings box shows the warnings that are currently suppressed.

2. To suppress a warning, click on the Add button in the Suppress warnings box.

3. Enter the numbers, separated by commas, of the warnings you want to suppress (for example 135,136). Or you can use the Add button multiple times.

4. To suppress all warnings, enable the option Suppress all warnings.

   Use the Edit and Delete button to change a warning number or to remove a number from the list.

Command line syntax

--no-warnings [=number,...]

-w [number,...]

Description

With this option you can suppresses all warning messages or specific warning messages.

On the command line this option works as follows:

- If you do not specify this option, all warnings are reported.
- If you specify this option but without numbers, all warnings are suppressed.
- If you specify this option with a number, only the specified warning is suppressed. You can specify the option --no-warnings=number multiple times.

Example

To suppress warnings 135 and 136, enter:

lpcp --no-warnings=135,136 test.o

Related information

Linker option --warnings-as-errors (Treat warnings as errors)
Linker option: --optimize (-O)

Menu entry

1. Select **Linker » Optimization**.
2. Select one or more of the following options:
   - Delete unreferenced sections
   - Use a 'first-fit decreasing' algorithm
   - Compress copy table
   - Delete duplicate code
   - Delete duplicate data

Command line syntax

```
--optimize=flag,...
-Oflags
```

You can set the following flags:

-`+/-delete-unreferenced-sections`  
  - c/C Delete unreferenced sections from the output file
-`+/-first-fit-decreasing`  
  - l/L Use a 'first-fit decreasing' algorithm to locate unrestricted sections in memory
-`+/-copytable-compression`  
  - t/T Emit smart restrictions to reduce copy table size
-`+/-delete-duplicate-code`  
  - x/X Delete duplicate code sections from the output file
-`+/-delete-duplicate-data`  
  - y/Y Delete duplicate constant data from the output file

Use the following options for predefined sets of flags:

- `--optimize=0 -- O0` No optimization  
  - `--OCLTXY` Alias for
- `--optimize=1 -- O1` Default optimization  
  - `--OCltxy` Alias for
- `--optimize=2 -- O2` All optimizations  
  - `--Ocltxy` Alias for

Default: `--optimize=1`
Description

With this option you can control the level of optimization.

Note that when you use the flag `+copytable-compression`, sections affected by the copy table are located as if they were in a clustered LSL group, if they do not have a locate restriction yet.

Related information

For details about each optimization see Section 5.6, Linker Optimizations.

Define the mutual order of sections in an LSL group in Section 12.8.2, Creating and Locating Groups of Sections.
**Linker option: --option-file (-f)**

**Menu entry**

1. Select **Linker » Miscellaneous**.
2. Add the option **--option-file** to the **Additional options** field.

   *Be aware that the options in the option file are added to the linker options you have set in the other pages. Only in extraordinary cases you may want to use them in combination.*

**Command line syntax**

```bash
--option-file=file,...
-f file,...
```

**Description**

This option is primarily intended for command line use. Instead of typing all options on the command line, you can create an option file which contains all options and flags you want to specify. With this option you specify the option file to the linker.

Use an option file when the command line would exceed the limits of the operating system, or just to store options and save typing.

Option files can also be generated on the fly, for example by the make utility. You can specify the option **--option-file** multiple times.

**Format of an option file**

- Multiple arguments on one line in the option file are allowed.
- To include whitespace in an argument, surround the argument with single or double quotes.
- If you want to use single quotes as part of the argument, surround the argument by double quotes and vise versa:

  "This has a single quote ' embedded"

  'This has a double quote " embedded'

  'This has a double quote " and a single quote '' embedded"

- When a text line reaches its length limit, use a \ to continue the line. Whitespace between quotes is preserved.

  "This is a continuation \ line"

  -> "This is a continuation line"
• It is possible to nest command line files up to 25 levels.

**Example**

Suppose the file `myoptions` contains the following lines:

```plaintext
--map-file=my.map               (generate a map file)
test.o                          (input file)
--library-directory=c:\mylibs   (additional search path for system libraries)
```

Specify the option file to the linker:

```
lpcp --option-file=myoptions
```

This is equivalent to the following command line:

```
lpcp --map-file=my.map test.o --library-directory=c:\mylibs
```

**Related information**

-
Linker option: --output (-o)

Menu entry
-

Command line syntax

--output=[filename][:format[:addr_size][,space_name]]...
-o[filename][:format[:addr_size][,space_name]]...

You can specify the following formats:

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ELF</td>
<td>ELF/DWARF</td>
</tr>
<tr>
<td>IHEX</td>
<td>Intel Hex</td>
</tr>
<tr>
<td>SREC</td>
<td>Motorola S-records</td>
</tr>
</tbody>
</table>

Description

By default, the linker generates an output file in ELF/DWARF format, with the name task1.elf.

With this option you can specify an alternative filename, and an alternative output format. The default output format is the format of the first input file.

You can use the --output option multiple times. This is useful to generate multiple output formats. With the first occurrence of the --output option you specify the basename (the filename without extension), which is used for subsequent --output options with no filename specified. If you do not specify a filename, or you do not specify the --output option at all, the linker uses the default basename taskn.

IHEX and SREC formats

If you specify the Intel Hex format or the Motorola S-records format, you can use the argument addr_size to specify the size of addresses in bytes (record length). For Intel Hex you can use the values: 1, 2, and 4 (default). For Motorola S-records you can specify: 2 (S1 records), 3 (S2 records, default) or 4 bytes (S3 records). Note that if you make the addr_size too small, the linker might give a fatal object writer error indicating an address overflow.

With the argument space_name you can specify the name of the address space. The name of the output file will be filename with the extension .hex or .sre and contains the code and data allocated in the specified space. If they exist, any other address spaces are also emitted whereas their output files are named filename_spacename with the extension .hex or .sre.

If you do not specify space_name, or you specify a non-existing space, the default address space is filled in.

Use option --chip-output (-c) to create Intel Hex or Motorola S-record output files for each chip defined in the LSL file (suitable for loading into a PROM-programmer).
Example

To create the output file `myfile.hex` of the address space named `linear`, enter:

```
lpcp test.o --output=myfile.hex:IHEX:2,linear
```

If they exist, any other address spaces are emitted as well and are named `myfile_spacename.hex`.

Related information

- **Linker option `--chip-output`** (Generate an output file for each chip)
- **Linker option `--hex-format`** (Specify Hex file format settings)
Linker option: --strip-debug (-S)

Menu entry
1. Select Linker » Miscellaneous.
2. Enable the option Strip symbolic debug information.

Command line syntax
--strip-debug
-S

Description
With this option you specify not to include symbolic debug information in the resulting output file.

Related information
-
Linker option: --user-provided-initialization-code (-i)

Menu entry

1. Select Linker » Miscellaneous.
2. Enable the option Do not use standard copy table for initialization.

Command line syntax

--user-provided-initialization-code

-i

Description

It is possible to use your own initialization code, for example, to save ROM space. With this option you tell the linker not to generate a copy table for initialize/clear sections. Use linker labels in your source code to access the positions of the sections when located.

If the linker detects references to the TASKING initialization code, an error is emitted: it is either the TASKING initialization routine or your own, not both.

Note that the options --no-rom-copy and --non-romable, may vary independently. The 'copytable-compression' optimization (--optimize=t) is automatically disabled when you enable this option.

Related information

Linker option --no-rom-copy (Do not generate ROM copy)

Linker option --non-romable (Application is not romable)

Linker option --optimize (Specify optimization)
Linker option: --verbose (-v)

Menu entry
-

Command line syntax

--verbose
-v

Description

With this option you put the linker in *verbose* mode. The linker prints the link phases while it processes the files. The linker prints one entry for each action it executes for a task. When you use this option twice (*-vv*) you put the linker in *extra verbose* mode. In this mode the linker also prints the filenames and it shows which objects are extracted from libraries and it shows verbose information that would normally be hidden when you use the normal verbose mode or when you run without verbose. With this option you can monitor the current status of the linker.

Related information
-


Linker option: --version (-V)

Menu entry

Command line syntax

--version

-v

Description

Display version information. The linker ignores all other options or input files.

Related information
Linker option: `--warnings-as-errors`

Menu entry

1. Select **Global Options**.
2. Enable the option **Treat warnings as errors**.

Command line syntax

```
--warnings-as-errors[=number,...]
```

Description

When the linker detects an error or warning, it tries to continue the link process and reports other errors and warnings. When you use this option without arguments, you tell the linker to treat all warnings as errors. This means that the exit status of the linker will be non-zero after the detection of one or more linker warnings. As a consequence, the linker will not produce any output files.

You can also limit this option to specific warnings by specifying a comma-separated list of warning numbers.

Related information

Linker option **--no-warnings** (Suppress some or all warnings)
8.5. Control Program Options

The control program ccpcp facilitates the invocation of the various components of the PCP toolset from a single command line.

Options in Eclipse versus options on the command line

Eclipse invokes the compiler, assembler and linker via the control program. Therefore, it uses the syntax of the control program to pass options and files to the tools. The control program processes command line options either by itself, or, when the option is unknown to the control program, it looks whether it can pass the option to one of the other tools. However, for directly passing an option to the C compiler, assembler or linker, it is recommended to use the control program options --pass-c, --pass-assembler, --pass-linker.

See the previous sections for details on the options of the tools.

Short and long option names

Options can have both short and long names. Short option names always begin with a single minus (-) character, long option names always begin with two minus (--) characters. You can abbreviate long option names as long as it forms a unique name. You can mix short and long option names on the command line.

Options can have flags or suboptions. To switch a flag 'on', use a lowercase letter or a +longflag. To switch a flag off, use an uppercase letter or a -longflag. Separate longflags with commas. The following two invocations are equivalent:

ccpcp -Wc-Oac test.c
ccpcp --pass-c=--optimize=+coalesce,+cse test.c

When you do not specify an option, a default value may become active.
Control program option: --address-size

Menu entry
-

Command line syntax
--address-size=addr_size

Description

If you specify IHEX or SREC with the control option --format, you can additionally specify the record length to be emitted in the output files.

With this option you can specify the size of the addresses in bytes (record length). For Intel Hex you can use the values 1, 2 or 4 bytes (default). For Motorola-S you can specify: 2 (S1 records), 3 (S2 records) or 4 bytes (S3 records, default).

If you do not specify addr_size, the default address size is generated.

Example

To create the SREC file test.sre with S1 records, type:

ccpcp --format=SREC --address-size=2 test.c

Related information

Control program option --format (Set linker output format)
Control program option --output (Output file)
Control program option: --case-insensitive

Menu entry

1. Select Assembler » Symbols.
2. Enable the option Case insensitive identifiers.

Command line syntax

--case-insensitive

Default: case sensitive

Description

With this option you tell the assembler not to distinguish between uppercase and lowercase characters. By default the assembler considers uppercase and lowercase characters as different characters.

Assembly source files that are generated by the compiler must always be assembled case sensitive. When you are writing your own assembly code, you may want to specify the case insensitive mode.

Example

When assembling case insensitive, the label LabelName is the same label as labelname.

ccpcp --case-insensitive test.src

Related information

Assembler option --case-insensitive
Assembler control $CASE
Control program option: --check

Menu entry
-

Command line syntax
--check

Description
With this option you can check the source code for syntax errors, without generating code. This saves time in developing your application because the code will not actually be compiled.

The compiler/assembler reports any warnings and/or errors.

This option is available on the command line only.

Related information
C compiler option --check (Check syntax)
Assembler option --check (Check syntax)
Control program option: --cpu (-C)

Menu entry
1. Expand C/C++ Build and select Processor.
2. From the Processor selection list, select a processor or select User defined TriCore ....

Command line syntax

```
--cpu=id | name | cpu
-C id | name | cpu
```

Description

With this option you define the target processor for which you create your application. You can specify a full processor name, like TC1796B, or a base CPU name, like tc1796b or its unique id, like tc1796b.

Based on this option the compiler can include the special function register file regcpu.sfr, and the assembler can include the file regcpu.def, if you specify option --tasking-sfr.

The standard list of supported processors is defined in the file processors.xml. This file defines for each processor its full name (for example, TC1796B), its ID, the base CPU name (for example, tc1796b), the core settings (for example, pcp2) and the list of silicon bugs for that processor. To show a list of all supported processors you can use option --cpu-list.

The control program reads the file processors.xml. The lookup sequence for names specified to this option is as follows:

1. match with the 'id' attribute in processors.xml (case insensitive, for example tc1796b)
2. if none matched, match with the 'name' attribute in processors.xml (case insensitive, for example TC1796B)
3. if still none matched, match any of the base CPU names (the 'cpu' attribute in processors.xml, for example tc1796b). If multiple processors exist with the same base CPU, a warning will be issued and the first one is selected.
4. if still none matched, the control program issues a fatal error.

The preferred use of the option --cpu, is to specify an ID because that is always a unique name. For example, --cpu=tc1796b. The control program will lookup this processor name in the file processors.xml. The control program passes the options to the underlaying tools. For example, `-D__CPU__=tc1796b -D__CPU_TC1796B__` to the C compiler, or `-dtc1796b.lsl -D__CPU__=tc1796b` to the linker.

Example

To generate the file test.elf for the TC1796B processor, enter:

```
ccpcp --cpu=tc1796b -t test.c
```
The control program will call the tools as follows:

cpcp  -D__CPU__=tc1796b -D__CPU_TC1796B__
     -o test.src test.c
aspcp -D__CPU__=tc1796b -D__CPU_TC1796B__
     -o test.o test.src
lpcp  -o test.elf -dtc1796b.1s1 -dextmem.1s1 -D__CPU__=tc1796b
     --map-file test.o -Linstall-dir/cpcp/lib/pcp2 -lc -lfp

Related information

Control program option --cpu-list (Show list of processors)

Control program option --processors (Read additional processor definitions)

Control program option --tasking-sfr (Include SFR file)

Section 1.2.4, Accessing Hardware from C
Control program option: --cpu-list

Menu entry
-

Command line syntax

--cpu-list[=pattern]

Description

With this option the control program shows a list of supported processors as defined in the file processors.xml. This can be useful when you want to select a processor name or id for the --cpu option.

The pattern works similar to the UNIX grep utility. You can use it to limit the output list.

Example

To show a list of all processors, enter:

ccpcp --cpu-list

To show all processors that have tc179 in their name, enter:

ccpcp --cpu-list=tc179

--- ~/cpcp/etc/processors.xml ---

<table>
<thead>
<tr>
<th>id</th>
<th>name</th>
<th>CPU</th>
<th>core</th>
</tr>
</thead>
<tbody>
<tr>
<td>tc1792</td>
<td>TC1792</td>
<td>tc1792</td>
<td>pcp2</td>
</tr>
<tr>
<td>tc1796</td>
<td>TC1796</td>
<td>tc1796</td>
<td>pcp2</td>
</tr>
<tr>
<td>tc1796b</td>
<td>TC1796B</td>
<td>tc1796b</td>
<td>pcp2</td>
</tr>
<tr>
<td>tc1797</td>
<td>TC1797</td>
<td>tc1797</td>
<td>pcp2</td>
</tr>
<tr>
<td>tc1791</td>
<td>TC1791</td>
<td>tc1791</td>
<td>pcp2</td>
</tr>
<tr>
<td>tc1793</td>
<td>TC1793</td>
<td>tc1793</td>
<td>pcp2</td>
</tr>
<tr>
<td>tc1798</td>
<td>TC1798</td>
<td>tc1798</td>
<td>pcp2</td>
</tr>
</tbody>
</table>

Related information

Control program option --cpu (Select processor)
Control program option: --create (-c)

Menu entry

Command line syntax

```
--create [ stage ]
-c [ stage ]
```

You can specify the following stages:

- **relocatable** I  Stop after the files are linked to a linker object file (.out)
- **mil** m  Stop after C files are compiled to MIL (.mil)
- **object** o  Stop after the files are assembled to objects (.o)
- **assembly** s  Stop after C files are compiled to assembly (.src)

Default (without flags): **--create=object**

Description

Normally the control program generates an absolute object file of the specified output format from the file you supplied as input. With this option you tell the control program to stop after a certain number of phases.

Example

To generate the object file `test.o`:

```
ccpcp --create test.c
```

The control program stops after the file is assembled. It does not link nor locate the generated output.

Related information

Linker option **--link-only** (Link only, no locating)
Control program option: --debug-info (-g)

Menu entry

1. Select C Compiler » Debugging.

2. To generate symbolic debug information, select Default, Small set or Full. To disable the generation of debug information, select None.

Command line syntax

--debug-info [=suboption]

-g [suboption]

You can set the following suboptions:

<table>
<thead>
<tr>
<th>suboption</th>
<th>code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>small</td>
<td>1</td>
<td>Emit small set of debug information.</td>
</tr>
<tr>
<td>default</td>
<td>2</td>
<td>Emit default symbolic debug information.</td>
</tr>
<tr>
<td>all</td>
<td>3</td>
<td>Emit full symbolic debug information.</td>
</tr>
</tbody>
</table>

Default: --debug-info (same as --debug-info=default)

Description

With this option you tell the control program to include debug information in the generated object file.

The control program passes the option --debug-info (-g) to the C compiler and calls the assembler with --debug-info=+smart,+local (-gsl).

Related information

C compiler option --debug-info (Generate symbolic debug information)

Assembler option --debug-info (Generate symbolic debug information)
Control program option: --define (-D)

Menu entry

1. Select C Compiler » Preprocessing and/or Assembler » Preprocessing.

   The Defined symbols box right-below shows the symbols that are currently defined.

2. To define a new symbol, click on the Add button in the Defined symbols box.

3. Type the symbol definition (for example, demo=1)

   Use the Edit and Delete button to change a macro definition or to remove a macro from the list.

Command line syntax

--define=macro_name[=macro_definition]

-Dmacro_name[=macro_definition]

Description

With this option you can define a macro and specify it to the preprocessor. If you only specify a macro name (no macro definition), the macro expands as ‘1’.

You can specify as many macros as you like. Simply use the Add button to add new macro definitions.

On the command line, use the option --define (-D) multiple times. If the command line exceeds the limit of the operating system, you can define the macros in an option file which you then must specify to the compiler with the option --option-file (-f) file.

Defining macros with this option (instead of in the C source) is, for example, useful to compile conditional C source as shown in the example below.

The control program passes the option --define (-D) to the compiler and the assembler.

   Make sure you do not use a reserved keyword as a macro name, as this can lead to unexpected results.

Example

Consider the following C program with conditional code to compile a demo program and a real program:

```c
void main( void )
{
    #if DEMO
        demo_func();    /* compile for the demo program */
    #else
        real_func();    /* compile for the real program */
```
You can now use a macro definition to set the DEMO flag:

```shell
ccpcp --define=DEMO test.c
ccpcp --define=DEMO=1 test.c
```

Note that both invocations have the same effect.

The next example shows how to define a macro with arguments. Note that the macro name and definition are placed between double quotes because otherwise the spaces would indicate a new option.

```shell
ccpcp --define="MAX(A,B)=((A) > (B) ? (A) : (B))" test.c
```

**Related information**

- Control program option **--undefine** (Remove preprocessor macro)
- Control program option **--option-file** (Specify an option file)
Control program option: --dep-file

Menu entry
-

Command line syntax

--dep-file [=file]

Description

With this option you tell the compiler to generate dependency lines that can be used in a Makefile. In contrast to the option --preprocess=+make, the dependency information will be generated in addition to the normal output file.

By default, the information is written to a file with extension .d (one for every input file). When you specify a filename, all dependencies will be combined in the specified file.

Example

ccpcp --dep-file=test.dep -t test.c

The compiler compiles the file test.c, which results in the output file test.src, and generates dependency lines in the file test.dep.

Related information

Control program option --preprocess=+make (Generate dependencies for make)
Control program option: --diag

Menu entry

1. From the Window menu, select Show View » Other » TASKING » Problems.

   The Problems view is added to the current perspective.

2. In the Problems view right-click on a message.

   A popup menu appears.

3. Select Detailed Diagnostics Info.

   A dialog box appears with additional information.

Command line syntax

```
--diag=[format:]{all | nr,...}
```

You can set the following output formats:

- **html**: HTML output.
- **rtf**: Rich Text Format.
- **text**: ASCII text.

Default format: text

Description

With this option you can ask for an extended description of error messages in the format you choose. The output is directed to stdout (normally your screen) and in the format you specify. You can specify the following formats: **html**, **rtf** or **text** (default). To create a file with the descriptions, you must redirect the output.

With the suboption **all**, the descriptions of all error messages are given. If you want the description of one or more selected error messages, you can specify the error message numbers, separated by commas.

Example

To display an explanation of message number 103, enter:

```
ccpcp --diag=103
```

This results in message 103 with explanation.

To write an explanation of all errors and warnings in HTML format to file `ccerrors.html`, use redirection and enter:

```
ccpcp --diag=html:all > ccerrors.html
```
Related information

Section 3.8, C Compiler Error Messages
Control program option: --dry-run (-n)

Menu entry
-

Command line syntax

--dry-run

-n

Description

With this option you put the control program in verbose mode. The control program prints the invocations of the tools it would use to process the files without actually performing the steps.

Related information

Control program option --verbose (Verbose output)
Control program option: --error-file

Menu entry
-

Command line syntax
--error-file

Description
With this option the control program tells the compiler, assembler and linker to redirect diagnostic messages to a file.

Example
To write diagnostic messages to error files instead of stderr, enter:

ccpcp --error-file test.c

Related information
Control Program option --warnings-as-errors (Treat warnings as errors)
Control program option: --error-limit

Menu entry
1. Select C Compiler » Diagnostics.
2. Enter a value in the Maximum number of emitted errors field.

Command line syntax

--error-limit=number

Default: 42

Description

With this option you limit the number of error messages in one invocation to the specified number. When the limit is exceeded, the control program aborts with fatal error message F105. Warnings and informational messages are not included in the count. When 0 (zero) or a negative number is specified, the control program emits all errors. Without this option the maximum number of errors is 42. The control program also passes this option to the C compiler, assembler and linker.

Related information

Section 3.8, C Compiler Error Messages
Control program option: --format

Menu entry
-

Command line syntax

--format=format

You can specify the following formats:

- **ELF**: ELF/DWARF
- **IHEX**: Intel Hex
- **SREC**: Motorola S-records

Description

With this option you specify the output format for the resulting (absolute) object file. The default output format is ELF/DWARF, which can directly be used by the debugger.

If you choose IHEX or SREC, you can additionally specify the address size of the chosen format (option --address-size).

Example

To generate a Motorola S-record output file:

```bash
ccpcp --format=SREC test1.c test2.c --output=test.sre
```

Related information

- Control program option --address-size (Set address size for linker IHEX/SREC files)
- Control program option --output (Output file)
- Linker option --chip-output (Generate an output file for each chip)
Control program option: --fp-model

Menu entry
1. Select C Compiler » Floating-Point.
2. Make a selection from the Floating-point model list.
3. If you selected Custom, enable one or more individual options.

Command line syntax

```
--fp-model=flags
```

You can set the following flags:

- `+/-contract`  
  allow expression contraction
- `+/-fastlib`  
  allow less precise library functions
- `+/-nonan`  
  allow optimizations to ignore NaN/Inf
- `+/-rewrite`  
  allow expression rewriting
- `+/-trap`  
  support trapping on exceptions
- `+/-negzero`  
  ignore sign of -0.0

```
    0 alias for --fp-model=CLNStZ (strict)
    1 alias for --fp-model=cLNSTZ (precise)
    2 alias for --fp-model=clnrTz (fast)
```

Default: --fp-model=clnrTz

Description

With this option you select the floating-point execution model.

With `--fp-model=+contract` you allow the compiler to contract multiple float operations into a single operation, with different rounding results. A possible example is fused multiply-add.

With `--fp-model=+fastlib` you allow the compiler to select faster but less accurate library functions for certain floating-point operations.

With `--fp-model=+nonan` you allow the compiler to ignore NaN or Inf input values. An example is to replace multiply by zero with zero.

With `--fp-model=+rewrite` you allow the compiler to rewrite expressions by reassociating. This might result in rounding differences and possibly different exceptions. An example is to rewrite $(a^c) + (b^c)$ as $(a+b)^c$. 
With `--fp-model=+trap` operations trap on floating-point exceptions. By default the control program uses the non-trapping version of the floating-point library (libfp.a). With this option you tell the control program to use the trapping version of the floating-point library (libfpt.a).

If you use the trapping floating-point library, exceptional floating-point cases are intercepted and can be handled separately by an application defined exception handler. Using this library decreases the execution speed of your application.

With `--fp-model=+negzero` you allow the compiler to ignore the sign of -0.0 values. An example is to replace (a-a) by zero.

**Related information**

Pragmas STDC FP_CONTRACT, fp_negzero, fp_nonan and fp_rewrite in Section 1.6, Pragmas to Control the Compiler.
Control program option: --help (-?)

Menu entry
-

Command line syntax

--help [=item]

-?

You can specify the following argument:

  options  Show extended option descriptions

Description

Displays an overview of all command line options. When you specify the argument options you can list detailed option descriptions.

Example

The following invocations all display a list of the available command line options:

  ccpcp -?
  ccpcp --help
  ccpcp

To see a detailed description of the available options, enter:

  ccpcp --help=options

Related information
-

Control program option: --include-directory (-I)

Menu entry

1. Select C Compiler » Include Paths.

   The Include paths box shows the directories that are added to the search path for include files.

2. To define a new directory for the search path, click on the Add button in the Include paths box.

3. Type or select a path.

   Use the Edit and Delete button to change a path or to remove a path from the list.

Command line syntax

--include-directory=path,...
-I path,...

Description

With this option you can specify the path where your include files are located. A relative path will be relative to the current directory.

The control program passes this option to the compiler and the assembler.

Example

Suppose that the C source file test.c contains the following lines:

```c
#include <stdio.h>
#include "myinc.h"
```

You can call the control program as follows:

```
ccpcp --include-directory=myinclude test.c
```

First the compiler looks for the file stdio.h in the directory myinclude relative to the current directory. If it was not found, the compiler searches in the environment variable and then in the default include directory.

The compiler now looks for the file myinc.h in the directory where test.c is located. If the file is not there the compiler searches in the directory myinclude. If it was still not found, the compiler searches in the environment variable and then in the default include directory.

Related information

C compiler option --include-directory (Add directory to include file search path)

C compiler option --include-file (Include file at the start of a compilation)
Control program option: --iso

Menu entry
1. Select C Compiler » Language.
2. From the Comply to C standard list, select ISO C99, ISO C11, or ISO C90.

Command line syntax

--iso={90|99|11}

Default: --iso=99

Description

Independent of the chosen ISO standard, the control program always links libraries with C99 support.

Example
To select the ISO C11 standard on the command line:

ccpcp --iso=11 test.c

Related information
C compiler option --iso (ISO C standard)
Control program option: --keep-output-files (-k)

Menu entry

Eclipse always removes generated output files when an error occurs.

Command line syntax

--keep-output-files

-k

Description

If an error occurs during the compilation, assembling or linking process, the resulting output file may be incomplete or incorrect. With this option you keep the generated output files when an error occurs.

By default the control program removes generated output files when an error occurs. This is useful when you use the make utility. If the erroneous files are not removed, the make utility may process corrupt files on a subsequent invocation.

Use this option when you still want to use the generated files. For example when you know that a particular error does not result in a corrupt file, or when you want to inspect the output file, or send it to Altium support.

The control program passes this option to the compiler, assembler and linker.

Example

ccpcp --keep-output-files test.c

When an error occurs during compiling, assembling or linking, the erroneous generated output files will not be removed.

Related information

C compiler option --keep-output-files

Assembler option --keep-output-files

Linker option --keep-output-files
Control program option: --keep-temporary-files (-t)

Menu entry

1. Select **Global Options**.
2. Enable the option **Keep temporary files**.

Command line syntax

--keep-temporary-files

-t

Description

By default, the control program removes intermediate files like the .src file (result of the compiler phase) and the .o file (result of the assembler phase).

With this option you tell the control program to keep temporary files it generates during the creation of the absolute object file.

Example

ccpcp --keep-temporary-files test.c

The control program keeps all intermediate files it generates while creating the absolute object file test.elf.

Related information
**Control program option: --library (-l)**

**Menu entry**

1. Select **Linker » Libraries**.
   
   *The Libraries box shows the list of libraries that are linked with the project.*

2. To add a library, click on the **Add** button in the **Libraries** box.

3. Type or select a library (including its path).

4. Optionally, disable the option **Link default libraries**.

   Use the **Edit** and **Delete** button to change a library name or to remove a library from the list.

**Command line syntax**

```
--library=name
-l name
```

**Description**

With this option you tell the linker via the control program to use system library `libname.a`, where `name` is a string. The linker first searches for system libraries in any directories specified with --library-directory, then in the directories specified with the environment variables `LIBTC1V1_3` / `LIBTC1V1_3_1` / `LIBTC1V1_6`, unless you used the option --ignore-default-library-path.

**Example**

To search in the system library `libc.a` (C library):

```
ccpcp test.o mylib.a --library=c
```

The linker links the file `test.o` and first looks in library `mylib.a` (in the current directory only), then in the system library `libc.a` to resolve unresolved symbols.

**Related information**

- Control program option --no-default-libraries (Do not link default libraries)
- Control program option --library-directory (Additional search path for system libraries)
- Section 5.3, *Linking with Libraries*
- Chapter 10, *Libraries*
Control program option: --library-directory (-L) / --ignore-default-library-path

Menu entry

1. Select Linker » Libraries.

   The Library search path box shows the directories that are added to the search path for library files.

2. To define a new directory for the search path, click on the Add button in the Library search path box.

3. Type or select a path.

   Use the Edit and Delete button to change a path or to remove a path from the list.

Command line syntax

--library-directory=path,...
-L path,...

--ignore-default-library-path
-L

Description

With this option you can specify the path(s) where your system libraries, specified with the option --library (-l), are located. If you want to specify multiple paths, use the option --library-directory for each separate path.

The default path is $(PRODDIR)\lib\pcp2.

If you specify only -L (without a pathname) or the long option --ignore-default-library-path, the linker will not search the default path and also not in the paths specified in the environment variables LIBTC1V1_3 / LIBTC1V1_3_1 / LIBTC1V1_6. So, the linker ignores steps 2 and 3 as listed below.

The priority order in which the linker searches for system libraries specified with the option --library (-l) is:

1. The path that is specified with the option --library-directory.

2. The path that is specified in the environment variables LIBTC1V1_3 / LIBTC1V1_3_1 / LIBTC1V1_6.

3. The default directory $(PRODDIR)\lib\pcp2.

Example

Suppose you call the control program as follows:
ccpcp test.c --library-directory=c:\mylibs --library=c

First the linker looks in the directory c:\mylibs for library libc.a (this option). If it does not find the requested libraries, it looks in the directory that is set with the environment variables LIBTC1V1_3 / LIBTC1V1_3_1 / LIBTC1V1_6. Then the linker looks in the default directory $(PRODDIR)\lib\pcp2 for libraries.

Related information

Control program option --library (Link system library)

Section 5.3.1, How the Linker Searches Libraries
Control program option: --list-files

Menu entry

Command line syntax

```
--list-files [=file]
```

Default: no list files are generated

Description

With this option you tell the assembler via the control program to generate a list file for each specified input file. A list file shows the generated object code and the relative addresses. Note that the assembler generates a relocatable object file with relative addresses.

With the optional `file` you can specify a name for the list file. This is only possible if you specify only one input file to the control program. If you do not specify a file name, or you specify more than one input file, the control program names the generated list file(s) after the specified input file(s) with extension `.lst`.

Note that object files and library files are not counted as input files.

Related information

Assembler option `--list-file` (Generate list file)

Assembler option `--list-format` (Format list file)
Control program option: --lsl-file (-d)

Menu entry

An LSL file can be generated when you create your TriCore project in Eclipse:

1. From the File menu, select File » New » TASKING TriCore C/C++ Project.

   The New C/C++ Project wizard appears.

2. Fill in the project settings in each dialog and click Next > until the TriCore Project Settings appear.

3. Enable the option Add linker script file to the project and click Finish.

   Eclipse creates your project and the file project.lsl in the project directory.

The LSL file can be specified in the Properties dialog:

1. Select Linker » Script File.

2. Specify a LSL file in the Linker script file (.lsl) field.

Command line syntax

--lsl-file=file,...

-dfile,...

Description

A linker script file contains vital information about the core for the locating phase of the linker. A linker script file is coded in LSL and contains the following types of information:

- the architecture definition describes the core’s hardware architecture.
- the memory definition describes the physical memory available in the system.
- the section layout definition describes how to locate sections in memory.

With this option you specify a linker script file via the control program to the linker. If you do not specify this option, the linker uses a default script file. You can specify the existing file target.lsl or the name of a manually written linker script file. You can use this option multiple times. The linker processes the LSL files in the order in which they appear on the command line.

Related information

Section 5.7, Controlling the Linker with a Script
Control program option: --make-target

Menu entry
-

Command line syntax

--make-target=name

Description

With this option you can overrule the default target name in the make dependencies generated by the options --preprocess=+make (-Em) and --dep-file. The default target name is the basename of the input file, with extension .o.

Example

ccpcp --preprocess=+make --make-target=../mytarget.o test.c

The compiler generates dependency lines with the default target name ../mytarget.o instead of test.o.

Related information

Control program option --preprocess=+make (Generate dependencies for make)

Control program option --dep-file (Generate dependencies in a file)
Control program option: --mil-link / --mil-split

Menu entry
1. Select C Compiler » Optimization.
2. Enable the option Build for application wide optimizations (MIL linking).

Command line syntax

```
--mil-link
--mil-split=[file,...]
```

Description

With option `--mil-link` the C compiler links the optimized intermediate representation (MIL) of all input files and MIL libraries specified on the command line in the compiler. The result is one single module that is optimized another time.

Option `--mil-split` does the same as option `--mil-link`, but in addition, the resulting MIL representation is written to a file with the suffix `.mil` and the C compiler also splits the MIL representation and writes it to separate files with suffix `.ms`. One file is written for each input file or MIL library specified on the command line. The `.ms` files are only updated on a change.

With option `--mil-split` you can perform application-wide optimizations during the frontend phase by specifying all modules at once, and still invoke the backend phase one module at a time to reduce the total compilation time.

Optionally, you can specify another filename for the `.ms` file the C compiler generates. Without an argument, the basename of the C source file is used to create the `.ms` filename. Note that if you specify a filename, you have to specify one filename for every input file.

Note that with both options some extra strict type checking is done that can cause building to fail in a way that is unforeseen and difficult to understand. For example, when you use one of these options in combination with option `--uchar` you might get the following error:

```
cpcp E289: ["..\..\..\..\strlen.c" 14/1] "strlen" redeclared with a different type
    previous declaration of "strlen"
1 errors, 0 warnings
```

Related information

Section 3.1, Compilation Process

C compiler option `--mil / --mil-split`
Control program option: --no-default-libraries

Menu entry
1. Select Linker » Libraries.
2. Disable the option Link default libraries.

Command line syntax

--no-default-libraries

Description
By default the control program specifies the standard C libraries (C99) and run-time library to the linker. With this option you tell the control program not to specify the standard C libraries and run-time library to the linker.

In this case you must specify the libraries you want to link to the linker with the option --library=library_name or pass the libraries as files on the command line. The control program recognizes the option --library (-l) as an option for the linker and passes it as such.

Example

ccpcp --no-default-libraries test.c

The control program does not specify any libraries to the linker. In normal cases this would result in unresolved externals.

To specify your own libraries (libc.a) and avoid unresolved externals:

ccpcp --no-default-libraries --library=c test.c

Related information
Control program option --library (Link system library)
Section 5.3.1, How the Linker Searches Libraries
Control program option: --no-map-file

Menu entry
1. Select Linker » Map File.
2. Disable the option Generate map file.

Command line syntax
--no-map-file

Description
By default the control program tells the linker to generate a linker map file.

A linker map file is a text file that shows how the linker has mapped the sections and symbols from the various object files (.o) to the linked object file. A locate part shows the absolute position of each section. External symbols are listed per space with their absolute address, both sorted on symbol and sorted on address.

With this option you prevent the generation of a map file.

Related information
Control program option: --no-warnings (-w)

Menu entry

1. Select C Compiler » Diagnostics.
   
   The Suppress C compiler warnings box shows the warnings that are currently suppressed.

2. To suppress a warning, click on the Add button in the Suppress warnings box.

3. Enter the numbers, separated by commas or as a range, of the warnings you want to suppress (for example 537, 538). Or you can use the Add button multiple times.

4. To suppress all warnings, enable the option Suppress all warnings.

   Use the Edit and Delete button to change a warning number or to remove a number from the list.

Command line syntax

```
--no-warnings [=number[-number],...]  
-w [number[-number],...]
```

Description

With this option you can suppresses all warning messages for the various tools or specific control program warning messages.

On the command line this option works as follows:

- If you do not specify this option, all warnings are reported.
- If you specify this option but without numbers, all warnings of all tools are suppressed.
- If you specify this option with a number or a range, only the specified control program warnings are suppressed. You can specify the option `--no-warnings=number` multiple times.

Example

To suppress all warnings for all tools, enter:

```
ccpcp test.c --no-warnings
```

Related information

Control program option --warnings-as-errors (Treat warnings as errors)
Control program option: --option-file (-f)

Menu entry
-

Command line syntax

--option-file=file,...
-f file,...

Description

This option is primarily intended for command line use. Instead of typing all options on the command line, you can create an option file which contains all options and flags you want to specify. With this option you specify the option file to the control program.

Use an option file when the command line would exceed the limits of the operating system, or just to store options and save typing.

You can specify the option --option-file multiple times.

Format of an option file

- Multiple arguments on one line in the option file are allowed.
- To include whitespace in an argument, surround the argument with single or double quotes.
- If you want to use single quotes as part of the argument, surround the argument by double quotes and vise versa:

  "This has a single quote ' embedded"

  'This has a double quote " embedded'

  'This has a double quote " and a single quote '" embeded"

- When a text line reaches its length limit, use a \ to continue the line. Whitespace between quotes is preserved.

  "This is a continuation \ line"

  -> "This is a continuation line"

- It is possible to nest command line files up to 25 levels.

Example

Suppose the file myoptions contains the following lines:
Specify the option file to the control program:

```
ccpcp --option-file=myoptions
```

This is equivalent to the following command line:

```
ccpcp --debug-info --define=DEMO=1 test.c
```

**Related information**

-
Control program option: --output (-o)

Menu entry
Eclipse always uses the project name as the basename for the output file.

Command line syntax

--output=file
-o file

Description
By default, the control program generates a file with the same basename as the first specified input file. With this option you specify another name for the resulting absolute object file.

The default output format is ELF/DWARF, but you can specify another output format with option --format.

Example

ccpcp test.c prog.c

The control program generates an ELF/DWARF object file (default) with the name test.elf.

To generate the file result.elf:

ccpcp --output=result.elf test.c prog.c

Related information

Control program option --format (Set linker output format)
Linker option --output (Output file)
Linker option --chip-output (Generate an output file for each chip)
Control program option: --pass (-W)

Menu entry
1. Select C Compiler » Miscellaneous or Assembler » Miscellaneous or Linker » Miscellaneous.
2. Add an option to the Additional options field.

Be aware that the options in the option file are added to the options you have set in the other pages. Only in extraordinary cases you may want to use them in combination. The assembler options are preceded by -Wa and the linker options are preceded by -Wl. For the C options you have to do this manually.

Command line syntax

- --pass-assembler=option       -Waoption       Pass option directly to the assembler
- --pass-c=option               -Wcoption       Pass option directly to the C compiler
- --pass-linker=option          -Wloption       Pass option directly to the linker

Description

With this option you tell the control program to call a tool with the specified option. The control program does not use or interpret the option itself, but specifies it directly to the tool which it calls.

Example

To pass the option --verbose directly to the linker, enter:

ccpcp --pass-linker=--verbose test.c

Related information

-
Control program option: --preprocess (-E) / --no-preprocessing-only

Menu entry
1. Select C Compiler » Preprocessing.
2. Enable the option Store preprocessor output in <file>.pre.
3. (Optional) Enable the option Keep comments in preprocessor output.
4. (Optional) Enable the option Keep #line info in preprocessor output.

Command line syntax

--preprocess[=flags]

-E[flags]

--no-preprocessing-only

You can set the following flags:

<table>
<thead>
<tr>
<th>Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>+/-comments</td>
<td>keep comments</td>
</tr>
<tr>
<td>+/-includes</td>
<td>generate a list of included source files</td>
</tr>
<tr>
<td>+/-list</td>
<td>generate a list of macro definitions</td>
</tr>
<tr>
<td>+/-make</td>
<td>generate dependencies for make</td>
</tr>
<tr>
<td>+/-noline</td>
<td>strip #line source position information</td>
</tr>
</tbody>
</table>

Default: --ECILMP

Description

With this option you tell the compiler to preprocess the C source. The C compiler sends the preprocessed output to the file name.pre (where name is the name of the C source file to compile). Eclipse also compiles the C source.

On the command line, the control program stops after preprocessing. If you also want to compile the C source you can specify the option --no-preprocessing-only. In this case the control program calls the compiler twice, once with option --preprocess and once for a regular compilation.

With --preprocess=+comments you tell the preprocessor to keep the comments from the C source file in the preprocessed output.

With --preprocess=+includes the compiler will generate a list of all included source files. The preprocessor output is discarded.

With --preprocess=+list the compiler will generate a list of all macro definitions. The preprocessor output is discarded.
With `--preprocess=+make` the compiler will generate dependency lines that can be used in a Makefile. The information is written to a file with extension `.d`. The preprocessor output is discarded. The default target name is the basename of the input file, with the extension `.o`. With the option `--make-target` you can specify a target name which overrules the default target name.

With `--preprocess=+noline` you tell the preprocessor to strip the `#line` source position information (lines starting with `#line`). These lines are normally processed by the assembler and not needed in the preprocessed output. When you leave these lines out, the output is easier to read.

**Example**

```
cccp -preprocess=+comments,-make,-noline --no-preprocessing-only test.c
```

The compiler preprocesses the file `test.c` and sends the output to the file `test.pre`. Comments are included but no dependencies are generated and the line source position information is not stripped from the output file. Next, the control program calls the compiler, assembler and linker to create the final object file `test.elf`.

**Related information**

- Control program option `--dep-file` (Generate dependencies in a file)
- Control program option `--make-target` (Specify target name for `-Em` output)
Control program option: --processors

Menu entry

1. From the Window menu, select Preferences.
   
   The Preferences dialog appears.

2. Select TASKING » PCP.

3. Click the Add button to add additional processor definition files.

Command line syntax

--processors=file

Description

With this option you can specify an additional XML file with processor definitions.

The standard list of supported processors is defined in the file processors.xml. This file defines for each processor its full name (for example, TC1796B), its ID, the base CPU name (for example, tc1796b), the core settings (for example, pcp2) and the list of silicon bugs for that processor.

The control program reads the specified file after the file processors.xml in the product's etc directory. Additional XML files can override processor definitions made in XML files that are read before.

Multiple --processors options are allowed.

Eclipse generates a --processors option in the makefiles for each specified XML file.

Example

Specify an additional processor definition file (suppose processors-new.xml contains a new processor PCPNEW):

ccpcp --processors=processors-new.xml --cpu=PCPNEW test.c

Related information

Control program option --cpu (Select processor)
Control program option: --silicon-bug

Menu entry

1. Expand C/C++ Build and select Processor.
2. From the Processor Selection list, select a processor.

   The CPU Problem Bypasses and Checks box shows the available workarounds/checks available for the selected processor.

3. (Optional) Select Show all CPU problem bypasses and checks.
4. Click Select All or select one or more individual options.

Command line syntax

--silicon-bug=arg,...

For a list of available arguments refer to the description of option --silicon-bug of the compiler and assembler. Depending on the available arguments this option is passed to the compiler and/or assembler.

Description

With this option the control program tells the compiler/assembler to use software workarounds for some CPU functional problems. Please refer to Chapter 14, CPU Problem Bypasses and Checks for more information about the individual problems and workarounds.

Example

To enable workarounds for problem PCP_Tc.038, enter:

cctc --silicon-bug=pcp-tc038 test.c

Related information

Chapter 14, CPU Problem Bypasses and Checks
C compiler option --silicon-bug
Assembler option --silicon-bug
Control program option: --static

Menu entry
-

Command line syntax

--static

Description

This option is directly passed to the compiler.

With this option, the compiler treats external definitions at file scope (except for main) as if they were declared static. As a result, unused functions will be eliminated, and the alias checking algorithm assumes that objects with static storage cannot be referenced from functions outside the current module.

This option only makes sense when you specify all modules of an application on the command line.

Example

ccpcp --static module1.c module2.c module3.c ...

Related information
-

Control program option: --tasking-sfr

Menu entry

1. Select **C/C++ Compiler » Preprocessing**.
2. Enable the option **Automatic inclusion of '.sfr' file**.
3. Select **Assembler » Preprocessing**.
4. Enable the option **Automatic inclusion of '.def' file**.

Command line syntax

`--tasking-sfr`

Description

By default, the C compiler and assembler do not include a special function register (SFR) file before compiling/assembling.

With this option the compiler includes the register file `regcpu.sfr` and the assembler include the file `regcpu.def` as based on the selected target processor. The compiler and assembler select the SFR file belonging to the target you selected on the **Processor** page (control program option `--cpu`). The control program passes the appropriate `-H` option to the tools.

Example

To generate the file `test.elf` for the TC1796B processor and automatically include SFR files, enter:

```
ccpcp --cpu=tc1796b --tasking-sfr -v -t test.c
```

The control program will call the tools as follows:

```
cpcp -D__CPU__=tc1796b -D__CPU_TC1796B__
-Hsfr/regtc1796b.sfr -o test.src test.c
aspcp -D__CPU__=tc1796b -D__CPU_TC1796B__
-Hsfr/regtc1796b.def -o test.o test.src
lpcp -o test.elf -dtc1796b.lsl -dextmem.lsl -D__CPU__=tc1796b
--map-file test.o -Linсталldir/cpcp/lib/pcp2 -lc -lfp
```

Related information

Control program option `--cpu` (Select processor)

Section 1.2.4, **Accessing Hardware from C**
Control program option: --uchar (-u)

Menu entry
1. Select C Compiler » Language.
2. Enable the option Treat 'char' variables as unsigned.

Command line syntax

--uchar
-u

Description
By default char is the same as specifying signed char. With this option char is the same as unsigned char.

Note that this option can cause conflicts when you use it in combination with MIL linking. With MIL linking some extra strict type checking is done that can cause building to fail in a way that is unforeseen and difficult to understand. For example, when you use option --mil-link in combination with option --uchar you might get the following error:

cpcp E289: ["..\.\.\..\strlen.c" 14/1] "strlen" redeclared with a different type
cpcp I802: ["installation-dir\cpcp\include\string.h" 44/17] previous declaration of "strlen"
1 errors, 0 warnings

This is caused by the fact that the MIL library is built without --uchar. You can workaround this problem by rebuilding the MIL libraries.

Related information
Section 1.1, Data Types
Control program option: --undefine (-U)

Menu entry

1. Select C Compiler » Preprocessing
   
   The Defined symbols box shows the symbols that are currently defined.

2. To remove a defined symbol, select the symbol in the Defined symbols box and click on the Delete button.

Command line syntax

--undefine=macro_name

-Umacro_name

Description

With this option you can undefine an earlier defined macro as with #undef. This option is for example useful to undefine predefined macros.

The following predefined ISO C standard macros cannot be undefined:

__FILE__ current source filename
__LINE__ current source line number (int type)
__TIME__ hh:mm:ss
__DATE__ Mmm dd yyyy
__STDC__ level of ANSI standard

The control program passes the option --undefine (-U) to the compiler.

Example

To undefine the predefined macro __TASKING__:

cpcp --define=__TASKING__ test.c

Related information

Control program option --define (Define preprocessor macro)

Section 1.7, Predefined Preprocessor Macros
Control program option: --verbose (-v)

Menu entry
1. Select Global Options.
2. Enable the option Verbose mode of control program.

Command line syntax
--verbose
-v

Description
With this option you put the control program in verbose mode. The control program performs its tasks while it prints the steps it performs to stdout.

Related information
Control program option --dry-run (Verbose output and suppress execution)
Control program option: --version (-V)

Menu entry

-  

Command line syntax

--version

-v

Description

Display version information. The control program ignores all other options or input files.

Related information

-
Control program option: --warnings-as-errors

Menu entry
1. Select Global Options.
2. Enable the option Treat warnings as errors.

Command line syntax

`--warnings-as-errors[=number[-number],...]`

Description

If one of the tools encounters an error, it stops processing the file(s). With this option you tell the tools to treat warnings as errors or treat specific control program warning messages as errors:

- If you specify this option but without numbers, all warnings are treated as errors.

- If you specify this option with a number or a range, only the specified control program warnings are treated as an error. You can specify the option `--warnings-as-errors=number` multiple times.

Use one of the `--pass-tool` options to pass this option directly to a tool when a specific warning for that tool must be treated as an error. For example, use `--pass-c=--warnings-as-errors=number` to treat a specific C compiler warning as an error.

Related information

Control program option `--no-warnings` (Suppress some or all warnings)

Control program option `--pass` (Pass option to tool)
8.6. Make Utility Options

When you build a project in Eclipse, Eclipse generates a makefile and uses the make utility `mkpcp` to build all your files. However, you can also use the make utility directly from the command line to build your project.

The invocation syntax is:

```
mkpcp [option...] [target...] [macro=def]
```

This section describes all options for the make utility. The make utility is a command line tool so there are no equivalent options in Eclipse.

For detailed information about the make utility and using makefiles see Section 6.3, Make Utility `mkpcp`. 
Defining Macros

Command line syntax

macro_name[=macro_definition]

Description

With this argument you can define a macro and specify it to the make utility.

A macro definition remains in existence during the execution of the makefile, even when the makefile recursively calls the make utility again. In the recursive call, the macro acts as an environment variable. This means that it is overruled by definitions in the recursive call. Use the option -e to prevent this.

You can specify as many macros as you like. If the command line exceeds the limit of the operating system, you can define the macros in an option file which you then must specify to the make utility with the option -m) file.

Defining macros on the command line is, for example, useful in combination with conditional processing as shown in the example below.

Example

Consider the following makefile with conditional rules to build a demo program and a real program:

```makefile
ifdef DEMO       # the value of DEMO is of no importance
    real.elf : demo.o main.o
            lpcp demo.o main.o -lc -lfp
else
    real.elf : real.o main.o
            lpcp real.o main.o -lc -lfp
endif
```

You can now use a macro definition to set the DEMO flag:

```makefile
mkpcp real.elf DEMO=1
```

In both cases the absolute object file real.elf is created but depending on the DEMO flag it is linked with demo.o or with real.o.

Related information

Make utility option -e (Environment variables override macro definitions)

Make utility option -m (Name of invocation file)
Make utility option: -?

Command line syntax

-?

Description

Displays an overview of all command line options.

Example

The following invocation displays a list of the available command line options:

mkpcp -?

Related information

-
Make utility option: -a

Command line syntax

- a

Description

Normally the make utility rebuilds only those files that are out of date. With this option you tell the make utility to rebuild all files, without checking whether they are out of date.

Example

mkpcp -a

Rebuilds all your files, regardless of whether they are out of date or not.

Related information

-
Make utility option: -c

Command line syntax

- c

Description

Eclipse uses this option when you create sub-projects. In this case the make utility calls another instance of the make utility for the sub-project. With the option -c, the make utility runs as a child process of the current make.

The option -c overrules the option -err.

Example

mkpcp -c

The make utility runs its commands as a child processes.

Related information

Make utility option -err (Redirect error message to file)
Make utility option: -D / -DD

Command line syntax

-D
-DD

Description

With the option -D the make utility prints every line of the makefile to standard output as it is read by mkpcp.

With the option -DD not only the lines of the makefile are printed but also the lines of the mkpcp.mk file (implicit rules).

Example

mkpcp -D

Each line of the makefile that is read by the make utility is printed to standard output (usually your screen).

Related information

-
Make utility option: -d/ -dd

Command line syntax

-\(d\)
-\(dd\)

Description

With the option \(d\) the make utility shows which files are out of date and thus need to be rebuild. The option \(dd\) gives more detail than the option \(d\).

Example

\texttt{mkpcp \(d\)}

Shows which files are out of date and rebuilds them.

Related information

-
Make utility option: -e

Command line syntax

-e

Description

If you use macro definitions, they may overrule the settings of the environment variables. With the option -e, the settings of the environment variables are used even if macros define otherwise.

Example

mkpcp -e

The make utility uses the settings of the environment variables regardless of macro definitions.

Related information

-
**Make utility option: -err**

**Command line syntax**

```
-err file
```

**Description**

With this option the make utility redirects error messages and verbose messages to a specified file.

With the option `-s` the make utility only displays error messages.

**Example**

```
mkpcp -err error.txt
```

The make utility writes messages to the file `error.txt`.

**Related information**

- **Make utility option -s** (Do not print commands before execution)
- **Make utility option -c** (Run as child process)
Make utility option: -f

Command line syntax

-\texttt{f my\_makefile}

Description

By default the make utility uses the file \texttt{makefile} to build your files.

With this option you tell the make utility to use the specified file instead of the file \texttt{makefile}. Multiple -\texttt{f} options act as if all the makefiles were concatenated in a left-to-right order.

If you use '-' instead of a makefile name it means that the information is read from stdin.

Example

\texttt{mkpcp -f mymake}

The make utility uses the file \texttt{mymake} to build your files.

Related information

-
Make utility option: -G

Command line syntax

-G path

Description

Normally you must call the make utility from the directory where your makefile and other files are stored. With the option -G you can call the make utility from within another directory. The path is the path to the directory where your makefile and other files are stored and can be absolute or relative to your current directory.

Example

Suppose your makefile and other files are stored in the directory ..\myfiles. You can call the make utility, for example, as follows:

mkpcp -G ..\myfiles

Related information

-
Make utility option: -i

Command line syntax

-i

Description

When an error occurs during the make process, the make utility exits with a certain exit code. With the option -i, the make utility exits without an error code, even when errors occurred.

Example

mkpcp -i

The make utility exits without an error code, even when an error occurs.

Related information

-
Make utility option: -K

Command line syntax

-K

Description

With this option the make utility keeps temporary files it creates during the make process. The make utility stores temporary files in the directory that you have specified with the environment variable TMPDIR or in the default 'temp' directory of your system when the TMPDIR environment variable is not specified.

Example

mkpcp -K

The make utility preserves all temporary files.

Related information

-
Make utility option: -k

Command line syntax

-k

Description

When during the make process the make utility encounters an error, it stops rebuilding your files.

With the option -k, the make utility only stops building the target that produced the error. All other targets defined in the makefile are built.

Example

mkpcp -k

If the make utility encounters an error, it stops building the current target but proceeds with the other targets that are defined in the makefile.

Related information

Make utility option -S (Undo the effect of -k)
Make utility option: -m

Command line syntax

-\texttt{m} \texttt{file}

Description

Instead of typing all options on the command line, you can create an option file which contains all options and flags you want to specify. With this option you specify the option file to the make utility.

Use an option file when the command line would exceed the limits of the operating system, or just to store options and save typing.

You can specify the option \texttt{-m} multiple times.

If you use `-' instead of a filename it means that the options are read from stdin.

Format of an option file

- Multiple arguments on one line in the option file are allowed.
- To include whitespace in an argument, surround the argument with single or double quotes.
- If you want to use single quotes as part of the argument, surround the argument by double quotes and vise versa:

  "This has a single quote ' embedded"

  'This has a double quote " embedded'

  'This has a double quote " and a single quote '' embedded"

  Note that adjacent strings are concatenated.

- When a text line reaches its length limit, use a `\` to continue the line. Whitespace between quotes is preserved.

  "This is a continuation \ line"

  \ \ \ \ \ \ -> "This is a continuation line"

- It is possible to nest command line files up to 25 levels.

Example

Suppose the file \texttt{myoptions} contains the following lines:

\texttt{-k}
\texttt{-err errors.txt}
\texttt{test.elf}
Specify the option file to the make utility:

`mkpcp -m myoptions`

This is equivalent to the following command line:

`mkpcp -k -err errors.txt test.elf`

**Related information**

-
**Make utility option: -n**

**Command line syntax**

`-n`

**Description**

With this option you tell the make utility to perform a dry run. The make utility shows what it would do but does not actually perform these tasks.

This option is for example useful to quickly inspect what would happen if you call the make utility.

**Example**

`mkpcp -n`

The make utility does not perform any tasks but displays what it would do if called without the option `-n`.

**Related information**

Make utility option `-s` (Do not print commands before execution)
Make utility option: -p

Command line syntax

-\texttt{p}

Description

Normally, if a command in a target rule in a makefile returns an error or when the target construction is interrupted, the make utility removes that target file. With this option you tell the make utility to make all target files precious. This means that all dependency files are never removed.

Example

\texttt{mkpcp -p}

The make utility never removes target dependency files.

Related information

Special target .\texttt{PRECIOUS} in Section 6.3.2.1, Targets and Dependencies
Make utility option: -q

Command line syntax

-q

Description

With this option the make utility does not perform any tasks but only returns an exit code. A zero status indicates that all target files are up to date, a non-zero status indicates that some or all target files are out of date.

Example

mkpcp -q

The make utility only returns an error code that indicates whether all target files are up to date or not. It does not rebuild any files.

Related information

-
Make utility option: -r

Command line syntax

- r

Description

When you call the make utility, it first reads the implicit rules from the file mkpcp.mk, then it reads the makefile with the rules to build your files. (The file mkpcp.mk is located in the \etc directory of the toolset.)

With this option you tell the make utility not to read mkpcp.mk and to rely fully on the make rules in the makefile.

Example

mkpcp -r

The make utility does not read the implicit make rules in mkpcp.mk.

Related information

-
Make utility option: -S

Command line syntax

-S

Description

With this option you cancel the effect of the option -k. This is only necessary in a recursive make where the option -k might be inherited from the top-level make via MAKEFLAGS or if you set the option -k in the environment variable MAKEFLAGS.

With this option you tell the make utility not to read mkpcp.mk and to rely fully on the make rules in the makefile.

Example

mkpcp -S

The effect of the option -k is cancelled so the make utility stops with the make process after it encounters an error.

The option -k in this example may have been set with the environment variable MAKEFLAGS or in a recursive call to mkpcp in the makefile.

Related information

Make utility option -k (On error, abandon the work for the current target only)
Make utility option: -s

Command line syntax

-s

Description

With this option you tell the make utility to perform its tasks without printing the commands it executes. Error messages are normally printed.

Example

mkpcp -s

The make utility rebuilds your files but does not print the commands it executes during the make process.

Related information

Make utility option -n (Perform a dry run)
**Make utility option: -t**

**Command line syntax**

```-t```

**Description**

With this option you tell the make utility to *touch* the target files, bringing them up to date, rather than performing the rules to rebuild them.

**Example**

```
mkpcp -t
```

The make utility updates out-of-date files by giving them a new date and time stamp. The files are not actually rebuild.

**Related information**

-
Make utility option: -time

Command line syntax

-time

Description

With this option you tell the make utility to display the current date and time on standard output.

Example

mkpcp -time

The make utility displays the current date and time and updates out-of-date files.

Related information

-
Make utility option: -V

Command line syntax

-V

Description

Display version information. The make utility ignores all other options or input files.

Related information

-
**Make utility option: -W**

**Command line syntax**

```
-W target
```

**Description**

With this option the make utility considers the specified target file always as up to date and will not rebuild it.

**Example**

```
mkpcp -W test.elf
```

The make utility rebuilds out of date targets in the makefile except the file `test.elf` which is considered now as up to date.

**Related information**

-
Make utility option: -w

Command line syntax

-w

Description

With this option the make utility sends error messages and verbose messages to standard output. Without this option, the make utility sends these messages to standard error.

This option is only useful on UNIX systems.

Example

mkpcp -w

The make utility sends messages to standard out instead of standard error.

Related information

-
Make utility option: -x

Command line syntax

-x

Description

With this option the make utility shows extended error messages. Extended error messages give more detailed information about the exit status of the make utility after errors.

Example

mkpcp  -x

If errors occur, the make utility gives extended information.

Related information

-
8.7. Parallel Make Utility Options

When you build a project in Eclipse, Eclipse generates a makefile and uses the make utility `amk` to build all your files. However, you can also use the make utility directly from the command line to build your project.

The invocation syntax is:

```
amk [option...] [target...] [macro=def]
```

This section describes all options for the parallel make utility.

For detailed information about the parallel make utility and using makefiles see Section 6.2, Make Utility amk.
Parallel make utility option: --always-rebuild (-a)

Command line syntax

--always-rebuild

-a

Description

Normally the make utility rebuilds only those files that are out of date. With this option you tell the make utility to rebuild all files, without checking whether they are out of date.

Example

amk -a

Rebuilds all your files, regardless of whether they are out of date or not.

Related information

-
Parallel make utility option: --change-dir (-G)

Command line syntax

```
--change-dir=\path
-G \path
```

Description

Normally you must call the make utility from the directory where your makefile and other files are stored.

With the option -G you can call the make utility from within another directory. The \path is the path to the directory where your makefile and other files are stored and can be absolute or relative to your current directory.

The macro SUBDIR is defined with the value of \path.

Example

Suppose your makefile and other files are stored in the directory ..\myfiles. You can call the make utility, for example, as follows:

```
amk -G ..\myfiles
```

Related information

-
Parallel make utility option: --diag

Command line syntax

```bash
--diag=[format:]{all | msg[-msg],...}
```

You can set the following output formats:

- html: HTML output.
- text: ASCII text.

Default format: text

Description

With this option you can ask for an extended description of error messages in the format you choose. The output is directed to stdout (normally your screen) and in the format you specify. You can specify the following formats: html, rtf or text (default). To create a file with the descriptions, you must redirect the output.

With the suboption all, the descriptions of all error messages are given. If you want the description of one or more selected error messages, you can specify the error message numbers, separated by commas, or you can specify a range.

Example

To display an explanation of message number 169, enter:

```
amk --diag=451
```

This results in the following message and explanation:

```
E451: make stopped
An error has occurred while executing one of the commands of the target, and -k option is not specified.
```

To write an explanation of all errors and warnings in HTML format to file amkerrors.html, use redirection and enter:

```
amk --diag=html:all > amkerrors.html
```

Related information

-
Parallel make utility option: --dry-run (-n)

Command line syntax

--dry-run
-n

Description

With this option you tell the make utility to perform a dry run. The make utility shows what it would do but does not actually perform these tasks.

This option is for example useful to quickly inspect what would happen if you call the make utility.

Example

amk -n

The make utility does not perform any tasks but displays what it would do if called without the option -n.

Related information

Parallel make utility option -s (Do not print commands before execution)
Parallel make utility option: --help (-? / -h)

Command line syntax

`--help[=item]`

`-h[item]`

`-?`

You can specify the following arguments:

```
options o Show extended option descriptions
```

Description

Displays an overview of all command line options. When you specify the argument `options` you can list detailed option descriptions.

Example

The following invocations all display a list of the available command line options:

```
amk -?
amk -h
amk --help
```

To see a detailed description of the available options, enter:

```
amk --help=options
```

Related information

-
Parallel make utility option: --jobs (-j) / --jobs-limit (-J)

Menu
1. From the Project menu, select Properties for

   The Properties dialog appears.
2. In the left pane, select C/C++ Build.

   In the right pane the C/C++ Build page appears.
3. On the Behavior tab, select Enable parallel build.
4. You can specify the number of parallel jobs, or you can use an optimal number of jobs. In the last case, amk will fork as many jobs in parallel as cores are available.

Command line syntax

--jobs[=number]
-j[number]

--jobs-limit[=number]
-J[number]

Description

When these options you can limit the number of parallel jobs. The default is 1. Zero means no limit. When you omit the number, amk uses the number of cores detected.

Option -J is the same as -j, except that the number of parallel jobs is limited by the number of cores detected.

Example

amk -j3

Limit the number of parallel jobs to 3.

Related information
**Parallel make utility option: --keep-going (-k)**

**Command line syntax**

```plaintext
--keep-going
-k
```

**Description**

When during the make process the make utility encounters an error, it stops rebuilding your files.

With the option `-k`, the make utility only stops building the target that produced the error. All other targets defined in the makefile are built.

**Example**

```plaintext
amk -k
```

If the make utility encounters an error, it stops building the current target but proceeds with the other targets that are defined in the makefile.

**Related information**

-
Parallel make utility option: --list-targets (-l)

Command line syntax

--list-targets
-l

Description

With this option, the make utility lists all "primary" targets that are out of date.

Example

amk -l
list of targets

Related information

-
Parallel make utility option: --makefile (-f)

Command line syntax

```
--makefile=my_makefile
-f my_makefile
```

Description

By default the make utility uses the file `makefile` to build your files.

With this option you tell the make utility to use the specified file instead of the file `makefile`. Multiple `-f` options act as if all the makefiles were concatenated in a left-to-right order.

If you use `-' instead of a makefile name it means that the information is read from `stdin`.

Example

```
amk -f mymake
```

The make utility uses the file `mymake` to build your files.

Related information

-
Parallel make utility option: --no-warnings (-w)

Command line syntax

--no-warnings[=number,...]

-w[=number,...]

Description

With this option you can suppresses all warning messages or specific warning messages.

On the command line this option works as follows:

• If you do not specify this option, all warnings are reported.

• If you specify this option but without numbers, all warnings are suppressed.

• If you specify this option with a number, only the specified warning is suppressed. You can specify the option --no-warnings=number multiple times.

Example

To suppress warnings 751 and 756, enter:

amk --no-warnings=751,756

Related information

Parallel make utility option --warnings-as-errors (Treat warnings as errors)
Parallel make utility option: --silent (-s)

Command line syntax

--silent

-s

Description

With this option you tell the make utility to perform its tasks without printing the commands it executes. Error messages are normally printed.

Example

amk -s

The make utility rebuilds your files but does not print the commands it executes during the make process.

Related information

Parallel make utility option -n (Perform a dry run)
Parallel make utility option: --version (-V)

Command line syntax

--version

-v

Description

Display version information. The make utility ignores all other options or input files.

Related information

-
Parallel make utility option: --warnings-as-errors

Command line syntax

--warnings-as-errors[=number,...]

Description

If the make utility encounters an error, it stops. When you use this option without arguments, you tell the make utility to treat all warnings as errors. This means that the exit status of the make utility will be non-zero after one or more warnings. As a consequence, the make utility now also stops after encountering a warning.

You can also limit this option to specific warnings by specifying a comma-separated list of warning numbers.

Related information

Parallel make utility option --no-warnings (Suppress some or all warnings)
8.8. Archiver Options

The archiver and library maintainer `arpcp` is a tool to build library files and it offers the possibility to replace, extract and remove modules from an existing library.

The invocation syntax is:

```
arpcp key_option [sub_option...] library [object_file]
```

This section describes all options for the archiver. Some suboptions can only be used in combination with certain key options. They are described together. Suboptions that can always be used are described separately.

For detailed information about the archiver, see Section 6.4, Archiver.

**Short and long option names**

Options can have both short and long names. Short option names always begin with a single minus (-) character, long option names always begin with two minus (--) characters. You can abbreviate long option names as long as it forms a unique name. You can mix short and long option names on the command line.

**Overview of the options of the archiver utility**

The following archiver options are available:

<table>
<thead>
<tr>
<th>Description</th>
<th>Option</th>
<th>Sub-option</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Main functions (key options)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Replace or add an object module</td>
<td>-r</td>
<td>-a -b -c -n -u -v</td>
</tr>
<tr>
<td>Extract an object module from the library</td>
<td>-x</td>
<td>-o -v</td>
</tr>
<tr>
<td>Delete object module from library</td>
<td>-d</td>
<td>-v</td>
</tr>
<tr>
<td>Move object module to another position</td>
<td>-m</td>
<td>-a -b -v</td>
</tr>
<tr>
<td>Print a table of contents of the library</td>
<td>-t</td>
<td>-s0 -s1</td>
</tr>
<tr>
<td>Print object module to standard output</td>
<td>-p</td>
<td></td>
</tr>
<tr>
<td><strong>Sub-options</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Append or move new modules after existing module name</td>
<td>-a name</td>
<td></td>
</tr>
<tr>
<td>Append or move new modules before existing module name</td>
<td>-b name</td>
<td></td>
</tr>
<tr>
<td>Suppress the message that is displayed when a new library is created</td>
<td>-c</td>
<td></td>
</tr>
<tr>
<td>Create a new library from scratch</td>
<td>-n</td>
<td></td>
</tr>
<tr>
<td>Preserve last-modified date from the library</td>
<td>-o</td>
<td></td>
</tr>
<tr>
<td>Print symbols in library modules</td>
<td>-s0</td>
<td>-s1</td>
</tr>
<tr>
<td>Replace only newer modules</td>
<td>-u</td>
<td></td>
</tr>
<tr>
<td>Verbose</td>
<td>-v</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td>Option</td>
<td>Sub-option</td>
</tr>
<tr>
<td>-----------------------------------------------------------------</td>
<td>--------</td>
<td>------------</td>
</tr>
<tr>
<td>Miscellaneous</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Display options</td>
<td>-?</td>
<td></td>
</tr>
<tr>
<td>Display description of one or more diagnostic messages</td>
<td>--diag</td>
<td></td>
</tr>
<tr>
<td>Display version header</td>
<td>-V</td>
<td></td>
</tr>
<tr>
<td>Read options from file</td>
<td>-f file</td>
<td></td>
</tr>
<tr>
<td>Suppress warnings above level $n$</td>
<td>-wn</td>
<td></td>
</tr>
</tbody>
</table>
Archiver option: --delete (-d)

Command line syntax

--delete [--verbose]

-d [-v]

Description

Delete the specified object modules from a library. With the suboption --verbose (-v) the archiver shows which files are removed.

--verbose -v  Verbose: the archiver shows which files are removed.

Example

arpcp --delete mylib.a obj1.o obj2.o

The archiver deletes obj1.o and obj2.o from the library mylib.a.

arpcp -d -v mylib.a obj1.o obj2.o

The archiver deletes obj1.o and obj2.o from the library mylib.a and displays which files are removed.

Related information

-
Archiver option: --diag

Command line syntax

--diag=[format:]{all | msg[-msg],...}

You can set the following output formats:

- html       HTML output.
- text        ASCII text.

Default format: text

Description

With this option you can ask for an extended description of error messages in the format you choose. The output is directed to stdout (normally your screen) and in the format you specify. The archiver does not perform any actions. You can specify the following formats: html, rtf or text (default). To create a file with the descriptions, you must redirect the output.

With the suboption all, the descriptions of all error messages are given. If you want the description of one or more selected error messages, you can specify the error message numbers, separated by commas, or you can specify a range.

Example

To display an explanation of message number 102, enter:

arpcp --diag=102

This results in the following message and explanation:

F102: cannot create "<file>"

The output file or a temporary file could not be created. Check if you have sufficient disk space and if you have write permissions for the specified file.

To write an explanation of all errors and warnings in HTML format to file arerrors.html, use redirection and enter:

arpcp --diag=html:all > arerrors.html

Related information

-
Archiver option: --dump (-p)

Command line syntax

--dump

-p

Description

Print the specified object module(s) in the library to standard output.

This option is only useful when you redirect or pipe the output to other files or tools that serve your own purposes. Normally you do not need this option.

Example

arp cp --dump mylib.a obj1.o > file.o

The archiver prints the file obj1.o to standard output where it is redirected to the file file.o. The effect of this example is very similar to extracting a file from the library but in this case the ‘extracted’ file gets another name.

Related information
Archiver option: --extract (-x)

Command line syntax

--extract [--modtime] [--verbose]

-x [-o] [-v]

Description

Extract an existing module from the library.

--modtime -o Give the extracted object module the same date as the last-modified date that was recorded in the library. Without this suboption it receives the last-modified date of the moment it is extracted.

--verbose -v Verbose: the archiver shows which files are extracted.

Example

To extract the file obj1.o from the library mylib.a:

arpcp --extract mylib.a obj1.o

If you do not specify an object module, all object modules are extracted:

arpcp -x mylib.a

Related information
Archiver option: --help (-?)

Command line syntax

--help [=item]

-?

You can specify the following argument:

options Show extended option descriptions

Description

Displays an overview of all command line options. When you specify the argument options you can list detailed option descriptions.

Example

The following invocations all display a list of the available command line options:

arpcp -?
arpcp --help
arpcp

To see a detailed description of the available options, enter:

arpcp --help=options

Related information

-
Archiver option: --move (-m)

Command line syntax

--move [-a posname] [-b posname]

-m [-a posname] [-b posname]

Description

Move the specified object modules to another position in the library.

The ordering of members in a library can make a difference in how programs are linked if a symbol is defined in more than one member.

By default, the specified members are moved to the end of the archive. Use the suboptions -a or -b to move them to a specified place instead.

--after=posname -a posname
Move the specified object module(s) after the existing module posname.

--before=posname -b posname
Move the specified object module(s) before the existing module posname.

Example

Suppose the library mylib.a contains the following objects (see option --print):

obj1.o
obj2.o
obj3.o

To move obj1.o to the end of mylib.a:

arpcp --move mylib.a obj1.o

To move obj3.o just before obj2.o:

arpcp -m -b obj3.o mylib.a obj2.o

The library mylib.a after these two invocations now looks like:

obj3.o
obj2.o
obj1.o

Related information

Archiver option --print (-t) (Print library contents)
Archiver option: --option-file (-f)

Command line syntax

--option-file=file
-f file

Description

Instead of typing all options on the command line, you can create an option file which contains all options and flags you want to specify. With this option you specify the option file to the archiver.

Use an option file when the command line would exceed the limits of the operating system, or just to store options and save typing.

You can specify the option --option-file (-f) multiple times.

If you use '-' instead of a filename it means that the options are read from stdin.

Format of an option file

• Multiple arguments on one line in the option file are allowed.

• To include whitespace in an argument, surround the argument with single or double quotes.

• If you want to use single quotes as part of the argument, surround the argument by double quotes and vise versa:

  "This has a single quote ' embedded"

  'This has a double quote " embedded'

  'This has a double quote " and a single quote ’" embedded"

• When a text line reaches its length limit, use a \ to continue the line. Whitespace between quotes is preserved.

  "This is a continuation \ line"

    -> "This is a continuation line"

• It is possible to nest command line files up to 25 levels.

Example

Suppose the file myoptions contains the following lines:

-x mylib.a obj1.o
-w5
Specify the option file to the archiver:

```
arcp --option-file=myoptions
```

This is equivalent to the following command line:

```
arcp -x mylib.a obj1.o -w5
```

**Related information**

-
Archiver option: --print (-t)

Command line syntax

--print [--symbols=0|1]
-t [-s0|-s1]

Description

Print a table of contents of the library to standard output. With the suboption -s0 the archiver displays all symbols per object file.

- --symbols=0 -s0 Displays per object the name of the object itself and all symbols in the object.
- --symbols=1 -s1 Displays the symbols of all object files in the library in the form library_name:object_name:symbol_name

Example

arpcp --print mylib.a

The archiver prints a list of all object modules in the library mylib.a:

arpcp -t -s0 mylib.a

The archiver prints per object all symbols in the library. For example:

cstart.o
  symbols:
    _PCP__context_8
    _PCP__cstart
    _PCP_channel_2

printf.o
  symbols:
    _PCP__data__printf
    _PCP_printf

Related information
Archiver option: --replace (-r)

Command line syntax

```
--replace [--after=posname] [--before=posname]
    [--create] [--new] [--newer-only] [--verbose]

-r [-a posname] [-b posname][-c] [-n] [-u] [-v]
```

Description

You can use the option `--replace [-r]` for several purposes:

- Adding new objects to the library
- Replacing objects in the library with the same object of a newer date
- Creating a new library

The option `--replace [-r]` normally adds a new module to the library. However, if the library already contains a module with the specified name, the existing module is replaced. If you specify a library that does not exist, the archiver creates a new library with the specified name.

If you add a module to the library without specifying the suboption `-a` or `-b`, the specified module is added at the end of the archive. Use the suboptions `-a` or `-b` to insert them after/before a specified place instead.

```
--after=posname    | -a posname  Insert the specified object module(s) after the existing module posname.
--before=posname  | -b posname  Insert the specified object module(s) before the existing module posname.
--create          | -c          Suppress the message that is displayed when a new library is created.
--new             | -n          Create a new library from scratch. If the library already exists, it is overwritten.
--newer-only      | -u          Insert the specified object module only if it is newer than the module in the library.
--verbose         | -v          Verbose: the archiver shows which files are replaced.
```

The suboptions `-a` or `-b` have no effect when an object is added to the library.

Example

Suppose the library `mylib.a` contains the following object (see option `--print`):

```
obj1.o
```

To add `obj2.o` to the end of `mylib.a`:

```
arpcp --replace mylib.a obj2.o
```
To insert obj3.o just before obj2.o:

```
arpcp -r -b obj2.o mylib.a obj3.o
```

The library mylib.a after these two invocations now looks like:

```
obj1.o
obj3.o
obj2.o
```

**Creating a new library**

To *create a new library file*, add an object file and specify a library that does not yet exist:

```
arpcp --replace newlib.a obj1.o
```

The archiver creates the library newlib.a and adds the object obj1.o to it.

To *create a new library file and overwrite an existing library*, add an object file and specify an existing library with the supoption *--new* (*-n*):

```
arpcp -r -n mylib.a obj1.o
```

The archiver overwrites the library mylib.a and adds the object obj1.o to it. The new library mylib.a only contains obj1.o.

**Related information**

*Archiver option --print (-t) (Print library contents)*
Archiver option: --version (-V)

Command line syntax

--version
-v

Description
Display version information. The archiver ignores all other options or input files.

Related information
-
Archiver option: --warning (-w)

Command line syntax

--warning=level

-w level

Description

With this suboption you tell the archiver to suppress all warnings above the specified level. The level is a number between 0 - 9.

The level of a message is printed between parentheses after the warning number. If you do not use the -w option, the default warning level is 8.

Example

To suppress warnings above level 5:

arpcp --extract --warning=5 mylib.a obj1.o

Related information
8.9. Expire Cache Utility Options

With the utility expirepcp you can limit the size of the cache (C compiler option --cache) by removing all files older than a few days or by removing older files until the total size of the cache is smaller than a specified size. See also Section 9.6, Compiler Cache.

The invocation syntax is:

expirepcp [option]... cache-directory

The compiler cache is present in the directory cpcpcache under the specified cache-directory.

This section describes all options for the expire cache utility.

Short and long option names

Options can have both short and long names. Short option names always begin with a single minus (-) character, long option names always begin with two minus (--) characters. You can abbreviate long option names as long as it forms a unique name. You can mix short and long option names on the command line.
**Expire cache utility option: --access (-a)**

**Command line syntax**

--access

-a

**Description**

Use the last access time instead of the last modification time to determine which files to delete.

**Example**

expirepcp --access --days=7 "installation-dir\mproject\.cache"

**Related information**

-
**Expire cache utility option: --days (-d)**

**Menu entry**

1. Select **C Compiler » Optimization » Compilation Speed**.
2. Enable the option **Cache generated code to improve the compilation speed**.
3. In the **Directory for cached files** field, enter the name for the location of the cache.
   
   *By default this is the .cache directory under your project directory.*
4. Specify the **Maximum days files will live in the cache**.

**Command line syntax**

```
--days=n
-d n
```

**Description**

Remove all files older than \( n \) days from the cache.

**Example**

To remove all files older than seven days, enter:

```
expirepcp --days=7 "installation-dir\mproject\.cache"
```

**Related information**

-
Expire cache utility option: --diag

Command line syntax

```
--diag=[format:]{all | msg[-msg],...}
```

You can set the following output formats:

- **html**: HTML output.
- **rtf**: Rich Text Format.
- **text**: ASCII text.

Default format: text

**Description**

With this option you can ask for an extended description of error messages in the format you choose. The output is directed to stdout (normally your screen) and in the format you specify. You can specify the following formats: **html**, **rtf** or **text** (default). To create a file with the descriptions, you must redirect the output.

With the suboption **all**, the descriptions of all error messages are given. If you want the description of one or more selected error messages, you can specify the error message numbers, separated by commas, or you can specify a range.

With this option the expire cache utility does not remove any files.

**Example**

To display an explanation of message number 204, enter:

```
expirepcp --diag=204
```

This results in the following message and explanation:

```
E204: failed to remove "<file>" <<cause>>
```

The removal of the indicated file failed. The <cause> provides more details of the problem.

To write an explanation of all errors and warnings in HTML format to file **expirepcp_errors.html**, use redirection and enter:

```
expirepcp --diag=html:all > expirepcp_errors.html
```

**Related information**

-
Expire cache utility option: --dry-run (-n)

Command line syntax

--dry-run

-n

Description

With this option you put the expire utility in verbose mode. The utility shows which files would be deleted, without actually removing them.

Related information

Expire cache utility option --verbose (Verbose output)
Expire cache utility option: --help (-?)

Command line syntax

--help [=item]

-?

You can specify the following argument:

  options  Show extended option descriptions

Description

Displays an overview of all command line options. When you specify the argument options you can list detailed option descriptions.

Example

The following invocations all display a list of the available command line options:

expirepcp -?
expirepcp --help
expirepcp

To see a detailed description of the available options, enter:

expirepcp --help=options

Related information

-
**Expire cache utility option: --megabytes (-m)**

**Menu entry**

1. Select **C Compiler » Optimization » Compilation Speed**.
2. Enable the option **Cache generated code to improve the compilation speed**.
3. In the **Directory for cached files** field, enter the name for the location of the cache. 
   *By default this is the .cache directory under your project directory.*
4. Enable the option **Clear cache upon project clean**.
   *Each time you use Project » Clean... the cache is cleared.*

**Command line syntax**

```
--megabytes=m
-m
```

**Description**

Reduce the size of the cache to $m$ MBytes by removing files from the cache, starting with the oldest file. With a size of 0 (zero) you clear the entire cache.

**Example**

To reduce the compiler cache size to 4 MB, enter:

```
expirepcp --megabytes=4 "installation-dir\mproject\.cache"
```

Older files are removed until the total size of the cache is smaller than 4 MB.

To clear the compiler cache, enter:

```
expirepcp --megabytes=0 "installation-dir\mproject\.cache"
```

**Related information**

-
Expire cache utility option: --totals (-t)

Command line syntax

--totals
-t

Description

Show the total size of the cache and the number of directories and files. This option is implicit when invoked without the --days and --megabytes options.

Example

expirepcp -t "installation-dir\mproject\.cache"

installation-dir\mproject\.cache\cpcpcache: 1 MB, 2 directories, 2 files

Related information

-
Expire cache utility option: --verbose (-v)

Command line syntax

--verbose

-v

Description

With this option you put the expire cache utility in verbose mode. The utility shows which files are being deleted.

Example

expirepcp -v --megabytes=0 "installation-dir\mproject\.cache"

2014-07-03 12:36:17 installation-dir\mproject\.cache\cpcpcache\myproject\6f0a3ba4

Related information

-
Expire cache utility option: --version (-V)

Command line syntax

--version

–v

Description

Display version information and exit. The expire cache utility ignores all other options.

Related information

-
Chapter 9. Influencing the Build Time

In general many settings have influence on the build time of a project. Any change in the tool settings of your project source will have more or less impact on the build time. The following sections describe several issues that can have significant influence on the build time.

9.1. SFR File

SFR files can define such a large number of SFRs that compiling the SFR file alone already takes up a significant part of the build time. To reduce the build time:

- By default, the tools do not automatically include the SFR file. You should include the SFR file only in the source modules where the SFRs are used, with a `#include` directive. In Eclipse make sure that the automatic inclusion option is disabled. You can find this option on the "C Compiler » Preprocessing" and the "Assembler » Preprocessing" pages.

  When you include the SFR file in the source, be aware that the SFR files are in the `sfr` subdirectory of the include files, so you must use: `#include <sfr/regtc1796b.sfr>`

9.2. MIL Linking

With MIL linking (see Section 3.6.1, Generic Optimizations (frontend)) it is possible to let the compiler apply optimizations application wide. This can yield significant optimization improvements, but the build times can also be significantly longer. MIL linking itself can require significant time, but also the changed build process implies longer build times. The MIL linking settings in Eclipse are:

- **Build for application wide optimizations (MIL linking)**

  This enables MIL linking. The build process changes: the C files are translated to intermediate code (MIL files) and the generated MIL files of the whole project are linked together by the C compiler.

  In general, if you do not need code compaction, for example because you are optimizing fully for speed, it is recommended to choose **Build for application wide optimizations (MIL linking)**.

9.3. Optimization Options

In general any optimization may require more work to be done by the compiler. But this does not mean that disabling all optimizations (level 0) gives the fastest compilation time. Disabling optimizations may result in more code being generated, resulting in more work for other parts of the compiler, like for example the register allocator.
9.4. Automatic Inlining

Automatic inlining is an optimization which can result in significant longer build time. The overall functions
will get bigger, often making it possible to do more optimizations. But also often resulting in more registers
to be in use in a function, giving the register allocation a tougher job.

9.5. Code Compaction

When you disable the code compaction optimization, the build times may be shorter. Certainly when MIL
linking is used where the full application is passed as a single MIL stream to the code generation. Code
compaction is however an optimization which can make a huge difference when optimizing for code size.
When size matters it makes no sense to disable this option. When you choose to optimize for speed
(--tradeoff=0) the code compaction is automatically disabled.

9.6. Compiler Cache

The C compiler has support for caching intermediate results to avoid full compilations. When the source
code after preprocessing and relevant compiler options and the compiler version are the same as in a
previous invocation, the previous result is copied to the output file. The cache only works when there is
a single C input file and a single output file (no --mil-split).

To enable caching from Eclipse:

1. From the Project menu, select Properties for

   The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Settings.

   In the right pane the Settings appear.

3. On the Tool Settings tab, select C Compiler » Optimization » Compilation Speed.

4. Enable the option Cache generated code to improve the compilation speed.

5. In the Directory for cached files field, enter the name for the location of the cache.

   By default this is the .cache directory under your project directory.

6. Specify the Maximum days files will live in the cache.

7. (Optional) Enable the option Clear cache upon project clean.

   Each time you use Project » Clean... the cache is cleared.

Eclipse calls the C compiler with option --cache. The cache directory may be shared, for instance by
placing it on a network drive. The compiler creates a directory cpcpcache in the specified directory.

When a result from the cache is used, the C compiler generates a comment line in the assembly source
file to notify that. In that case be aware of the following:
• In case source merging is enabled an older version of the source is still shown. As long as a source change has no effect on the preprocessed code, the cached version of the output file is used.

• Some options, like --define, --include-directory and --output are not part of the hash used for the cache. As long as a change in these options has no influence on the preprocessed code, the cached version of the output is used. This means that the options listed as comments in the generated assembly file might not match the options actually used.

With every compilation of a file that results in a cache miss, a new file is stored in the cache. Old files are not removed from the cache automatically because that would slow down the compiler too much. To keep the cache size reasonable specify a maximum number of days the files will live in the cache. Eclipse uses the utility expirepcp for this. It is recommended to run this utility frequently, for example with each time the project is linked. For more information on this utility see Section 6.5, Expire Cache Utility.

9.7. Header Files

Many applications include all header files in each module, often by including them all within a single include file. Processing header files takes time. It is a good programming practice to only include the header files that are really required in a module, because:

• it is clear what interfaces are used by a module
• an incremental build after modifying a header file results in less modules required to be rebuild
• it reduces compile time

9.8. Parallel Build

The make utility amk, which is used by Eclipse, has a feature to build jobs in parallel. This means that multiple modules can be compiled in parallel. With today's multi-core processors this means that each core can be fully utilized. In practice even on single core machines the compile time decreases when using parallel jobs. On multi-core machines the build time even improves further when specifying more parallel jobs than the number of cores.

In Eclipse you can control the parallel build behavior:

1. From the Project menu, select Properties for

   The Properties dialog appears.

2. In the left pane, select C/C++ Build.

   In the right pane the C/C++ Build page appears.

3. On the Behavior tab, select Enable parallel build.

4. You can specify the number of parallel jobs, or you can use an optimal number of jobs. In the last case, amk will fork as many jobs in parallel as cores are available.
Chapter 10. Libraries

This chapter contains an overview of all library functions that you can call in your C source. This includes all functions of the standard C library (ISO C99) and some functions of the floating-point library.

Section 10.1, Library Functions, gives an overview of all library functions you can use, grouped per header file. A number of functions declared in wchar.h are parallel to functions in other header files. These are discussed together.

Section 10.2, C Library Reentrancy, gives an overview of which functions are reentrant and which are not.

C library / floating-point library

The following libraries are included in the PCP toolset. Both Eclipse and the control program ccpcp automatically select the appropriate libraries depending on the specified options.

<table>
<thead>
<tr>
<th>Libraries</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>libc.a</td>
<td>C library</td>
</tr>
<tr>
<td>libfp[t].a</td>
<td>Floating-point libraries</td>
</tr>
<tr>
<td></td>
<td>Optional letter:</td>
</tr>
<tr>
<td></td>
<td>t = trapping (control program option --fp-model=+trap)</td>
</tr>
</tbody>
</table>

For the C library also a MIL library variant is present (file with extension .ma).

Sources for the libraries are present in the directories lib\src, lib\src.* in the form of an executable. If you run the executable it will extract the sources in the corresponding directory.

Floating-point library with trapping

If you use the trapping floating-point library (libfpt.a), exceptional floating-point cases are intercepted and can be handled separately by an application defined trap handler. Using this library decreases the execution speed of your application. The header file except.h contains the PCP specific software floating-point trap handling interface definition. See Section 10.1.7, except.h for the interface functions and a list of floating-point exceptions, such as overflow and underflow.

The file except.c implements aliases for the following functions:

<table>
<thead>
<tr>
<th>Alias</th>
<th>Resulting function</th>
</tr>
</thead>
<tbody>
<tr>
<td>fegetenv</td>
<td>_fp_get_exception_status</td>
</tr>
<tr>
<td>fesetenv</td>
<td>_fp_set_exception_status</td>
</tr>
<tr>
<td>feclearexcept</td>
<td>_fp_clear_exception_status</td>
</tr>
<tr>
<td>feraiseexcept</td>
<td>_fp_raise_exception</td>
</tr>
<tr>
<td>fetestexcept</td>
<td>_fp_test_exception_status</td>
</tr>
</tbody>
</table>

519
10.1. Library Functions

The tables in the sections below list all library functions, grouped per header file in which they are declared. Some functions are not completely implemented because their implementation depends on the context where your application will run. These functions are for example all I/O related functions. Where possible, these functions are implemented using file system simulation (FSS). This system can be used by the debugger to simulate an I/O environment which enables you to debug your application.

A number of wide character functions are available as C source code, but have not been compiled with the C library. To use complete wide character functionality, you must recompile the libraries with the macro \texttt{WCHAR\_SUPPORT\_ENABLED} and keep this macro also defined when compiling your own sources. See C compiler option \texttt{--define (-D)}. The easiest way is to adapt the makefile for the library and change the \texttt{CC} line to:

\begin{verbatim}
CC = $(PRODDIR)\bin\cpcp -DWCHAR\_SUPPORT\_ENABLED
\end{verbatim}

10.1.1. assert.h

\texttt{assert(expr)} \quad Prints a diagnostic message if NDEBUG is not defined. (Implemented as macro)

For C11 only, the following macro is defined:

\begin{verbatim}
#define static_assert _Static_assert
\end{verbatim}

10.1.2. complex.h

The complex number $z$ is also written as $x+yi$ where $x$ (the real part) and $y$ (the imaginary part) are real numbers of types \texttt{float}, \texttt{double} or \texttt{long double}. The real and imaginary part can be stored in structs or in arrays. This implementation uses arrays because structs may have different alignments.

The header file \texttt{complex.h} also defines the following macros for backward compatibility:

\begin{verbatim}
complex _Complex /* C99 keyword */
imaginary _Imaginary /* C99 keyword */
\end{verbatim}

Parallel sets of functions are defined for double, float and long double. They are respectively named \texttt{function}, \texttt{functionf}, \texttt{functionl}. All long type functions, though declared in \texttt{complex.h}, are implemented as the double type variant which nearly always meets the requirement in embedded applications.

This implementation uses the obvious implementation for complex multiplication; and a more sophisticated implementation for division and absolute value calculations which handles underflow, overflow and infinities with more care. The ISO C99 \texttt{#pragma CX\_LIMITED\_RANGE} therefore has no effect.

\textbf{Trigonometric functions}

\begin{verbatim}
csin csinf csinl          Returns the complex sine of $z$.
ccos ccosf ccosl          Returns the complex cosine of $z$.
ctan ctanf ctanl          Returns the complex tangent of $z$.
casin casinf casinl       Returns the complex arc sine $\sin^{-1}(z)$.
\end{verbatim}
cacos  cacosf  cacosl  Returns the complex arc cosine \( \cos^{-1}(z) \).
catan  catanf  catanl  Returns the complex arc tangent \( \tan^{-1}(z) \).
csinh  csinhf  csinhl  Returns the complex hyperbolic sine of \( z \).
ccosh  ccoshf  ccoshl  Returns the complex hyperbolic cosine of \( z \).
cctanh  cctanhf  cctanhl  Returns the complex hyperbolic tangent of \( z \).
ccasinh  ccasinhf  ccasinhl  Returns the complex arc hyperbolic sinus of \( z \).
ccosh  ccoshf  ccoshl  Returns the complex hyperbolic cosine of \( z \).
cctanh  cctanhf  cctanhl  Returns the complex arc hyperbolic tangent of \( z \).

Exponential and logarithmic functions

cexp  cexpf  cexpl  Returns the result of the complex exponential function \( e^z \).
clog  clogf  clogl  Returns the complex natural logarithm.

Power and absolute-value functions

cabs  cabsf  cabsl  Returns the complex absolute value of \( z \) (also known as norm, modulus or magnitude).
cpow  cpowf  cpowl  Returns the complex value of \( x \) raised to the power \( y \) \((x^y)\) where both \( x \) and \( y \) are complex numbers.
csqrt  csqrtf  csqrtl  Returns the complex square root of \( z \).

Manipulation functions

carg  cargf  cargl  Returns the argument of \( z \) (also known as phase angle).
cimag  cimagf  cimagl  Returns the imaginary part of \( z \) as a real (respectively as a double, float, long double).
conj  conjf  conjl  Returns the complex conjugate value (the sign of its imaginary part is reversed).
cproj  cprojf  cprojl  Returns the value of the projection of \( z \) onto the Riemann sphere.
creal  crealf  creall  Returns the real part of \( z \) as a real (respectively as a double, float, long double).

10.1.3. cstart.h

The header file cstart.h controls the system startup code’s general settings and register initializations. It contains defines only, no functions.

10.1.4. ctype.h and wctype.h

The header file ctype.h declares the following functions which take a character \( c \) as an integer type argument. The header file wctype.h declares parallel wide character functions which take a character \( c \) of the wchar_t type as argument.
### 10.1.5. dbg.h

The header file dbg.h contains the debugger call interface for file system simulation. It contains low level functions. This header file is not defined in ISO C99.

- `_dbg_trap`  
  Low level function to trap debug events

- `_argcv(const char *buf, size_t size)`  
  Low level function for command line argument passing
10.1.6. errno.h

int errno    External variable that holds implementation defined error codes.

The following error codes are defined as macros in errno.h:

<table>
<thead>
<tr>
<th>Macro</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EPERM</td>
<td>1</td>
<td>Operation not permitted</td>
</tr>
<tr>
<td>ENOENT</td>
<td>2</td>
<td>No such file or directory</td>
</tr>
<tr>
<td>EINTR</td>
<td>3</td>
<td>Interrupted system call</td>
</tr>
<tr>
<td>EIO</td>
<td>4</td>
<td>I/O error</td>
</tr>
<tr>
<td>EBADF</td>
<td>5</td>
<td>Bad file number</td>
</tr>
<tr>
<td>EAGAIN</td>
<td>6</td>
<td>No more processes</td>
</tr>
<tr>
<td>ENOMEM</td>
<td>7</td>
<td>Not enough core</td>
</tr>
<tr>
<td>EACCES</td>
<td>8</td>
<td>Permission denied</td>
</tr>
<tr>
<td>EFAULT</td>
<td>9</td>
<td>Bad address</td>
</tr>
<tr>
<td>EXIST</td>
<td>10</td>
<td>File exists</td>
</tr>
<tr>
<td>ENOTDIR</td>
<td>11</td>
<td>Not a directory</td>
</tr>
<tr>
<td>EISDIR</td>
<td>12</td>
<td>Is a directory</td>
</tr>
<tr>
<td>EINVAL</td>
<td>13</td>
<td>Invalid argument</td>
</tr>
<tr>
<td>ENFILE</td>
<td>14</td>
<td>File table overflow</td>
</tr>
<tr>
<td>EMFILE</td>
<td>15</td>
<td>Too many open files</td>
</tr>
<tr>
<td>ETXTBSY</td>
<td>16</td>
<td>Text file busy</td>
</tr>
<tr>
<td>ENOSPC</td>
<td>17</td>
<td>No space left on device</td>
</tr>
<tr>
<td>ESPIPE</td>
<td>18</td>
<td>Illegal seek</td>
</tr>
<tr>
<td>EROFS</td>
<td>19</td>
<td>Read-only file system</td>
</tr>
<tr>
<td>EPIPE</td>
<td>20</td>
<td>Broken pipe</td>
</tr>
<tr>
<td>ELOOP</td>
<td>21</td>
<td>Too many levels of symbolic links</td>
</tr>
<tr>
<td>ENAMETOOLONG</td>
<td>22</td>
<td>File name too long</td>
</tr>
</tbody>
</table>

Floating-point errors

<table>
<thead>
<tr>
<th>Macro</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EDOM</td>
<td>23</td>
<td>Argument too large</td>
</tr>
<tr>
<td>ERANGE</td>
<td>24</td>
<td>Result too large</td>
</tr>
</tbody>
</table>

Errors returned by printf/scanf

<table>
<thead>
<tr>
<th>Macro</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ERR_FORMAT</td>
<td>25</td>
<td>Illegal format string for printf/scanf</td>
</tr>
<tr>
<td>ERR_NOFLOAT</td>
<td>26</td>
<td>Floating-point not supported</td>
</tr>
<tr>
<td>ERR_NOLONG</td>
<td>27</td>
<td>Long not supported</td>
</tr>
<tr>
<td>ERR_NOPoint</td>
<td>28</td>
<td>Pointers not supported</td>
</tr>
</tbody>
</table>

Encoding errors set by functions like fgetwc, getwc, mbtowc, etc ...

<table>
<thead>
<tr>
<th>Macro</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EILSEQ</td>
<td>29</td>
<td>Invalid or incomplete multibyte or wide character</td>
</tr>
</tbody>
</table>

Errors returned by RTOS

<table>
<thead>
<tr>
<th>Macro</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ECANCELED</td>
<td>30</td>
<td>Operation canceled</td>
</tr>
<tr>
<td>ENODEV</td>
<td>31</td>
<td>No such device</td>
</tr>
</tbody>
</table>
10.1.7. except.h

The header file except.h contains the PCP specific software floating-point exception handling interface definition. This header file is not defined in ISO C99.

```c
 fp_install_trap_handler( void (*)( _fp_exception_info_t * ) exception )
 fp_get_exception_mask( void )
 fp_set_exception_mask( int )
 fp_get_exception_status( void )
 fp_set_exception_status( int ) name
```

For each supported exception, a macro is defined. The following exceptions are defined:

- **EFINVOP** Invalid operation, for instance 0.0/0.0, 0.0*INF or on a NaN
- **EFDIVZ** Division by zero, for instance 12.5/0.0 (not 0.0/0.0)
- **EFOVFL** Overflow, when the result of an operation is too large
- **EFUNFL** Underflow, when the result of an operation is too small
- **EFINEXCT** Inexact
- **EFALL** Combination of all of the above enlisted exceptions

INF means infinite which is the largest absolute floating-point number.

NAN means Not A Number, this is a special notation for an undefined floating-point number.

10.1.8. fcntl.h

The header file fcntl.h contains the function open(), which calls the low level function _open(), and definitions of flags used by the low level function _open(). This header file is not defined in ISO C99.

```c
open (FSS implementation)
```

10.1.9. fenv.h

Contains mechanisms to control the floating-point environment.

- **fegetenv** Stores the current floating-point environment.
- **feholdexcept** Saves the current floating-point environment and installs an environment that ignores all floating-point exceptions.
Restores a previously saved (fegetenv or feholdexcept) floating-point environment.

Saves the currently raised floating-point exceptions, restores a previously saved floating-point environment and finally raises the saved exceptions.

Clears the current exception status flags corresponding to the flags specified in the argument.

Stores the current setting of the floating-point status flags.

Raises the exceptions represented in the argument. As a result, other exceptions may be raised as well.

Sets the current floating-point status flags.

Returns the bitwise-OR of the exception macros corresponding to the exception flags which are currently set and are specified in the argument.

For each supported exception, a macro is defined. The following exceptions are defined:

<table>
<thead>
<tr>
<th>Macro</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FE_DIVBYZERO</td>
<td>Integer division by zero</td>
</tr>
<tr>
<td>FE_INEXACT</td>
<td>Result is not exact</td>
</tr>
<tr>
<td>FE_INVALID</td>
<td>Integer division by zero</td>
</tr>
<tr>
<td>FE_OVERFLOW</td>
<td>Integer overflow</td>
</tr>
<tr>
<td>FE_UNDERFLOW</td>
<td>Integer underflow</td>
</tr>
<tr>
<td>FE_ALL_EXCEPT</td>
<td>Integer division by zero, integer overflow, integer underflow</td>
</tr>
</tbody>
</table>

Returns the current rounding direction, represented as one of the values of the rounding direction macros.

Sets the current rounding directions.

For each supported rounding mode, a macro is defined. The following rounding mode macro is defined:

<table>
<thead>
<tr>
<th>Macro</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FE_TONEAREST</td>
<td>Integer division by zero</td>
</tr>
</tbody>
</table>

10.1.10. float.h

The header file float.h defines the characteristics of the real floating-point types float, double and long double.

float.h used to contain prototypes for the functions copysign(f), isinf(f), isfinite(f), isnan(f) and scalb(f). These functions have accordingly to the ISO C99 standard been moved to the header file math.h. See also Section 10.1.17, math.h and tgmath.h.

The following functions are only available for ISO C90:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>copysignf(float f, float s)</td>
<td>Copies the sign of the second argument s to the value of the first argument f and returns the result.</td>
</tr>
<tr>
<td>copysign(double d, double s)</td>
<td>Copies the sign of the second argument s to the value of the first argument d and returns the result.</td>
</tr>
<tr>
<td>isnff(float f)</td>
<td>Test the variable f on being an infinite (IEEE-754) value.</td>
</tr>
<tr>
<td>isinf(double d) ;</td>
<td>Test the variable d on being an infinite (IEEE-754) value.</td>
</tr>
<tr>
<td>isfinitef(float f)</td>
<td>Test the variable f on being a finite (IEEE-754) value.</td>
</tr>
</tbody>
</table>
isfinite(double d) Test the variable \( d \) on being a finite (IEEE-754) value.
isnanf(float f) Test the variable \( f \) on being NaN (Not a Number, IEEE-754).
isnan(double d) Test the variable \( d \) on being NaN (Not a Number, IEEE-754).
scalbf(float f, int p) Returns \( f \times 2^p \) for integral values without computing \( 2^N \).
scalb(double d, int p) Returns \( d \times 2^p \) for integral values without computing \( 2^N \). (See also scalbn in Section 10.1.17, math.h and tgmath.h)

10.1.11. inttypes.h and stdint.h

The header files stdint.h and inttypes.h provide additional declarations for integer types and have various characteristics. The stdint.h header file contains basic definitions of integer types of certain sizes, and corresponding sets of macros. This header file clearly refers to the corresponding sections in the ISO C99 standard.
The inttypes.h header file includes stdint.h and adds portable formatting and conversion functions. Below the conversion functions from inttypes.h are listed.

imaxabs(intmax_t j) Returns the absolute value of \( j \)
imaxdiv(intmax_t numer, intmax_t denom) Computes \( \text{numerator/denominator} \) and \( \text{numerator \% denominator} \). The result is stored in the \( \text{quot} \) and \( \text{rem} \) components of the \( \text{imaxdiv_t} \) structure type.
strtoimax(const char * restrict nptr, char ** restrict endptr, int base) Convert string to maximum sized integer. (Compare strtoall)
strtouimax(const char * restrict nptr, char ** restrict endptr, int base) Convert string to maximum sized unsigned integer. (Compare strtouall)
wctoimax(const wchar_t * restrict nptr, wchar_t ** restrict endptr, int base) Convert wide string to maximum sized integer. (Compare wcstoll)
wctouimax(const wchar_t * restrict nptr, wchar_t ** restrict endptr, int base) Convert wide string to maximum sized unsigned integer. (Compare wcstoull)

10.1.12. io.h

The header file io.h contains prototypes for low level I/O functions. This header file is not defined in ISO C99.

_close(fd) Used by the functions close and fclose. (FSS implementation)
_lseek(fd, offset, whence) Used by all file positioning functions: fgetpos, fseek, fsetpos, ftell, rewind. (FSS implementation)
_open(fd, flags) Used by the functions fopen and freopen. (FSS implementation)
_read(fd, *buff, cnt) Reads a sequence of characters from a file. (FSS implementation)
_unlink(*name) Used by the function remove. (FSS implementation)
_write(fd, *buffer, cnt)  
        Writes a sequence of characters to a file. (FSS implementation)

10.1.13. iso646.h

The header file iso646.h adds tokens that can be used instead of regular operator tokens.

#define and     &&
#define and_eq  &==
#define bitand  &
#define bitor   |
#define compl   ~
#define not     !
#define not_eq  !=
#define or      ||
#define or_eq   |==
#define xor     ^
#define xor_eq  ^=

10.1.14. limits.h

Contains the sizes of integral types, defined as macros.

10.1.15. locale.h

To keep C code reasonable portable across different languages and cultures, a number of facilities are provided in the header file locale.h.

```
char *setlocale( int category, const char *locale )
```

The function above changes locale-specific features of the run-time library as specified by the category to change and the name of the locale.

The following categories are defined and can be used as input for this function:

```
LC_ALL      0      LC_NUMERIC   3
LC_COLLATE  1      LC_TIME      4
LC_CTYPE    2      LC_MONETARY  5
```

```
struct lconv *localeconv( void )
```

Returns a pointer to type struct lconv with values appropriate for the formatting of numeric quantities according to the rules of the current locale. The struct lconv in this header file is conforming the ISO standard.

10.1.16. malloc.h

The header file malloc.h contains prototypes for memory allocation functions. This include file is not defined in ISO C99, it is included for backwards compatibility with ISO C90. For ISO C99, the memory allocation functions are part of stdlib.h. See Section 10.1.26, stdlib.h and wchar.h.
malloc(size)  Allocates space for an object with size size. The allocated space is not initialized. Returns a pointer to the allocated space.

aligned_alloc(alignment, size)  (C11 only) Allocates space for an object whose alignment is specified by alignment and with size size. The allocated space is not initialized. Returns a pointer to the allocated space.

calloc(nobj, size)  Allocates space for n objects with size size. The allocated space is initialized with zeros. Returns a pointer to the allocated space.

free(*ptr)  Deallocates the memory space pointed to by ptr which should be a pointer earlier returned by the malloc or calloc function.

realloc(*ptr, size)  Deallocates the old object pointed to by ptr and returns a pointer to a new object with size size, while preserving its contents. If the new size is smaller than the old size, some contents at the end of the old region will be discarded. If the new size is larger than the old size, all of the old contents are preserved and any bytes in the new object beyond the size of the old object will have indeterminate values.

10.1.17. math.h and tgmath.h

The header file math.h contains the prototypes for many mathematical functions. Before ISO C99, all functions were computed using the double type (the float was automatically converted to double, prior to calculation). In this ISO C99 version, parallel sets of functions are defined for double, float and long double. They are respectively named function, functionf, functionl. All long type functions, though declared in math.h, are implemented as the double type variant which nearly always meets the requirement in embedded applications.

The header file tgmath.h contains parallel type generic math macros whose expansion depends on the used type. tgmath.h includes math.h and the effect of expansion is that the correct math.h functions are called. The type generic macro, if available, is listed in the second column of the tables below.

<table>
<thead>
<tr>
<th>math.h</th>
<th>tgmath.h</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sin</td>
<td>sinf</td>
<td>sinl</td>
</tr>
<tr>
<td>cos</td>
<td>cosf</td>
<td>cosl</td>
</tr>
<tr>
<td>tan</td>
<td>tanf</td>
<td>tanl</td>
</tr>
<tr>
<td>asin</td>
<td>asinf</td>
<td>asinl</td>
</tr>
<tr>
<td>acos</td>
<td>acosf</td>
<td>acosl</td>
</tr>
<tr>
<td>atan</td>
<td>atanf</td>
<td>atanl</td>
</tr>
<tr>
<td>atan2</td>
<td>atan2f</td>
<td>atan2l</td>
</tr>
<tr>
<td>sinh</td>
<td>sinhf</td>
<td>sinhl</td>
</tr>
</tbody>
</table>
### Exponential and logarithmic functions

All of these functions are new in ISO C99, except for `exp`, `log` and `log10`.

<table>
<thead>
<tr>
<th>math.h</th>
<th>tgmath.h</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>exp</td>
<td>expf</td>
<td>Returns the result of the exponential function $e^x$.</td>
</tr>
<tr>
<td>exp2</td>
<td>exp2f</td>
<td>Returns the result of the exponential function $2^x$.</td>
</tr>
<tr>
<td>expm1</td>
<td>expm1f</td>
<td>Returns the result of the exponential function $e^x-1$.</td>
</tr>
<tr>
<td>log</td>
<td>logf</td>
<td>Returns the natural logarithm $\ln(x)$, $x&gt;0$.</td>
</tr>
<tr>
<td>log10</td>
<td>log10f</td>
<td>Returns the base-10 logarithm of $x$, $x&gt;0$.</td>
</tr>
<tr>
<td>log1p</td>
<td>log1pf</td>
<td>Returns the base-e logarithm of $(1+x).x &lt;&gt; -1$.</td>
</tr>
<tr>
<td>log2</td>
<td>log2f</td>
<td>Returns the base-2 logarithm of $x. x&gt;0$.</td>
</tr>
<tr>
<td>ilogb</td>
<td>ilogbf</td>
<td>Returns the signed exponent of $x$ as an integer. $x&gt;0$.</td>
</tr>
<tr>
<td>logb</td>
<td>logbf</td>
<td>Returns the exponent of $x$ as a signed integer in value in floating-point notation. $x &gt; 0$.</td>
</tr>
</tbody>
</table>

### frexp, ldexp, modf, scalbn, scalbln

<table>
<thead>
<tr>
<th>math.h</th>
<th>tgmath.h</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>frexp</td>
<td>frexp</td>
<td>Splits a float $x$ into fraction $f$ and exponent $n$, so that: $f = 0.0$ or $0.5 \leq</td>
</tr>
<tr>
<td>ldexp</td>
<td>ldexp</td>
<td>Inverse of frexp. Returns the result of $x \times 2^n$. ($x$ and $n$ are both arguments).</td>
</tr>
<tr>
<td>modf</td>
<td>modff</td>
<td>Splits a float $x$ into fraction $f$ and integer $n$, so that: $</td>
</tr>
<tr>
<td>scalbn</td>
<td>scalbnf</td>
<td>Computes the result of $x \times \text{FLT_RADIX}^n$. efficiently, not normally by computing $\text{FLT_RADIX}^n$ explicitly.</td>
</tr>
<tr>
<td>scalbln</td>
<td>scalblnf</td>
<td>Same as scalbn but with argument $n$ as long int.</td>
</tr>
</tbody>
</table>

### Rounding functions

<table>
<thead>
<tr>
<th>math.h</th>
<th>tgmath.h</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ceil</td>
<td>ceilf</td>
<td>Returns the smallest integer not less than $x$, as a double.</td>
</tr>
<tr>
<td>floor</td>
<td>floorf</td>
<td>Returns the largest integer not greater than $x$, as a double.</td>
</tr>
</tbody>
</table>
### Description

<table>
<thead>
<tr>
<th>math.h</th>
<th>tgmath.h</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>rint</td>
<td>rintf</td>
<td>rintl</td>
</tr>
<tr>
<td>lrint</td>
<td>lrintf</td>
<td>lrintl</td>
</tr>
<tr>
<td>llrint</td>
<td>llrintf</td>
<td>llrintl</td>
</tr>
<tr>
<td>nearbyint</td>
<td>nearbyintf</td>
<td>nearbyintl</td>
</tr>
<tr>
<td>round</td>
<td>roundf</td>
<td>roundl</td>
</tr>
<tr>
<td>lround</td>
<td>lroundf</td>
<td>lroundl</td>
</tr>
<tr>
<td>llround</td>
<td>llroundf</td>
<td>llroundl</td>
</tr>
<tr>
<td>trunc</td>
<td>truncf</td>
<td>truncl</td>
</tr>
</tbody>
</table>

### Remainder after division

<table>
<thead>
<tr>
<th>math.h</th>
<th>tgmath.h</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>fmod</td>
<td>fmodf</td>
<td>fmodl</td>
</tr>
<tr>
<td>remainder</td>
<td>remainderf</td>
<td>remainderl</td>
</tr>
<tr>
<td>remquo</td>
<td>remquof</td>
<td>remquol</td>
</tr>
</tbody>
</table>

### Power and absolute-value functions

<table>
<thead>
<tr>
<th>math.h</th>
<th>tgmath.h</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>cbrt</td>
<td>cbrtf</td>
<td>cbrtl</td>
</tr>
<tr>
<td>fabs</td>
<td>fabsf</td>
<td>fabsl</td>
</tr>
<tr>
<td>fma</td>
<td>fmaf</td>
<td>fmal</td>
</tr>
<tr>
<td>hypot</td>
<td>hypotf</td>
<td>hypotl</td>
</tr>
<tr>
<td>pow</td>
<td>powf</td>
<td>powl</td>
</tr>
<tr>
<td>sqrt</td>
<td>sqrtf</td>
<td>sqrtl</td>
</tr>
</tbody>
</table>

### Manipulation functions: copysign, nan, nextafter, nexttoward

<table>
<thead>
<tr>
<th>math.h</th>
<th>tgmath.h</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>copysign</td>
<td>copysignf</td>
<td>copysignl</td>
</tr>
<tr>
<td>nan</td>
<td>nanf</td>
<td>nanl</td>
</tr>
</tbody>
</table>
### Positive difference, maximum, minimum

<table>
<thead>
<tr>
<th>math.h</th>
<th>tgmath.h</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>fdim</td>
<td>fdimf</td>
<td>fdiml</td>
</tr>
<tr>
<td>fmax</td>
<td>fmaxf</td>
<td>fmaxl</td>
</tr>
<tr>
<td>fmin</td>
<td>fminf</td>
<td>fminl</td>
</tr>
</tbody>
</table>

### Error and gamma

<table>
<thead>
<tr>
<th>math.h</th>
<th>tgmath.h</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>erf</td>
<td>erff</td>
<td>erfl</td>
</tr>
<tr>
<td>erfc</td>
<td>erfcf</td>
<td>erfcl</td>
</tr>
<tr>
<td>lgamma</td>
<td>lgammaf</td>
<td>lgammacl</td>
</tr>
<tr>
<td>tgamma</td>
<td>tgammaf</td>
<td>tgammacl</td>
</tr>
</tbody>
</table>

### Comparison macros

The next are implemented as macros. For any ordered pair of numeric values exactly one of the relationships - *less*, *greater*, and *equal* - is true. These macros are type generic and therefore do not have a parallel function in `tgmath.h`. All arguments must be expressions of real-floating type.

<table>
<thead>
<tr>
<th>math.h</th>
<th>tgmath.h</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>isgreater</td>
<td>–</td>
<td>Returns the value of $(x) &gt; (y)$</td>
</tr>
<tr>
<td>isgreaterequal</td>
<td>–</td>
<td>Returns the value of $(x) &gt;= (y)$</td>
</tr>
<tr>
<td>isless</td>
<td>–</td>
<td>Returns the value of $(x) &lt; (y)$</td>
</tr>
<tr>
<td>islessequal</td>
<td>–</td>
<td>Returns the value of $(x) &lt;= (y)$</td>
</tr>
<tr>
<td>islessgreater</td>
<td>–</td>
<td>Returns the value of $(x) &lt; (y)</td>
</tr>
<tr>
<td>isunordered</td>
<td>–</td>
<td>Returns 1 if its arguments are unordered, 0 otherwise.</td>
</tr>
</tbody>
</table>

### Classification macros

The next are implemented as macros. These macros are type generic and therefore do not have a parallel function in `tgmath.h`. All arguments must be expressions of real-floating type.
### math.h

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>fpclassify</td>
<td>Returns the class of its argument:</td>
</tr>
<tr>
<td></td>
<td>FP_INFINITE, FP_NAN, FP_NORMAL, FP_SUBNORMAL or FP_ZERO</td>
</tr>
<tr>
<td>isfinite</td>
<td>Returns a nonzero value if and only if its argument has a finite value</td>
</tr>
<tr>
<td>isinf</td>
<td>Returns a nonzero value if and only if its argument has an infinite value</td>
</tr>
<tr>
<td>isnan</td>
<td>Returns a nonzero value if and only if its argument has NaN value.</td>
</tr>
<tr>
<td>isnormal</td>
<td>Returns a nonzero value if an only if its argument has a normal value.</td>
</tr>
<tr>
<td>signbit</td>
<td>Returns a nonzero value if and only if its argument value is negative.</td>
</tr>
</tbody>
</table>

### 10.1.18. setjmp.h

The `setjmp` and `longjmp` in this header file implement a primitive form of non-local jumps, which may be used to handle exceptional situations. This facility is traditionally considered more portable than `signal.h`

```c
int setjmp(jmp_buf env)  /* Records its caller's environment in env and returns 0. */
void longjmp(jmp_buf env, int status)  /* Restores the environment previously saved with a call to setjmp(). */
```

### 10.1.19. signal.h

Signals are possible asynchronous events that may require special processing. Each signal is named by a number. The following signals are defined:

<table>
<thead>
<tr>
<th>Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIGINT</td>
<td>Receipt of an interactive attention signal</td>
</tr>
<tr>
<td>SIGILL</td>
<td>Detection of an invalid function message</td>
</tr>
<tr>
<td>SIGFPE</td>
<td>An erroneous arithmetic operation (for example, zero divide, overflow)</td>
</tr>
<tr>
<td>SIGSEGV</td>
<td>An invalid access to storage</td>
</tr>
<tr>
<td>SIGTERM</td>
<td>A termination request sent to the program</td>
</tr>
<tr>
<td>SIGABRT</td>
<td>Abnormal termination, such as is initiated by the <code>abort</code> function</td>
</tr>
</tbody>
</table>

The next function sends the signal `sig` to the program:

```c
int raise(int sig)
```

The next function determines how subsequent signals will be handled:

```c
signalfunction *signal (int, signalfunction *)
```
The first argument specifies the signal, the second argument points to the signal-handler function or has one of the following values:

- **SIG_DFL**: Default behavior is used
- **SIG_IGN**: The signal is ignored

The function returns the previous value of `signalfunction` for the specific signal, or **SIG_ERR** if an error occurs.

### 10.1.20. stdalign.h

This C11 header file contains the following macro definitions about alignment:

```c
#define alignas _Alignas
#define __alignas_is_defined 1

#define alignof _Alignof
#define __alignof_is_defined 1
```

### 10.1.21. stdarg.h

The facilities in this header file gives you a portable way to access variable arguments lists, such as needed for `fprintf` and `vfprintf`. `va_copy` is new in ISO C99. This header file contains the following macros:

- **va_arg(va_list ap,type)**: Returns the value of the next argument in the variable argument list. Its return type has the type of the given argument `type`. A next call to this macro will return the value of the next argument.

- **va_copy(va_list dest, va_list src)**: This macro duplicates the current state of `src` in `dest`, creating a second pointer into the argument list. After this call, `va_arg()` may be used on `src` and `dest` independently.

- **va_end(va_list ap)**: This macro must be called after the arguments have been processed. It should be called before the function using the macro 'va_start' is terminated.

- **va_start(va_list ap, lastarg)**: This macro initializes `ap`. After this call, each call to `va_arg()` will return the value of the next argument. In our implementation, `va_list` cannot contain any bit type variables. Also the given argument `lastarg` must be the last non-bit type argument in the list.

### 10.1.22. stdbool.h

This header file contains the following macro definitions. These names for boolean type and values are consistent with C++. You are allowed to `#undefine` or redefine the macros below.

```c
#define bool                            _Bool
#define true                            1
#define false                           0
#define __bool_true_false_are_defined   1
```
### 10.1.23. stddef.h

This header file defines the types for common use:

- **ptrdiff_t**: Signed integer type of the result of subtracting two pointers.
- **size_t**: Unsigned integral type of the result of the `sizeof` operator.
- **wchar_t**: Integer type to represent character codes in large character sets.

Besides these types, the following macros are defined:

- **NULL**: Expands to the null pointer constant `(void *) 0.`
- **offsetof(_type, _member)**: Expands to an integer constant expression with type `size_t` that is the offset in bytes of `_member` within structure type `_type`.

### 10.1.24. stdint.h

See Section 10.1.11, `inttypes.h` and `stdint.h`

### 10.1.25. stdio.h and wchar.h

#### Types

The header file `stdio.h` contains functions for performing input and output. A number of functions also have a parallel wide character function or macro, defined in `wchar.h`. The header file `wchar.h` also includes `stdio.h`.

In the C language, many I/O facilities are based on the concept of streams. The `stdio.h` header file defines the data type `FILE` which holds the information about a stream. A `FILE` object is created with the function `fopen`. The pointer to this object is used as an argument in many of the in this header file. The `FILE` object can contain the following information:

- the current position within the stream
- pointers to any associated buffers
- indications of for read/write errors
- end of file indication

The header file also defines type `fpos_t` as an `unsigned long`.

#### Macros

<table>
<thead>
<tr>
<th><code>stdio.h</code></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NULL</td>
<td>Expands to the null pointer constant <code>(void *) 0.</code></td>
</tr>
<tr>
<td>BUFSIZ</td>
<td>Size of the buffer used by the <code>setbuf/setvbuf</code> function: 512</td>
</tr>
<tr>
<td>EOF</td>
<td>End of file indicator. Expands to -1.</td>
</tr>
</tbody>
</table>
### stdio.h

<table>
<thead>
<tr>
<th>stdio.h</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WEOF</td>
<td>End of file indicator. Expands to UINT_MAX (defined in limits.h) Note: WEOF need not to be a negative number as long as its value does not correspond to a member of the wide character set. (Defined in wchar.h).</td>
</tr>
<tr>
<td>FOPEN_MAX</td>
<td>Number of files that can be opened simultaneously: 10</td>
</tr>
<tr>
<td>FILENAME_MAX</td>
<td>Maximum length of a filename: 10</td>
</tr>
<tr>
<td>_IOFBF</td>
<td>Expand to an integer expression, suitable for use as argument to the setvbuf function.</td>
</tr>
<tr>
<td>_IOLBF</td>
<td></td>
</tr>
<tr>
<td>_IONBF</td>
<td></td>
</tr>
<tr>
<td>L_tmpnam</td>
<td>Size of the string used to hold temporary file names: 8 (tmpxxxxx)</td>
</tr>
<tr>
<td>TMP_MAX</td>
<td>Maximum number of unique temporary filenames that can be generated: 0x8000</td>
</tr>
<tr>
<td>SEEK_CUR</td>
<td></td>
</tr>
<tr>
<td>SEEK_END</td>
<td></td>
</tr>
<tr>
<td>SEEK_SET</td>
<td></td>
</tr>
<tr>
<td>stderr</td>
<td>Expressions of type &quot;pointer to FILE&quot; that point to the FILE objects associated with standard error, input and output streams.</td>
</tr>
<tr>
<td>stdin</td>
<td></td>
</tr>
<tr>
<td>stdout</td>
<td></td>
</tr>
</tbody>
</table>

### File access

<table>
<thead>
<tr>
<th>stdio.h</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>fopen(name, mode)</td>
<td>Opens a file for a given mode. Available modes are:</td>
</tr>
<tr>
<td></td>
<td>&quot;r&quot; read; open text file for reading</td>
</tr>
<tr>
<td></td>
<td>&quot;w&quot; write; create text file for writing;</td>
</tr>
<tr>
<td></td>
<td>if the file already exists, its contents is discarded</td>
</tr>
<tr>
<td></td>
<td>&quot;a&quot; append; open existing text file or create new text file for writing at end of file</td>
</tr>
<tr>
<td></td>
<td>&quot;r+&quot; open text file for update; reading and writing</td>
</tr>
<tr>
<td></td>
<td>&quot;w+&quot; create text file for update; previous contents if any is discarded</td>
</tr>
<tr>
<td></td>
<td>&quot;a+&quot; append; open or create text file for update, writes at end of file</td>
</tr>
</tbody>
</table>

(FSS implementation)

<table>
<thead>
<tr>
<th>fclose(name)</th>
<th>Flushes the data stream and closes the specified file that was previously opened with fopen. (FSS implementation)</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>fflush(name)</th>
<th>If stream is an output stream, any buffered but unwritten data is written. Else, the effect is undefined. (FSS implementation)</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>freopen(name, mode, stream)</th>
<th>Similar to fopen, but rather than generating a new value of type FILE *, the existing value is associated with a new stream. (FSS implementation)</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>setbuf(stream, buffer)</th>
<th>If buffer is NULL, buffering is turned off for the stream. Otherwise, setbuf is equivalent to: (void) setvbuf(stream, buffer, _IOFBF, BUFSIZ).</th>
</tr>
</thead>
</table>
**stdio.h**

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
</table>
| setvbuf(stream, buffer, mode, size) | Controls buffering for the *stream*; this function must be called before reading or writing. *Mode* can have the following values:  
|                  | _IOFBF causes full buffering                                                             |
|                  | _IOLBF causes line buffering of text files                                              |
|                  | _IONBF causes no buffering.                                                               |
|                  | If *buffer* is not NULL, it will be used as a buffer; otherwise a buffer will be allocated. *size* determines the buffer size. |

**Formatted input/output**

The format string of printf related functions can contain plain text mixed with conversion specifiers. Each conversion specifier should be preceded by a '%'. The conversion specifier should be built in order:

- **Flags** (in any order):
  - Specifies left adjustment of the converted argument.
  - A number is always preceded with a sign character.  
    - `+` has higher precedence than space.
  - `space` a negative number is preceded with a sign, positive numbers with a space.
  - `0` specifies padding to the field width with zeros (only for numbers).
  - `#` specifies an alternate output form. For o, the first digit will be zero. For x or X, "0x" and "0X" will be prefixed to the number. For e, E, f, g, G, the output always contains a decimal point, trailing zeros are not removed.

- A number specifying a minimum field width. The converted argument is printed in a field with at least the length specified here. If the converted argument has fewer characters than specified, it will be padded at the left side (or at the right when the flag '-' was specified) with spaces. Padding to numeric fields will be done with zeros when the flag '0' is also specified (only when padding left). Instead of a numeric value, also '*' may be specified, the value is then taken from the next argument, which is assumed to be of type int.

- A period. This separates the minimum field width from the precision.

- A number specifying the maximum length of a string to be printed. Or the number of digits printed after the decimal point (only for floating-point conversions). Or the minimum number of digits to be printed for an integer conversion. Instead of a numeric value, also '*' may be specified, the value is then taken from the next argument, which is assumed to be of type int.

- A length modifier 'h', 'hh', 'l', 'll', 'L', 'j', 'z' or 't'. 'h' indicates that the argument is to be treated as a short or unsigned short. 'hh' indicates that the argument is to be treated as a char or unsigned char. 'l' should be used if the argument is a long integer, 'll' for a long long. 'L' indicates that the argument is a long double. 'j' indicates a pointer to intmax_t or uintmax_t, 'z' indicates a pointer to size_t and 't' indicates a pointer to ptrdiff_t.
Flags, length specifier, period, precision and length modifier are optional, the conversion character is not. The conversion character must be one of the following, if a character following '%', is not in the list, the behavior is undefined:

<table>
<thead>
<tr>
<th>Character</th>
<th>Printed as</th>
</tr>
</thead>
<tbody>
<tr>
<td>d, i</td>
<td>int, signed decimal</td>
</tr>
<tr>
<td>o</td>
<td>int, unsigned octal</td>
</tr>
<tr>
<td>x, X</td>
<td>int, unsigned hexadecimal in lowercase or uppercase respectively</td>
</tr>
<tr>
<td>u</td>
<td>int, unsigned decimal</td>
</tr>
<tr>
<td>c</td>
<td>int, single character (converted to unsigned char)</td>
</tr>
<tr>
<td>s</td>
<td>char *, the characters from the string are printed until a NULL character is found. When the given precision is met before, printing will also stop</td>
</tr>
<tr>
<td>f, F</td>
<td>double</td>
</tr>
<tr>
<td>e, E</td>
<td>double</td>
</tr>
<tr>
<td>g, G</td>
<td>double</td>
</tr>
<tr>
<td>a, A</td>
<td>double</td>
</tr>
<tr>
<td>n</td>
<td>int *, the number of characters written so far is written into the argument. This should be a pointer to an integer in default memory. No value is printed.</td>
</tr>
<tr>
<td>p</td>
<td>pointer</td>
</tr>
<tr>
<td>%</td>
<td>No argument is converted, a '%%' is printed.</td>
</tr>
</tbody>
</table>

**printf conversion characters**

All arguments to the `scanf` related functions should be pointers to variables (in default memory) of the type which is specified in the format string.

The format string can contain:

- Blanks or tabs, which are skipped.
- Normal characters (not '%'), which should be matched exactly in the input stream.
- Conversion specifications, starting with a '%' character.

Conversion specifications should be built as follows (in order):

- A '*', meaning that no assignment is done for this field.
- A number specifying the maximum field width.
- The conversion characters d, i, n, o, u and x may be preceded by 'h' if the argument is a pointer to short rather than int, or by 'hh' if the argument is a pointer to char, or by 'l' (letter ell) if the argument is a pointer to long or by 'll' for a pointer to long long, 'j' for a pointer to intmax_t or uintmax_t, 'z' for a pointer to size_t or 't' for a pointer to ptrdiff_t. The conversion characters e, f, and g may be preceded by 'l' if the argument is a pointer to double rather than float, and by 'L' for a pointer to a long double.
**TASKING VX-toolset for PCP User Guide**

- A conversion specifier. "", maximum field width and length modifier are optional, the conversion character is not. The conversion character must be one of the following, if a character following "%" is not in the list, the behavior is undefined.

Length specifier and length modifier are optional, the conversion character is not. The conversion character must be one of the following, if a character following "%" is not in the list, the behavior is undefined.

<table>
<thead>
<tr>
<th>Character</th>
<th>Scanned as</th>
</tr>
</thead>
<tbody>
<tr>
<td>d</td>
<td>int, signed decimal.</td>
</tr>
<tr>
<td>i</td>
<td>int, the integer may be given octal (i.e. a leading 0 is entered) or hexadecimal (leading &quot;0x&quot; or &quot;0X&quot;), or just decimal.</td>
</tr>
<tr>
<td>o</td>
<td>int, unsigned octal.</td>
</tr>
<tr>
<td>u</td>
<td>int, unsigned decimal.</td>
</tr>
<tr>
<td>x</td>
<td>int, unsigned hexadecimal in lowercase or uppercase.</td>
</tr>
<tr>
<td>c</td>
<td>single character (converted to unsigned char).</td>
</tr>
<tr>
<td>s</td>
<td>char *, a string of non white space characters. The argument should point to an array of characters, large enough to hold the string and a terminating NULL character.</td>
</tr>
<tr>
<td>f, F</td>
<td>float</td>
</tr>
<tr>
<td>e, E</td>
<td>float</td>
</tr>
<tr>
<td>g, G</td>
<td>float</td>
</tr>
<tr>
<td>a, A</td>
<td>float</td>
</tr>
<tr>
<td>n</td>
<td>int *, the number of characters written so far is written into the argument. No scanning is done.</td>
</tr>
<tr>
<td>p</td>
<td>pointer; hexadecimal value which must be entered without 0x- prefix.</td>
</tr>
<tr>
<td>[...]</td>
<td>Matches a string of input characters from the set between the brackets. A NULL character is added to terminate the string. Specifying [ ]... includes the ’]’ character in the set of scanning characters.</td>
</tr>
<tr>
<td>[^...]</td>
<td>Matches a string of input characters not in the set between the brackets. A NULL character is added to terminate the string. Specifying [^]... includes the ’]’ character in the set.</td>
</tr>
<tr>
<td>%</td>
<td>Literal ’%’, no assignment is done.</td>
</tr>
</tbody>
</table>

**scanf conversion characters**

<table>
<thead>
<tr>
<th>stdio.h</th>
<th>wchar.h</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>fscanf(stream,</td>
<td>fwscanf(stream,</td>
<td>Performs a formatted read from the given stream.</td>
</tr>
<tr>
<td>format, ...)</td>
<td>format, ...)</td>
<td>Returns the number of items converted successfully. <em>(FSS implementation)</em></td>
</tr>
<tr>
<td>scanf(format, ...)</td>
<td>wscanf(format, ...)</td>
<td>Performs a formatted read from stdin. Returns the number of items converted successfully. <em>(FSS implementation)</em></td>
</tr>
<tr>
<td>sscanf(*s, format, ...)</td>
<td>swscanf(*s, format, ...)</td>
<td>Performs a formatted read from the string s. Returns the number of items converted successfully.</td>
</tr>
<tr>
<td>stdio.h</td>
<td>wchar.h</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>vfscanf(stream, format, arg)</td>
<td>vfwscanf(stream, format, arg)</td>
<td>Same as fscanf/fwscanf, but extra arguments are given as variable argument list arg. (See Section 10.1.21, stdarg.h)</td>
</tr>
<tr>
<td>vscanf(format, arg)</td>
<td>vwscanf(format, arg)</td>
<td>Same as scanf/swscanf, but extra arguments are given as variable argument list arg. (See Section 10.1.21, stdarg.h)</td>
</tr>
<tr>
<td>vsscanf(*s, format, arg)</td>
<td>vswscan(*s, format, arg)</td>
<td>Same as scanf/swscanf, but extra arguments are given as variable argument list arg. (See Section 10.1.21, stdarg.h)</td>
</tr>
<tr>
<td>fprintf(stream, format, ...)</td>
<td>fwprintf(stream, format, ...)</td>
<td>Performs a formatted write to the given stream. Returns EOF/WEOF on error. (FSS implementation)</td>
</tr>
<tr>
<td>printf(format, ...)</td>
<td>wprintf(format, ...)</td>
<td>Performs a formatted write to the stream stdout. Returns EOF/WEOF on error. (FSS implementation)</td>
</tr>
<tr>
<td>sprintf(*s, format, ...)</td>
<td>swprintf(*s, format, ...)</td>
<td>Performs a formatted write to string s. Returns EOF/WEOF on error.</td>
</tr>
<tr>
<td>snprintf(*s, n, format, ...)</td>
<td>swprintf(*s, n, format, ...)</td>
<td>Same as sprintf, but n specifies the maximum number of characters (including the terminating null character) to be written.</td>
</tr>
<tr>
<td>vfprintf(stream, format, arg)</td>
<td>vfwprintf(stream, format, arg)</td>
<td>Same as fprintf/fwprintf, but extra arguments are given as variable argument list arg. (See Section 10.1.21, stdarg.h) (FSS implementation)</td>
</tr>
<tr>
<td>vprintf(format, arg)</td>
<td>vwprintf(format, arg)</td>
<td>Same as printf/wprintf, but extra arguments are given as variable argument list arg. (See Section 10.1.21, stdarg.h) (FSS implementation)</td>
</tr>
<tr>
<td>vsprintf(*s, format, arg)</td>
<td>vswprintf(*s, format, arg)</td>
<td>Same as sprintf/swprintf, but extra arguments are given as variable argument list arg. (See Section 10.1.21, stdarg.h)</td>
</tr>
</tbody>
</table>

The C library functions printf(), fprintf(), vfprintf(), vsprintf(), ... call one single function, _doprint(), that deals with the format string and arguments. The same applies to all scanf type functions, which call the function _doscan(), and also for the wprintf and wcscnf type functions which call _dowprintf() and _dowscanf() respectively. The C library contains three versions of these routines: int, long and long long versions. If you use floating-point the formatter function for floating-point _doflt() or _dowflt() is called. Depending on the formatting arguments you use, the correct routine is used from the library. Of course the larger the version of the routine the larger your produced code will be.

Note that when you call any of the printf/scanf routines indirectly, the arguments are not known and always the long long version with floating-point support is used from the library.

Example:
The linker extracts the long version without floating-point support from the library.

See also the description of `#pragma weak` in Section 1.6, Pragmas to Control the Compiler.

**Character input/output**

<table>
<thead>
<tr>
<th>stdio.h</th>
<th>wchar.h</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>fgetc(stream)</code></td>
<td><code>fgetwc(stream)</code></td>
<td>Reads one character from <code>stream</code>. Returns the read character, or EOF/WEOF on error. (<em>FSS implementation</em>)</td>
</tr>
</tbody>
</table>
| `getc(stream)` | `getwc(stream)` | Same as `fgetc/fgetwc` except that is implemented as a macro. (*FSS implementation*)

NOTE: Currently #defined as `getchar()/getwchar()` because FILE I/O is not supported. Returns the read character, or EOF/WEOF on error. |
| `getchar(stdin)` | `getwchar(stdin)` | Reads one character from the `stdin` stream. Returns the character read or EOF/WEOF on error. Implemented as macro. (*FSS implementation*) |
| `fgets(*s, n, stream)` | `fgetws(*s, n, stream)` | Reads at most the next `n-1` characters from the `stream` into array `s` until a newline is found. Returns `s` or NULL or EOF/WEOF on error. (*FSS implementation*) |
| `puts(*s)` | - | (C90/C99 only) Reads characters from the `stdin` stream into array `s` until end-of-file is encountered or a newline is found. The newline is replaced by a NULL character. Returns `s` or NULL on EOF. (*FSS implementation*) |
| `ungetc(c, stream)` | `ungetwc(c, stream)` | Pushes character `c` back onto the input `stream`. Returns EOF/WEOF on error. |
| `fputc(c, stream)` | `fputwc(c, stream)` | Put character `c` onto the given `stream`. Returns EOF/WEOF on error. (*FSS implementation*) |
| `putc(c, stream)` | `putwc(c, stream)` | Same as `fpuc/fputwc` except that is implemented as a macro. (*FSS implementation*) |
### Direct input/output

<table>
<thead>
<tr>
<th>Library</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>stdio.h</strong></td>
<td><strong>wchar.h</strong></td>
</tr>
<tr>
<td><code>putchar(c, stdout)</code></td>
<td><code>putwchar(c, stdout)</code></td>
</tr>
<tr>
<td><code>fputs(*s, stream)</code></td>
<td><code>fputws(*s, stream)</code></td>
</tr>
<tr>
<td><code>puts(*s)</code></td>
<td><code>-</code></td>
</tr>
</tbody>
</table>

### Random access

<table>
<thead>
<tr>
<th>Library</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>stdio.h</strong></td>
<td></td>
</tr>
<tr>
<td><code>fread(ptr, size, nobj, stream)</code></td>
<td>Reads nobj members of size bytes from the given stream into the array pointed to by ptr. Returns the number of elements successfully read. <em>(FSS implementation)</em></td>
</tr>
<tr>
<td><code>fwrite(ptr, size, nobj, stream)</code></td>
<td>Writes nobj members of size bytes from to the array pointed to by ptr to the given stream. Returns the number of elements successfully written. <em>(FSS implementation)</em></td>
</tr>
</tbody>
</table>

When repositioning a binary file, the new position `origin` is given by the following macros:

- `SEEK_SET 0` - offset characters from the beginning of the file
- `SEEK_CUR 1` - offset characters from the current position in the file
- `SEEK_END 2` - offset characters from the end of the file

<table>
<thead>
<tr>
<th>Library</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>ftell(stream)</code></td>
<td>Returns the current file position for stream, or -1L on error. <em>(FSS implementation)</em></td>
</tr>
</tbody>
</table>
| `rewind(stream)` | Sets the file position indicator for the stream to the beginning of the file. This function is equivalent to:  
  `(void) fseek(stream, 0L, SEEK_SET);`  
  `clearerr(stream);`  
  *(FSS implementation)* |
| `fgetpos(stream, pos)` | Stores the current value of the file position indicator for stream in the object pointed to by pos. *(FSS implementation)* |
| `fsetpos(stream, pos)` | Positions stream at the position recorded by fgetpos in *pos. *(FSS implementation)* |
Operations on files

<table>
<thead>
<tr>
<th>stdio.h</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>remove(file)</td>
<td>Removes the named file, so that a subsequent attempt to open it fails. Returns a non-zero value if not successful.</td>
</tr>
<tr>
<td>rename(old,new)</td>
<td>Changes the name of the file from old name to new name. Returns a non-zero value if not successful.</td>
</tr>
<tr>
<td>tmpfile()</td>
<td>Creates a temporary file of the mode &quot;wb+&quot; that will be automatically removed when closed or when the program terminates normally. Returns a file pointer.</td>
</tr>
<tr>
<td>tmpnam(buffer)</td>
<td>Creates new file names that do not conflict with other file names currently in use. The new file name is stored in a buffer which must have room for L_tmpnam characters. Returns a pointer to the temporary name. The file names are created in the current directory and all start with &quot;tmp&quot;. At most TMP_MAX unique file names can be generated.</td>
</tr>
</tbody>
</table>

Error handling

<table>
<thead>
<tr>
<th>stdio.h</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>clearerr(stream)</td>
<td>Clears the end of file and error indicators for stream.</td>
</tr>
<tr>
<td>ferror(stream)</td>
<td>Returns a non-zero value if the error indicator for stream is set.</td>
</tr>
<tr>
<td>feof(stream)</td>
<td>Returns a non-zero value if the end of file indicator for stream is set.</td>
</tr>
<tr>
<td>perror(*s)</td>
<td>Prints s and the error message belonging to the integer errno. (See Section 10.1.6, errno.h)</td>
</tr>
</tbody>
</table>

10.1.26. stdlib.h and wchar.h

The header file stdlib.h contains general utility functions which fall into the following categories (Some have parallel wide character, declared in wchar.h)

- Numeric conversions
- Random number generation
- Memory management
- Environment communication
- Searching and sorting
- Integer arithmetic
- Multibyte/wide character and string conversions.
Macros

EXIT_SUCCESS Predefined exit codes that can be used in the exit function.
0
EXIT_FAILURE
1
RAND_MAX Highest number that can be returned by the rand/srand function.
32767
MB_CUR_MAX Maximum number of bytes in a multibyte character for the extended character set
specified by the current locale (category LC_CTYPE, see Section 10.1.15, locale.h).

Numeric conversions

The following functions convert the initial portion of a string *s to a double, int, long int and
long long value respectively.

double atof(*s)
int atoi(*s)
long atol(*s)
long long atoll(*s)

The following functions convert the initial portion of the string *s to a float, double and long double value
respectively. *endp will point to the first character not used by the conversion.

stdlib.h            wchar.h
float                 float
      strtof(*s,**endp)     wcstof(*s,**endp)
double               double
      strtod(*s,**endp)     wcstod(*s,**endp)
long double          long double
      strtold(*s,**endp)    wcstold(*s,**endp)

The following functions convert the initial portion of the string *s to a long, long long, unsigned
long and unsigned long long respectively. Base specifies the radix. *endp will point to the first
character not used by the conversion.

stdlib.h            wchar.h
long strtol (*s,**endp,base)     long wcstol (*s,**endp,base)
long long strtoll
      (*s,**endp,base)     long long wcstoll (*s,**endp,base)
unsigned long strtoul
      (*s,**endp,base)     unsigned long wcstoul (*s,**endp,base)
unsigned long long strtoull
      (*s,**endp,base)     unsigned long long wcstoull (*s,**endp,base)

Random number generation

rand Returns a pseudo random integer in the range 0 to RAND_MAX.
srand(seed) Same as rand but uses seed for a new sequence of pseudo random numbers.
Memory management

**malloc(size)**
Allocates space for an object with size `size`. The allocated space is not initialized. Returns a pointer to the allocated space.

**(C11 only)** **aligned_alloc(alignment, size)**
Allocates space for an object whose alignment is specified by `alignment` and with size `size`. The allocated space is not initialized. Returns a pointer to the allocated space.

**calloc(nobj, size)**
Allocates space for `n` objects with size `size`. The allocated space is initialized with zeros. Returns a pointer to the allocated space.

**free(ptr)**
Deallocates the memory space pointed to by `ptr` which should be a pointer earlier returned by the `malloc` or `calloc` function.

**realloc(ptr, size)**
Deallocates the old object pointed to by `ptr` and returns a pointer to a new object with size `size`, while preserving its contents. If the new size is smaller than the old size, some contents at the end of the old region will be discarded. If the new size is larger than the old size, all of the old contents are preserved and any bytes in the new object beyond the size of the old object will have indeterminate values.

Environment communication

**abort()**
Causes abnormal program termination. If the signal SIGABRT is caught, the signal handler may take over control. (See Section 10.1.19, `signal.h`).

**atexit(func)**
`func` points to a function that is called (without arguments) when the program normally terminates.

**exit(status)**
Causes normal program termination. Acts as if `main()` returns with status as the return value. Status can also be specified with the predefined macros `EXIT_SUCCESS` or `EXIT_FAILURE`.

**_Exit(status)**
Same as `exit`, but not registered by the `atexit` function or signal handlers registered by the `signal` function are called.

**(C11 only)** **at_quick_exit(func)**
Registers the function pointed to by `func` to be called (without arguments) when `quick_exit` is called. Returns zero if the registration succeeds, nonzero if it fails.

**(C11 only)** **quick_exit(status)**
Causes normal program termination. Calls all functions registered by the `at_quick_exit` function, in the reverse order of their registration, and then calls `_Exit`.

**getenv(s)**
Searches an environment list for a string `s`. Returns a pointer to the contents of `s`. NOTE: this function is not implemented because there is no OS.

**system(s)**
Passes the string `s` to the environment for execution. NOTE: this function is not implemented because there is no OS.
Searching and sorting

*bsearch(*key, *base, n, size, *cmp)*

This function searches in an array of \( n \) members, for the object pointed to by key. The initial base of the array is given by base. The size of each member is specified by size. The given array must be sorted in ascending order, according to the results of the function pointed to by cmp. Returns a pointer to the matching member in the array, or NULL when not found.

*qsort(*base, n, size, *cmp)*

This function sorts an array of \( n \) members using the quick sort algorithm. The initial base of the array is given by base. The size of each member is specified by size. The array is sorted in ascending order, according to the results of the function pointed to by cmp.

Integer arithmetic

*int abs(j)*

*long labs(j)*

*long long llabs(j)*

*div_t div(x,y)*

*ldiv_t ldiv(x,y)*

*ldiv_t lldiv(x,y)*

Compute the absolute value of an int, long int, and long long int \( j \) respectively.

Compute \( x/y \) and \( x\%y \) in a single operation. \( x \) and \( y \) have respectively type int, long int and long long int. The result is stored in the members quot and rem of struct div_t, ldiv_t and lldiv_t which have the same types.

Multibyte/wide character and string conversions

*mblen(*s,n)*

Determines the number of bytes in the multibyte character pointed to by \( s \). At most \( n \) characters will be examined. (See also mbrlen in Section 10.1.32, wchar.h).

*mbtowc(*pwc,*s,n)*

Converts the multibyte character in \( s \) to a wide character code and stores it in pwc. At most \( n \) characters will be examined.

*wctomb(*s,wc)*

Converts the wide character \( wc \) into a multibyte representation and stores it in the string pointed to by \( s \). At most MB_CUR_MAX characters are stored.

*mbstowcs(*pwcs,*s,n)*

Converts a sequence of multibyte characters in the string pointed to by \( s \) into a sequence of wide characters and stores at most \( n \) wide characters into the array pointed to by pwcs. (See also mbsrtowcs in Section 10.1.32, wchar.h).

*wcstombs(*s,*pwcs,n)*

Converts a sequence of wide characters in the array pointed to by pwcs into multibyte characters and stores at most \( n \) multibyte characters into the string pointed to by \( s \). (See also wcstowmb in Section 10.1.32, wchar.h).

10.1.27. stdnoreturn.h

This C11 header file contains the following macro definition:

#define noreturn _Noreturn
10.1.28. string.h and wchar.h

This header file provides numerous functions for manipulating strings. By convention, strings in C are arrays of characters with a terminating null character. Most functions therefore take arguments of type *char. However, many functions have also parallel wide character functions which take arguments of type *wchar_t. These functions are declared in wchar.h.

Copying and concatenation functions

<table>
<thead>
<tr>
<th>string.h</th>
<th>wchar.h</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>memcpy(*s1,*s2,n)</td>
<td>wmemncpy(*sl,*s2,n)</td>
<td>Copies n characters from *s2 into *s1 and returns *s1. If *s1 and *s2 overlap the result is undefined.</td>
</tr>
<tr>
<td>memmove(*s1,*s2,n)</td>
<td>wmemmove(*sl,*s2,n)</td>
<td>Same as memcpy, but overlapping strings are handled correctly. Returns *s1.</td>
</tr>
<tr>
<td>strcpy(*s1,*s2)</td>
<td>wcscpy(*s1,*s2)</td>
<td>Copies *s2 into *s1 and returns *s1. If *s1 and *s2 overlap the result is undefined.</td>
</tr>
<tr>
<td>strncpy(*s1,*s2,n)</td>
<td>wcsncpy(*sl,*s2,n)</td>
<td>Copies not more than n characters from *s2 into *s1 and returns *s1. If *s1 and *s2 overlap the result is undefined.</td>
</tr>
<tr>
<td>strcat(*s1,*s2)</td>
<td>wcscat(*s1,*s2)</td>
<td>Appends a copy of *s2 to *s1 and returns *s1. If *s1 and *s2 overlap the result is undefined.</td>
</tr>
<tr>
<td>strncat(*s1,*s2,n)</td>
<td>wcsncat(*sl,*s2,n)</td>
<td>Appends not more than n characters from *s2 to *s1 and returns *s1. If *s1 and *s2 overlap the result is undefined.</td>
</tr>
</tbody>
</table>

Comparison functions

<table>
<thead>
<tr>
<th>string.h</th>
<th>wchar.h</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>memcmp(*s1,*s2,n)</td>
<td>wmemcmp(*sl,*s2,n)</td>
<td>Compares the first n characters of *s1 to the first n characters of *s2. Returns &lt; 0 if *s1 &lt; *s2, 0 if *s1 == *s2, or &gt; 0 if *s1 &gt; *s2.</td>
</tr>
<tr>
<td>strcmp(*s1,*s2)</td>
<td>wcscmp(*s1,*s2)</td>
<td>Compares string *s1 to *s2. Returns &lt; 0 if *s1 &lt; *s2, 0 if *s1 == *s2, or &gt; 0 if *s1 &gt; *s2.</td>
</tr>
<tr>
<td>strncmp(*s1,*s2,n)</td>
<td>wcsncmp(*sl,*s2,n)</td>
<td>Compares the first n characters of *s1 to the first n characters of *s2. Returns &lt; 0 if *s1 &lt; *s2, 0 if *s1 == *s2, or &gt; 0 if *s1 &gt; *s2.</td>
</tr>
<tr>
<td>strcoll(*s1,*s2)</td>
<td>wcscoll(*s1,*s2)</td>
<td>Performs a local-specific comparison between string *s1 and string *s2 according to the LC_COLLATE category of the current locale. Returns &lt; 0 if *s1 &lt; *s2, 0 if *s1 == *s2, or &gt; 0 if *s1 &gt; *s2. (See Section 10.1.15, locale.h)</td>
</tr>
<tr>
<td>strxfrm(*s1,*s2,n)</td>
<td>wcsxfrm(*sl,*s2,n)</td>
<td>Transforms (a local) string *s2 so that a comparison between transformed strings with strcmp gives the same result as a comparison between non-transformed strings with strcoll. Returns the transformed string *s1.</td>
</tr>
</tbody>
</table>
Search functions

<table>
<thead>
<tr>
<th>string.h</th>
<th>wchar.h</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>memchr(*s, c, n)</td>
<td>wmemchr(*s, c, n)</td>
<td>Checks the first $n$ characters of *s on the occurrence of character c. Returns a pointer to the found character.</td>
</tr>
<tr>
<td>strchr(*s, c)</td>
<td>wcschr(*s, c)</td>
<td>Returns a pointer to the first occurrence of character c in *s or the null pointer if not found.</td>
</tr>
<tr>
<td>strrchr(*s, c)</td>
<td>wcsrchr(*s, c)</td>
<td>Returns a pointer to the last occurrence of character c in *s or the null pointer if not found.</td>
</tr>
<tr>
<td>strspn(*s, *set)</td>
<td>wcspn(*s, *set)</td>
<td>Searches *s for a sequence of characters specified in *set. Returns the length of the first sequence found.</td>
</tr>
<tr>
<td>strcspn(*s, *set)</td>
<td>wcscspn(*s, *set)</td>
<td>Searches *s for a sequence of characters not specified in *set. Returns the length of the first sequence found.</td>
</tr>
<tr>
<td>strpbrk(*s, *set)</td>
<td>wcspbrk(*s, *set)</td>
<td>Same as strspn/wcspn but returns a pointer to the first character in *s that also is specified in *set.</td>
</tr>
<tr>
<td>strstr(*s, *sub)</td>
<td>wcsstr(*s, *sub)</td>
<td>Searches for a substring *sub in *s. Returns a pointer to the first occurrence of *sub in *s.</td>
</tr>
<tr>
<td>strtok(*s, *dlm)</td>
<td>wcstok(*s, *dlm)</td>
<td>A sequence of calls to this function breaks the string *s into a sequence of tokens delimited by a character specified in *dlm. The token found in *s is terminated with a null character. Returns a pointer to the first position in *s of the token.</td>
</tr>
</tbody>
</table>

Miscellaneous functions

<table>
<thead>
<tr>
<th>string.h</th>
<th>wchar.h</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>memset(*s, c, n)</td>
<td>wmemset(*s, c, n)</td>
<td>Fills the first $n$ bytes of *s with character c and returns *s.</td>
</tr>
<tr>
<td>strerror(errno)</td>
<td>-</td>
<td>Typically, the values for errno come from int errno. This function returns a pointer to the associated error message. (See also Section 10.1.6, errno.h)</td>
</tr>
<tr>
<td>strlen(*s)</td>
<td>wcslen(*s)</td>
<td>Returns the length of string *s.</td>
</tr>
</tbody>
</table>

10.1.29. time.h and wchar.h

The header file *time.h* provides facilities to retrieve and use the (calendar) date and time, and the process time. Time can be represented as an integer value, or can be broken-down in components. Two arithmetic data types are defined which are capable of holding the integer representation of times:

- clock_t unsigned long long
- time_t unsigned long

The type struct tm below is defined according to ISO C99 with one exception: this implementation does not support leap seconds. The struct tm type is defines as follows:

```c
struct tm {
```
int tm_sec;       /* seconds after the minute - [0, 59]   */
int tm_min;       /* minutes after the hour - [0, 59]     */
int tm_hour;      /* hours since midnight - [0, 23]       */
int tm_mday;      /* day of the month - [1, 31]           */
int tm_mon;       /* months since January - [0, 11]       */
int tm_year;      /* year since 1900                      */
int tm_wday;      /* days since Sunday - [0, 6]           */
int tm_yday;      /* days since January 1 - [0, 365]      */
int tm_isdst;     /* Daylight Saving Time flag */
};

Time manipulation

clock
Returns the application's best approximation to the processor time used by the
program since it was started. This low-level routine is not implemented because it
strongly depends on the hardware. To determine the time in seconds, the result of
clock should be divided by the value defined by CLOCKS_PER_SEC.

difftime(t1,t0) Returns the difference t1-t0 in seconds.
mktime(tm *tp) Converts the broken-down time in the structure pointed to by tp, to a value of type
time_t. The return value has the same encoding as the return value of the time
function.
time(*timer) Returns the current calendar time. This value is also assigned to *timer.

Time conversion

asctime(tm *tp) Converts the broken-down time in the structure pointed to by tp into a string in the
form Mon Feb 04 16:15:14 2013\n\0. Returns a pointer to this string.
ctime(*timer) Converts the calendar time pointed to by timer to local time in the form of a string.
This is equivalent to: asctime(localtime(timer))
gmtime(*timer) Converts the calendar time pointed to by timer to the broken-down time, expressed
as UTC. Returns a pointer to the broken-down time.
localtime(*timer) Converts the calendar time pointed to by timer to the broken-down time, expressed
as local time. Returns a pointer to the broken-down time.

Formatted time

The next function has a parallel function defined in wchar.h:

<table>
<thead>
<tr>
<th>time.h</th>
<th>wchar.h</th>
</tr>
</thead>
<tbody>
<tr>
<td>strftime(*s, smax, *fmt, tm *tp)</td>
<td>wcsftime(*s, smax, *fmt, tm *tp)</td>
</tr>
</tbody>
</table>

Formats date and time information from struct tm *tp into *s according to the specified format *fmt.
No more than smax characters are placed into *s. The formatting of strftime is locale-specific using
the LC_TIME category (see Section 10.1.15, locale.h).

You can use the next conversion specifiers:
%a  abbreviated weekday name
%A  full weekday name
%b  abbreviated month name
%B  full month name
%c  locale-specific date and time representation (same as %a %b %e %T %Y)
%C  last two digits of the year
%d  day of the month (01-31)
%D  same as %m/%d/%y
%e  day of the month (1-31), with single digits preceded by a space
%F  ISO 8601 date format: %Y-%m-%d
%g  last two digits of the week based year (00-99)
%G  week based year (0000–9999)
%h  same as %b
%H  hour, 24-hour clock (00-23)
%I  hour, 12-hour clock (01-12)
%j  day of the year (001-366)
%m  month (01-12)
%M  minute (00-59)
%n  replaced by newline character
%p  locale's equivalent of AM or PM
%r  locale's 12-hour clock time; same as %I:%M:%S %p
%R  same as %H:%M
%S  second (00-59)
%t  replaced by horizontal tab character
%T  ISO 8601 time format: %H:%M:%S
%u  ISO 8601 weekday number (1-7), Monday as first day of the week
%U  week number of the year (00-53), week 1 has the first Sunday
%V  ISO 8601 week number (01-53) in the week-based year
%w  weekday (0-6, Sunday is 0)
%W  week number of the year (00-53), week 1 has the first Monday
%x  local date representation
%x  local time representation
%y  year without century (00-99)
%Y  year with century
%z  ISO 8601 offset of time zone from UTC, or nothing
%Z  time zone name, if any
10.1.30. uchar.h

The C11 header file `uchar.h` declares types and functions for manipulating Unicode characters.

This header file declares the types:

- `char16_t` Unsigned integer type used for 16-bit characters.
- `char32_t` Unsigned integer type used for 32-bit characters.
- `size_t` Unsigned integer type of the result of the `sizeof` operator.
- `wchar_t` Integer type to represent character codes in large character sets.

The functions perform conversions between multibyte characters and Unicode characters. In these functions, `ps` points to struct `mbstate_t` which holds the conversion state information necessary to convert between sequences of multibyte characters and Unicode characters:

```c
typedef struct
{
    wchar_t     wc_value;  /* wide character value solved so far */
    unsigned short n_bytes;  /* number of bytes of solved multibyte */
    unsigned short encoding;  /* encoding rule for wide character <=> multibyte conversion */
} mbstate_t;

mbrtoc16(*pc16,*s,n,*ps) Converts a multibyte character *s to a 16-bit character *pc16 according to conversion state `ps`.

c16rtomb(*s,c16,*ps) Converts a 16-bit character `c16` to a multibyte character according to conversion state `ps` and stores the multibyte character in `*s`.

mbrtoc32(*pc32,*s,n,*ps) Converts a multibyte character *s to a 32-bit character *pc32 according to conversion state `ps`.

c32rtomb(*s,c32,*ps) Converts a 32-bit character `c32` to a multibyte character according to conversion state `ps` and stores the multibyte character in `*s`.
```

10.1.31. unistd.h

The file `unistd.h` contains standard UNIX I/O functions. These functions are all implemented using file system simulation. Except for `lstat` and `fstat` which are not implemented. This header file is not defined in ISO C99.
access(*name, mode) Use file system simulation to check the permissions of a file on the host. *mode* specifies the type of access and is a bit pattern constructed by a logical OR of the following values:

- **R_OK** Checks read permission.
- **W_OK** Checks write permission.
- **X_OK** Checks execute (search) permission.
- **F_OK** Checks to see if the file exists.

(*FSS implementation*)

chdir(*path) Use file system simulation to change the current directory on the host to the directory indicated by *path*. (*FSS implementation*)

close(fd) File close function. The given file descriptor should be properly closed. This function calls _close(). (*FSS implementation*)

cwd(*buf, size) Use file system simulation to retrieve the current directory on the host. Returns the directory name. (*FSS implementation*)

fseek(fd, offset, whence) Moves read-write file offset. Calls _fseek(). (*FSS implementation*)

read(fd, *buff, cnt) Reads a sequence of characters from a file. This function calls _read(). (*FSS implementation*)

stat(*name, *buff) Use file system simulation to stat() a file on the host platform. (*FSS implementation*)

lstat(*name, *buff) This function is identical to stat(), except in the case of a symbolic link, where the link itself is 'stat'-ed, not the file that it refers to. (*Not implemented*)

fstat(fd, *buff) This function is identical to stat(), except that it uses a file descriptor instead of a name. (*Not implemented*)

unlink(*name) Removes the named file, so that a subsequent attempt to open it fails. (*FSS implementation*)

write(fd, *buff, cnt) Write a sequence of characters to a file. Calls _write(). (*FSS implementation*)

10.1.32. wchar.h

Many functions in wchar.h represent the wide character variant of other functions so these are discussed together. (See Section 10.1.25, stdio.h and wchar.h, Section 10.1.26, stdlib.h and wchar.h, Section 10.1.28, string.h and wchar.h and Section 10.1.29, time.h and wchar.h).

The remaining functions are described below. They perform conversions between multibyte characters and wide characters. In these functions, *ps* points to struct mbstate_t which holds the conversion state information necessary to convert between sequences of multibyte characters and wide characters:

typedef struct
{
  wchar_t          wc_value;    /* wide character value solved so far */
  unsigned short   n_bytes;     /* number of bytes of solved multibyte */
  unsigned short   encoding;    /* encoding rule for wide */
} mbstate_t;
When multibyte characters larger than 1 byte are used, this struct will be used to store the conversion information when not all the bytes of a particular multibyte character have been read from the source. In this implementation, multibyte characters are 1 byte long (MB_CUR_MAX and MB_LEN_MAX are defined as 1) and this will never occur.

**mbsinit(*ps)**
Determines whether the object pointed to by *ps* is an initial conversion state. Returns a non-zero value if so.

**mbsrtowcs(*pwcs,**src,**n,**ps)**
Restartable version of mbstowcs. See Section 10.1.26, stdlib.h and wchar.h. The initial conversion state is specified by *ps*. The input sequence of multibyte characters is specified indirectly by src.

**wcsrtombs(*s,**src,**n,**ps)**
Restartable version of wcstombs. See Section 10.1.26, stdlib.h and wchar.h. The initial conversion state is specified by *ps*. The input wide string is specified indirectly by src.

**mbtowc(*pwc,**s,**n,**ps)**
Converts a multibyte character *s* to a wide character *pwc* according to conversion state *ps*. See also mbtowc in Section 10.1.26, stdlib.h and wchar.h.

**wcrtomb(*s,**wc,**ps)**
Converts a wide character *wc* to a multibyte character according to conversion state *ps* and stores the multibyte character in *s*.

**btowc(c)**
Returns the wide character corresponding to character *c*. Returns WEOF on error.

**wctob(c)**
Returns the multibyte character corresponding to the wide character *c*. The returned multibyte character is represented as one byte. Returns EOF on error.

**mbrlen(*s,**n,**ps)**
Inspects up to *n* bytes from the string *s* to see if those characters represent valid multibyte characters, relative to the conversion state held in *ps*.

### 10.1.33. wctype.h

Most functions in wctype.h represent the wide character variant of functions declared in ctype.h and are discussed in Section 10.1.4, ctype.h and wctype.h. In addition, this header file provides extensible, locale specific functions and wide character classification.

**wctype(*property)**
Constructs a value of type wctype_t that describes a class of wide characters identified by the string *property*. If property identifies a valid class of wide characters according to the LC_TYPE category (see Section 10.1.15, locale.h) of the current locale, a non-zero value is returned that can be used as an argument in the iswctype function.

**iswctype(wc,**desc)**
Tests whether the wide character *wc* is a member of the class represented by wctype_t *desc*. Returns a non-zero value if tested true.
Equivalent to locale specific test

<table>
<thead>
<tr>
<th>Function</th>
<th>Equivalent to locale specific test</th>
</tr>
</thead>
<tbody>
<tr>
<td>iswalnum(wc)</td>
<td>iswctype(wc, wctype(&quot;alnum&quot;))</td>
</tr>
<tr>
<td>iswalpha(wc)</td>
<td>iswctype(wc, wctype(&quot;alpha&quot;))</td>
</tr>
<tr>
<td>iswcntrl(wc)</td>
<td>iswctype(wc, wctype(&quot;cntrl&quot;))</td>
</tr>
<tr>
<td>iswdigit(wc)</td>
<td>iswctype(wc, wctype(&quot;digit&quot;))</td>
</tr>
<tr>
<td>iswgraph(wc)</td>
<td>iswctype(wc, wctype(&quot;graph&quot;))</td>
</tr>
<tr>
<td>iswlower(wc)</td>
<td>iswctype(wc, wctype(&quot;lower&quot;))</td>
</tr>
<tr>
<td>iswprint(wc)</td>
<td>iswctype(wc, wctype(&quot;print&quot;))</td>
</tr>
<tr>
<td>iswpunct(wc)</td>
<td>iswctype(wc, wctype(&quot;punct&quot;))</td>
</tr>
<tr>
<td>iswspace(wc)</td>
<td>iswctype(wc, wctype(&quot;space&quot;))</td>
</tr>
<tr>
<td>iswupper(wc)</td>
<td>iswctype(wc, wctype(&quot;upper&quot;))</td>
</tr>
<tr>
<td>iswxditig(wc)</td>
<td>iswctype(wc, wctype(&quot;xdigit&quot;))</td>
</tr>
</tbody>
</table>

`wctrans(*property)` Constructs a value of type `wctype_t` that describes a mapping between wide characters identified by the string `*property`. If property identifies a valid mapping of wide characters according to the LC_TYPE category (see Section 10.1.15, `locale.h`) of the current locale, a non-zero value is returned that can be used as an argument in the `towctrans` function.

`towctrans(wc, desc)` Transforms wide character `wc` into another wide character, described by `desc`.

### 10.2. C Library Reentrancy

Some of the functions in the C library are reentrant, others are not. The table below shows the functions in the C library, and whether they are reentrant or not. A dash means that the function is reentrant. Note that some of the functions are not reentrant because they set the global variable `errno` (or call other functions that eventually set `errno`). If your program does not check this variable and `errno` is the only reason for the function not being reentrant, these functions can be assumed reentrant as well.

The explanation of the cause why a function is not reentrant sometimes refers to a footnote because the explanation is too lengthy for the table.

<table>
<thead>
<tr>
<th>Function</th>
<th>Not reentrant because</th>
</tr>
</thead>
<tbody>
<tr>
<td>_close</td>
<td>Uses global File System Simulation buffer, _dbg_request</td>
</tr>
<tr>
<td>_doflt</td>
<td>Uses I/O functions which modify iob[]. See (1).</td>
</tr>
<tr>
<td>_doprint</td>
<td>Uses indirect access to static iob[] array. See (1).</td>
</tr>
<tr>
<td>_doscan</td>
<td>Uses indirect access to iob[] and calls ungetc (access to local static ungetc[] buffer). See (1).</td>
</tr>
<tr>
<td>Function</td>
<td>Not reentrant because</td>
</tr>
<tr>
<td>---------------</td>
<td>--------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>_Exit</td>
<td>See exit.</td>
</tr>
<tr>
<td>_filbuf</td>
<td>Uses iob[], which is not reentrant. See (1).</td>
</tr>
<tr>
<td>_flsbuf</td>
<td>Uses iob[]. See (1).</td>
</tr>
<tr>
<td>_getfltt</td>
<td>Uses iob[]. See (1).</td>
</tr>
<tr>
<td>_iob</td>
<td>Defines static iob[]. See (1).</td>
</tr>
<tr>
<td>_lseek</td>
<td>Uses global File System Simulation buffer, _dbg_request</td>
</tr>
<tr>
<td>_open</td>
<td>Uses global File System Simulation buffer, _dbg_request</td>
</tr>
<tr>
<td>_read</td>
<td>Uses global File System Simulation buffer, _dbg_request</td>
</tr>
<tr>
<td>_unlink</td>
<td>Uses global File System Simulation buffer, _dbg_request</td>
</tr>
<tr>
<td>_write</td>
<td>Uses global File System Simulation buffer, _dbg_request</td>
</tr>
<tr>
<td>abort</td>
<td>Calls exit</td>
</tr>
<tr>
<td>abs labs llabs</td>
<td>-</td>
</tr>
<tr>
<td>access</td>
<td>Uses global File System Simulation buffer, _dbg_request</td>
</tr>
<tr>
<td>acos acosf acosl</td>
<td>Sets errno.</td>
</tr>
<tr>
<td>acosh acoshf acoshl</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>aligned_alloc</td>
<td>See malloc (5).</td>
</tr>
<tr>
<td>asctime</td>
<td>asctime defines static array for broken-down time string.</td>
</tr>
<tr>
<td>asinf asinfl</td>
<td>Sets errno.</td>
</tr>
<tr>
<td>asinh asinhf asinhl</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>at_quick_exit</td>
<td>at_quick_exit defines static array with function pointers to execute when quick_exit is called.</td>
</tr>
<tr>
<td>atan atanf atanl</td>
<td>-</td>
</tr>
<tr>
<td>atan2 atan2f atan2l</td>
<td>-</td>
</tr>
<tr>
<td>atanh atanhfl atanhhl</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>atexit</td>
<td>atexit defines static array with function pointers to execute at exit of program.</td>
</tr>
<tr>
<td>atof</td>
<td>-</td>
</tr>
<tr>
<td>atoi</td>
<td>-</td>
</tr>
<tr>
<td>atol</td>
<td>-</td>
</tr>
<tr>
<td>bsearch</td>
<td>-</td>
</tr>
<tr>
<td>btowc</td>
<td>-</td>
</tr>
<tr>
<td>c16rtomb</td>
<td>Sets errno. Uses static internal_state variable.</td>
</tr>
<tr>
<td>c32rtomb</td>
<td>Sets errno. Uses static internal_state variable.</td>
</tr>
<tr>
<td>cabs cabsf cabsl</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>cacos cacosf cacosl</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>cacosh cacoshf cfacoshl</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>Function</td>
<td>Not reentrant because</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>calloc</td>
<td>calloc uses static buffer management structures. See malloc (5).</td>
</tr>
<tr>
<td>carg cargf cargl</td>
<td>-</td>
</tr>
<tr>
<td>casin casinf casinl</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>casinh casinhf csinhl</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>catan catanf catanl</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>catanh catanhf catanhl</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>cbrt cbrtf cbrtl</td>
<td>-</td>
</tr>
<tr>
<td>ccos ccosf ccosl</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>ccosh ccoshf ccoshl</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>ceil ceilf ceill</td>
<td>-</td>
</tr>
<tr>
<td>cexp cexpf cexpl</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>chdir</td>
<td>Uses global File System Simulation buffer, _dbg_request</td>
</tr>
<tr>
<td>cimag cimagf cimagl</td>
<td>-</td>
</tr>
<tr>
<td>cleanup</td>
<td>Calls fclose. See (1)</td>
</tr>
<tr>
<td>clearerr</td>
<td>Modifies iob[]. See (1)</td>
</tr>
<tr>
<td>clock</td>
<td>Uses global File System Simulation buffer, _dbg_request</td>
</tr>
<tr>
<td>clog clogf clogl</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>close</td>
<td>Calls _close</td>
</tr>
<tr>
<td>conj conjf conjl</td>
<td>-</td>
</tr>
<tr>
<td>copysign copysignf</td>
<td>-</td>
</tr>
<tr>
<td>copysignl</td>
<td>-</td>
</tr>
<tr>
<td>cos cosf cosl</td>
<td>-</td>
</tr>
<tr>
<td>cosh ccoshf coshl</td>
<td>cosh calls exp(), which sets errno. If errno is discarded, cosh is reentrant.</td>
</tr>
<tr>
<td>cpow cpowf cpowl</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>cproj cprojf cprojl</td>
<td>-</td>
</tr>
<tr>
<td>creal crealf creall</td>
<td>-</td>
</tr>
<tr>
<td>csin csinf csinl</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>csinh csinhf csinhl</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>csqrt csqrtf csqrfl</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>ctan ctanf ctanl</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>ctanh ctanhf ctanhl</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>ctime</td>
<td>Calls asctime</td>
</tr>
<tr>
<td>difftime</td>
<td>-</td>
</tr>
<tr>
<td>div ldiv lldiv</td>
<td>-</td>
</tr>
<tr>
<td>erf erfl erff</td>
<td>-</td>
</tr>
<tr>
<td>Function</td>
<td>Not reentrant because</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>erf, erfc, erfcl</td>
<td>Calls fclose indirectly which uses iob[ ] calls functions in _atexit array. See (1). To make exit reentrant kernel support is required.</td>
</tr>
<tr>
<td>exit</td>
<td>Sets errno.</td>
</tr>
<tr>
<td>exp, expf, expl</td>
<td>Sets errno.</td>
</tr>
<tr>
<td>exp2, exp2f, exp2l</td>
<td>Sets errno.</td>
</tr>
<tr>
<td>expm1, expm1f, expm1l</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>fabs, fabsf, fabsl</td>
<td>-</td>
</tr>
<tr>
<td>fclose</td>
<td>Uses values in iob[ ]. See (1).</td>
</tr>
<tr>
<td>fdim, fdimf, fdiml</td>
<td>-</td>
</tr>
<tr>
<td>feclearexcept</td>
<td>Writes PSW bits.</td>
</tr>
<tr>
<td>fetenv</td>
<td>- (reads PSW bits)</td>
</tr>
<tr>
<td>fegetexceptflag</td>
<td>- (reads PSW bits via calls to other functions)</td>
</tr>
<tr>
<td>fegetround</td>
<td>- (reads PSW bits)</td>
</tr>
<tr>
<td>feholdexcept</td>
<td>Reads/writes PSW bits via calls to other functions.</td>
</tr>
<tr>
<td>feof</td>
<td>Uses values in iob[ ]. See (1).</td>
</tr>
<tr>
<td>feraisexcept</td>
<td>Writes PSW bits.</td>
</tr>
<tr>
<td>ferror</td>
<td>Uses values in iob[ ]. See (1).</td>
</tr>
<tr>
<td>fesetenv</td>
<td>Writes PSW bits.</td>
</tr>
<tr>
<td>fesetexceptflag</td>
<td>Writes PSW bits via calls to other functions.</td>
</tr>
<tr>
<td>fesetround</td>
<td>Writes PSW bits.</td>
</tr>
<tr>
<td>fetestexcept</td>
<td>- (reads PSW bits)</td>
</tr>
<tr>
<td>feupdateenv</td>
<td>Writes PSW bits via calls to other functions.</td>
</tr>
<tr>
<td>fflush</td>
<td>Modifies iob[ ]. See (1).</td>
</tr>
<tr>
<td>fgetc, fgetwc</td>
<td>Uses pointer to iob[ ]. See (1).</td>
</tr>
<tr>
<td>fgetpos</td>
<td>Sets the variable errno and uses pointer to iob[ ]. See (1) / (2).</td>
</tr>
<tr>
<td>fgets, fgetws</td>
<td>Uses iob[ ]. See (1).</td>
</tr>
<tr>
<td>floor, floorf, floorl</td>
<td>-</td>
</tr>
<tr>
<td>fma, fmaf, fmal</td>
<td>-</td>
</tr>
<tr>
<td>fmax, fmaxf, fmaxl</td>
<td>-</td>
</tr>
<tr>
<td>fmin, fminf, fminl</td>
<td>-</td>
</tr>
<tr>
<td>fmod, fmodf, fmodl</td>
<td>-</td>
</tr>
<tr>
<td>fopen</td>
<td>Uses iob[ ] and calls malloc when file open for buffered IO. See (1)</td>
</tr>
<tr>
<td>fpclassify</td>
<td>-</td>
</tr>
<tr>
<td>fprintf, fwprintf</td>
<td>-</td>
</tr>
<tr>
<td>fputc, fputwc</td>
<td>Uses iob[ ]. See (1).</td>
</tr>
<tr>
<td>fputc, fputwc</td>
<td>Uses iob[ ]. See (1).</td>
</tr>
<tr>
<td>Function</td>
<td>Not reentrant because</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>fputs fputws</td>
<td>Uses iob[]. See (1).</td>
</tr>
<tr>
<td>fread</td>
<td>Calls fgetc. See (1).</td>
</tr>
<tr>
<td>free</td>
<td>free uses static buffer management structures. See malloc (5).</td>
</tr>
<tr>
<td>freopen</td>
<td>Modifies iob[]. See (1).</td>
</tr>
<tr>
<td>frexp frexpf frexpl</td>
<td></td>
</tr>
<tr>
<td>fscanf fwscanf</td>
<td>Uses iob[]. See (1)</td>
</tr>
<tr>
<td>fseek</td>
<td>Uses iob[] and calls _lseek. Accesses ungetc[] array. See (1).</td>
</tr>
<tr>
<td>fsetpos</td>
<td>Uses iob[] and sets errno. See (1) / (2).</td>
</tr>
<tr>
<td>fstat</td>
<td>(Not implemented)</td>
</tr>
<tr>
<td>ftell</td>
<td>Uses iob[] and sets errno. Calls _lseek. See (1) / (2).</td>
</tr>
<tr>
<td>fwrite</td>
<td>Uses iob[]. See (1).</td>
</tr>
<tr>
<td>getc getwc</td>
<td>Uses iob[]. See (1).</td>
</tr>
<tr>
<td>getchar getwchar</td>
<td>Uses iob[]. See (1).</td>
</tr>
<tr>
<td>getcwd</td>
<td>Uses global File System Simulation buffer, _dbg_request</td>
</tr>
<tr>
<td>getenv</td>
<td>Skeleton only.</td>
</tr>
<tr>
<td>gets getws</td>
<td>Uses iob[]. See (1).</td>
</tr>
<tr>
<td>gmtime</td>
<td>gmtime defines static structure</td>
</tr>
<tr>
<td>hypot hypotf hypotl</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>ilogb ilogbf ilogbl</td>
<td>Sets errno.</td>
</tr>
<tr>
<td>imaxabs</td>
<td>-</td>
</tr>
<tr>
<td>imaxdiv</td>
<td>-</td>
</tr>
<tr>
<td>isalnum iswalnum</td>
<td>-</td>
</tr>
<tr>
<td>isalpha iswalpha</td>
<td>-</td>
</tr>
<tr>
<td>isasci iwsasci</td>
<td>-</td>
</tr>
<tr>
<td>iscntrl iswcntrl</td>
<td>-</td>
</tr>
<tr>
<td>isdigit iswdigit</td>
<td>-</td>
</tr>
<tr>
<td>isfinite</td>
<td>-</td>
</tr>
<tr>
<td>isgraph iswgraph</td>
<td>-</td>
</tr>
<tr>
<td>isgreater</td>
<td>-</td>
</tr>
<tr>
<td>isgreaterequal</td>
<td>-</td>
</tr>
<tr>
<td>isinf</td>
<td>-</td>
</tr>
<tr>
<td>isless</td>
<td>-</td>
</tr>
<tr>
<td>islessequal</td>
<td>-</td>
</tr>
<tr>
<td>islessgreater</td>
<td>-</td>
</tr>
<tr>
<td>islower iswlower</td>
<td>-</td>
</tr>
<tr>
<td>Function</td>
<td>Not reentrant because</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>isnan</td>
<td>-</td>
</tr>
<tr>
<td>isnormal</td>
<td>-</td>
</tr>
<tr>
<td>isprint iswprint</td>
<td>-</td>
</tr>
<tr>
<td>ispunct iswpunct</td>
<td>-</td>
</tr>
<tr>
<td>isspace iswspace</td>
<td>-</td>
</tr>
<tr>
<td>isnunordered</td>
<td>-</td>
</tr>
<tr>
<td>isupper iswupper</td>
<td>-</td>
</tr>
<tr>
<td>iswalnum</td>
<td>-</td>
</tr>
<tr>
<td>iswalpha</td>
<td>-</td>
</tr>
<tr>
<td>iswcntrl</td>
<td>-</td>
</tr>
<tr>
<td>iswctype</td>
<td>-</td>
</tr>
<tr>
<td>iswdigit</td>
<td>-</td>
</tr>
<tr>
<td>iswgraph</td>
<td>-</td>
</tr>
<tr>
<td>iswlower</td>
<td>-</td>
</tr>
<tr>
<td>iswprint</td>
<td>-</td>
</tr>
<tr>
<td>iswpunct</td>
<td>-</td>
</tr>
<tr>
<td>iswspace</td>
<td>-</td>
</tr>
<tr>
<td>iswupper</td>
<td>-</td>
</tr>
<tr>
<td>iswdx ditig</td>
<td>-</td>
</tr>
<tr>
<td>isw wdigit</td>
<td>-</td>
</tr>
<tr>
<td>ldexp ldexpf ldexp1</td>
<td>Sets errno. See (2).</td>
</tr>
<tr>
<td>lgamma lgammaf lgamma1</td>
<td>Sets errno.</td>
</tr>
<tr>
<td>llrint llrintf llrintl</td>
<td>-</td>
</tr>
<tr>
<td>llround llroundf llroundl</td>
<td>Sets errno.</td>
</tr>
<tr>
<td>localeconv</td>
<td>N.A.; skeleton function</td>
</tr>
<tr>
<td>localtime</td>
<td>-</td>
</tr>
<tr>
<td>log logf logl</td>
<td>Sets errno. See (2).</td>
</tr>
<tr>
<td>log10 log10f log10l</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>log1p log1pf log1pl</td>
<td>Sets errno.</td>
</tr>
<tr>
<td>log2 log2f log2l</td>
<td>Sets errno.</td>
</tr>
<tr>
<td>logb logbf logbl</td>
<td>Sets errno.</td>
</tr>
<tr>
<td>longjmp</td>
<td>-</td>
</tr>
<tr>
<td>lrint lrintf lrintl</td>
<td>-</td>
</tr>
<tr>
<td>lround lroundf lroundl</td>
<td>Sets errno.</td>
</tr>
<tr>
<td>lseek</td>
<td>Calls _lseek</td>
</tr>
<tr>
<td>Function</td>
<td>Not reentrant because</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>lstat</td>
<td><em>(Not implemented)</em></td>
</tr>
<tr>
<td>malloc</td>
<td>Requires kernel support. See (5).</td>
</tr>
<tr>
<td>mblen</td>
<td>N.A., skeleton function</td>
</tr>
<tr>
<td>mbrlen</td>
<td>Sets errno.</td>
</tr>
<tr>
<td>mbrtoc16</td>
<td>Sets errno. Uses static internal_state variable.</td>
</tr>
<tr>
<td>mbrtoc32</td>
<td>Sets errno. Uses static internal_state variable.</td>
</tr>
<tr>
<td>mbtowc</td>
<td>Sets errno. Uses static internal_state variable.</td>
</tr>
<tr>
<td>mbsinit</td>
<td>-</td>
</tr>
<tr>
<td>mbsrtowcs</td>
<td>Sets errno.</td>
</tr>
<tr>
<td>mbstowcs</td>
<td>N.A., skeleton function</td>
</tr>
<tr>
<td>mbtowc</td>
<td>N.A., skeleton function</td>
</tr>
<tr>
<td>memchr</td>
<td>-</td>
</tr>
<tr>
<td>wmemchr</td>
<td>-</td>
</tr>
<tr>
<td>memcmp</td>
<td>-</td>
</tr>
<tr>
<td>wmemcmp</td>
<td>-</td>
</tr>
<tr>
<td>memcpy</td>
<td>-</td>
</tr>
<tr>
<td>wmemcpy</td>
<td>-</td>
</tr>
<tr>
<td>memmove</td>
<td>-</td>
</tr>
<tr>
<td>wmemmove</td>
<td>-</td>
</tr>
<tr>
<td>memset</td>
<td>-</td>
</tr>
<tr>
<td>wmemset</td>
<td>-</td>
</tr>
<tr>
<td>mktime</td>
<td>-</td>
</tr>
<tr>
<td>modf</td>
<td>-</td>
</tr>
<tr>
<td>modff</td>
<td>-</td>
</tr>
<tr>
<td>modfl</td>
<td>-</td>
</tr>
<tr>
<td>nan</td>
<td>-</td>
</tr>
<tr>
<td>nanf</td>
<td>-</td>
</tr>
<tr>
<td>nanl</td>
<td>-</td>
</tr>
<tr>
<td>nearbyint</td>
<td>-</td>
</tr>
<tr>
<td>nearbyintf</td>
<td>-</td>
</tr>
<tr>
<td>nearbyintl</td>
<td>-</td>
</tr>
<tr>
<td>nextafter</td>
<td>-</td>
</tr>
<tr>
<td>nextafterf</td>
<td>-</td>
</tr>
<tr>
<td>nextafterl</td>
<td>-</td>
</tr>
<tr>
<td>nexttoward</td>
<td>-</td>
</tr>
<tr>
<td>nexttowardf</td>
<td>-</td>
</tr>
<tr>
<td>nexttowardl</td>
<td>-</td>
</tr>
<tr>
<td>offsetof</td>
<td>-</td>
</tr>
<tr>
<td>open</td>
<td>Calls _open</td>
</tr>
<tr>
<td>perror</td>
<td>Uses errno. See (2)</td>
</tr>
<tr>
<td>pow</td>
<td>Sets errno. See (2)</td>
</tr>
<tr>
<td>powf</td>
<td>-</td>
</tr>
<tr>
<td>powl</td>
<td>-</td>
</tr>
<tr>
<td>printf</td>
<td>Uses iob[]. See (1)</td>
</tr>
<tr>
<td>wprintf</td>
<td>Uses iob[]. See (1)</td>
</tr>
<tr>
<td>putc</td>
<td>Uses iob[]. See (1)</td>
</tr>
<tr>
<td>putwc</td>
<td>Uses iob[]. See (1)</td>
</tr>
<tr>
<td>putchar</td>
<td>Uses iob[]. See (1)</td>
</tr>
<tr>
<td>putwchar</td>
<td>Uses iob[]. See (1)</td>
</tr>
<tr>
<td>puts</td>
<td>-</td>
</tr>
<tr>
<td>qsort</td>
<td>Calls _Exit.</td>
</tr>
<tr>
<td>raise</td>
<td>Updates the signal handler table</td>
</tr>
<tr>
<td>Function</td>
<td>Not reentrant because</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>rand</td>
<td>Uses static variable to remember latest random number. Must diverge from ISO C standard to define reentrant rand. See (4).</td>
</tr>
<tr>
<td>read</td>
<td>Calls _read</td>
</tr>
<tr>
<td>realloc</td>
<td>See malloc (5).</td>
</tr>
<tr>
<td>remainder</td>
<td></td>
</tr>
<tr>
<td>remainderf</td>
<td></td>
</tr>
<tr>
<td>remainderl</td>
<td></td>
</tr>
<tr>
<td>remove</td>
<td>Uses global File System Simulation buffer, _dbg_request</td>
</tr>
<tr>
<td>remquo</td>
<td>-</td>
</tr>
<tr>
<td>remquof</td>
<td>-</td>
</tr>
<tr>
<td>remquol</td>
<td>-</td>
</tr>
<tr>
<td>rename</td>
<td>Uses global File System Simulation buffer, _dbg_request</td>
</tr>
<tr>
<td>rewind</td>
<td>Eventually calls _lseek</td>
</tr>
<tr>
<td>rint</td>
<td>-</td>
</tr>
<tr>
<td>rintf</td>
<td>-</td>
</tr>
<tr>
<td>rintl</td>
<td>-</td>
</tr>
<tr>
<td>round</td>
<td>-</td>
</tr>
<tr>
<td>roundf</td>
<td>-</td>
</tr>
<tr>
<td>roundl</td>
<td>-</td>
</tr>
<tr>
<td>scalbln</td>
<td>-</td>
</tr>
<tr>
<td>scalblnf</td>
<td>-</td>
</tr>
<tr>
<td>scalblnl</td>
<td>-</td>
</tr>
<tr>
<td>scalbn</td>
<td>-</td>
</tr>
<tr>
<td>scalbnf</td>
<td>-</td>
</tr>
<tr>
<td>scalbnl</td>
<td>-</td>
</tr>
<tr>
<td>scanf</td>
<td>Uses iob[ ], calls _doscan. See (1).</td>
</tr>
<tr>
<td>wscanf</td>
<td></td>
</tr>
<tr>
<td>setbuf</td>
<td>Sets iob[ ]. See (1).</td>
</tr>
<tr>
<td>setjmp</td>
<td>-</td>
</tr>
<tr>
<td>setlocale</td>
<td>N.A.; skeleton function</td>
</tr>
<tr>
<td>setvbuf</td>
<td>Sets iob and calls malloc. See (1) / (5).</td>
</tr>
<tr>
<td>signal</td>
<td>Updates the signal handler table</td>
</tr>
<tr>
<td>signbit</td>
<td>-</td>
</tr>
<tr>
<td>sin</td>
<td>-</td>
</tr>
<tr>
<td>sinf</td>
<td>-</td>
</tr>
<tr>
<td>sinl</td>
<td>-</td>
</tr>
<tr>
<td>sinh</td>
<td>-</td>
</tr>
<tr>
<td>sinhf</td>
<td>-</td>
</tr>
<tr>
<td>sinhlf</td>
<td>-</td>
</tr>
<tr>
<td>snprintf</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>swprintf</td>
<td></td>
</tr>
<tr>
<td>sprintf</td>
<td>Sets errno. See (2).</td>
</tr>
<tr>
<td>sqrt</td>
<td>Sets errno. See (2).</td>
</tr>
<tr>
<td>sqrtf</td>
<td>Sets errno. See (2).</td>
</tr>
<tr>
<td>sqrtl</td>
<td>See rand</td>
</tr>
<tr>
<td>srand</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>sscanf</td>
<td>Uses global File System Simulation buffer, _dbg_request</td>
</tr>
<tr>
<td>swscanf</td>
<td></td>
</tr>
<tr>
<td>strcat</td>
<td>-</td>
</tr>
<tr>
<td>wscat</td>
<td>-</td>
</tr>
<tr>
<td>strchr</td>
<td>-</td>
</tr>
<tr>
<td>wcschr</td>
<td>-</td>
</tr>
<tr>
<td>strcmp</td>
<td>-</td>
</tr>
<tr>
<td>wcscmp</td>
<td>-</td>
</tr>
<tr>
<td>strcoll</td>
<td>-</td>
</tr>
<tr>
<td>wscoll</td>
<td>-</td>
</tr>
<tr>
<td>strcpy</td>
<td>-</td>
</tr>
<tr>
<td>wcscpy</td>
<td>-</td>
</tr>
<tr>
<td>strcspn</td>
<td>-</td>
</tr>
<tr>
<td>wcsncspn</td>
<td>-</td>
</tr>
<tr>
<td>strerror</td>
<td>-</td>
</tr>
<tr>
<td>Function</td>
<td>Not reentrant because</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>strftime wcsftime</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>strlen wcslen</td>
<td></td>
</tr>
<tr>
<td>strncat wcsncat</td>
<td></td>
</tr>
<tr>
<td>strncmp wcsncmp</td>
<td></td>
</tr>
<tr>
<td>strncpy wcsncpy</td>
<td></td>
</tr>
<tr>
<td>strpbrk wcspbrk</td>
<td></td>
</tr>
<tr>
<td>strrchr wcsrchr</td>
<td>strrchr saves last position in string in local static variable. This function</td>
</tr>
<tr>
<td>strspn wcsspn</td>
<td>is not reentrant by design. See (4).</td>
</tr>
<tr>
<td>strstr wcstrstr</td>
<td></td>
</tr>
<tr>
<td>strtod wcstod</td>
<td></td>
</tr>
<tr>
<td>strtof wcstof</td>
<td></td>
</tr>
<tr>
<td>strtoimax</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>strtok wcstok</td>
<td>strtok saves last position in string in local static variable. This function</td>
</tr>
<tr>
<td>strtol wcstol</td>
<td>is not reentrant by design. See (4).</td>
</tr>
<tr>
<td>strtold wcstold</td>
<td>Sets errno. See (2).</td>
</tr>
<tr>
<td>strtoull wcstoull</td>
<td>Sets errno. See (2).</td>
</tr>
<tr>
<td>strtoimax</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>strxfrm wcsxfrm</td>
<td></td>
</tr>
<tr>
<td>system</td>
<td>N.A; skeleton function</td>
</tr>
<tr>
<td>tan tanf tanl</td>
<td>Sets errno. See (2).</td>
</tr>
<tr>
<td>tanh tanhf tanhl</td>
<td>Sets errno via call to other functions.</td>
</tr>
<tr>
<td>tgamma tgammaf</td>
<td>Sets errno.</td>
</tr>
<tr>
<td>tgammal</td>
<td>Uses static variable which defines initial start time</td>
</tr>
<tr>
<td>time</td>
<td></td>
</tr>
<tr>
<td>tmpfile</td>
<td>Uses iob[]. See (1).</td>
</tr>
<tr>
<td>tmpnam</td>
<td>Uses local buffer to build filename. Function can be adapted to use user buffer. This makes the function non ISO C. See (4).</td>
</tr>
<tr>
<td>toascii</td>
<td></td>
</tr>
<tr>
<td>tolower</td>
<td></td>
</tr>
<tr>
<td>toupper</td>
<td></td>
</tr>
<tr>
<td>towctrans</td>
<td></td>
</tr>
<tr>
<td>towlower</td>
<td></td>
</tr>
<tr>
<td>towupper</td>
<td></td>
</tr>
<tr>
<td>trunc truncf trunc1</td>
<td></td>
</tr>
</tbody>
</table>
Several functions in the C library are not reentrant due to the following reasons:

- The `iob[]` structure is static. This influences all I/O functions.
- The `ungetc[]` array is static. This array holds the characters (one for each stream) when `ungetc()` is called.
- The variable `errno` is globally defined. Numerous functions read or modify `errno`.
- `_doprint` and `_doscan` use static variables for e.g. character counting in strings.
- Some string functions use locally defined (static) buffers. This is prescribed by ANSI.
- `malloc` uses a static heap space.

The following description discusses these items in more detail. The numbers at the beginning of each paragraph relate to the number references in the table above.

### (1) iob structures

<table>
<thead>
<tr>
<th>Function</th>
<th>Not reentrant because</th>
</tr>
</thead>
<tbody>
<tr>
<td>ungetc ungetwc</td>
<td>Uses static buffer to hold unget characters for each file. Can be moved into iob structure. See (1).</td>
</tr>
<tr>
<td>unlink</td>
<td>Uses global File System Simulation buffer, <code>_dbg_request</code></td>
</tr>
<tr>
<td>printf vfprintf</td>
<td>Uses iob[]. See (1).</td>
</tr>
<tr>
<td>scanf vscanf</td>
<td>Calls <code>_doscan</code></td>
</tr>
<tr>
<td>printf vfprintf</td>
<td>Uses iob[]. See (1).</td>
</tr>
<tr>
<td>scanf vscanf</td>
<td>Calls <code>_doscan</code></td>
</tr>
<tr>
<td>printf vfprintf</td>
<td>Sets <code>errno</code>.</td>
</tr>
<tr>
<td>scanf vscanf</td>
<td>Sets <code>errno</code>.</td>
</tr>
<tr>
<td>wcrtomb</td>
<td>Sets <code>errno</code>. Uses static internal_state variable.</td>
</tr>
<tr>
<td>wcsrtoimbs</td>
<td>Sets <code>errno</code>.</td>
</tr>
<tr>
<td>wcstoimax</td>
<td>Sets <code>errno</code> via calls to other functions.</td>
</tr>
<tr>
<td>wcstombs</td>
<td>N.A.; skeleton function</td>
</tr>
<tr>
<td>wcstoumax</td>
<td>Sets <code>errno</code> via calls to other functions.</td>
</tr>
<tr>
<td>wctob</td>
<td>-</td>
</tr>
<tr>
<td>wctomb</td>
<td>N.A.; skeleton function</td>
</tr>
<tr>
<td>wctrans</td>
<td>-</td>
</tr>
<tr>
<td>wctype</td>
<td>-</td>
</tr>
<tr>
<td>write</td>
<td>Calls <code>_write</code></td>
</tr>
</tbody>
</table>

Table: C library reentrancy

The following description discusses these items in more detail. The numbers at the beginning of each paragraph relate to the number references in the table above.
The I/O part of the C library is not reentrant by design. This is mainly caused by the static declaration of the `iob[]` array. The functions which use elements of this array access these elements via pointers (`FILE *`).

Building a multi-process system that is created in one link-run is hard to do. The C language scoping rules for external variables make it difficult to create a private copy of the `iob[]` array. Currently, the `iob[]` array has external scope. Thus it is visible in every module involved in one link phase. If these modules comprise several tasks (processes) in a system each of which should have its private copy of `iob[]`, it is apparent that the `iob[]` declaration should be changed. This requires adaptation of the library to the multi-tasking environment. The library modules must use a process identification as an index for determining which `iob[]` array to use. Thus the library is suitable for interfacing to that kernel only.

Another approach for the `iob[]` declaration problem is to declare the array static in one of the modules which create a task. Thus there can be more than one `iob[]` array in the system without having conflicts at link time. This brings several restrictions: Only the module that holds the declaration of the static `iob[]` can use the standard file handles `stdin`, `stdout` and `stderr` (which are the first three entries in `iob[]`). Thus all I/O for these three file handles should be located in one module.

(2) errno declaration

Several functions in the C library set the global variable `errno`. After completion of the function the user program may consult this variable to see if some error occurred. Since most of the functions that set `errno` already have a return type (this is the reason for using `errno`) it is not possible to check successful completion via the return type.

The library routines can set `errno` to the values defined in `errno.h`. See the file `errno.h` for more information.

`errno` can be set to ERR_FORMAT by the print and scan functions in the C library if you specify illegal format strings.

`errno` will never be set to ERR_NOLONGLONG or ERR_NOPTR since the C library supports long and pointer conversion routines for input and output.

`errno` can be set to ERANGE by the following functions: `exp()`, `strtol()`, `strtoul()` and `tan()`. These functions may produce results that are out of the valid range for the return type. If so, the result of the function will be the largest representable value for that type and `errno` is set to ERANGE.

`errno` is set to EDOM by the following functions: `acos()`, `asin()`, `log()`, `pow()` and `sqrt()`. If the arguments for these functions are out of their valid range ( e.g. `sqrt(-1)`), `errno` is set to EDOM.

`errno` can be set to ERR_POS by the file positioning functions `ftell()`, `fsetpos()` and `fgetpos()`.

(3) ungetc

Currently the ungetc buffer is static. For each file entry in the `iob[]` structure array, there is one character available in the buffer to unget a character.

(4) local buffers
tmpnam() creates a temporary filename and returns a pointer to a local static buffer. This is according to the ANSI definition. Changing this function such that it creates the name in a user specified buffer requires another calling interface. Thus the function would be no longer portable.

strtok() scans through a string and remembers that the string and the position in the string for subsequent calls. This function is not reentrant by design. Making it reentrant requires support of a kernel to store the information on a per process basis.

rand() generates a sequence of random numbers. The function uses the value returned by a previous call to generate the next value in the sequence. This function can be made reentrant by specifying the previous random value as one of the arguments. However, then it is no longer a standard function.

(5) malloc

Malloc uses a heap space which is assigned at locate time. Thus this implementation is not reentrant. Making a reentrant malloc requires some sort of system call to obtain free memory space on a per process basis. This is not easy to solve within the current context of the library. This requires adaptation to a kernel.

This paragraph on reentrancy applies to multi-process environments only. If reentrancy is required for calling library functions from an exception handler, another approach is required. For such a situation it is of no use to allocate e.g. multiple iob[] structures. In such a situation several pieces of code in the library have to be declared 'atomic': this means that interrupts have to be disabled while executing an atomic piece of code.

The default exception handler (exception_handler) delivered in the floating-point run-time library in except.c is not reentrant, because it uses global variables for the custom handler and status.
Chapter 11. List File Formats

This chapter describes the format of the assembler list file and the linker map file.

11.1. Assembler List File Format

The assembler list file is an additional output file of the assembler that contains information about the generated code. For details on how to generate a list file, see Section 4.5, Generating a List File.

The list file consists of a page header and a source listing.

Page header

The page header is repeated on every page:

```
TASKING VX-toolset for PCP: PCP assembler vx.yrz Build yymmddqq
Title                                                           Page 1

ADDR CODE      CYCLES  LINE SOURCE LINE
```

The first line contains version information. The second line can contain a title which you can specify with the assembler control $TITLE and always contains a page number. The third line is empty and the fourth line contains the headings of the columns for the source listing.

With the assembler controls $LIST ON/OFF, $PAGE, and with the assembler option --list-format you can format the list file.

Source listing

The following is a sample part of a listing. An explanation of the different columns follows below.

```
ADDR CODE      CYCLES  LINE SOURCE LINE
1      ; Module start
.
.
0003 93C0rrrr            27         ldl.il  r7,@DPTR(_PCP_world)
0005 53rr                28         ld.pi   r5,_PCP_world
0006 93C0rrrr            29         ldl.il  r7,@DPTR(_PCP__data__printf)
0008 55rr                30         st.pi   r5,_PCP__data__printf
.
.
0000                     44 buf:    .space  4
|  RESERVED
0003
```
This column contains the memory address. The address is a hexadecimal number that represents the offset from the beginning of a relocatable section or the absolute address for an absolute section. The address only appears on lines that generate object code.

This is the object code generated by the assembler for this source line, displayed in hexadecimal format. The displayed code need not be the same as the generated code that is entered in the object module. The code can also be relocatable code. In this case the letter 'r' is printed for the relocatable code part in the listing. For lines that allocate space, the code field contains the text "RESERVED". For lines that initialize a buffer, the code field lists one value followed by the word "REPEATS".

The first number in this column is the number of instruction cycles needed to execute the instruction(s) as generated in the CODE field. The second number is the accumulated cycle count of this section.

This column contains the line number. This is a decimal number indicating each input line, starting from 1 and incrementing with each source line.

This column contains the source text. This is a copy of the source line from the assembly source file.

For the .SET and .EQU directives the ADDR and CODE columns do not apply. The symbol value is listed instead.

11.2. Linker Map File Format

The linker map file is an additional output file of the linker that shows how the linker has mapped the sections and symbols from the various object files (.o) to output sections. Locate information is not present, because that is not available for a PCP project. External symbols are listed per space with their absolute address, both sorted on symbol and sorted on address. For details on how to generate a map file, see Section 5.9, Generating a Map File.

With the linker option --map-file-format you can specify which parts of the map file you want to see.

In Eclipse the linker map file (project.mapxml) is generated in the output directory of the build configuration, usually Debug or Release. You can open the map file by double-clicking on the file name.
Each page displays a part of the map file. You can use the drop-down list or the Outline view to navigate through the different tables and you can use the following buttons.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Back</td>
<td>Goes back one page in the history list.</td>
</tr>
<tr>
<td></td>
<td>Forward</td>
<td>Goes forward one page in the history list.</td>
</tr>
<tr>
<td></td>
<td>Next Table</td>
<td>Shows the next table from the drop-down list.</td>
</tr>
<tr>
<td></td>
<td>Previous Table</td>
<td>Shows the previous table from the drop-down list.</td>
</tr>
</tbody>
</table>

When you right-click in the view, a popup menu appears (for example, to reset the layout of a table). The meaning of the different parts is:

**Tool and Invocation**

This part of the map file contains information about the linker, its version header information, binary location and which options are used to call it.

**Processed Files**

This part of the map file shows all processed files. This also includes object files that are extracted from a library, with the symbol that led to the extraction. This part is not available when you use MIL linking (control program option --mil-link).

**Link Result**

This part of the map file shows per object file how the link phase has mapped the sections from the various object files (.o) to output sections.

<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>[in] Section</td>
<td>A section name and id from the input object file. The number between '()' uniquely identifies the section.</td>
</tr>
</tbody>
</table>
Module Local Symbols

This part of the map file shows a table for each local scope within an object file. Each table has three columns, 1 the symbol name, 2 the address of the symbol and 3 the space where the symbol resides in. The table is sorted on symbol name within each space.

By default this part is not shown in the map file. You have to turn this part on manually with linker option --map-file-format=+statics (module local symbols).

Cross References

This part of the map file lists all symbols defined in the object modules and for each symbol the object modules that contain a reference to the symbol are shown. Also, symbols that remain undefined are shown. This part is not available when you use MIL linking (control program option --mil-link).

Call Graph

This part of the map file contains a schematic overview that shows how (library) functions call each other. To obtain call graph information, the assembly file must contain .CALLS directives.

The following example is a part of a call graph in the textual version of the map file (.map):

```plaintext
_PCPI__ROOT__ [0, 0]

|-- _PCPI__cstart [0, 0]

| |-- hellopcp.src:_PCPI__cocofun_4 *

| |-- _PCPI_main [0, 0]

|     |-- _PCPI_printf [0, 0]

|         |-- hellopcp.src:_PCPI__cocofun_4 *

|         |-- hellopcp.src:_PCPI__cocofun_3 *

|         |-- hellopcp.src:_PCPI__cocofun_6 [0, 0]

|         |-- hellopcp.src:_PCPI__cocofun_5 [0, 0]

|         |-- hellopcp.src:_PCPI__cocofun_2 [0, 0]

|         |-- _PCPI__fflush *
```
A * after a function name indicates that the call tree starting with this function is shown separately, with a * in front of the function name.

A * in front of a function name indicates that the function is not considered a "root" in the call graph since it is called by one or more other functions.

An additional R (not shown in this example) indicates this function is part of a recursive call chain. If both a leaf and the root of a tree are marked this way, all nodes in between are in a recursive chain.

An '__INDIRECT__' entry (not shown in this example) indicates an indirect function call. It is not an actual function. Each function listed as a caller of the __INDIRECT__ placeholder symbol places a call through a function pointer. Each function listed as a callee of the __INDIRECT__ placeholder symbol has its address taken (and used).

[ ] after a function contains information about the stack usage. The first field is the amount of stack used by the function and the second field is the amount of stack used by the function including its callees.

In the graphical version of the map file, you can expand or collapse a single node. Use the buttons to expand/collapse all nodes in the call graph. Hover the mouse over a function (root, callee or node) to see information about the stack usage.
<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="root icon" /></td>
<td>Root</td>
<td>This function is the top of the call graph. If there are interrupt handlers, there can be several roots.</td>
</tr>
<tr>
<td><img src="image" alt="callee icon" /></td>
<td>Callee</td>
<td>This function is referenced by several No leaf functions. Right-click on the function and select <strong>Expand all References</strong> to see all functions that reference this function. Select <strong>Back to Caller</strong> to return to the calling function.</td>
</tr>
<tr>
<td><img src="image" alt="node icon" /></td>
<td>Node</td>
<td>A normal node (function) in the call graph.</td>
</tr>
<tr>
<td><img src="image" alt="caller icon" /></td>
<td>Caller</td>
<td>This function calls a function which is listed separately in the call graph. Right-click on the function and select <strong>Go to Callee</strong> to see the callee. Hover the mouse over the function to see a popup with all callees.</td>
</tr>
</tbody>
</table>

**Overlay**

This part of the map file shows how the stack is organized. This part also shows the locate overlay information if you used overlay groups in the linker script file.

**Processor and Memory**

This part of the map file shows the processor and memory information of the linker script file.

By default this part is not shown in the map file. You have to turn this part on manually with linker option `--map-file-format=+lsl` (processor and memory info). You can print this information to a separate file with linker option `--lsl-dump`.

You can expand or collapse a part of the information.

**Removed Sections**

This part of the map file shows the sections which are removed from the output file as a result of the optimization option to delete unreferenced sections and or duplicate code or constant data (linker option `--optimize=cxy`).

<table>
<thead>
<tr>
<th>Section</th>
<th>The name of the section which has been removed.</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>The name of the input object file where the section is removed from.</td>
</tr>
<tr>
<td>Library</td>
<td>The name of the library where the object file is part of.</td>
</tr>
<tr>
<td>Symbol</td>
<td>The symbols that were present in the section.</td>
</tr>
<tr>
<td>Reason</td>
<td>The reason why the section has been removed. This can be because the section is unreferenced or duplicated.</td>
</tr>
</tbody>
</table>
Chapter 12. Linker Script Language (LSL)

To make full use of the linker, you can write a script with information about the architecture of the target processor and locating information. The language for the script is called the Linker Script Language (LSL). This chapter first describes the structure of an LSL file. The next section contains a summary of the LSL syntax. In the remaining sections, the semantics of the Linker Script Language is explained.

The TASKING linker is a target independent linker/locator that can simultaneously link and locate all programs for all cores available on a target board. The target board may be of arbitrary complexity. A simple target board may contain one standard processor with some external memory that executes one task. A complex target board may contain multiple standard processors and DSPs combined with configurable IP-cores loaded in an FPGA. Each core may execute a different program, and external memory may be shared by multiple cores.

LSL serves two purposes. First it enables you to specify the characteristics (that are of interest to the linker) of your specific target board and of the cores installed on the board. Second it enables you to specify how sections should be located in memory.

12.1. Structure of a Linker Script File

A script file consists of several definitions. The definitions can appear in any order.

The architecture definition (required)

In essence an architecture definition describes how the linker should convert logical addresses into physical addresses for a given type of core. If the core supports multiple address spaces, then for each space the linker must know how to perform this conversion. In this context a physical address is an offset on a given internal or external bus. Additionally the architecture definition contains information about items such as the (hardware) stack and the interrupt vector table.

This specification is normally written by Altium. Altium supplies LSL files in the include.lsl directory. The architecture definition of the LSL file should not be changed by you unless you also modify the core's hardware architecture. If the LSL file describes a multi-core system an architecture definition must be available for each different type of core.

See Section 12.4, Semantics of the Architecture Definition for detailed descriptions of LSL in the architecture definition.

The derivative definition

The derivative definition describes the configuration of the internal (on-chip) bus and memory system. Basically it tells the linker how to convert offsets on the buses specified in the architecture definition into offsets in internal memory. Microcontrollers and DSPs often have internal memory and I/O sub-systems apart from one or more cores. The design of such a chip is called a derivative.

Altium provides LSL descriptions of supported derivatives, along with "SFR files", which provide easy access to registers in I/O sub-systems from C and assembly programs. When you build an ASIC or use a derivative that is not (yet) supported by the TASKING tools, you may have to write a derivative definition.
When you want to use multiple cores of the same type, you must instantiate the cores in a derivative definition, since the linker automatically instantiates only a single core for an unused architecture.

See Section 12.5, Semantics of the Derivative Definition for a detailed description of LSL in the derivative definition.

**The processor definition**

The processor definition describes an instance of a derivative. Typically the processor definition instantiates one derivative only (single-core processor). A processor that contains multiple cores having the same (homogeneous) or different (heterogeneous) architecture can also be described by instantiating multiple derivatives of the same or different types in separate processor definitions.

See Section 12.6, Semantics of the Board Specification for a detailed description of LSL in the processor definition.

**The memory and bus definitions (optional)**

Memory and bus definitions are used within the context of a derivative definition to specify internal memory and on-chip buses. In the context of a board specification the memory and bus definitions are used to define external (off-chip) memory and buses. Given the above definitions the linker can convert a logical address into an offset into an on-chip or off-chip memory device.

See Section 12.6.3, Defining External Memory and Buses, for more information on how to specify the external physical memory layout. Internal memory for a processor should be defined in the derivative definition for that processor.

**The board specification**

The processor definition and memory and bus definitions together form a board specification. LSL provides language constructs to easily describe single-core and heterogeneous or homogeneous multi-core systems. The board specification describes all characteristics of your target board's system buses, memory devices, I/O sub-systems, and cores that are of interest to the linker. Based on the information provided in the board specification the linker can for each core:

- convert a logical address to an offset within a memory device
- locate sections in physical memory
- maintain an overall view of the used and free physical memory within the whole system while locating

**The section layout definition (optional)**

The optional section layout definition enables you to exactly control where input sections are located. Features are provided such as: the ability to place sections at a given load-address or run-time address, to place sections in a given order, and to overlay code and/or data sections.

Which object files (sections) constitute the task that will run on a given core is specified on the command line when you invoke the linker. The linker will link and locate all sections of all tasks simultaneously. From the section layout definition the linker can deduce where a given section may be located in memory,
form the board specification the linker can deduce which physical memory is (still) available while locating the section.

See Section 12.8, *Semantics of the Section Layout Definition*, for more information on how to locate a section at a specific place in memory.

**Skeleton of a Linker Script File**

```plaintext
architecture architecture_name
{
    // Specification core architecture
}

derivative derivative_name
{
    // Derivative definition
}

processor processor_name
{
    // Processor definition
}

memory and/or bus definitions

section_layout space_name
{
    // section placement statements
}
```

**12.2. Syntax of the Linker Script Language**

This section describes what the LSL language looks like. An LSL document is stored as a file coded in UTF-8 with extension `.lsl`. Before processing an LSL file, the linker preprocesses it using a standard C preprocessor. Following this, the linker interprets the LSL file using a scanner and parser. Finally, the linker uses the information found in the LSL file to guide the locating process.

**12.2.1. Preprocessing**

When the linker loads an LSL file, the linker first processes it with a C-style preprocessor. As such, it strips C and C++ comments. Lines starting with the `#` character are taken as commands for the preprocessor. You can use the standard ISO C99 preprocessor directives, including:

```plaintext
#include "file"
#include <file>
```

Preprocess and include file `file` at this point in the LSL file.

For example:
Preprocess and include the file arch.lsl at this point in the LSL file.

#if condition
#else
#endif

If the condition evaluates to a non-zero value, copy the following lines, up to an #else or #endif command, skip lines between #else and #endif, if present. If the condition evaluates to zero, skip the lines up to the #else command, or #endif if no #else is present, and copy the lines between the #else and #endif commands.

#include "arch.lsl"

#ifdef identifier
#else
#endif

Same as #if, but with defined(identifier) as condition.

#error text

Causes a fatal error the given message (optional).

12.2.2. Lexical Syntax

The following lexicon is used to describe the syntax of the Linker Script Language:

A ::= B = A is defined as B

A ::= B C = A is defined as B and C; B is followed by C

A ::= B | C = A is defined as B or C

<B>^0|1 = zero or one occurrence of B

<B>^0>=0 = zero of more occurrences of B

<B>^0>=1 = one of more occurrences of B

IDENTIFIER = a character sequence starting with 'a'-'z', 'A'-'Z' or '_'. Following characters may also be digits and dots '.'

STRING = sequence of characters not starting with \n, \r or \t

DQSTRING = " STRING " (double quoted string)

OCT_NUM = octal number, starting with a zero (06, 045)

DEC_NUM = decimal number, not starting with a zero (14, 1024)
HEX_NUM = hexadecimal number, starting with '0x' (0x0023, 0xFF00)

OCT_NUM, DEC_NUM and HEX_NUM can be followed by a k (kilo), M (mega), or G (giga).

Characters in **bold** are characters that occur literally. Words in *italics* are higher order terms that are defined in the same or in one of the other sections.

To write comments in LSL file, you can use the C style '/* */' or C++ style '//'.

### 12.2.3. Identifiers and Tags

<table>
<thead>
<tr>
<th>Identifier</th>
<th>:==</th>
<th>(\text{IDENTIFIER})</th>
</tr>
</thead>
<tbody>
<tr>
<td>arch_name</td>
<td></td>
<td>(\text{IDENTIFIER})</td>
</tr>
<tr>
<td>bus_name</td>
<td></td>
<td>(\text{IDENTIFIER})</td>
</tr>
<tr>
<td>core_name</td>
<td></td>
<td>(\text{IDENTIFIER})</td>
</tr>
<tr>
<td>derivative_name</td>
<td></td>
<td>(\text{IDENTIFIER})</td>
</tr>
<tr>
<td>file_name</td>
<td></td>
<td>(\text{DQSTRING})</td>
</tr>
<tr>
<td>group_name</td>
<td></td>
<td>(\text{IDENTIFIER})</td>
</tr>
<tr>
<td>heap_name</td>
<td></td>
<td>(\text{section_name})</td>
</tr>
<tr>
<td>map_name</td>
<td></td>
<td>(\text{IDENTIFIER})</td>
</tr>
<tr>
<td>mem_name</td>
<td></td>
<td>(\text{IDENTIFIER})</td>
</tr>
<tr>
<td>proc_name</td>
<td></td>
<td>(\text{IDENTIFIER})</td>
</tr>
<tr>
<td>section_name</td>
<td></td>
<td>(\text{DQSTRING})</td>
</tr>
<tr>
<td>space_name</td>
<td></td>
<td>(\text{IDENTIFIER})</td>
</tr>
<tr>
<td>stack_name</td>
<td></td>
<td>(\text{section_name})</td>
</tr>
<tr>
<td>symbol_name</td>
<td></td>
<td>(\text{DQSTRING})</td>
</tr>
<tr>
<td>tag_attr</td>
<td></td>
<td>((\text{tag}, \text{tag})^0)</td>
</tr>
<tr>
<td>tag</td>
<td>:==</td>
<td>(\text{tag} = \text{DQSTRING})</td>
</tr>
</tbody>
</table>

A tag is an arbitrary text that can be added to a statement.

### 12.2.4. Expressions

The expressions and operators in this section work the same as in ISO C.

<table>
<thead>
<tr>
<th>Number</th>
<th>:==</th>
<th>(\text{OCT_NUM})</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>(\text{DEC_NUM})</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(\text{HEX_NUM})</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Expression</th>
<th>:==</th>
<th>(\text{number})</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>(\text{symbol_name})</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(\text{unary_op expr})</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(\text{expr binary_op expr})</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(\text{expr ? expr : expr})</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(\text{( expr )})</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(\text{function_call})</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Unary Op</th>
<th>:==</th>
<th>(\text{!} \quad \text{logical NOT})</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>(\text{~} \quad \text{bitwise complement})</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(\text{-} \quad \text{negative value})</td>
</tr>
</tbody>
</table>
### 12.2.5. Built-in Functions

- The `function_call` ::= 
  - `absolute ( expr )`
  - `addressof ( addr_id )`
  - `checksum ( checksum_algo, expr, expr )`
  - `exists ( section_name )`
  - `max ( expr, expr )`
  - `min ( expr, expr )`
  - `sizeof ( size_id )`

- The `addr_id` ::= 
  - `sect : section_name`
  - `group : group_name`
  - `mem : mem_name`

- The `checksum_algo` ::= `crc32w`

- The `size_id` ::= 
  - `sect : section_name`
  - `group : group_name`
  - `mem : mem_name`

- Every space, bus, memory, section or group you refer to, must be defined in the LSL file.

- The `addressof()` and `sizeof()` functions with the `group` or `sect` argument can only be used in the right hand side of an assignment. The `sizeof()` function with the `mem` argument can be used anywhere in section layouts.

- The `checksum()` function can only be used in a `struct` statement.

You can use the following built-in functions in expressions. All functions return a numerical value. This value is a 64-bit signed integer.
absolute()

```markdown
int absolute( expr )
```

Converts the value of `expr` to a positive integer.

```markdown
absolute( "labelA"-"labelB" )
```

addressof()

```markdown
int addressof( addr_id )
```

Returns the offset of `addr_id`, which is a named section, group, or memory in the address space of the section layout. If the referenced object is a group or memory, it must be defined in the LSL file. To get the offset of the section with the name `asect`:

```markdown
addressof( sect: "asect")
```

This function only works in assignments and `struct` statements.

checksum()

```markdown
int checksum( checksum_algo, expr, expr )
```

Returns the computed checksum over a contiguous address range. The first argument specifies how the checksum must be computed (see below), the second argument is an expression that represents the start address of the range, while the third argument represents the end address (exclusive). The value of the end address expression must be strictly larger than the value of the start address (i.e. the size of the checksum address range must be at least one MAU). Each address in the range must point to a valid memory location. Memory locations in the address range that are not occupied by a section are filled with zeros.

The only checksum algorithm (`checksum_algo`) currently supported is `crc32w`. This algorithm computes the checksum using a Cyclic Redundancy Check with the "CRC-32" polynomial 0xEDB88320. The input range is processed per 4-byte word. Those 4 bytes are passed to the checksum algorithm in reverse order if the target architecture is little-endian. For big-endian targets, this checksum algorithm is equal to a regular byte-wise CRC-32 implementation. Both the start address and end address values must be aligned on 4 MAUs. The behavior of this checksum algorithm is undefined when used in an address space that has a MAU size not equal to 8.

```markdown
checksum( crc32w,
         addressof( mem:foo ),
         addressof( mem:foo ) + sizeof( mem:foo ) )
```

This function only works in `struct` statements.

exists()

```markdown
int exists( section_name )
```
The function returns 1 if the section `section_name` exists in one or more object file, 0 otherwise. If the section is not present in input object files, but generated from LSL, the result of this function is undefined.

To check whether the section `mysection` exists in one of the object files that is specified to the linker:

```c
exists( "mysection" )
```

```c
max()
```

```c
int max( expr, expr )
```

Returns the value of the expression that has the largest value. To get the highest value of two symbols:

```c
max( "sym1" , "sym2")
```

```c
min()
```

```c
int min( expr, expr )
```

Returns the value of the expression hat has the smallest value. To get the lowest value of two symbols:

```c
min( "sym1" , "sym2")
```

```c
sizeof()
```

```c
int sizeof( size_id )
```

Returns the size of the object (group, section or memory) the identifier refers to. To get the size of the section "asection":

```c
sizeof( sect: "asection" )
```

The `group` and `sect` arguments only works in assignments and `struct` statements. The `mem` argument can be used anywhere in section layouts. If the referenced object is a group or memory, it must be defined in the LSL file.

### 12.2.6. LSL Definitions in the Linker Script File

```lan
description ::= <definition>*

definition ::= architecture_definition
| derivative_definition
| board_spec
| section_definition
| section_setup
```

- At least one `architecture_definition` must be present in the LSL file.
12.2.7. Memory and Bus Definitions

\[
\text{mem\_def} ::= \text{memory} \ \text{mem\_name} <\text{tag\_attr}>^{0|1} \{ <\text{mem\_descr} ;>^{>0} \}
\]

- A `mem\_def` defines a memory with the `mem\_name` as a unique name.

\[
\text{mem\_descr} ::= \text{type} = <\text{reserved}>^{0|1} \ \text{mem\_type} \\
\phantom{\text{mem\_descr}} | \text{mau} = \text{expr} \\
\phantom{\text{mem\_descr}} | \text{size} = \text{expr} \\
\phantom{\text{mem\_descr}} | \text{speed} = \text{number} \\
\phantom{\text{mem\_descr}} | \text{priority} = \text{number} \\
\phantom{\text{mem\_descr}} | \text{exec\_priority} = \text{number} \\
\phantom{\text{mem\_descr}} | \text{fill} = \text{fill\_values}^{0|1} \\
\phantom{\text{mem\_descr}} | \text{write\_unit} = \text{expr} \\
\phantom{\text{mem\_descr}} | \text{mapping}
\]

- A `mem\_def` contains exactly one `type` statement.

- A `mem\_def` contains exactly one `mau` statement (non-zero size).

- A `mem\_def` contains exactly one `size` statement.

- A `mem\_def` contains zero or one `priority` (or `speed`) statement (if absent, the default value is 1).

- A `mem\_def` contains zero or one `exec\_priority` statement.

- A `mem\_def` contains zero or one `fill` statement.

- A `mem\_def` contains zero or one `write\_unit` statement.

- A `mem\_def` contains at least one `mapping`

\[
\text{mem\_type} ::= \text{rom} \ // \text{attrs} = \text{rx} \\
\phantom{\text{mem\_type}} | \text{ram} \ // \text{attrs} = \text{rw} \\
\phantom{\text{mem\_type}} | \text{nvram} \ // \text{attrs} = \text{rwx} \\
\phantom{\text{mem\_type}} | \text{blockram}
\]

\[
\text{fill\_values} ::= \text{expr} \\
\phantom{\text{fill\_values}} | [ \text{expr} <, \text{expr}>^{>0} ]
\]

\[
\text{bus\_def} ::= \text{bus} \ \text{bus\_name} \{ <\text{bus\_descr} ;>^{>0} \}
\]

- A `bus\_def` statement defines a bus with the given `bus\_name` as a unique name within a core architecture.

\[
\text{bus\_descr} ::= \text{mau} = \text{expr} \\
\phantom{\text{bus\_descr}} | \text{width} = \text{expr} \ // \text{bus width, nr} \\
\phantom{\text{bus\_descr}} | \ // \text{of data bits} \\
\phantom{\text{bus\_descr}} | \text{mapping} \ // \text{legal destination} \\
\phantom{\text{bus\_descr}} | \ // 'bus' only
\]
• The **mau** and **width** statements appear exactly once in a `bus_descr`. The default value for **width** is the **mau** size.

• The bus width must be an integer times the bus MAU size.

• The MAU size must be non-zero.

• A bus can only have a `mapping` on a destination bus (through `dest = bus:`).

```plaintext
mapping ::= map <map_name>0|1 ( map_descr <, map_descr>^=0 )

map_descr ::= dest = destination
             | dest_dbits = range
             | dest_offset = expr
             | size = expr
             | src_dbits = range
             | src_offset = expr
             | reserved
             | priority = number
             | exec_priority = number
             | tag
```

• A `map_descr` requires at least the `size` and `dest` statements.

• A `map_descr` contains zero or one `priority` statement (if absent, the default value is 0).

• A `map_descr` contains zero or one `exec_priority` statement.

• Each `map_descr` can occur only once.

• You can define multiple mappings from a single source.

• Overlap between source ranges or destination ranges is not allowed.

• If the `src_dbits` or `dest_dbits` statement is not present, its value defaults to the `width` value if the source/destination is a bus, and to the **mau** size otherwise.

• The `reserved` statement is allowed only in mappings defined for a memory.

```plaintext
destination ::= space : space_name
               | bus : <proc_name | core_name : >0|1 bus_name
```

• A `space_name` refers to a defined address space.

• A `proc_name` refers to a defined processor.

• A `core_name` refers to a defined core.

• A `bus_name` refers to a defined bus.

• The following mappings are allowed (source to destination)
• space => space
• space => bus
• bus => bus
• memory => bus

range ::= expr .. expr

• With address ranges, the end address is not part of the range.

12.2.8. Architecture Definition

architecture_definition ::= architecture arch_name
                             <( parameter_list )>0|1
                             <extends arch_name
                             <( argument_list )>0|1 >0|1
                             { <arch_spec>='0 }

• An architecture_definition defines a core architecture with the given arch_name as a unique name.

• At least one space_def and at least one bus_def have to be present in an architecture_definition.

• An architecture_definition that uses the extends construct defines an architecture that inherits all elements of the architecture defined by the second arch_name. The parent architecture must be defined in the LSL file as well.

parameter_list ::= parameter <, parameter>='0

parameter ::= IDENTIFIER <= expr>0|1

argument_list ::= expr <, expr>'='0

arch_spec ::= bus_def
                    | space_def
                    | endianness_def

space_def ::= space space_name <tag_attr>0|1 { <space_descr;>='0 }

• A space_def defines an address space with the given space_name as a unique name within an architecture.

space_descr ::= space_property ;
                    | section_definition  //no space ref
                    | reserved_range

space_property ::= id = number // as used in object
                      | mau = expr
                      | align = expr
• A \texttt{space_def} contains exactly one \texttt{id} and one \texttt{mau} statement.

• A \texttt{space_def} contains at most one \texttt{align} statement.

• A \texttt{space_def} contains at most one \texttt{page_size} statement.

• A \texttt{space_def} contains at least one \texttt{mapping}.

\begin{verbatim}
stack_def ::= stack stack_name ( stack_descr
                          <, stack_descr >=0 )

heap_def ::= heap heap_name ( heap_descr
                           <, heap_descr >=0 )
\end{verbatim}

• A \texttt{stack_def} defines a stack with the \texttt{stack_name} as a unique name.

\begin{verbatim}
stack_descr ::= min_size = expr
             | grows = direction
             | align = expr
             | fixed
             | entry_points = entry_point_list
             | attributes
             | tag

entry_point_list ::= symbol_name
                    | [ symbol_name <, symbol_name >=0 ]
\end{verbatim}

• The \texttt{min_size} statement must be present.

• The \texttt{min_size} value must be 1 or greater.

• You can specify at most one \texttt{align} statement and one \texttt{grows} statement.

• Each stack definition can have one or more \texttt{entry_points} statements for stack estimation. The \texttt{symbol_name} corresponds to the caller name in the \texttt{.CALLS} directive as generated by the compiler.
• The `min_size` statement must be present.

• The `min_size` value must be 1 or greater.

• You can specify at most one `align` statement and one `grows` statement.

\[\text{direction} ::= \text{low_to_high} \mid \text{high_to_low}\]

• If you do not specify the `grows` statement, the stack and heap grow `low-to-high`.

\[\text{copy_table_def} ::= \text{copytable} <( \text{copy_table_descr} <, \text{copy_table_descr} >)^01 >^01\]

• A `space_def` contains at most one `copytable` statement.

• Exactly one copy table must be defined in one of the spaces.

\[\text{copy_table_descr} ::= \text{align} = \text{expr} \mid \text{copy_unit} = \text{expr} \mid \text{dest} <\text{space_name}>^01 = \text{space_name} \mid \text{page} \mid \text{table} \{ <\text{subtable_descr}; >^0 \} \mid \text{tag}\]

\[\text{subtable_descr} ::= \text{symbol} = \text{symbol_name} \mid \text{space} = \text{subtable_space_ref}\]

\[\text{subtable_space_ref} ::= <\text{processor_name}>^01 : <\text{core_name}>^01 : \text{space_name}\]

• The `copy_unit` is defined by the size in MAUs in which the startup code moves data.

• The `dest` statement is only required when the startup code initializes memory used by another processor that has no access to ROM.

• A `space_name` refers to a defined address space.

\[\text{start_addr} ::= \text{start_address} ( \text{start_addr_descr} <, \text{start_addr_descr}>^0 )\]

\[\text{start_addr_descr} ::= \text{run_addr} = \text{expr} \mid \text{symbol} = \text{symbol_name}\]

• A `symbol_name` refers to the section that contains the startup code.

\[\text{reserved_range} ::= \text{reserved} <\text{tag_attr}>^01 \text{ expr} .. \text{ expr}\]

• The end address is not part of the range.
**12.2.9. Derivative Definition**

A derivative definition defines a derivative with the given derivative_name as a unique name. A core_def defines a core with the given core_name as a unique name. At least one core_def must be present in a derivative_definition.

- An architecture refers to a defined core architecture.
- Exactly one architecture statement must be present in a core_def.
- Exactly one copytable_space statement must be present in a core_def, or in exactly one space in that core, a copytable statement must be present.

**12.2.10. Processor Definition and Board Specification**

A board_spec defines a processor with the given proc_name as a unique name.
A `proc_def` defines a processor with the `proc_name` as a unique name.

If you do not explicitly define a processor for a derivative in an LSL file, the linker defines a processor with the same name as that derivative.

A `derivative_name` refers to a defined derivative.

A `proc_def` contains exactly one `derivative` statement.

### 12.2.11. Section Setup

A `section_setup` contains exactly one `section_setup_item` statement.

### 12.2.12. Section Layout Definition

A section definition inside a space definition does not have a `space_ref`.

All global section definitions have a `space_ref`.
If more than one processor is present, the proc_name must be given for a global section layout.

If the section layout refers to a processor that has more than one core, the core_name must be given in the space_ref.

A proc_name refers to a defined processor.

A core_name refers to a defined core.

A space_name refers to a defined address space.

A section layout contains at most one direction statement.

If you do not specify the direction statement, the locate direction of the section layout is low-to-high.

Either a section_name or at least one section_selection must be defined.
section_selections ::= ( section_selection
   <, section_selection>^0 )

section_selection ::= attributes = < <+|-> attribute>^0
   | tag

• +attribute means: select all sections that have this attribute.
• -attribute means: select all sections that do not have this attribute.

special_section_statement ::= heap heap_name <stack_heap_mods>^0|1
   | stack stack_name <stack_heap_mods>^0|1
   | copytable
   | reserved section_name <reserved_specs>^0|1

• Special sections cannot be selected in load-time groups.

stack_heap_mods ::= ( stack_heap_mod <, stack_heap_mod>^0 )

stack_heap_mod ::= size = expr
   | tag

reserved_specs ::= ( reserved_spec <, reserved_spec>^0 )

reserved_spec ::= attributes
   | fill_spec
   | size = expr
   | alloc_allowed = absolute | ranged

• If a reserved section has attributes r, rw, x, rx or rwx, and no fill pattern is defined, the section is filled with zeros. If no attributes are set, the section is created as a scratch section (attributes ws, no image).

memcpy_statement ::= memcpy section_name
   ( memcpy_spec <, memcpy_spec>^0|1 )

memcpy_spec ::= memory = memory_reference
   | fill_spec

• A memcpy statement must contain exactly one memory statement.
• A memcpy statement can contain at most one fillspec.

fill_spec ::= fill = fill_values

fill_values ::= expr
   | [ expr <, expr>^0 ]
aggregate_section_statement  
::= \{ <section_statement>^0 \}  
|  
group_descr  
|  
if_statement  
|  
section_creation_statement  
|  
struct_statement  


group_descr  ::=  group <group_name>0|1 <( group_specs )>0|1  

section_statement  
• For every group with a name, the linker defines a label.

• No two groups for address spaces of a core can have the same group_name.


group_specs  ::=  group_spec <, group_spec >=0  

group_spec  ::=  group_alignment  
|  
attributes  
|  
copy  
|  
nocopy  
|  
group_load_address  
|  
fill <= fill_values>0|1  
|  
group_page  
|  
group_run_address  
|  
group_type  
|  
allow_cross_references  
|  
priority = number  
|  
tag 


• The allow-cross-references property is only allowed for overlay groups.

• The copy and nocopy properties cannot be applied both to the same group.

• Sub groups inherit all properties from a parent group.


group_alignment  ::=  align = expr  

attributes  ::=  attributes = <attribute>^1

attribute  ::=  r // readable sections  
|  
w // writable sections  
|  
x // executable code sections  
|  
i // initialized sections  
|  
s // scratch sections  
|  
b // blanked (cleared) sections  
|  
p // protected sections


group_load_address  ::=  load_addr <= load_or_run_addr>0|1

group_page  ::=  page <= expr>0|1  
|  
page_size = expr [< range ] < | [ range ]>^0>0|1
**Linker Script Language (LSL)**

\[
\text{group_run_address} ::= \text{run_addr} \leq \text{load_or_run_addr}^{0\mid 1}
\]

\[
\text{group_type} ::= \text{clustered} \\
\quad | \quad \text{contiguous} \\
\quad | \quad \text{ordered} \\
\quad | \quad \text{overlay}
\]

- For **non-contiguous** groups, you can only specify `group_alignment` and `attributes`.
- The `overlay` keyword also sets the `contiguous` property.
- The `clustered` property cannot be set together with `contiguous` or `ordered` on a single group.

\[
\text{load_or_run_addr} ::= \text{addr_absolute} \\
\quad | \quad \text{addr_range} < | \text{addr_range} >^{0\mid 1}
\]

\[
\text{addr_absolute} ::= \text{expr} \\
\quad | \quad \text{memory_reference} [\ \text{expr}\ ]
\]

- An absolute address can only be set on `ordered` groups.

\[
\text{addr_range} ::= [\ \text{expr} \ldots \text{expr}\ ] \\
\quad | \quad \text{memory_reference} \\
\quad | \quad \text{memory_reference} [\ \text{expr} \ldots \text{expr}\ ]
\]

- The parent of a group with an `addr_range` or `page` restriction cannot be `ordered`, `contiguous` or `clustered`.
- The end address is not part of the range.

\[
\text{memory_reference} ::= \text{mem} : \langle \text{proc_name} :>^{0\mid 1} \text{mem_name} </ \text{map_name}>^{0\mid 1}
\]

- A `proc_name` refers to a defined processor.
- A `mem_name` refers to a defined memory.
- A `map_name` refers to a defined memory mapping.

\[
\text{if_statement} ::= \text{if} (\ \text{expr}\ ) \text{section_statement} \\
\quad | \quad \text{else} \text{section_statement}^{0\mid 1}
\]

\[
\text{section_creation_statement} ::= \text{section} \text{section_name} (\ \text{section_specs}\ ) \\
\quad | \quad \{\ \text{section_statement2}\ }^{0\mid 1}
\]

\[
\text{section_specs} ::= \text{section_spec} , \text{section_spec}^{0\mid 1}
\]

\[
\text{section_spec} ::= \text{attributes} \\
\quad | \quad \text{fill_spec} \\
\quad | \quad \text{size} = \text{expr} \\
\quad | \quad \text{blocksize} = \text{expr} \\
\quad | \quad \text{overflow} = \text{section_name} \\
\quad | \quad \text{tag}
\]
12.3. Expression Evaluation

Only constant expressions are allowed, including sizes, but not addresses, of sections in object files.

All expressions are evaluated with 64-bit precision integer arithmetic. The result of an expression can be absolute or relocatable. A symbol you assign is created as an absolute symbol. Symbol references are only allowed in symbol assignments and struct statements.

12.4. Semantics of the Architecture Definition

Keywords in the architecture definition

architecture
  extends
endianness    big  little
bus
  mau
  width
  map
space
  id
  mau
  align
  page_size
  page
direction    low_to_high  high_to_low
12.4.1. Defining an Architecture

With the keyword `architecture` you define an architecture and assign a unique name to it. The name is used to refer to it at other places in the LSL file:

```
architecture name
{
    definitions
}
```

If you are defining multiple core architectures that show great resemblance, you can define the common features in a parent core architecture and extend this with a child core architecture that contains specific features. The child inherits all features of the parent. With the keyword extends you create a child core architecture:
A core architecture can have any number of parameters. These are identifiers which get values assigned on instantiation or extension of the architecture. You can use them in any expression within the core architecture. Parameters can have default values, which are used when the core architecture is instantiated with less arguments than there are parameters defined for it. When you extend a core architecture you can pass arguments to the parent architecture. Arguments are expressions that set the value of the parameters of the sub-architecture.

**12.4.2. Defining Internal Buses**

With the `bus` keyword you define a bus (the combination of data and corresponding address bus). The bus name is used to identify a bus and does not conflict with other identifiers. Bus descriptions in an architecture definition or derivative definition define internal buses. Some internal buses are used to communicate with the components outside the core or processor. Such buses on a processor have physical pins reserved for the number of bits specified with the `width` statements.

- The `mau` field specifies the MAU size (Minimum Addressable Unit) of the data bus. This field is required and must be non-zero.

- The `width` field specifies the width (number of address lines) of the data bus. The default value is the MAU size.

- The `map` keyword specifies how this bus maps onto another bus (if so). Mappings are described in Section 12.4.4, *Mappings*.

```plaintext
bus bus_name
{
    mau = 8;
    width = 8;
    map ( map_description );
}
```

**12.4.3. Defining Address Spaces**

With the `space` keyword you define a logical address space. The space name is used to identify the address space and does not conflict with other identifiers.

- The `id` field defines how the addressing space is identified in object files. In general, each address space has a unique ID. The linker locates sections with a certain ID in the address space with the same ID. This field is required.
• The `mau` field specifies the MAU size (Minimum Addressable Unit) of the space. This field is required and must be non-zero.

• The `align` value must be a power of two. The linker uses this value to compute the start addresses when sections are concatenated. An align value of \( n \) means that objects in the address space have to be aligned on \( n \) MAUs.

• The `page_size` field sets the page alignment and page size in MAUs for the address space. It must be a power of 2. The default value is 1. If one or more page ranges are supplied the supplied value only sets the page alignment. The ranges specify the available space in each page, as offsets to the page start, which is aligned at the page alignment.

  See also the `page` keyword in subsection Locating a group in Section 12.8.2, Creating and Locating Groups of Sections.

• With the optional `direction` field you can specify how all sections in this space should be located. This can be either from `low_to_high` addresses (this is the default) or from `high_to_low` addresses.

• The `map` keyword specifies how this address space maps onto an internal bus or onto another address space. Mappings are described in Section 12.4.4, Mappings.

**Stacks and heaps**

• The `stack` keyword defines a stack in the address space and assigns a name to it. The architecture definition must contain at least one stack definition. Each stack of a core architecture must have a unique name. See also the `stack` keyword in Section 12.8.3, Creating or Modifying Special Sections.

  The stack is described in terms of a minimum size (`min_size`) and the direction in which the stack grows (`grows`). This can be either from `low_to_high` addresses (stack grows upwards, this is the default) or from `high_to_low` addresses (stack grows downwards). The `min_size` is required.

  By default, the linker tries to maximize the size of the stacks and heaps. After locating all sections, the largest remaining gap in the space is used completely for the stacks and heaps. If you specify the keyword `fixed`, you can disable this so-called 'balloon behavior'. The size is also fixed if you used a stack or heap in the software layout definition in a restricted way. For example when you override a stack with another size or select a stack in an ordered group with other sections.

  A stack may have an `attributes` property with value `b`. Such a stack must be cleared at program startup. No other attributes are allowed.

  Optionally you can specify an alignment for the stack with the argument `align`. This alignment must be equal or larger than the alignment that you specify for the address space itself.

  For each stack, a stack size estimation may be computed (and listed in a map file) from a call graph. Each root node of the call graph is treated as a separate thread that can run independently from the other threads. Root nodes can be specified using the `entry_points` keyword. The estimated stack usage for a root node is the highest sum of stack usage values along a path to a leaf node. The total estimated stack usage of a link task is the sum of the calculated stack usage of such independent call graphs.

  A stack definition may have one or more `entry_points` statements that specify the code that uses that stack - all functions that are reachable (by calls) from the entry points are considered to be using...
the stack at run-time. Each symbol name specified as an entry point must match a node in the call
graph, which must not have more than one caller. As a result of the entry point specification, the specific
call (edge) is removed from the call graph (so the symbol becomes a root). A symbol may be declared
as entry point for multiple stacks.

- The **heap** keyword defines a heap in the address space and assigns a name to it. The definition of a
heap is similar to the definition of a stack. See also the **heap** keyword in Section 12.8.3, *Creating or
Modifying Special Sections*.

Stacks and heaps are only generated by the linker if the corresponding linker labels are referenced in the
object files.

See Section 12.8, *Semantics of the Section Layout Definition*, for information on creating and placing
stack sections.

**Copy tables**

- The **copytable** keyword defines a copy table in the address space. The content of the copy table is
created by the linker and contains the start address and size of all sections that should be initialized
by the startup code. You must define exactly one copy table in one of the address spaces (for a core).

Optionally you can specify an alignment for the copy table with the argument **align**. This alignment
must be equal or larger than the alignment that you specify for the address space itself. If smaller, the
alignment for the address space is used.

The **copy_unit** argument specifies the size in MAUs of information chunks that are copied. If you do
not specify the copy unit, the MAU size of the address space itself is used.

The **dest** argument specifies the destination address space that the code uses for the copy table. The
linker uses this information to generate the correct addresses in the copy table. The memory into where
the sections must be copied at run-time, must be accessible from this destination space.

Sections generated for the copy table may get a page restriction with the address space's page size,
by adding the **page** argument.

One or more **table** arguments split off one or more sub-tables from a copy table. Each sub-table can
be handled separately from the others and from the main table. This can be useful in a multi-core
system, for example. All initialization entries generated from a section in an address space can be
redirected to a sub-table by putting the address space name in a comma-separated list following **space**
= *. The initialization code that handles a sub-table needs a reference to it. This can be accomplished
by specifying a symbol for the sub-table using **symbol** = **symbol_name**; . Each sub-table including
the main table (which is filled with all entries not redirected to a sub-table) ends with a terminator entry
and they are all placed in the regular copy table section.

```c

copytable
  (align = 4,
   dest = linear,
   table
   {
     symbol = "_lc_ub_table_tcl";

```
Reserved address ranges

- The `reserved` keyword specifies to reserve a part of an address space even if not all of the range is covered by memory. See also the `reserved` keyword in Section 12.8.3, Creating or Modifying Special Sections.

Start address

- The `start_address` keyword specifies the start address for the position where the C startup code is located. When a processor is reset, it initializes its program counter to a certain start address, sometimes called the reset vector. In the architecture definition, you must specify this start address in the correct address space in combination with the name of the label in the application code which must be located here.

  The `run_addr` argument specifies the start address (reset vector). If the core starts executing using an entry from a vector table, and directly jumps to the start label, you should omit this argument.

  The `symbol` argument specifies the name of the label in the application code that should be located at the specified start address. The `symbol` argument is required. The linker will resolve the start symbol and use its value after locating for the start address field in IEEE-695 files and Intel Hex files. If you also specified the `run_addr` argument, the start symbol (label) must point to a section. The linker locates this section such that the start symbol ends up on the start address.

```linker
space space_name
{
    id = 1;
    mau = 8;
    align = 8;
    page_size = 1;
    stack name (min_size = 1k, grows = low_to_high);
    reserved start_address .. end_address;
    start_address ( run_addr = 0x0000,
                    symbol = "start_label"
    )
    map ( map_description );
}
```

12.4.4. Mappings

You can use a mapping when you define a space, bus or memory. With the `map` field you specify how addresses from the source (space, bus or memory) are translated to addresses of a destination (space, bus). The following mappings are possible:
With a mapping you specify a range of source addresses you want to map (specified by a source offset and a size), the destination to which you want to map them (a bus or another address space), and the offset address in the destination.

- The `dest` argument specifies the destination. This can be a bus or another address space (only for a space to space mapping). This argument is required.

- The `src_offset` argument specifies the offset of the source addresses. In combination with size, this specifies the range of address that are mapped. By default the source offset is 0x0000.

- The `size` argument specifies the number of addresses that are mapped. This argument is required.

- The `dest_offset` argument specifies the position in the destination to which the specified range of addresses is mapped. By default the destination offset is 0x0000.

If you are mapping a bus to another bus, the number of data lines of each bus may differ. In this case you have to specify a range of source data lines you want to map (`src_dbits = begin..end`) and the range of destination data lines you want to map them to (`dest_dbits = first..last`).

- The `src_dbits` argument specifies a range of data lines of the source bus. By default all data lines are mapped.

- The `dest_dbits` argument specifies a range of data lines of the destination bus. By default, all data lines from the source bus are mapped on the data lines of the destination bus (starting with line 0).

A mapping can optionally have a name which can be referenced in an address assignment.

If you define a memory and the memory mapping must not be used by default when locating sections in address spaces, you can specify the `reserved` argument. This marks all address space areas that the mapping points to as reserved. If a section has an absolute or address range restriction, the reservation is lifted and the section may be located at these locations. This feature is only useful when more than one mapping is available for a range of memory addresses, otherwise the `memory` keyword with the same name would be used.

For example:

```plaintext
memory xrom
{
    mau = 8;
    size = 1M;
    type = rom;
    map        cached (dest=bus:spe:fpi_bus, dest_offset=0x80000000, size=1M);
    map not_cached (dest=bus:spe:fpi_bus, dest_offset=0xa0000000, size=1M);
}
```
Mapping priority

If you define a memory you can set a locate priority on a mapping with the keywords `priority` and `exec_priority`. The values of these priorities are relative which means they add to the priority of memories. Whereas a priority set on the memory applies to all address space areas reachable through any mapping of the memory, a priority set on a mapping only applies to address space areas reachable through the mapping. The memory mapping with the highest priority is considered first when locating. To set only a priority for non-executable (data) sections, add a `priority` keyword with the desired value and an `exec_priority` set to zero. To set only a priority for executable (code) sections, simply set an `exec_priority` keyword to the desired value.

The default for a mapping `priority` is zero, while the default for `exec_priority` is the same as the specified `priority`. If you specify a value for `priority` in LSL it must be greater than zero. A value for `exec_priority` must be greater or equal to zero.

For more information about priority values see the description of the memory `priority` keyword.

```hs
memory dspram
{
    mau = 8;
    size = 112k;
    type = ram;
    map (dest=bus:tc0:fpi_bus, dest_offset=0xd0000000, size=112k, priority=8, exec_priority=0);
    map (dest=bus:sri, dest_offset=0x70000000, size=112k);
}
```

From space to space

If you map an address space to another address space (nesting), you can do this by mapping the subspace to the containing larger space. In this example a small space of 64 kB is mapped on a large space of 16 MB.

```hs
space small
{
    id = 2;
    mau = 4;
    map (src_offset = 0, dest_offset = 0, dest = space : large, size = 64k);
}
```

From space to bus

All spaces that are not mapped to another space must map to a bus in the architecture:

```hs
space large
{
```
id = 1;
mau = 4;
map (src_offset = 0, dest_offset = 0,
     dest = bus:bus_name, size = 16M );
}

From bus to bus

The next example maps an external bus called e_bus to an internal bus called i_bus. This internal bus resides on a core called mycore. The source bus has 16 data lines whereas the destination bus has only 8 data lines. Therefore, the keywords src_dbits and dest_dbits specify which source data lines are mapped on which destination data lines.

architecture mycore
{
    bus i_bus
    {
        mau = 4;
    }

    space i_space
    {
        map (dest=bus:i_bus, size=256);
    }
}

bus e_bus
{
    mau = 16;
    width = 16;
    map (dest = bus:mycore:i_bus, src_dbits = 0..7, dest_dbits = 0..7 )
}

It is not possible to map an internal bus to an external bus.

12.5. Semantics of the Derivative Definition

Keywords in the derivative definition

derivative
    extends
core
    architecture
import
space_id_offset
copytable_space
bus
    mau

598
12.5.1. Defining a Derivative

With the keyword 

```derivative
name
{
    definitions
}
```

If you are defining multiple derivatives that show great resemblance, you can define the common features in a parent derivative and extend this with a child derivative that contains specific features. The child inherits all features of the parent (cores and memories). With the keyword 

```extends
```

you create a child derivative:

```derivative
name_child_deriv extends name_parent_deriv
{
    definitions
}
```

As with a core architecture, a derivative can have any number of parameters. These are identifiers which get values assigned on instantiation or extension of the derivative. You can use them in any expression within the derivative definition.
derivative name_child_deriv (parm1, parm2=1) 
    extends name_parent_deriv (arguments)
{
    definitions
}

12.5.2. Instantiating Core Architectures

With the keyword core you instantiate a core architecture in a derivative.

• With the keyword architecture you tell the linker that the given core has a certain architecture. The architecture name refers to an existing architecture definition in the same LSL file.

For example, if you have two cores (called mycore_1 and mycore_2) that have the same architecture (called mycorearch), you must instantiate both cores as follows:

```vxl
core mycore_1
{
    architecture = mycorearch;
}
core mycore_2
{
    architecture = mycorearch;
}
```

If the architecture definition has parameters you must specify the arguments that correspond with the parameters. For example mycorearch1 expects two parameters which are used in the architecture definition:

```vxl
core mycore
{
    architecture = mycorearch1 (1,2);
}
```

• With the keyword import you can combine multiple cores with the same architecture into a single link task. The imported cores share a single symbol namespace.

• The address spaces in each imported core must have a unique ID in the link task. With the keyword space_id_offset you specify for each imported core that the space IDs of the imported core start at a specific offset.

• With the keyword copytable_space you can specify that writable sections for a core must be initialized by using the copy table of a different core.

```vxl
core mycore_1
{
    architecture = mycorearch;
    space_id_offset = 100; // add 100 to all space IDs in the architecture definition
    copytable_space = mycore:myspace; // use copytable from core mycore
```
core mycore_2
{
    architecture = mycorearch;
    space_id_offset = 200; // add 200 to all space IDs in
    // the architecture definition
    copytable_space = mycore:myspace; // use copytable from core mycore
}

core mycore
{
    architecture = mycorearch;
    import mycore_1; // add all address spaces of mycore_1 for linking
    import mycore_2; // add all address spaces of mycore_2 for linking
}

12.5.3. Defining Internal Memory and Buses

With the keyword memory you define physical memory that is present on the target board. The memory
name is used to identify the memory and does not conflict with other identifiers. It is common to define
internal memory (on-chip) in the derivative definition. External memory (off-chip memory) is usually defined
in the board specification (See Section 12.6.3, Defining External Memory and Buses).

- The type field specifies a memory type:
  - rom: read-only memory - it can only be written at load-time
  - ram: random access volatile writable memory - writing at run-time is possible while writing at load-time
    has no use since the data is not retained after a power-down
  - nvr am: non volatile ram - writing is possible both at load-time and run-time
  - blockram: writing is possible both at load-time and run-time. Changes are applied in RAM, so after
    a full device reset the data in a blockram reverts to the original state.

The optional reserved qualifier before the memory type, tells the linker not to locate any section in
the memory by default. You can locate sections in such memories using an absolute address or range
restriction (see subsection Locating a group in Section 12.8.2, Creating and Locating Groups of Sections).

- The mau field specifies the MAU size (Minimum Addressable Unit) of the memory. This field is required
  and must be non-zero.

- The size field specifies the size in MAU of the memory. This field is required.

- The priority field specifies a locate priority for a memory. The speed field has the same meaning
  but is considered deprecated. By default, a memory has its priority set to 1. The memories with the
  highest priority are considered first when trying to locate a rule. Subsequently, the next highest priority
  memories are added if the rule was not located successfully, and so on until the lowest priority that is
  available is reached or the rule is located. The lowest priority value is zero. Sections with an ordered
and/or contiguous restriction are not affected by the locate priority. If such sections also have a page restriction, the locate priority is still used to select a page.

- If an exec_priority is specified for a memory, the regular priority (either specified or its default value) does not apply to locate rules with only executable sections. Instead, the supplied value applies for such rules. Additionally, the exec_priority value is used for any executable unrestricted sections, even if they appear in an unrestricted rule together with non-executable sections.

- The map field specifies how this memory maps onto an (internal) bus. The mapping can have a name. Mappings are described in Section 12.4.4, Mappings.

- The optional write_unit field specifies the minimum write unit (MWU). This is the minimum number of MAUs required in a write action. This is useful to initialize memories that can only be written in units of two or more MAUs. If write_unit is not defined the minimum write unit is 0.

- The optional fill field contains a bit pattern that the linker writes to all memory addresses that remain unoccupied during the locate process. The result of the expression, or list of expressions, is used as values to write to memory, each in MAU.

```
memory mem_name
{
    type = rom;
    mau = 8;
    write_unit = 4;
    fill = 0xaa;
    size = 64k;
    priority = 2;
    map map_name ( map_description );
}
```

With the bus keyword you define a bus in a derivative definition. Buses are described in Section 12.4.2, Defining Internal Buses.

## 12.6. Semantics of the Board Specification

### Keywords in the board specification

- processor
  - derivative
- bus
  - mau
  - width
  - map
- memory
  - type
  - reserved
  - rom
  - ram
  - nvram
  - blockram
  - mau
  - size
  - speed
  - priority
12.6.1. Defining a Processor

If you have a target board with multiple processors that have the same derivative, you need to instantiate each individual processor in a processor definition. This information tells the linker which processor has which derivative and enables the linker to distinguish between the present processors.

With the keyword `processor` you define a processor. You can freely choose the processor name. The name is used to refer to it at other places in the LSL file:

```
processor proc_name
{
    processor definition
}
```

12.6.2. Instantiating Derivatives

With the keyword `derivative` you tell the linker that the given processor has a certain derivative. The derivative name refers to an existing derivative definition in the same LSL file.

For example, if you have two processors on your target board (called `myproc_1` and `myproc_2`) that have the same derivative (called `myderiv`), you must instantiate both processors as follows:

```
processor myproc_1
{
    derivative = myderiv;
}
```

```
processor myproc_2
{
```
\begin{itemize}
\item derivative = myderiv;
\end{itemize}

If the derivative definition has parameters you must specify the arguments that correspond with the parameters. For example, myderiv1 expects two parameters which are used in the derivative definition:

\begin{verbatim}
processor myproc
{
    derivative = myderiv1 (2,4);
}
\end{verbatim}

\subsection*{12.6.3. Defining External Memory and Buses}

It is common to define external memory (off-chip) and external buses at the global scope (outside any enclosing definition). Internal memory (on-chip memory) is usually defined in the scope of a derivative definition.

With the keyword \texttt{memory} you define physical memory that is present on the target board. The memory name is used to identify the memory and does not conflict with other identifiers. If you define memory parts in the LSL file, only the memory defined in these parts is used for placing sections.

If no external memory is defined in the LSL file and if the linker option to allocate memory on demand is set then the linker will assume that all virtual addresses are mapped on physical memory. You can override this behavior by specifying one or more memory definitions.

\begin{verbatim}
memory mem_name
{
    type = rom;
    mau = 8;
    write_unit = 4;
    fill = 0xaa;
    size = 64k;
    priority = 2;
    map map_name ( map_description );
}
\end{verbatim}

For a description of the keywords, see Section 12.5.3, Defining Internal Memory and Buses.

With the keyword \texttt{bus} you define a bus (the combination of data and corresponding address bus). The bus name is used to identify a bus and does not conflict with other identifiers. Bus descriptions at the global scope (outside any definition) define external buses. These are buses that are present on the target board.

\begin{verbatim}
bus bus_name
{
    mau = 8;
    width = 8;
    map ( map_description );
}
\end{verbatim}

For a description of the keywords, see Section 12.4.2, Defining Internal Buses.
You can connect off-chip memory to any derivative: you need to map the off-chip memory to a bus and map that bus on the internal bus of the derivative you want to connect it to.

12.7. Semantics of the Section Setup Definition

Keywords in the section setup definition

```
section_setup
  stack
    min_size
    grows low_to_high high_to_low
    align
    fixed
    id
  heap
    min_size
    grows low_to_high high_to_low
    align
    fixed
    id
  copytable
    align
    copy_unit
    dest
    page
    table space symbol
  reserved
  start_address
    run_addr
    symbol
  prohibit_references_to
  modify input
    space
    attributes
    copy
```

12.7.1. Setting up a Section

With the keyword `section_setup` you can define stacks, heaps, copy tables, start address and/or reserved address ranges outside their address space definition. In addition you can configure space reference restrictions and input section modifications.

```
section_setup ::my_space
{
  reserved address range
  stack definition
  heap definition
  copy table definition
  start adress
```
space reference restrictions
input section modifications
}

See the subsections Stacks and heaps, Copy tables, Start address and Reserved address ranges in Section 12.4.3, Defining Address Spaces for details on the keywords stack, heap, copytable and reserved.

**Space reference restrictions**

With a space reference restriction, references from the section setup’s address space to sections in specific address spaces can be deleted and blocked. If sections, for example code, in space A are not allowed or not able to access sections (functions or variables) in space B, you can configure this in LSL as follows:

```lsl
section_setup ::A
{
    prohibit_references_to ::B;
}
```

The linker emits an error when such a reference is found in a relocation.

**Input section modifications**

Before sections are located and before selections defined in section_layout are performed, you can still modify a few section properties. These are:

- change the address space of a section
- add (+w) or remove (−w) the writable attribute
- add (+p) or remove (−p) the protected attribute

You cannot set the protected attribute on linker created sections like reserved sections and output sections.

Sections are selected the same way as in groups in a section_layout. Instead of attributes=+w you can use the copy keyword.

```lsl
section_setup ::A
{
    modify input (space=::B, attributes=+w)
    {
        select "mysection";
    }
}
```

Note that the new address space must be used to select a modified section in a section_layout. To locate the section mysection in the example somewhere, it must be selected in a section_layout for space ::B. If the link result is output to a file, for example by only linking or incremental linking, the modified properties are exported. So, when the resulting file is used in another invocation of the linker, the section can appear in a different address space.
12.8. Semantics of the Section Layout Definition

Keywords in the section layout definition

```
section_layout
direction     low_to_high  high_to_low
group
  align
  attributes    + -  r w x b i s p
copy
nocopy
fill
ordered
contiguous
clustered
overlay
allow_cross_references
load_addr
  mem
run_addr
  mem
page
page_size
priority
select
stack
  size
heap
  size
reserved
  size
    attributes    r w x
fill
  alloc_allowed absolute ranged
copytable
memcpy
  memory
fill
section
  size
    blocksize
    attributes    r w x
fill
overflow
struct
  checksum

if
else
```
12.8.1. Defining a Section Layout

With the keyword `section_layout` you define a section layout for exactly one address space. In the section layout you can specify how input sections are placed in the address space, relative to each other, and what the absolute run and load addresses of each section will be.

You can define one or more section definitions. Each section definition arranges the sections in one address space. You can precede the address space name with a processor name and/or core name, separated by colons. You can omit the processor name and/or the core name if only one processor is defined and/or only one core is present in the processor. A reference to a space in the only core of the only processor in the system would look like "::my_space". A reference to a space of the only core on a specific processor in the system could be "my_chip::my_space". The next example shows a section definition for sections in the `my_space` address space of the processor called `my_chip`:

```plaintext
section_layout my_chip::my_space ( locate_direction )
{
    section statements
}
```

Locate direction

With the optional keyword `direction` you specify whether the linker starts locating sections from `low_to_high` (default) or from `high_to_low`. In the second case the linker starts locating sections at the highest addresses in the address space but preserves the order of sections when necessary (one processor and core in this example).

```plaintext
section_layout ::my_space ( direction = high_to_low )
{
    section statements
}
```

If you do not explicitly tell the linker how to locate a section, the linker decides on the basis of the section attributes in the object file and the information in the architecture definition and memory parts where to locate the section.

12.8.2. Creating and Locating Groups of Sections

Sections are located per group. A group can contain one or more (sets of) input sections as well as other groups. Per group you can assign a mutual order to the sets of sections and locate them into a specific memory part.

```plaintext
group ( group_specifications )
{
    section statements
}
```

With the `section statements` you generally select sets of sections to form the group. This is described in subsection Selecting sections for a group.
Instead of selecting sections, you can also modify special sections like stack and heap or create a reserved section. This is described in Section 12.8.3, Creating or Modifying Special Sections.

With the group_specifications you actually locate the sections in the group. This is described in subsection Locating a group.

Selecting sections for a group

With the keyword select you can select one or more sections for the group. You can select a section by name or by attributes. If you select a section by name, you can use a wildcard pattern:

* matches with all section names
? matches with a single character in the section name
\ takes the next character literally
[abc] matches with a single ‘a’, ’b’ or ’c’ character
[a-z] matches with any single character in the range ’a’ to ’z’

```plaintext
group ( ... )
{
    select "mysection";
    select "*";
}
```

The first select statement selects the section with the name "mysection". The second select statement selects all sections that were not selected yet.

A section is selected by the first select statement that matches, in the union of all section layouts for the address space. Global section layouts are processed in the order in which they appear in the LSL file. Internal core architecture section layouts always take precedence over global section layouts.

When you use wildcards, the linker skips sections with an absolute address from the selection process, for example, a start section already having an absolute start address.

Note that when you select sections with an exact name (no wildcards), all sections with that name are automatically protected against unreferenced section removal. With a selection using wildcards, matching sections are selected, but matching sections that are unreferenced may be removed.

- The attributes field selects all sections that carry (or do not carry) the given attribute. With +attribute you select sections that have the specified attribute set. With -attribute you select sections that do not have the specified attribute set. You can specify one or more of the following attributes:
  - r readable sections
  - w writable sections
  - x executable sections
  - i initialized sections
  - b sections that should be cleared at program startup
To select all read-only sections:

```c
group ( ... )
{
    select (attributes = +r-w);
}
```

Keep in mind that all section selections are restricted to the address space of the section layout in which this group definition occurs.

- With the `ref_tree` field you can select a group of related sections. The relation between sections is often expressed by means of references. By selecting just the 'root' of tree, the complete tree is selected. This is for example useful to locate a group of related sections in special memory (e.g. fast memory). The (referenced) sections must meet the following conditions in order to be selected:
  1. The sections are within the section layout's address space
  2. The sections match the specified attributes
  3. The sections have no absolute restriction (as is the case for all wildcard selections)

For example, to select the code sections referenced from `foo1`:

```c
group refgrp (contiguous, run_addr=mem:ext_c)
{
    select ref_tree "foo1" (attributes=+x);
}
```

If `foo1` references `foo2` and `foo2` references `foo3`, then all these sections are selected by the selection shown above.

### Locating a group

```c
group group_name ( group_specifications )
{
    section_statements
}
```

With the `group_specifications` you actually define how the linker must locate the group. You can roughly define three things: 1) assign properties to the sections in a group like alignment and read/write attributes, 2) define the mutual order in the address space for sections in the group and 3) restrict the possible addresses for the sections in a group.

The linker creates labels that allow you to refer to the begin and end address of a group from within the application software. Labels `_lc_gb_group_name` and `_lc_ge_group_name` mark the begin and end of the group respectively, where the begin is the lowest address used within this group and the end is the highest address used. Notice that a group not necessarily occupies all memory between begin and end address. The given label refers to where the section is located at run-time (versus load-time).
1. Assign properties to the sections in a group like alignment and read/write attributes.

These properties are assigned to all sections in the group (and subgroups) and override the attributes of the input sections.

- The **align** field tells the linker to align all sections in the group according to the align value. The alignment of a section is first determined by its own initial alignment and the defined alignment for the address space. Alignments are never decreased, if multiple alignments apply to a section, the largest one is used.

- The **attributes** field tells the linker to assign one or more attributes to all sections in the group. This overrules the default attributes. By default the linker uses the attributes of the input sections. You can set the **r**, **w**, or **rw** attributes and you can switch between the **b** and **s** attributes.

- The **copy** field tells the linker to locate a read-only section in RAM and generate a ROM copy and a copy action in the copy table. This property makes the sections in the group writable which causes the linker to generate ROM copies for the sections.

- The effect of the **nocopy** field is the opposite of the **copy** field. It prevents the linker from generating ROM copies of the selected sections. You cannot apply both **copy** and **nocopy** to the same statement.

2. Define the mutual order of sections in an LSL group.

By default, a group is **unrestricted** which means that the linker has total freedom to place the sections of the group in the address space.

- The **ordered** keyword tells the linker to locate the sections in the same order in the address space as they appear in the group (but not necessarily adjacent).

Suppose you have an ordered group that contains the sections 'A', 'B' and 'C'. By default the linker places the sections in the address space like 'A' - 'B' - 'C', where section 'A' gets the lowest possible address. With `direction=high_to_low` in the `section_layout` space properties, the linker places the sections in the address space like 'C' - 'B' - 'A', where section 'A' gets the highest possible address.

- The **contiguous** keyword tells the linker to locate the sections in the group in a single address range. Within a contiguous group the input sections are located in arbitrary order, however the group occupies one contiguous range of memory. Due to alignment of sections there can be 'alignment gaps' between the sections.

When you define a group that is both **ordered** and **contiguous**, this is called a **sequential** group. In a sequential group the linker places sections in the same order in the address space as they appear in the group and it occupies a contiguous range of memory.

- The **clustered** keyword tells the linker to locate the sections in the group in a number of contiguous blocks. It tries to keep the number of these blocks to a minimum. If enough memory is available, the
group will be located as if it was specified as contiguous. Otherwise, it gets split into two or more blocks.

If a contiguous or clustered group contains alignment gaps, the linker can locate sections that are not part of the group in these gaps. To prevent this, you can use the fill keyword. If the group is located in RAM, the gaps are treated as reserved (scratch) space. If the group is located in ROM, the alignment gaps are filled with zeros by default. You can however change the fill pattern by specifying a bit pattern. The result of the expression, or list of expressions, is used as values to write to memory, each in MAU.

- The overlay keyword tells the linker to overlay the sections in the group. The linker places all sections in the address space using a contiguous range of addresses. (Thus an overlay group is automatically also a contiguous group.) To overlay the sections, all sections in the overlay group share the same run-time address.

For each input section within the overlay the linker automatically defines two symbols. The symbol _lc_cb_section_name is defined as the load-time start address of the section. The symbol _lc_ce_section_name is defined as the load-time end address of the section. C (or assembly) code may be used to copy the overlaid sections.

If sections in the overlay group contain references between groups, the linker reports an error. The keyword allow_cross_references tells the linker to accept cross-references. Normally, it does not make sense to have references between sections that are overlaid.

```c
group ovl (overlay)
{
    group a
    {
        select "my_ovl_p1";
        select "my_ovl_p2";
    }
    group b
    {
        select "my_ovl_q1";
    }
}
```

It may be possible that one of the sections in the overlay group already has been defined in another group where it received a load-time address. In this case the linker does not overrule this load-time address and excludes the section from the overlay group.

3. Restrict the possible addresses for the sections in a group.

The load-time address specifies where the group’s elements are loaded in memory at download time. The run-time address specifies where sections are located at run-time, that is when the program is executing. If you do not explicitly restrict the address in the LSL file, the linker assigns addresses to the sections based on the restrictions relative to other sections in the LSL file and section alignments. The program is responsible for copying overlay sections at appropriate moment from its load-time location to its run-time location (this is typically done by the startup code).
• The \texttt{run_addr} keyword defines the run-time address. If the run-time location of a group is set explicitly, the given order between groups specify whether the run-time address propagates to the parent group or not. The location of the sections in a group can be restricted either to a single absolute address, or to a number of address ranges (not including the end address). With an expression you can specify that the group should be located at the absolute address specified by the expression:

\begin{verbatim}
group (ordered, run_addr = 0xa00f0000)
\end{verbatim}

A group with an absolute address must be ordered, the first section in the group is located at the specified absolute address.

You can use the \texttt{[offset]} variant to locate the group at the given absolute offset in memory:

\begin{verbatim}
group (ordered, run_addr = mem:A[0x1000])
\end{verbatim}

A group with an absolute address must be ordered, the first section in the group is located at the specified absolute offset in memory.

A range can be an absolute space address range, written as \texttt{[expr .. expr]}, a complete memory device, written as \texttt{mem:mem_name}, or a memory address range, \texttt{mem:mem_name[expr .. expr]}

\begin{verbatim}
group (run_addr = mem:my_dram)
\end{verbatim}

You can use the \texttt{[|]} to specify an address range of more than one physical memory device:

\begin{verbatim}
group (run_addr = mem:A | mem:B)
\end{verbatim}

When used in top-level section layouts, a memory name refers to a board-level memory. You can select on-chip memory with \texttt{mem:proc_name:mem_name}. If the memory has multiple parallel mappings towards the current address space, you can select a specific named mapping in the memory by appending \texttt{/map_name} to the memory specifier. The linker then maps memory offsets only through that mapping, so the address(es) where the sections in the group are located are determined by that memory mapping.

\begin{verbatim}
group (run_addr = mem:CPU1:A/cached)
\end{verbatim}

• The \texttt{load_addr} keyword changes the meaning of the section selection in the group: the linker selects the load-time ROM copy of the named section(s) instead of the regular sections. Just like \texttt{run_addr} you can specify an absolute address or an address range.

\begin{verbatim}
group (contiguous, load_addr)
{
  select "mydata"; // select ROM copy of mydata:
  // "[mydata]"
}
\end{verbatim}

The load-time and run-time addresses of a group cannot be set at the same time. If the load-time property is set for a group, the group (only) restricts the positioning at load-time of the group's sections. It is not possible to set the address of a group that has a not-unrestricted parent group.

The properties of the load-time and run-time start address are:
• At run-time, before using an element in an overlay group, the application copies the sections from their load location to their run-time location, but only if these two addresses are different. For non-overlay sections this happens at program start-up.

• The start addresses cannot be set to absolute values for unrestricted groups.

• For non-overlay groups that do not have an overlay parent, the load-time start address equals the run-time start address.

• For any group, if the run-time start address is not set, the linker selects an appropriate address.

• If an ordered group or sequential group has an absolute address and contains sections that have separate page restrictions (not defined in LSL), all those sections are located in a single page. In other cases, for example when an unrestricted group has an address range assigned to it, the paged sections may be located in different pages.

For overlays, the linker reserves memory at the run-time start address as large as the largest element in the overlay group.

• The page keyword tells the linker to place the group in one page. Instead of specifying a run-time address, you can specify a page and optional a page number. Page numbers start from zero. If you omit the page number, the linker chooses a page.

The page keyword refers to pages in the address space as defined in the architecture definition.

• With the page_size keyword you can override the page alignment and size set on the address space. When you set the page size to zero, the linker removes simple (auto generated) page restrictions from the selected sections. See also the page_size keyword in Section 12.4.3, Defining Address Spaces.

• With the priority keyword you can change the order in which sections are located. This is useful when some sections are considered important for good performance of the application and a small amount of fast memory is available. The value is a number for which the default is 1, so higher priorities start at 2. Sections with a higher priority are located before sections with a lower priority, unless their relative locate priority is already determined by other restrictions like run_addr and page.

```c
group (priority=2)
{
    select "importantcode1";
    select "importantcode2";
}
```

12.8.3. Creating or Modifying Special Sections

Instead of selecting sections, you can also create a reserved section or an output section or modify special sections like a stack or a heap. Because you cannot define these sections in the input files, you must use the linker to create them.
Stack

- The keyword `stack` tells the linker to reserve memory for the stack. The name for the stack section refers to the stack as defined in the architecture definition. If no name was specified in the architecture definition, the default name is `stack`.

With the keyword `size` you can specify the size for the stack. If the size is not specified, the linker uses the size given by the `min_size` argument as defined for the stack in the architecture definition. Normally the linker automatically tries to maximize the size, unless you specified the keyword `fixed`.

```plaintext
group ( ... )
{
    stack "mystack" ( size = 2k );
}
```

The linker creates two labels to mark the begin and end of the stack, `_lc_ub_stack_name` for the begin of the stack and `_lc_ue_stack_name` for the end of the stack. The linker allocates space for the stack when there is a reference to either of the labels.

See also the `stack` keyword in Section 12.4.3, *Defining Address Spaces*.

Heap

- The keyword `heap` tells the linker to reserve a dynamic memory range for the `malloc()` function. Each heap section has a name. With the keyword `size` you can change the size for the heap. If the `size` is not specified, the linker uses the size given by the `min_size` argument as defined for the heap in the architecture definition. Normally the linker automatically tries to maximize the size, unless you specified the keyword `fixed`.

```plaintext
group ( ... )
{
    heap "myheap" ( size = 2k );
}
```

The linker creates two labels to mark the begin and end of the heap, `_lc_ub_heap_name` for the begin of the heap and `_lc_ue_heap_name` for the end of the heap. The linker allocates space for the heap when a reference to either of the section labels exists in one of the input object files.

Reserved section

- The keyword `reserved` tells the linker to create an area or section of a given size. The linker will not locate any other sections in the memory occupied by a reserved section, with some exceptions. Each reserved section has a name. With the keyword `size` you can specify a size for a given reserved area or section.

```plaintext
group ( ... )
{
    reserved "myreserved" ( size = 2k );
}
```
The optional fill field contains a bit pattern that the linker writes to all memory addresses that remain unoccupied during the locate process. The result of the expression, or list of expressions, is used as values to write to memory, each in MAU. The first MAU of the fill pattern is always the first MAU in the section.

By default, no sections can overlap with a reserved section. With alloc_allowed=absolute sections that are located at an absolute address due to an absolute group restriction can overlap a reserved section. The same applies for reserved sections with alloc_allowed=ranged set. Sections restricted to a fixed address range can also overlap a reserved section.

With the attributes field you can set the access type of the reserved section. The linker locates the reserved section in its space with the restrictions that follow from the used attributes, r, w or x or a valid combination of them. The allowed attributes are shown in the following table. A value between < and > in the table means this value is set automatically by the linker.

<table>
<thead>
<tr>
<th>Properties set in LSL</th>
<th>Resulting section properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>attributes filled access memory content</td>
<td></td>
</tr>
<tr>
<td>x yes</td>
<td>&lt;rom&gt; executable</td>
</tr>
<tr>
<td>r yes</td>
<td>r &lt;rom&gt; data</td>
</tr>
<tr>
<td>r no</td>
<td>r &lt;rom&gt; scratch</td>
</tr>
<tr>
<td>r yes</td>
<td>r &lt;rom&gt; executable</td>
</tr>
<tr>
<td>rw yes</td>
<td>rw &lt;ram&gt; data</td>
</tr>
<tr>
<td>rw no</td>
<td>rw &lt;ram&gt; scratch</td>
</tr>
<tr>
<td>rwx yes</td>
<td>rw &lt;ram&gt; executable</td>
</tr>
</tbody>
</table>

If you do not specify any attributes, the linker will reserve the given number of maus, no matter what type of memory lies beneath. If you do not specify a fill pattern, no section is generated.

The linker creates two labels to mark the begin and end of the section, _lc_ub_name for the begin of the section and _lc_ue_name for the end of the reserved section.

Output sections

• The keyword section tells the linker to accumulate sections obtained from object files ("input sections") into an output section of a fixed size in the locate phase. You can select the input sections with select statements. You can use groups inside output sections, but you can only set the align, attributes, nocopy and load_addr properties and the load_addr property cannot have an address specified.

The fill field contains a bit pattern that the linker writes to all unused space in the output section. When all input sections have an image (code/data) you must specify a fill pattern. If you do not specify a fill pattern, all input sections must be scratch sections. The fill pattern is aligned at the start of the output section.
As with a reserved section you can use the `attributes` field to set the access type of the output section.

```plaintext
group ( ... )
{
    section "myoutput" ( size = 4k, attributes = rw,
                         fill = 0xaa )
    {
        select "myinput1";
        select "myinput2";
    }
}
```

The available room for input sections is determined by the `size`, `blocksize` and `overflow` fields. With the keyword `size` you specify the fixed size of the output section. Input sections are placed from output section start towards higher addresses (offsets). When the end of the output section is reached and one or more input sections are not yet placed, an error is emitted. If however, the `overflow` field is set to another output section, remaining sections are located as if they were selected for the overflow output section.

```plaintext
group ( ... )
{
    section "tsk1_data" ( size=4k, attributes=rw, fill=0,
                           overflow = "overflow_data")
    {
        select ".data.tsk1.*"
    }
    section "tsk2_data" ( size=4k, attributes=rw, fill=0,
                          overflow = "overflow_data")
    {
        select ".data.tsk2.*"
    }
    section "overflow_data" ( size=4k, attributes=rx,
                              fill=0)
    {
    }
}
```

With the keyword `blocksize`, the size of the output section will adapt to the size of its content. For example:

```plaintext
group flash_area ( run_addr = 0x10000 )
{
    section "flash_code" ( blocksize=4k, attributes=rx,
                           fill=0)
    {
        select "*.flash";
    }
}
```
If the content of the section is 1 mau, the size will be 4 KB, if the content is 11 kB, the section will be 12 kB, etc. If you use size in combination with blocksize, the size value is used as default (minimal) size for this section. If it is omitted, the default size will be of blocksize. It is not allowed to omit both size and blocksize from the section definition.

The linker creates two labels to mark the begin and end of the section, _lc_ub_name for the begin of the section and _lc_ue_name for the end of the output section.

When the copy property is set on an enclosing group, a ROM copy is created for the output section and the output section itself is made writable causing it to be located in RAM by default. For this to work, the output section and its input sections must be read-only and the output section must have a fill property.

A copy table can also be inserted into an output section, but only if two additional conditions are met:

- The copy table is the last section added to the output section.
- There must be sufficient room in the output section to accommodate the additional size of the copy table.

A copy table will likely increase in size after being added to the output section, so if you would add sections after the copy table selection, this would overwrite part of the copy table. The linker will emit an error message if either of the conditions is not met.

```c
group ( ... )
{
  section "myoutput_tbl" ( size = 4k, attributes = r, fill = 0)
  {
    select "myinput";
    select "table"; // select the copy table
  }
}
```

**Copy table**

- The keyword copytable tells the linker to select a section that is used as copy table. The content of the copy table is created by the linker. It contains the start address and length of all sections that should be initialized by the startup code.

  The linker creates two labels to mark the begin and end of the section, _lc_ub_table for the begin of the section and _lc_ue_table for the end of the copy table. The linker generates a copy table when a reference to either of the section labels exists in one of the input object files.

**Memory copy sections**

- If a memory (usually RAM) needs to be initialized by a different core than the one(s) that will use it, a copy of the contents of the memory can be placed in a section using a memcpy statement in a section_layout. All data (including code) present in the specified memory is then placed in a new section with the provided name and appropriate attributes. Unused areas in the memory are filled in the section using the supplied fill pattern or with zeros if no fill pattern is specified. If the memory contains a memory copy section the result is undefined. The actual initialization of the memory at run-time needs
to be done separately, this LSL feature only directs the linker to make the data located in the memory available for initialization. Note that a memory of type `ram` cannot hold initialized data, use type `blockram` instead.

**Structures**

- A `struct` statement in a `section_layout` creates a section and fills it with numbers that each occupy one or more MAUs. The new section must be named by providing a double-quoted string after the `struct` keyword. Each element has the form `expr : number ;`, where the expression provides the value to insert in the section and the number determines the number of MAUs occupied by the expression value. Elements are placed in the section in the order in which they appear in the `struct` body without any gaps between them. Multi-MAU elements are split into MAUs according to the endianness of the target. A `struct` section is read-only and it cannot be copied to RAM at startup (using the `copy` group attribute). No default alignment is set.

For example,

```markdown
struct "mystruct"
{
  0x1234                                       : 2;
  addressof( mem:foo )                         : 4;
  addressof( mem:foo ) + sizeof( mem:foo )     : 4;
  checksum( crc32w,
            addressof( mem:foo ),
            addressof( mem:foo ) + sizeof( mem:foo ) ) : 4
}
```

### 12.8.4. Creating Symbols

You can tell the linker to create symbols before locating by putting assignments in the section layout definition. Symbol names are represented by double-quoted strings. Any string is allowed, but object files may not support all characters for symbol names. You can use two different assignment operators. With the simple assignment operator `=`; the symbol is created unconditionally. With the `:=` operator, the symbol is only created if it already exists as an undefined reference in an object file.

The expression that represents the value to assign to the symbol may contain references to other symbols. If such a referred symbol is a special section symbol, creation of the symbol in the left hand side of the assignment will cause creation of the special section.

```markdown
section_layout
{
  "_lc_cp" := "_lc_ub_table";
  // when the symbol _lc_cp occurs as an undefined reference
  // in an object file, the linker generates a copy table
}
```

### 12.8.5. Conditional Group Statements

Within a group, you can conditionally select sections or create special sections.
• With the if keyword you can specify a condition. The succeeding section statement is executed if the condition evaluates to TRUE (1).

• The optional else keyword is followed by a section statement which is executed in case the if-condition evaluates to FALSE (0).

group ( ... )
{
  \textbf{if} ( \text{exists( "mysection" )} )
  \begin{itemize}
    \item \text{select} "mysection";
  \end{itemize}
  \textbf{else}
  \begin{itemize}
    \item \text{reserved} "myreserved" ( \text{size=}2k );
  \end{itemize}
}
Chapter 13. Debug Target Configuration Files

DTC files (Debug Target Configuration files) define all possible configurations for a debug target. A debug target can be target hardware such as an evaluation board or a simulator. The DTC files are used by Eclipse to configure the project and the debugger. The information is used by the Target Board Configuration wizard and the debug configuration. DTC files are located in the etc directory of the installed product and use .dtc as filename suffix.

Based on the DTC files, the Target Board Configuration wizard adjust the project's LSL file and creates a debug launch configuration.

13.1. Custom Board Support

When you need support for a custom board and the board requires a different configuration than those that are in the product, it is necessary to create a dedicated DTC file.

To add a custom board

1. From the etc directory of the product, make a copy of a .dtc file and put it in your project directory (in the current workspace).

   In Eclipse, the DTC file should now be visible as part of your project.

2. Edit the file and give it a name that reflects the custom board.

The Import Board Configuration wizard in Eclipse adds DTC files that are present in your current project to the list of available target boards.

Syntax of a DTC file

DTC files are XML files and use the XML Schema file dtc.xsd, also present in the etc directory of the installed product.

Inspect the DTC XML schema file dtc.xsd for a description of the allowed elements and the available attributes. Use a delivered .dtc file as a starting point for creating a custom board specification.

Basically a DTC file consists of the definition of the debug target (debugTarget element) which embodies one or more configurations (configuration element) and one or more communication methods (communicationMethod element). The Import Board Configuration wizard in Eclipse reflects the structure of the DTC file. The elements that determine the settings that are applied by the wizard, can be found at any level in the DTC file. The wizard will apply all elements that are within the path to the selected configuration. This is best explained by an example of a DTC file with the following basic layout:

```
debugTarget: Infineon TriBoard TC1796B
  lsl
  communicationMethod: DAS over MiniWigglerII
    lsl
    configuration: Single Chip
      lsl
```
communicationMethod: DAS over USB-Wiggler
  lsl
  configuration: Single Chip
    lsl
lsl

In this example there is an LSL element at every level. If, in the Target Board Configuration wizard in Eclipse, you set the debug target configuration to "DAS over MiniWigglerII" -> "Single Chip", the wizard puts the following LSL parts into the project's LSL file in this order:

- the lsl part under the debugTarget element
- the lsl part under the communicationMethod "DAS over MiniWigglerII" element
- the lsl part under the configuration "Single Chip" in the communicationMethod "DAS over MiniWigglerII" element
- the lsl part in the debugTarget element at the end of the DTC file

The same applies to all other elements that determine the underlying settings.

**DTC macros in LSL**

To protect the Target Board Configuration wizard from changing the LSL file, you can protect the LSL file by adding the macro `__DTC_IGNORE`. This can be useful for projects that need the same LSL file, but still need to run on different target boards.

```
#define __DTC_IGNORE
```

The following DTC macros can be present in the LSL file:

<table>
<thead>
<tr>
<th>LSL Define</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>__DTC_IGNORE</td>
<td>If defined, protects the LSL file against changes by the Target Board</td>
</tr>
<tr>
<td></td>
<td>Configuration wizard.</td>
</tr>
<tr>
<td>__DTC_START</td>
<td>The LSL part that is between these macros can be replaced by LSL text</td>
</tr>
<tr>
<td>__DTC_END</td>
<td>from the DTC file. If the macros are not present in the LSL file, the Target</td>
</tr>
<tr>
<td></td>
<td>Board Configuration wizard will add them.</td>
</tr>
</tbody>
</table>

**13.2. Description of DTC Elements and Attributes**

The following table contains a description of the DTC elements and attributes. For each element a list of allowed elements is listed and the available attributes are described.

<table>
<thead>
<tr>
<th>Element / Attribute</th>
<th>Description</th>
<th>Allowed Elements</th>
</tr>
</thead>
<tbody>
<tr>
<td>debugTarget</td>
<td>The debug target.</td>
<td>flashChips, lsl, communicationMethod,</td>
</tr>
<tr>
<td>name</td>
<td>The name of the configuration.</td>
<td>def, processor, resource, initialize</td>
</tr>
<tr>
<td>manufacturer</td>
<td>The manufacturer of the debug target.</td>
<td></td>
</tr>
<tr>
<td>Element / Attribute</td>
<td>Description</td>
<td>Allowed Elements</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>processor</td>
<td>Defines a processor that can be present on the debug target. Multiple processor definitions are allowed. The user should select the actual processor on the debug target.</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>name A descriptive name of the processor derivative.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>cpu Defines the CPU name, as for example supplied with the option --cpu of the control program.</td>
<td></td>
</tr>
<tr>
<td>communicationMethod</td>
<td>Defines a communication method. A communication method is the channel that is used to communicate with the target.</td>
<td>ref, resource, initialize, configuration, lsl, processor</td>
</tr>
<tr>
<td></td>
<td>name A descriptive name of the communication method.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>debugInstrument The debug instrument DLL/Shared library file to be used for this communication method. Do not supply a path or a filename suffix.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>gdiMethod This is the method used for communication. Allowed values: rs232, tcpip, can, none</td>
<td></td>
</tr>
<tr>
<td>def</td>
<td>Define a set of elements as a macro. The macro can be expanded using the ref element.</td>
<td>isl, resource, initialize, ref, configuration, flashMonitor</td>
</tr>
<tr>
<td></td>
<td>id The macro name.</td>
<td></td>
</tr>
<tr>
<td>resource</td>
<td>Defines a resource definition that can be used by Eclipse, the debugger or by the debug instrument.</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>id The identifier name used by the debugger or debug instrument to retrieve the value.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>value The value assigned to the resource.</td>
<td></td>
</tr>
<tr>
<td>ref</td>
<td>Reference to a macro defined with a def element. The elements contained in the def element with the same name will be expanded at the location of the ref. Multiple refs to the same def are allowed.</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>id The name of the referenced macro.</td>
<td></td>
</tr>
<tr>
<td>configuration</td>
<td>Defines a configuration.</td>
<td>ref, initialize, resource, lsl, flashMonitor, processor</td>
</tr>
<tr>
<td></td>
<td>name The descriptive name of the configuration.</td>
<td></td>
</tr>
<tr>
<td>Element / Attribute</td>
<td>Description</td>
<td>Allowed Elements</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>initialize</td>
<td>This element defines an initialization expression. Each initialize element contains a resourceId attribute. If the DI requests this resource the debugger will compose a string from all initialize elements with the same resourceId. This DI can use this string to initialize registers by passing it to the debugger as an expression to be evaluated.</td>
<td>-</td>
</tr>
<tr>
<td>resourceId</td>
<td>The name of the resource to be used.</td>
<td></td>
</tr>
<tr>
<td>name</td>
<td>The name of the register to be initialized.</td>
<td></td>
</tr>
<tr>
<td>value</td>
<td>When the cstart attribute is false, this is the value to be used, otherwise, it is the default value when using this configuration. It will be used by the startup code editor to set the default register values.</td>
<td></td>
</tr>
<tr>
<td>cstart</td>
<td>A boolean value. If true the debugger should ask the C startup code editor for the value, otherwise the contents of the value attribute is used. The default value is true.</td>
<td></td>
</tr>
<tr>
<td>flashMonitor</td>
<td>This element specifies the flash programming monitor to be used for this configuration.</td>
<td>-</td>
</tr>
<tr>
<td>monitor</td>
<td>Filename of the monitor, usually an Intel Hex or S-Record file.</td>
<td></td>
</tr>
<tr>
<td>workspaceAddress</td>
<td>The address of the workspace of the flash programming monitor.</td>
<td></td>
</tr>
<tr>
<td>flashSectorBufferSize</td>
<td>Specifies the buffer size for buffering a flash sector.</td>
<td></td>
</tr>
<tr>
<td>chip</td>
<td>This element defines a flash chip. It must be used by the flash properties page to add it on request to the list of flash chips.</td>
<td>debugTarget</td>
</tr>
<tr>
<td>vendor</td>
<td>The vendor of this flash chip.</td>
<td></td>
</tr>
<tr>
<td>chip</td>
<td>The name of the chip.</td>
<td></td>
</tr>
<tr>
<td>width</td>
<td>The width of the chip in bits.</td>
<td></td>
</tr>
<tr>
<td>chips</td>
<td>The number of chips present on the board.</td>
<td></td>
</tr>
<tr>
<td>baseAddress</td>
<td>The base address of the chip.</td>
<td></td>
</tr>
<tr>
<td>chipSize</td>
<td>The size of the chip in bytes.</td>
<td></td>
</tr>
<tr>
<td>flashChips</td>
<td>Specify a list of flash chips that can be available on this debug target.</td>
<td>chip</td>
</tr>
</tbody>
</table>
### 13.3. Special Resource Identifiers

The following resource IDs are available in the TASKING VX-toolset for TriCore:

**DAS debug instrument (DI): gdi2das**

<table>
<thead>
<tr>
<th>Resource Name</th>
<th>Description</th>
<th>Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>AccessPort</td>
<td>The port used to connect to the wiggler.</td>
<td>JTAG0, JTAG1,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>USB0</td>
</tr>
<tr>
<td>DASserver</td>
<td>The DAS Server used for communication.</td>
<td>UDAS</td>
</tr>
<tr>
<td>DasTimeOut</td>
<td>The timeout value for communication with the DAS server in milliseconds.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The default is 0x4000.</td>
<td></td>
</tr>
<tr>
<td>RegisterFile</td>
<td>The core register file that is used by the debug instrument.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>This is usually &quot;regbase_f7e1.dat&quot; or &quot;regbase_ffff.dat&quot;, depending on the</td>
<td></td>
</tr>
<tr>
<td></td>
<td>register base address.</td>
<td></td>
</tr>
<tr>
<td>TerminateServer</td>
<td>Terminate the DAS server when the session is closed.</td>
<td>0, 1</td>
</tr>
</tbody>
</table>

### 13.4. Initialize Elements

The initialize elements are used to initialize SFRs at startup. This is also done using a resource of the debug instrument. The following resource IDs exist for the DAS debug instrument (gdi2das):

<table>
<thead>
<tr>
<th>Resource Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>einit</td>
<td>Initialize an SFR that is protected with the ENDINIT flag.</td>
</tr>
<tr>
<td>init</td>
<td>Initialize an SFR that is not protected with the ENDINIT flag.</td>
</tr>
<tr>
<td>noinit</td>
<td>Do not initialize an SFR before the startup code is executed.</td>
</tr>
</tbody>
</table>
Chapter 14. CPU Problem Bypasses and Checks

Infineon Technologies regularly publishes microcontroller errata sheets for reporting both functional problems and deviations from the electrical and timing specifications.

For some of these functional problems in the microcontroller itself, the TASKING VX-toolset for PCP provides workarounds. In fact these are software workarounds for hardware problems.

Support to deal with CPU functional problem is provided in three areas:

• Whenever possible and relevant, compiler bypasses will modify the code in order to avoid the identified erroneous code sequences;

• The assembler gives warnings for suspicious or erroneous code sequences;

• Ready-built, 'protected' standard C libraries with bypasses for all identified PCP CPU functional problems are included in the toolset.

This chapter lists a summary of functional problems which can be bypassed by the TASKING VX-toolset for PCP. Please refer to the Infineon errata sheets for the CPU step you are using, to verify if you need to use one of these bypasses.

To set a CPU bypass or check

1. From the Project menu, select Properties

   The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Processor.

   In the right pane the Processor page appears.

3. From the Processor Selection list, select a processor.

   The CPU Problem Bypasses and Checks box shows the available workarounds/checks available for the selected processor.

4. (Optional) Select Show all CPU problem bypasses and checks.

5. Click Select All or select one or more individual options.

Overview of the CPU problem bypasses and checks

The following table contains an overview of the silicon bugs you can provide to the C compiler option --silicon-bug and the assembler option --silicon-bug. WA means a workaround by the compiler or assembler, CK means a check by the compiler or assembler.
<table>
<thead>
<tr>
<th>CPU Problem</th>
<th>Description</th>
<th>Compiler</th>
<th>Assembler</th>
<th>CPU</th>
</tr>
</thead>
<tbody>
<tr>
<td>PCP TC.034</td>
<td>Usage of R7 requires delays between operations</td>
<td></td>
<td>CK</td>
<td>TC1767, TC1797</td>
</tr>
<tr>
<td>PCP TC.038</td>
<td>PCP atomic PRAM operations may operate incorrectly</td>
<td>WA</td>
<td>CK</td>
<td>TC1767, TC1797</td>
</tr>
</tbody>
</table>
**PCP_TC.034**

**Command line option**

```
--silicon-bug=pcp-tc034
```

**Description**

If the following instruction sequence is used:

```
instr writing to R7
```
directly followed by

```
instr reading from R7
```
then the second instruction will fail, providing wrong data. The write will be successful anyway. The assembler issues a warning if the above sequence occurs.

**Workaround**

Add a NOP between a write to R7 followed by a read from R7.
PCP_TC.038

Command line option

--silicon-bug=pcp-tc038

Description

PCP atomic PRAM instructions (XCH.PI, MSET.PI, MCLR.PI) may operate incorrectly due to external FPI read-modify-write operations.

To bypass this CPU functional problem, the C compiler does not generate these atomic instructions.

The assembler issues a warning when one of the atomic PRAM instructions appear.
Chapter 15. CERT C Secure Coding Standard

The CERT C Secure Coding Standard provides rules and recommendations for secure coding in the C programming language. The goal of these rules and recommendations is to eliminate insecure coding practices and undefined behaviors that can lead to exploitable vulnerabilities. The application of the secure coding standard will lead to higher-quality systems that are robust and more resistant to attack.

This chapter contains an overview of the CERT C Secure Coding Standard recommendations and rules that are supported by the TASKING VX-toolset.

For details see the CERT C Secure Coding Standard web site. For general information about CERT secure coding, see www.cert.org/secure-coding.

Identifiers

Each rule and recommendation is given a unique identifier. These identifiers consist of three parts:

- a three-letter mnemonic representing the section of the standard
- a two-digit numeric value in the range of 00-99
- the letter "C" indicates that this is a C language guideline

The three-letter mnemonic is used to group similar coding practices and to indicate to which category a coding practice belongs.

The numeric value is used to give each coding practice a unique identifier. Numeric values in the range of 00-29 are reserved for recommendations, while values in the range of 30-99 are reserved for rules.

C compiler invocation

With the C compiler option --cert you can enable one or more checks for the CERT C Secure Coding Standard recommendations/rules. With --diag=cert you can see a list of the available checks, or you can use a three-letter mnemonic to list only the checks in a particular category. For example, --diag=pre lists all supported checks in the preprocessor category.

15.1. Preprocessor (PRE)

PRE01-C Use parentheses within macros around parameter names

Parenthesize all parameter names in macro definitions to avoid precedence problems.
Macro replacement lists should be parenthesized

Macro replacement lists should be parenthesized to protect any lower-precedence operators from the surrounding expression. The example below is syntactically correct, although the != operator was omitted. Enclosing the constant -1 in parenthesis will prevent the incorrect interpretation and force a compiler error:

```
#define EOF -1  // should be (-1)
int getchar(void);
void f(void)
{
    if (getchar() EOF) // != operator omitted
    {
        /* ... */
    }
}
```

Wrap multi-statement macros in a do-while loop

When multiple statements are used in a macro, enclose them in a do-while statement, so the macro can appear safely inside if clauses or other places that expect a single statement or a statement block. Braces alone will not work in all situations, as the macro expansion is typically followed by a semicolon.

Do not conclude a single statement macro definition with a semicolon

Macro definitions consisting of a single statement should not conclude with a semicolon. If required, the semicolon should be included following the macro expansion. Inadvertently inserting a semicolon can change the control flow of the program.

15.2. Declarations and Initialization (DCL)

Declare objects with appropriate storage durations

The lifetime of an automatic object ends when the function returns, which means that a pointer to the object becomes invalid.

Declare identifiers before using them

The ISO C90 standard allows implicit typing of variables and functions. Because implicit declarations lead to less stringent type checking, they can often introduce unexpected and erroneous behavior or even security vulnerabilities. The ISO C99 standard requires type identifiers and forbids implicit function declarations. For backwards compatibility reasons, the VX-toolset C compiler assumes an implicit declaration and continues translation after issuing a warning message (W505 or W535).
DCL32-C Guarantee that mutually visible identifiers are unique

The compiler encountered two or more identifiers that are identical in the first 31 characters. The ISO C99 standard allows a compiler to ignore characters past the first 31 in an identifier. Two distinct identifiers that are identical in the first 31 characters may lead to problems when the code is ported to a different compiler.

DCL35-C Do not invoke a function using a type that does not match the function definition

This warning is generated when a function pointer is set to refer to a function of an incompatible type. Calling this function through the function pointer will result in undefined behavior. Example:

```c
void my_function(int a);
int main(void)
{
    int (*new_function)(int a) = my_function;
    return (*new_function)(10); /* the behavior is undefined */
}
```

### 15.3. Expressions (EXP)

EXP01-C Do not take the size of a pointer to determine the size of the pointed-to type

The size of the object(s) allocated by malloc(), calloc() or realloc() should be a multiple of the size of the base type of the result pointer. Therefore, the sizeof expression should be applied to this base type, and not to the pointer type.

EXP12-C Do not ignore values returned by functions

The compiler gives this warning when the result of a function call is ignored at some place, although it is not ignored for other calls to this function. This warning will not be issued when the function result is ignored for all calls, or when the result is explicitly ignored with a (void) cast.

EXP30-C Do not depend on order of evaluation between sequence points

Between two sequence points, an object should only be modified once. Otherwise the behavior is undefined.

EXP32-C Do not access a volatile object through a non-volatile reference

If an attempt is made to refer to an object defined with a volatile-qualified type through use of an lvalue with non-volatile-qualified type, the behavior is undefined.

EXP33-C Do not reference uninitialized memory

Uninitialized automatic variables default to whichever value is currently stored on the stack or in the register allocated for the variable. Consequently, uninitialized memory can cause a program to behave in an unpredictable or unplanned manner and may provide an avenue for attack.
Ensure a null pointer is not dereferenced

Attempting to dereference a null pointer results in undefined behavior, typically abnormal program termination.

Call functions with the arguments intended by the API

When a function is properly declared with function prototype information, an incorrect call will be flagged by the compiler. When there is no prototype information available at the call, the compiler cannot check the number of arguments and the types of the arguments. This message is issued to warn about this situation.

Do not call offsetof() on bit-field members or invalid types

The behavior of the offsetof() macro is undefined when the member designator parameter designates a bit-field.

15.4. Integers (INT)

Ensure that unsigned integer operations do not wrap

A constant with an unsigned integer type is truncated, resulting in a wrap-around.

Do not shift a negative number of bits or more bits than exist in the operand

The shift count of the shift operation may be negative or greater than or equal to the size of the left operand. According to the C standard, the behavior of such a shift operation is undefined. Make sure the shift count is in range by adding appropriate range checks.

Evaluate integer expressions in a larger size before comparing or assigning to that size

If an integer expression is compared to, or assigned to a larger integer size, that integer expression should be evaluated in that larger size by explicitly casting one of the operands.

15.5. Floating Point (FLP)

Do not use floating point variables as loop counters

To avoid problems with limited precision and rounding, floating point variables should not be used as loop counters.

Take granularity into account when comparing floating point values

Floating point arithmetic in C is inexact, so floating point values should not be tested for exact equality or inequality.

Beware of precision loss when converting integral types to floating point

Conversion from integral types to floating point types without sufficient precision can lead to loss of precision.
15.6. Arrays (ARR)

ARR01-C Do not apply the sizeof operator to a pointer when taking the size of an array

A function parameter declared as an array, is converted to a pointer by the compiler. Therefore, the sizeof operator applied to this parameter yields the size of a pointer, and not the size of an array.

ARR34-C Ensure that array types in expressions are compatible

Using two or more incompatible arrays in an expression results in undefined behavior.

ARR35-C Do not allow loops to iterate beyond the end of an array

Reading or writing of data outside the bounds of an array may lead to incorrect program behavior or execution of arbitrary code.

15.7. Characters and Strings (STR)

STR30-C Do not attempt to modify string literals

Writing to a string literal has undefined behavior, as identical strings may be shared and/or allocated in read-only memory.

STR33-C Size wide character strings correctly

Wide character strings may be improperly sized when they are mistaken for narrow strings or for multi-byte character strings.

STR34-C Cast characters to unsigned types before converting to larger integer sizes

A signed character is sign-extended to a larger signed integer value. Use an explicit cast, or cast the value to an unsigned type first, to avoid unexpected sign-extension.

STR36-C Do not specify the bound of a character array initialized with a string literal

The compiler issues this warning when the character buffer initialized by a string literal does not provide enough room for the terminating null character.

15.8. Memory Management (MEM)

MEM00-C Allocate and free memory in the same module, at the same level of abstraction

The compiler issues this warning when the result of the call to malloc(), calloc() or realloc() is discarded, and therefore not free()d, resulting in a memory leak.

MEM08-C Use realloc() only to resize dynamically allocated arrays

Only use realloc() to resize an array. Do not use it to transform an object to an object of a different type.
MEM30-C  Do not access freed memory

When memory is freed, its contents may remain intact and accessible because it is at the memory manager's discretion when to reallocate or recycle the freed chunk. The data at the freed location may appear valid. However, this can change unexpectedly, leading to unintended program behavior. As a result, it is necessary to guarantee that memory is not written to or read from once it is freed.

MEM31-C  Free dynamically allocated memory exactly once

Freeing memory multiple times has similar consequences to accessing memory after it is freed. The underlying data structures that manage the heap can become corrupted. To eliminate double-free vulnerabilities, it is necessary to guarantee that dynamic memory is freed exactly once.

MEM32-C  Detect and handle memory allocation errors

The result of realloc() is assigned to the original pointer, without checking for failure. As a result, the original block of memory is lost when realloc() fails.

MEM33-C  Use the correct syntax for flexible array members

Use the ISO C99 syntax for flexible array members instead of an array member of size 1.

MEM34-C  Only free memory allocated dynamically

Freeing memory that is not allocated dynamically can lead to corruption of the heap data structures.

MEM35-C  Allocate sufficient memory for an object

The compiler issues this warning when the size of the object(s) allocated by malloc(), calloc() or realloc() is smaller than the size of an object pointed to by the result pointer. This may be caused by a sizeof expression with the wrong type or with a pointer type instead of the object type.

15.9. Environment (ENV)

ENV32-C  All atexit handlers must return normally

The compiler issues this warning when an atexit() handler is calling a function that does not return. No atexit() registered handler should terminate in any way other than by returning.

15.10. Signals (SIG)

SIG30-C  Call only asynchronous-safe functions within signal handlers

SIG32-C  Do not call longjmp() from inside a signal handler

Invoking the longjmp() function from within a signal handler can lead to undefined behavior if it results in the invocation of any non-asynchronous-safe functions, likely compromising the integrity of the program.
15.11. Miscellaneous (MSC)

**MSC32-C** Ensure your random number generator is properly seeded

Ensure that the random number generator is properly seeded by calling srand().
Chapter 16. MISRA C Rules

This chapter contains an overview of the supported and unsupported MISRA C rules.

16.1. MISRA C:1998

This section lists all supported and unsupported MISRA C:1998 rules.

See also Section 3.7.2, C Code Checking: MISRA C.

A number of MISRA C rules leave room for interpretation. Other rules can only be checked in a limited way. In such cases the implementation decisions and possible restrictions for these rules are listed.

\( \times \) means that the rule is not supported by the TASKING C compiler. (R) is a required rule, (A) is an advisory rule.

1. (R) The code shall conform to standard C, without language extensions.
2. (A) Other languages should only be used with an interface standard.
3. (A) Inline assembly is only allowed in dedicated C functions.
4. (A) Provision should be made for appropriate run-time checking.
5. (R) Only use characters and escape sequences defined by ISO C.
6. (R) Character values shall be restricted to a subset of ISO 106460-1.
7. (R) Trigraphs shall not be used.
8. (R) Multibyte characters and wide string literals shall not be used.
9. (R) Comments shall not be nested.
10. (A) Sections of code should not be "commented out".

In general, it is not possible to decide whether a piece of comment is C code that is commented out, or just some pseudo code. Instead, the following heuristics are used to detect possible C code inside a comment:

- a line ends with ‘;’, or
- a line starts with ‘}’, possibly preceded by white space

11. (R) Identifiers shall not rely on significance of more than 31 characters.
12. (A) The same identifier shall not be used in multiple name spaces.
13. (A) Specific-length typedefs should be used instead of the basic types.
14. (R) Use unsigned char or signed char instead of plain char.
15. (A) Floating-point implementations should comply with a standard.
16. (R) The bit representation of floating-point numbers shall not be used.

A violation is reported when a pointer to a floating-point type is converted to a pointer to an integer type.
typedef names shall not be reused.  
18. (A) Numeric constants should be suffixed to indicate type.  
A violation is reported when the value of the constant is outside the range indicated  
by the suffixes, if any. 
19. (R) Octal constants (other than zero) shall not be used. 
20. (R) All object and function identifiers shall be declared before use. 
21. (R) Identifiers shall not hide identifiers in an outer scope. 
22. (A) Declarations should be at function scope where possible. 
23. (A) All declarations at file scope should be static where possible. 
24. (R) Identifiers shall not have both internal and external linkage. 
25. (R) Identifiers with external linkage shall have exactly one definition. 
26. (R) Multiple declarations for objects or functions shall be compatible. 
27. (A) External objects should not be declared in more than one file. 
28. (A) The register storage class specifier should not be used. 
29. (R) The use of a tag shall agree with its declaration. 
30. (R) All automatics shall be initialized before being used.  
This rule is checked using worst-case assumptions. This means that violations are  
reported not only for variables that are guaranteed to be uninitialized, but also for  
variables that are uninitialized on some execution paths. 
31. (R) Braces shall be used in the initialization of arrays and structures. 
32. (R) Only the first, or all enumeration constants may be initialized. 
33. (R) The right hand operand of && or || shall not contain side effects. 
34. (R) The operands of a logical && or || shall be primary expressions. 
35. (R) Assignment operators shall not be used in Boolean expressions. 
36. (A) Logical operators should not be confused with bitwise operators. 
37. (R) Bitwise operations shall not be performed on signed integers. 
38. (R) A shift count shall be between 0 and the operand width minus 1.  
This violation will only be checked when the shift count evaluates to a constant value  
at compile time. 
39. (R) The unary minus shall not be applied to an unsigned expression. 
40. (A) sizeof should not be used on expressions with side effects. 
41. (A) The implementation of integer division should be documented. 
42. (R) The comma operator shall only be used in a for condition. 
43. (R) Don't use implicit conversions which may result in information loss. 
44. (A) Redundant explicit casts should not be used. 
45. (R) Type casting from any type to or from pointers shall not be used.
46. (R) The value of an expression shall be evaluation order independent. This rule is checked using worst-case assumptions. This means that a violation will be reported when a possible alias may cause the result of an expression to be evaluation order dependent.

47. (A) No dependence should be placed on operator precedence rules.

48. (A) Mixed arithmetic should use explicit casting.

49. (A) Tests of a (non-Boolean) value against 0 should be made explicit.

50. (R) F.P. variables shall not be tested for exact equality or inequality.

51. (A) Constant unsigned integer expressions should not wrap-around.

52. (R) There shall be no unreachable code.

53. (R) All non-null statements shall have a side-effect.

54. (R) A null statement shall only occur on a line by itself.

55. (A) Labels should not be used.

56. (R) The goto statement shall not be used.

57. (R) The continue statement shall not be used.

58. (R) The break statement shall not be used (except in a switch).

59. (R) An if or loop body shall always be enclosed in braces.

60. (A) All if, else if constructs should contain a final else.

61. (R) Every non-empty case clause shall be terminated with a break.

62. (R) All switch statements should contain a final default case.

63. (A) A switch expression should not represent a Boolean case.

64. (R) Every switch shall have at least one case.

65. (R) Floating-point variables shall not be used as loop counters.

66. (A) A for should only contain expressions concerning loop control. A violation is reported when the loop initialization or loop update expression modifies an object that is not referenced in the loop test.

67. (A) Iterator variables should not be modified in a for loop.

68. (R) Functions shall always be declared at file scope.

69. (R) Functions with variable number of arguments shall not be used.

70. (R) Functions shall not call themselves, either directly or indirectly. A violation will be reported for direct or indirect recursive function calls in the source file being checked. Recursion via functions in other source files, or recursion via function pointers is not detected.

71. (R) Function prototypes shall be visible at the definition and call.

72. (R) The function prototype of the declaration shall match the definition.

73. (R) Identifiers shall be given for all prototype parameters or for none.

74. (R) Parameter identifiers shall be identical for declaration/definition.

75. (R) Every function shall have an explicit return type.
76. (R) Functions with no parameters shall have a `void` parameter list.
77. (R) An actual parameter type shall be compatible with the prototype.
78. (R) The number of actual parameters shall match the prototype.
79. (R) The values returned by `void` functions shall not be used.
80. (R) Void expressions shall not be passed as function parameters.
81. (A) `const` should be used for reference parameters not modified.
82. (A) A function should have a single point of exit.
83. (R) Every exit point shall have a `return` of the declared return type.
84. (R) For `void` functions, `return` shall not have an expression.
85. (A) Function calls with no parameters should have empty parentheses.
86. (A) If a function returns error information, it should be tested. A violation is reported when the return value of a function is ignored.
87. (R) `#include` shall only be preceded by other directives or comments.
88. (R) Non-standard characters shall not occur in `#include` directives.
89. (R) `#include` shall be followed by either `<filename>` or "filename".
90. (R) Plain macros shall only be used for constants/qualifiers/specifiers.
91. (R) Macros shall not be `#define`d and `#undef`d within a block.
92. (A) `#undef` should not be used.
93. (A) A function should be used in preference to a function-like macro.
94. (R) A function-like macro shall not be used without all arguments.
95. (R) Macro arguments shall not contain pre-preprocessing directives. A violation is reported when the first token of an actual macro argument is '#'.
96. (R) Macro definitions/parameters should be enclosed in parentheses.
97. (A) Don't use undefined identifiers in pre-processing directives.
98. (R) A macro definition shall contain at most one `#` or `##` operator.
99. (R) All uses of the `#pragma` directive shall be documented. This rule is really a documentation issue. The compiler will flag all `#pragma` directives as violations.
100. (R) `defined` shall only be used in one of the two standard forms.
101. (A) Pointer arithmetic should not be used.
102. (A) No more than 2 levels of pointer indirection should be used. A violation is reported when a pointer with three or more levels of indirection is declared.
103. (R) No relational operators between pointers to different objects. In general, checking whether two pointers point to the same object is impossible. The compiler will only report a violation for a relational operation with incompatible pointer types.
104. (R) Non-constant pointers to functions shall not be used.
105. (R) Functions assigned to the same pointer shall be of identical type.
106. (R) Automatic address may not be assigned to a longer lived object.
107. (R) The null pointer shall not be de-referenced.
   A violation is reported for every pointer dereference that is not guarded by a NULL
   pointer test.
108. (R) All struct/union members shall be fully specified.
109. (R) Overlapping variable storage shall not be used.
   A violation is reported for every union declaration.
110. (R) Unions shall not be used to access the sub-parts of larger types.
     A violation is reported for a union containing a struct member.
111. (R) Bit-fields shall have type unsigned int or signed int.
112. (R) Bit-fields of type signed int shall be at least 2 bits long.
113. (R) All struct/union members shall be named.
114. (R) Reserved and standard library names shall not be redefined.
115. (R) Standard library function names shall not be reused.
116. (R) Production libraries shall comply with the MISRA C restrictions.
117. (R) The validity of library function parameters shall be checked.
118. (R) Dynamic heap memory allocation shall not be used.
119. (R) The error indicator errno shall not be used.
120. (R) The macro offsetof shall not be used.
121. (R) <locale.h> and the setlocale function shall not be used.
122. (R) The setjmp and longjmp functions shall not be used.
123. (R) The signal handling facilities of <signal.h> shall not be used.
124. (R) The <stdio.h> library shall not be used in production code.
125. (R) The functions atof/atoi/atol shall not be used.
126. (R) The functions abort/exit/getenv/system shall not be used.
127. (R) The time handling functions of library <time.h> shall not be used.

16.2. MISRA C:2004

This section lists all supported and unsupported MISRA C:2004 rules.

See also Section 3.7.2, C Code Checking: MISRA C.

A number of MISRA C rules leave room for interpretation. Other rules can only be checked in a limited
way. In such cases the implementation decisions and possible restrictions for these rules are listed.

x means that the rule is not supported by the TASKING C compiler. (R) is a required rule, (A) is an advisory
rule.
Environment


1.2 (R) No reliance shall be placed on undefined or unspecified behavior.

x 1.3 (R) Multiple compilers and/or languages shall only be used if there is a common defined interface standard for object code to which the languages/compilers/assemblers conform.

x 1.4 (R) The compiler/linker shall be checked to ensure that 31 character significance and case sensitivity are supported for external identifiers.

x 1.5 (A) Floating-point implementations should comply with a defined floating-point standard.

Language extensions

2.1 (R) Assembly language shall be encapsulated and isolated.

2.2 (R) Source code shall only use /* ... */ style comments.

2.3 (R) The character sequence /* shall not be used within a comment.

2.4 (A) Sections of code should not be "commented out". In general, it is not possible to decide whether a piece of comment is C code that is commented out, or just some pseudo code. Instead, the following heuristics are used to detect possible C code inside a comment: - a line ends with ';', or - a line starts with '}', possibly preceded by white space

Documentation

x 3.1 (R) All usage of implementation-defined behavior shall be documented.

x 3.2 (R) The character set and the corresponding encoding shall be documented.

x 3.3 (A) The implementation of integer division in the chosen compiler should be determined, documented and taken into account.

3.4 (R) All uses of the #pragma directive shall be documented and explained. This rule is really a documentation issue. The compiler will flag all #pragma directives as violations.

3.5 (R) The implementation-defined behavior and packing of bit-fields shall be documented if being relied upon.

x 3.6 (R) All libraries used in production code shall be written to comply with the provisions of this document, and shall have been subject to appropriate validation.

Character sets

4.1 (R) Only those escape sequences that are defined in the ISO C standard shall be used.

4.2 (R) Trigraphs shall not be used.
Identifiers

5.1 (R) Identifiers (internal and external) shall not rely on the significance of more than 31 characters.
5.2 (R) Identifiers in an inner scope shall not use the same name as an identifier in an outer scope, and therefore hide that identifier.
5.3 (R) A typedef name shall be a unique identifier.
5.4 (R) A tag name shall be a unique identifier.
5.5 (A) No object or function identifier with static storage duration should be reused.
5.6 (A) No identifier in one name space should have the same spelling as an identifier in another name space, with the exception of structure and union member names.
5.7 (A) No identifier name should be reused.

Types

6.1 (R) The plain char type shall be used only for storage and use of character values.
6.2 (R) signed and unsigned char type shall be used only for the storage and use of numeric values.
6.3 (A) typedefs that indicate size and signedness should be used in place of the basic types.
6.4 (R) Bit-fields shall only be defined to be of type unsigned int or signed int.
6.5 (R) Bit-fields of type signed int shall be at least 2 bits long.

Constants

7.1 (R) Octal constants (other than zero) and octal escape sequences shall not be used.

Declarations and definitions

8.1 (R) Functions shall have prototype declarations and the prototype shall be visible at both the function definition and call.
8.2 (R) Whenever an object or function is declared or defined, its type shall be explicitly stated.
8.3 (R) For each function parameter the type given in the declaration and definition shall be identical, and the return types shall also be identical.
8.4 (R) If objects or functions are declared more than once their types shall be compatible.
8.5 (R) There shall be no definitions of objects or functions in a header file.
8.6 (R) Functions shall be declared at file scope.
8.7 (R) Objects shall be defined at block scope if they are only accessed from within a single function.
8.8 (R) An external object or function shall be declared in one and only one file.
8.9 (R) An identifier with external linkage shall have exactly one external definition.

8.10 (R) All declarations and definitions of objects or functions at file scope shall have internal linkage unless external linkage is required.

8.11 (R) The static storage class specifier shall be used in definitions and declarations of objects and functions that have internal linkage.

8.12 (R) When an array is declared with external linkage, its size shall be stated explicitly or defined implicitly by initialization.

Initialization

9.1 (R) All automatic variables shall have been assigned a value before being used. This rule is checked using worst-case assumptions. This means that violations are reported not only for variables that are guaranteed to be uninitialized, but also for variables that are uninitialized on some execution paths.

9.2 (R) Braces shall be used to indicate and match the structure in the non-zero initialization of arrays and structures.

9.3 (R) In an enumerator list, the "=" construct shall not be used to explicitly initialize members other than the first, unless all items are explicitly initialized.

Arithmetic type conversions

10.1 (R) The value of an expression of integer type shall not be implicitly converted to a different underlying type if:
   a) it is not a conversion to a wider integer type of the same signedness, or
   b) the expression is complex, or
   c) the expression is not constant and is a function argument, or
   d) the expression is not constant and is a return expression.

10.2 (R) The value of an expression of floating type shall not be implicitly converted to a different type if:
   a) it is not a conversion to a wider floating type, or
   b) the expression is complex, or
   c) the expression is a function argument, or
   d) the expression is a return expression.

10.3 (R) The value of a complex expression of integer type may only be cast to a type of the same signedness that is no wider than the underlying type of the expression.

10.4 (R) The value of a complex expression of floating type may only be cast to a type that is no wider than the underlying type of the expression.

10.5 (R) If the bitwise operators ~ and << are applied to an operand of underlying type unsigned char or unsigned short, the result shall be immediately cast to the underlying type of the operand.

10.6 (R) A "U" suffix shall be applied to all constants of unsigned type.
Pointer type conversions

11.1 (R) Conversions shall not be performed between a pointer to a function and any type other than an integral type.

11.2 (R) Conversions shall not be performed between a pointer to object and any type other than an integral type, another pointer to object type or a pointer to void.

11.3 (A) A cast should not be performed between a pointer type and an integral type.

11.4 (A) A cast should not be performed between a pointer to object type and a different pointer to object type.

11.5 (R) A cast shall not be performed that removes any `const` or `volatile` qualification from the type addressed by a pointer.

Expressions

12.1 (A) Limited dependence should be placed on C's operator precedence rules in expressions.

12.2 (R) The value of an expression shall be the same under any order of evaluation that the standard permits. This rule is checked using worst-case assumptions. This means that a violation will be reported when a possible alias may cause the result of an expression to be evaluation order dependent.

12.3 (R) The `sizeof` operator shall not be used on expressions that contain side effects.

12.4 (R) The right-hand operand of a logical `&&` or `||` operator shall not contain side effects.

12.5 (R) The operands of a logical `&&` or `||` shall be `primary-expressions`.

12.6 (A) The operands of logical operators (`&&`, `||` and `!`) should be effectively Boolean. Expressions that are effectively Boolean should not be used as operands to operators other than (`&&`, `||` and `!`).

12.7 (R) Bitwise operators shall not be applied to operands whose underlying type is signed.

12.8 (R) The right-hand operand of a shift operator shall lie between zero and one less than the width in bits of the underlying type of the left-hand operand. This violation will only be checked when the shift count evaluates to a constant value at compile time.

12.9 (R) The unary minus operator shall not be applied to an expression whose underlying type is unsigned.

12.10 (R) The comma operator shall not be used.

12.11 (A) Evaluation of constant unsigned integer expressions should not lead to wrap-around.

12.12 (R) The underlying bit representations of floating-point values shall not be used. A violation is reported when a pointer to a floating-point type is converted to a pointer to an integer type.

12.13 (A) The increment (`++`) and decrement (`--`) operators should not be mixed with other operators in an expression.

Control statement expressions

13.1 (R) Assignment operators shall not be used in expressions that yield a Boolean value.
13.2 (A) Tests of a value against zero should be made explicit, unless the operand is effectively Boolean.

13.3 (R) Floating-point expressions shall not be tested for equality or inequality.

13.4 (R) The controlling expression of a for statement shall not contain any objects of floating type.

13.5 (R) The three expressions of a for statement shall be concerned only with loop control. A violation is reported when the loop initialization or loop update expression modifies an object that is not referenced in the loop test.

13.6 (R) Numeric variables being used within a for loop for iteration counting shall not be modified in the body of the loop.

13.7 (R) Boolean operations whose results are invariant shall not be permitted.

**Control flow**

14.1 (R) There shall be no unreachable code.

14.2 (R) All non-null statements shall either:
   a) have at least one side effect however executed, or
   b) cause control flow to change.

14.3 (R) Before preprocessing, a null statement shall only occur on a line by itself; it may be followed by a comment provided that the first character following the null statement is a white-space character.

14.4 (R) The goto statement shall not be used.

14.5 (R) The continue statement shall not be used.

14.6 (R) For any iteration statement there shall be at most one break statement used for loop termination.

14.7 (R) A function shall have a single point of exit at the end of the function.

14.8 (R) The statement forming the body of a switch, while, do ... while or for statement be a compound statement.

14.9 (R) An if (expression) construct shall be followed by a compound statement. The else keyword shall be followed by either a compound statement, or another if statement.

14.10 (R) All if ... else if constructs shall be terminated with an else clause.

**Switch statements**

15.1 (R) A switch label shall only be used when the most closely-enclosing compound statement is the body of a switch statement.

15.2 (R) An unconditional break statement shall terminate every non-empty switch clause.

15.3 (R) The final clause of a switch statement shall be the default clause.

15.4 (R) A switch expression shall not represent a value that is effectively Boolean.

15.5 (R) Every switch statement shall have at least one case clause.
Functions

16.1 (R) Functions shall not be defined with variable numbers of arguments.
16.2 (R) Functions shall not call themselves, either directly or indirectly. A violation will be reported for direct or indirect recursive function calls in the source file being checked. Recursion via functions in other source files, or recursion via function pointers is not detected.
16.3 (R) Identifiers shall be given for all of the parameters in a function prototype declaration.
16.4 (R) The identifiers used in the declaration and definition of a function shall be identical.
16.5 (R) Functions with no parameters shall be declared with parameter type `void`.
16.6 (R) The number of arguments passed to a function shall match the number of parameters.
16.7 (A) A pointer parameter in a function prototype should be declared as pointer to `const` if the pointer is not used to modify the addressed object.
16.8 (R) All exit paths from a function with non-void return type shall have an explicit return statement with an expression.
16.9 (R) A function identifier shall only be used with either a preceding `&`, or with a parenthesized parameter list, which may be empty.
16.10 (R) If a function returns error information, then that error information shall be tested. A violation is reported when the return value of a function is ignored.

Pointers and arrays

17.1 (R) Pointer arithmetic shall only be applied to pointers that address an array or array element.
17.2 (R) Pointer subtraction shall only be applied to pointers that address elements of the same array.
17.3 (R) `>`, `>=`, `<`, `<=` shall not be applied to pointer types except where they point to the same array. In general, checking whether two pointers point to the same object is impossible. The compiler will only report a violation for a relational operation with incompatible pointer types.
17.4 (R) Array indexing shall be the only allowed form of pointer arithmetic.
17.5 (A) The declaration of objects should contain no more than 2 levels of pointer indirection. A violation is reported when a pointer with three or more levels of indirection is declared.
17.6 (R) The address of an object with automatic storage shall not be assigned to another object that may persist after the first object has ceased to exist.

Structures and unions

18.1 (R) All structure or union types shall be complete at the end of a translation unit.
18.2 (R) An object shall not be assigned to an overlapping object.
18.3 (R) An area of memory shall not be reused for unrelated purposes.
Preprocessing directives

18.4 (R) Unions shall not be used.

19.1 (A) `#include` statements in a file should only be preceded by other preprocessor directives or comments.

19.2 (A) Non-standard characters should not occur in header file names in `#include` directives.

19.3 (R) The `#include` directive shall be followed by either a `<filename>` or "filename" sequence.

19.4 (R) C macros shall only expand to a braced initializer, a constant, a parenthesized expression, a type qualifier, a storage class specifier, or a do-while-zero construct.

19.5 (R) Macros shall not be `#define`d or `#undef`d within a block.

19.6 (R) `#undef` shall not be used.

19.7 (A) A function should be used in preference to a function-like macro.

19.8 (R) A function-like macro shall not be invoked without all of its arguments.

19.9 (R) Arguments to a function-like macro shall not contain tokens that look like preprocessing directives. A violation is reported when the first token of an actual macro argument is '#'.

19.10 (R) In the definition of a function-like macro each instance of a parameter shall be enclosed in parentheses unless it is used as the operand of # or ##.

19.11 (R) All macro identifiers in preprocessor directives shall be defined before use, except in `#ifdef` and `#ifndef` preprocessor directives and the `defined()` operator.

19.12 (R) There shall be at most one occurrence of the # or ## preprocessor operators in a single macro definition.

19.13 (A) The # and ## preprocessor operators should not be used.

19.14 (R) The `defined` preprocessor operator shall only be used in one of the two standard forms.

19.15 (R) Precautions shall be taken in order to prevent the contents of a header file being included twice.

19.16 (R) Preprocessing directives shall be syntactically meaningful even when excluded by the preprocessor.

19.17 (R) All `#else`, `#elif` and `#endif` preprocessor directives shall reside in the same file as the `#if` or `#ifdef` directive to which they are related.

Standard libraries

20.1 (R) Reserved identifiers, macros and functions in the standard library, shall not be defined, redefined or undefined.

20.2 (R) The names of standard library macros, objects and functions shall not be reused.

20.3 (R) The validity of values passed to library functions shall be checked.
20.4 (R) Dynamic heap memory allocation shall not be used.
20.5 (R) The error indicator errno shall not be used.
20.6 (R) The macro offsetof, in library <stddef.h>, shall not be used.
20.7 (R) The setjmp macro and the longjmp function shall not be used.
20.8 (R) The signal handling facilities of <signal.h> shall not be used.
20.9 (R) The input/output library <stdio.h> shall not be used in production code.
20.10 (R) The library functions atof, atoi and atol from library <stdlib.h> shall not be used.
20.11 (R) The library functions abort, exit, getenv and system from library <stdlib.h> shall not be used.
20.12 (R) The time handling functions of library <time.h> shall not be used.

Run-time failures

x 21.1 (R) Minimization of run-time failures shall be ensured by the use of at least one of:
   a) static analysis tools/techniques;
   b) dynamic analysis tools/techniques;
   c) explicit coding of checks to handle run-time faults.

16.3. MISRA C:2012

This section lists all supported and unsupported MISRA C:2012 rules.

See also Section 3.7.2, C Code Checking: MISRA C.

A number of MISRA C rules leave room for interpretation. Other rules can only be checked in a limited way. In such cases the implementation decisions and possible restrictions for these rules are listed.

x means that the rule is not supported by the TASKING C compiler. (M) is a mandatory rule, (R) is a required rule, (A) is an advisory rule.

A standard C environment

1.1 (R) The program shall contain no violations of the standard C syntax and constraints, and shall not exceed the implementation’s translation limits.
1.2 (A) Language extensions should not be used.
1.3 (R) There shall be no occurrence of undefined or critical unspecified behavior.

Unused code

2.1 (R) A project shall not contain unreachable code.
2.2 (R) There shall be no dead code.
2.3 (A) A project should not contain unused type declarations.
A project should not contain unused tag declarations. (A) 2.4
A project should not contain unused macro declarations. (A) 2.5
A function should not contain unused label declarations. (A) 2.6
There should be no unused parameters in functions. (A) 2.7

Comments

3.1 (R) The character sequences /* and // shall not be used within a comment.
3.2 (R) Line-splicing shall not be used in // comments.

Character sets and lexical conventions

4.1 (R) Octal and hexadecimal escape sequences shall be terminated.
4.2 (A) Trigraphs should not be used.

Identifiers

5.1 (R) External identifiers shall be distinct.
5.2 (R) Identifiers declared in the same scope and name space shall be distinct.
5.3 (R) An identifier declared in an inner scope shall not hide an identifier declared in an outer scope.
5.4 (R) Macro identifiers shall be distinct.
5.5 (R) Identifiers shall be distinct from macro names.
5.6 (R) A typedef name shall be a unique identifier.
5.7 (R) A tag name shall be a unique identifier.
5.8 (R) Identifiers that define objects or functions with external linkage shall be unique.
5.9 (A) Identifiers that define objects or functions with internal linkage should be unique.

Types

6.1 (R) Bit-fields shall only be declared with an appropriate type.
6.2 (R) Single-bit named bit-fields shall not be of a signed type.

Literals and constants

7.1 (R) Octal constants shall not be used.
7.2 (R) A "u" or "U" suffix shall be applied to all integer constants that are represented in an unsigned type.
7.3 (R) The lowercase character "l" shall not be used in a literal suffix trivial.
7.4 (R) A string literal shall not be assigned to an object unless the object's type is "pointer to const-qualified char".
Declarations and definitions

8.1 (R) Types shall be explicitly specified.
8.2 (R) Function types shall be in prototype form with named parameters.
8.3 (R) All declarations of an object or function shall use the same names and type qualifiers.
8.4 (R) A compatible declaration shall be visible when an object or function with external linkage is defined.
8.5 (R) An external object or function shall be declared once in one and only one file.
8.6 (R) An identifier with external linkage shall have exactly one external definition.
8.7 (A) Functions and objects should not be defined with external linkage if they are referenced in only one translation unit.
8.8 (R) The static storage class specifier shall be used in all declarations of objects and functions that have internal linkage.
8.9 (A) An object should be defined at block scope if its identifier only appears in a single function.
8.10 (R) An inline function shall be declared with the static storage class.
8.11 (A) When an array with external linkage is declared, its size should be explicitly specified.
8.12 (R) Within an enumerator list, the value of an implicitly-specified enumeration constant shall be unique.
8.13 (A) A pointer should point to a const-qualified type whenever possible.
8.14 (R) The restrict type qualifier shall not be used.

Initialization

9.1 (M) The value of an object with automatic storage duration shall not be read before it has been set.
9.2 (R) The initializer for an aggregate or union shall be enclosed in braces.
9.3 (R) Arrays shall not be partially initialized.
9.4 (R) An element of an object shall not be initialized more than once.
9.5 (R) Where designated initializers are used to initialize an array object the size of the array shall be specified explicitly.

The essential type model

10.1 (R) Operands shall not be of an inappropriate essential type.
10.2 (R) Expressions of essentially character type shall not be used inappropriately in addition and subtraction operations.
10.3 (R) The value of an expression shall not be assigned to an object with a narrower essential type or of a different essential type category.
10.4 (R) Both operands of an operator in which the usual arithmetic conversions are performed shall have the same essential type category.
10.5 (A) The value of an expression should not be cast to an inappropriate essential type.
10.6 (R) The value of a composite expression shall not be assigned to an object with wider essential type.
10.7 (R) If a composite expression is used as one operand of an operator in which the usual arithmetic conversions are performed then the other operand shall not have wider essential type.
10.8 (R) The value of a composite expression shall not be cast to a different essential type category or a wider essential type.

**Pointer type conversions**

11.1 (R) Conversions shall not be performed between a pointer to a function and any other type.
11.2 (R) Conversions shall not be performed between a pointer to an incomplete type and any other type.
11.3 (R) A cast shall not be performed between a pointer to object type and a pointer to a different object type.
11.4 (A) A conversion should not be performed between a pointer to object and an integer type.
11.5 (A) A conversion should not be performed from pointer to `void` into pointer to object.
11.6 (R) A cast shall not be performed between pointer to `void` and an arithmetic type.
11.7 (R) A cast shall not be performed between pointer to object and a non-integer arithmetic type.
11.8 (R) A cast shall not remove any `const` or `volatile` qualification from the type pointed to by a pointer.
11.9 (R) The macro `NULL` shall be the only permitted form of integer null pointer constant.

**Expressions**

12.1 (A) The precedence of operators within expressions should be made explicit.
12.2 (R) The right hand operand of a shift operator shall lie in the range zero to one less than the width in bits of the essential type of the left hand operand.
12.3 (A) The comma operator should not be used.
12.4 (A) Evaluation of constant expressions should not lead to unsigned integer wrap-around.
12.5 (M) The `sizeof` operator shall not have an operand which is a function parameter declared as "array of type".

**Side effects**

13.1 (R) Initializer lists shall not contain persistent side effects.
13.2 (R) The value of an expression and its persistent side effects shall be the same under all permitted evaluation orders.
A full expression containing an increment (++) or decrement (--) operator should have no other potential side effects other than that caused by the increment or decrement operator.

The result of an assignment operator should not be used.

The right hand operand of a logical && or || operator shall not contain persistent side effects.

The operand of the sizeof operator shall not contain any expression which has potential side effects.

**Control statement expressions**

A loop counter shall not have essentially floating type.

A for loop shall be well-formed.

Controlling expressions shall not be invariant.

The controlling expression of an if statement and the controlling expression of an iteration-statement shall have essentially Boolean type.

**Control flow**

The goto statement should not be used.

The goto statement shall jump to a label declared later in the same function.

Any label referenced by a goto statement shall be declared in the same block, or in any block enclosing the goto statement.

There should be no more than one break or goto statement used to terminate any iteration statement.

A function should have a single point of exit at the end.

The body of an iteration-statement or a selection-statement shall be a compound-statement.

All if ... else if constructs shall be terminated with an else statement.

**Switch statements**

All switch statements shall be well-formed.

A switch label shall only be used when the most closely-enclosing compound statement is the body of a switch statement.

An unconditional break statement shall terminate every switch-clause.

Every switch statement shall have a default label.

A default label shall appear as either the first or the last switch label of a switch statement.

Every switch statement shall have at least two switch-clauses.

A switch-expression shall not have essentially Boolean type.
Functions

17.1 (R) The features of <stdarg.h> shall not be used.
17.2 (R) Functions shall not call themselves, either directly or indirectly.
17.3 (M) A function shall not be declared implicitly.
17.4 (M) All exit paths from a function with non-void return type shall have an explicit return statement with an expression.
17.5 (A) The function argument corresponding to a parameter declared to have an array type shall have an appropriate number of elements.
17.6 (M) The declaration of an array parameter shall not contain the static keyword between the [ ].
17.7 (R) The value returned by a function having non-void return type shall be used.
17.8 (A) A function parameter should not be modified.

Pointers and arrays

18.1 (R) A pointer resulting from arithmetic on a pointer operand shall address an element of the same array as that pointer operand.
18.2 (R) Subtraction between pointers shall only be applied to pointers that address elements of the same array.
18.3 (R) The relational operators >, >=, < and <= shall not be applied to objects of pointer type except where they point into the same object.
18.4 (A) The +, −, += and −= operators should not be applied to an expression of pointer type.
18.5 (A) Declarations should contain no more than two levels of pointer nesting.
18.6 (R) The address of an object with automatic storage shall not be copied to another object that persists after the first object has ceased to exist.
18.7 (R) Flexible array members shall not be declared.
18.8 (R) Variable-length array types shall not be used.

Overlapping storage

19.1 (M) An object shall not be assigned or copied to an overlapping object.
19.2 (A) The union keyword should not be used.

Preprocessing directives

20.1 (A) #include directives should only be preceded by preprocessor directives or comments.
20.2 (R) The ' ', " or \ characters and the /* or // character sequences shall not occur in a header file name.
20.3 (R) The #include directive shall be followed by either a <filename> or "filename" sequence.
A macro shall not be defined with the same name as a keyword.

#undef should not be used.

Tokens that look like a preprocessing directive shall not occur within a macro argument.

Expressions resulting from the expansion of macro parameters shall be enclosed in parentheses.

The controlling expression of a #if or #elif preprocessing directive shall evaluate to 0 or 1.

All identifiers used in the controlling expression of #if or #elif preprocessing directives shall be #define'd before evaluation.

The # and ## preprocessor operators should not be used.

A macro parameter immediately following a # operator shall not immediately be followed by a ## operator.

A macro parameter used as an operand to the # or ## operators, which is itself subject to further macro replacement, shall only be used as an operand to these operators.

A line whose first token is # shall be a valid preprocessing directive.

All #else, #elif and #endif preprocessor directives shall reside in the same file as the #if, #ifdef or #ifndef directive to which they are related.

#define and #undef shall not be used on a reserved identifier or reserved macro name.

A reserved identifier or macro name shall not be declared.

The memory allocation and deallocation functions of <stdlib.h> shall not be used.

The standard header file <setjmp.h> shall not be used.

The standard header file <signal.h> shall not be used.

The Standard Library input/output functions shall not be used.

The atof, atoi, atol and atoll functions of <stdlib.h> shall not be used.

The library functions abort, exit and system of <stdlib.h> shall not be used.

The library functions bsearch and qsort of <stdlib.h> shall not be used.

The Standard Library time and date functions shall not be used.

The standard header file <tgmath.h> shall not be used.

The exception handling features of <fenv.h> should not be used.

Any value passed to a function in <ctype.h> shall be representable as an unsigned char or be the value EOF.

The Standard Library function memcmp shall not be used to compare null terminated strings.

The pointer arguments to the Standard Library functions memcpy, memmove and memcmp shall be pointers to qualified or unqualified versions of compatible types.
21.16 (R) The pointer arguments to the Standard Library function `memcmp` shall point to either a pointer type, an essentially signed type, an essentially unsigned type, an essentially Boolean type or an essentially enum type.

21.17 (M) Use of the string handling functions from `<string.h>` shall not result in accesses beyond the bounds of the objects referenced by their pointer parameters.

21.18 (M) The size_t argument passed to any function in `<string.h>` shall have an appropriate value.

21.19 (M) The pointers returned by the Standard Library functions localeconv, getenv, setlocale or, strerror shall only be used as if they have pointer to const-qualified type.

21.20 (M) The pointer returned by the Standard Library functions asctime, ctime, gmtime, localtime, localeconv, getenv, setlocale or, strerror shall not be used following a subsequent call to the same function.

### Resources

- **22.1 (R)** All resources obtained dynamically by means of Standard Library functions shall be explicitly released.
- **22.2 (M)** A block of memory shall only be freed if it was allocated by means of a Standard Library function.
- **22.3 (R)** The same file shall not be open for read and write access at the same time on different streams.
- **22.4 (M)** There shall be no attempt to write to a stream which has been opened as read-only.
- **22.5 (M)** A pointer to a `FILE` object shall not be dereferenced.
- **22.6 (M)** The value of a pointer to a `FILE` shall not be used after the associated stream has been closed.
- **22.7 (R)** The macro `EOF` shall only be compared with the unmodified return value from any Standard Library function capable of returning `EOF`.
- **22.8 (R)** The value of `errno` shall be set to zero prior to a call to an errno-setting-function.
- **22.9 (R)** The value of `errno` shall be tested against zero after calling an errno-setting-function.
- **22.10 (R)** The value of `errno` shall only be tested when the last function to be called was an errno-setting-function.